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Intellectual Property Statement
SHENZHEN MINDRAY BIO-MEDICAL ELECTRONICS CO., LTD. (hereinafter called Mindray) owns the intellectual 
property rights to this Mindray product and this manual. This manual may refer to information protected by 
copyright or patents and does not convey any license under the patent rights or copyright of Mindray, or of 
others. 

Mindray intends to maintain the contents of this manual as confidential information. Disclosure of the 
information in this manual in any manner whatsoever without the written permission of Mindray is strictly 
forbidden. 

Release, amendment, reproduction, distribution, rental, adaptation, translation or any other derivative work of 
this manual in any manner whatsoever without the written permission of Mindray is strictly forbidden.

is the trademark, registered or otherwise, of Mindray in China and other countries. All other 
trademarks that appear in this manual are used only for informational or editorial purposes. They are the 
property of their respective owners.

This posting serves as notice under 35 U.S.C.§287(a) for Mindray patents: http://www.mindrayna.com/patents.

Manufacturer’s Responsibility
Contents of this manual are subject to changes without prior notice.

Mindray is responsible for the effects on safety, reliability and performance of this product, only if:

■ all installation operations, expansions, changes, modifications and repairs of this product are conducted by
Mindray authorized personnel;

■ the electrical installation of the relevant room complies with the applicable national and local 
requirements;

■ the product is used in accordance with the instructions for use.

WARNING

• Only skilled/trained clinical professionals should operate this equipment. 

• It is important for the hospital or organization that uses this equipment to perform a recommended 
service/maintenance plan. Neglect of this may result in machine breakdown or personal injury.

Service
Mindray maintains a network of service representatives and factory-trained distributors. Prior to requesting 
service, perform a complete operational check of the instrument to verify proper control settings. If operational 
problems continue to exist, contact Mindray service.

In North America contact the Service Department at (800) 288-2121, ext: 8116 for Technical Support or (201) 
995-8000 for assistance in determining the nearest field service location.

Please include the instrument model number, the serial number, and a description of the problem with all 
requests for service.

Any questions regarding the warranty should be directed to the local sales or service representative.
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Preface
Manual Purpose

This manual contains the instructions necessary to operate the product safely and in accordance with its 
function and intended use. Observance of this manual is a prerequisite for proper product performance and 
correct operation and ensures patient and operator safety. 

This manual is based on the maximum configuration and therefore some contents may not apply to the product. 
If you have any question, please contact Mindray.

This manual is an integral part of the product. It should always be kept close to the equipment so that it can be 
obtained conveniently when needed.

Intended Audience
This manual is geared for clinical professionals who are expected to have a working knowledge of medical 
procedures, practices and terminology as required for monitoring of patients.

Illustrations
All illustrations in this manual serve as examples only. They may not necessarily reflect the setup or data 
displayed on the patient monitor.

Conventions
■ Italic text is used in this manual to quote the referenced manuals, chapters, sections and formulas.

■ Bold text is used to indicate the screen texts and names of hard keys.

■ → is used to indicate operational procedures.
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1 Safety

1.1 Safety Information

WARNING

• Indicates a potential hazard or unsafe practice that, if not avoided, could result in death or serious 
injury.

CAUTION

• Indicates a potential hazard or unsafe practice that, if not avoided, could result in minor personal 
injury or product/property damage.

NOTE
• Provides application tips or other useful information that does not involve patient or user risk.

1.1.1 Warnings

WARNING

• Patient with a pacemaker – on ventricular paced patients, episodes of Ventricular Tachycardia may 
not always be detected. Do not rely entirely upon the system’s automated arrhythmia detection 
algorithm.  Keep pacemaker patients under close surveillance.

• This equipment is used for a single patient at a time.

• To avoid explosion hazards, do not use the equipment in the presence of oxygen-rich atmospheres, 
flammable anesthetics, or other flammable agents.

• Do not touch the equipment’s metal parts or connectors when in contact with the patient; otherwise 
patient injury may result.

• Never mix patient electrode types or brands. Dissimilar metals or other incompatibilities may cause 
considerable baseline drift and may increase trace recovery time after defibrillation.

• To reduce the hazard of burns during high-frequency surgical procedure, ensure that the monitor’s 
cables and transducers never come into contact with the electro-surgery unit (ESU).

• The neutral electrode of the electro-surgery unit (ESU) shall properly contact the patient. Otherwise, 
burns may result.

• MR unsafe: the N Series monitor is not intended to be used within the Magnetic Resonance (MR) 
environment.

• Before connecting the equipment to the mains power, ensure that the voltage and frequency ratings 
of the power line are the same as those indicated on the equipment’s label or in this manual.

• Before putting the system into operation, the operator must verify that the equipment, connecting 
cables, and accessories are in correct working order and operating condition. 

• To avoid risk of electric shock, the equipment must only be connected to mains power with 
protective earth, or operated on battery power. 

• Do not touch the patient and live parts simultaneously. Otherwise patient injury may result.

• Do not touch the patient or metal parts in contact with the patient during defibrillation. Otherwise 
serious injury or death could result. 

• Do not open the equipment housings. All servicing and future upgrades must be carried out by 
trained and authorized personnel.
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• Do not rely exclusively on the audible alarm system for patient monitoring. Turning the alarm 
volume to a low level or off may result in a hazard to the patient. Always keep the patient under 
close surveillance.

• Alarm settings should be customized according to patient situations. 

• Do not place the equipment or accessories in any position that might cause it to fall on the patient.

• Do not start or operate the equipment unless the setup was verified to be correct.

• To avoid inadvertent disconnection, route all cables in a way to prevent a stumbling hazard. Wrap 
and secure excess cabling to reduce risk of entanglement by patients or personnel. 

• The physiological data and alarm messages displayed on the equipment are for reference only and 
cannot be directly used for diagnostic interpretation. The equipment should not be used as the sole 
basis for medical decisions. It must be used in conjunction with clinical signs and symptom. If any 
measurement seems questionable, first check the patient’s vital signs by alternate means and then 
check the equipment for proper functioning.

1.1.2 Cautions

CAUTION

• Use only parts and accessories specified in this manual. 

• Disposable accessories are not designed to be reused. Reuse may cause a risk of contamination and 
affect the measurement accuracy.

• Ensure that the equipment is supplied with continuous electric power during operation from the 
mains power or batteries. Sudden power failure may cause data loss.

• When no battery is installed, ensure that the monitor is supplied with continuous electric power 
during operation. Sudden power failure may lead to data loss.

• Store and use the equipment in specified environmental condition. The monitor and accessories 
may not meet the performance specification due to aging, stored or used outside the specified 
temperature and humidity range.

• Magnetic and electrical fields are capable of interfering with the proper performance of the 
equipment. For this reason make sure that all external devices operated in the vicinity of the 
equipment comply with the relevant EMC requirements. Mobile phones, X-ray equipment, and MRI 
devices are possible sources of interference as they may emit higher levels of electromagnetic 
radiation. 

• Always install or carry the equipment properly to avoid damage caused by drops, impacts, strong 
vibrations or other mechanical forces.

• Dry the equipment immediately in case of rain or water spray. 

• Some settings are password protected and can only be changed by authorized personnel. Contact 
your department manager or biomedical engineering department for the passwords used at your 
facility.

• Do not loop the patient cabling into a tight coil or wrap around the device, as this can damage the 
patient cabling.

• Dispose of the package material as per the applicable waste control regulations. Keep it out of 
children’s reach.

• At the end of its service life, the equipment, as well as its accessories, must be disposed of in 
compliance with the guidelines regulating the disposal of such products. If you have any questions 
concerning disposal of the equipment, please contact Mindray.

1.1.3 Notes

NOTE

• The equipment software copyright is solely owned by Mindray. No organization or individual shall 
resort to modifying, copying, or exchanging it or to any other infringement on it in any form or by 
any means without due permission.

• Put the equipment in a location where it can be easily viewed and operated. 
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• The equipment uses a mains plug as isolation means to the mains power. Do not locate the 
equipment in a place difficult to access the mains plug.

• During normal use, the operator is expected to face the front of the equipment.

• Remove the battery before shipping the monitor or if it will not be used for an extended period of 
time.

• Remove the battery before transporting the equipment or if the equipment will not be used for a 
long time.

• The software was developed in compliance with IEC62304, to minimize the possibility of hazards 
arising from software errors.

• This manual is based on the maximum configuration and therefore some contents may not apply to 
the product. If you have any question, please contact Mindray.

• Observance of this manual is a prerequisite for proper product performance and correct operation 
and ensures patient and operator safety.

• Keep this manual in the vicinity of the equipment so that it can be referenced when needed.

1.2 Equipment Symbols

Symbol Description Symbol Description

General warning sign Refer to instruction manual/booklet

Serial number Catalogue number

Date of manufacture Manufacturer

USB connector Protected against vertically falling water 
drops per IEC 60529

Battery indicator Computer network

Equipotentiality Alternating current

Defibrillation-proof type CF applied part Defibrillation-proof type BF applied part

Stop USB Output

Input/output IBP zero key
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NIBP start/stop Calibration

Start Stop

Set baseline Batch code

Stand-by Menu

Check sensor Graphical record

Gas outlet Gas inlet

Pushing prohibited (wheels locked, no 
pushing)

Unlocking

Video output Non-ionizing electromagnetic radiation

Dispose of in accordance to local 
requirements

Plastic identification symbol

Certified to CAN/CSA Std. C22.2 No. 60601-1, No. 60601-1-6, No. 60601-1-8, No. 60601-2-25, No. 60601-2-26, 
No. 60601-2-27, No. 80601-2-30, No. 60601-2-34, No. 60601-2-49, No. 80601-2-55, No. 80601-2-56, and No. 
80601-2-61

Symbol Description Symbol Description
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2 Equipment Introduction

2.1 Indications for Use
The BeneVision N12/N15/N17/N19/N22 patient monitors are intended for monitoring, displaying, reviewing, 
storing, alarming, and transferring of multiple physiological parameters including ECG (3-lead, 5-lead, 6-lead or 
12-lead selectable, Arrhythmia Detection, ST Segment Analysis, QT Analysis, and Heart Rate (HR)), Respiration 
Rate (Resp), Temperature (Temp), Pulse Oxygen Saturation (SpO2), Pulse Rate (PR), Non-invasive Blood Pressure 
(NIBP), Invasive Blood Pressure (IBP), Pulmonary Artery Wedge Pressure (PAWP), Cardiac Output (C.O.), 
Continuous Cardiac Output (CCO), Mixed/Central Venous Oxygen Saturation (SvO2/ScvO2), Carbon Dioxide 
(CO2), Oxygen (O2), Anesthetic Gas (AG), Bispectral Index (BIS), Respiration Mechanics (RM), Neuromuscular 
Transmission Monitoring (NMT), Electroencephalograph (EEG), and Regional Oxygen Saturation (rSO2). The 
system also provides an interpretation of resting 12-lead ECG.

All the parameters can be monitored on single adult, pediatric, and neonatal patients except for the following: 

■ The arrhythmia detection, BIS, RM, CCO, SvO2/ScvO2, PAWP, and NMT monitoring are intended for adult 
and pediatric patients only; 

■ C.O. monitoring is intended for adult patients only; 

The monitors are to be used in healthcare facilities by clinical professionals or under their guidance. They should 
only be used by persons who have received adequate training in their use. The BeneVision N12/N15/N17/N19/
N22 monitors are not intended for helicopter transport, hospital ambulance, or home use.

NOTE
• This manual is based on the maximum configuration and therefore some contents may not apply to 

the product. If you have any question, please contact Mindray.

2.2 Applied Parts 
The applied parts of the monitor are:

■ ECG electrode and leadwire

■ SpO2 sensor

■ Temp probe

■ NIBP cuff

■ IBP transducer

■ C.O. sensor

■ CCO sensor

■ ScvO2 sensor 

■ CO2 sampling line/nasal sampling cannula, water trap, and mask

■ AG sampling line, water trap, airway adapter, and mask

■ RM sensor

■ EEG electrode

■ BIS sensor

■ NMT sensor and electrode

■ rSO2 sensor

2.3 System Components
The N22 and N19 monitors consist of the main unit, primary display, secondary displays, external modules, 
satellite module rack (SMR), input devices, and output devices.
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The N17, N15, N12 monitors consist of the main unit, external display, external modules, input devices, and 
output devices. The N17 and N15 can also configured with the satellite module rack (SMR).

NOTE
• The monitor may not include all these components. Contact the local service personnel for available 

components.

2.3.1 N22, N19 Main Unit
The main unit processes data from modules and sends information to displays and, optionally, among 
networked devices. 

2.3.1.1 N22, N19 Main Unit for Integrated Installation

If the main unit and the primary display are installed together. It provides the following connectors:

(1) (2) (3) (4)

(5) (6) (7) (9) (9) (11)

(4) (4) (10)

(8) (9)

N22, N19 Main Unit Bottom View

N22, N19 Main Unit Side View

12

13

(1) Cable retainer

(2) AC Power input

(3) Nurse call connector (NC)

It is a BNC connector. It connects the monitor to the hospital’s nurse call system through the nurse call cable (PN: 
8000-21-10361). Alarms from the monitor are sent to the nurse station through the nurse call system, if 
configured to do so. 

(4) Satellite module rack connector (SMR1, 2, 3): connects the SMR and N1/T1 docking station.
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CAUTION

• Main unit installation and troubleshooting should be executed by Mindray service personnel or 
authorized technicians. 

NOTE
• The UDI label on the main unit should be consistent with that on the display.

(5) Equipotential Grounding Terminal

When using the monitor together with other devices, connect their equipotential grounding terminals together 
to eliminate the potential difference between them. 

(6) Video output connector (VP1): connects the secondary display.

(7) Network Connector (LAN1)

It is a standard RJ45 connector which connects the monitor to the central monitoring system (CMS) or other 
network devices.

(8) Network Connector (LAN 2)

Reserved for future use.

(9) Serial bus connectors (MSB1, 2, 3): connect approved USB devices, for example the keyboard, mouse, and 
barcode reader. If an independent secondary display is connected, the MSB1 connector is connected to the SBH 
connector at the rear of the secondary display to activate the MSB connector connecting the keyboard and 
mouse for the independent secondary display. 

(10) Network Connector (LAN3)

It is a standard RJ45 connector which connects the iView system to the external network. 

(11) Video output connector (VP2): connects the iView display.

(12) USB connectors: available only when iView module is configured. They connect approved USB devices to the 
iView, for example keyboard and mouse. 

(13) UDI label
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2.3.1.2 N22, N19 Main Unit for Separate Installation

If the main unit and the primary display are separately installed, besides the connectors described in 2.3.1.1 N22, 
N19 Main Unit for Integrated Installation, the main unit also provides connectors at the rear. 

2.3.2 N22, N19 Displays
The displays are used to display system information, alarm messages, parameter numerics, waveforms, and so 
on. The displays integrate audible and visual alarms and provide USB connectivity. There are two display sizes 
available: the 22-inch display and the 19-inch display. The monitor supports a primary display, a secondary 
display, and a iView display. 

(1) Video output connector (VP3): connects the VP connector on the separated primary display.

(2) Serial bus connector (MSB4): connects the serial bus hub connector (SBH) on the separated 
primary display.

(3) Signal input connector (SIG): connects the SIG1 connector on the separated primary display.

(4) DC-in connector: connects the DC-in connector on the separated primary display.

(1)      (2)       (3) (4)
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2.3.2.1 N22, N19 Integrated Primary Display

The primary display can be attached to or separately from the main unit, either horizontally or vertically. 

The following picture shows the indicators and connectors on the primary display when it is installed with the 
main unit. 

(7)

(4)

(5)

(1)

 (2)(3) (6)

(4)

(5)

(1)

(5)

(3)
(2)

(7)
(6)

(1) Alarm lamp:

When a physiological alarm or technical alarm occurs, this lamp lights and flashes corresponding with the alarm 
priority:

◆ High priority alarms: the lamp quickly flashes red.

◆ Medium priority alarms: the lamp slowly flashes yellow.

◆ Low priority alarms: the lamp lights in cyan without flashing.
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2.3.2.2 N22, N19 Separated Primary Display and Secondary Display

Besides the indicators and connectors, which are the same as those of the integrated primary display, the 
separated primary display and the secondary display have connectors at the rear. 

(2) Battery indicator:

◆ Yellow: the battery is being charged.

◆ Green: the battery is fully charged.

◆ Flashing green: the monitor operates on battery power.

◆ Off: no battery is installed, or the battery is malfunctioning, or the monitor is powered off and no AC power 
is connected.

(3) AC power indicator

◆ On: when AC power is connected.

◆ Off: when AC power is not connected. 

(4) Power switch

◆ Pressing this switch turns on the monitor.

◆ When the monitor is on, pressing and holding this switch turns off the monitor.  

(5) Serial bus connectors (MSB): connect approved USB devices, for example keyboard, mouse, and barcode reader. 
Note that every connector may not be visible if the handle (7) is installed.

(6) Navigation knob

(7) Handle

(1)               (2)       (3)       (4)           (5)

(6)

(1) Serial bus connector (MSB1, MSB2): connect approved USB devices, for example keyboard, mouse, and barcode 
reader.

(2) Signal input connector (SIG1): for the separate primary display, it connects the SIG connector at the rear of the 
main unit; for the secondary display, it is reserved for future use. 

(3) Serial bus hub connector (SBH): connects the MSB1 connector at the bottom of the main unit to activate MSB 
connectors for the independent secondary display.
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NOTE

• The UDI label on the main unit must be consistent with that on the display

•  VP of the primary display must connect to VP3 on the main unit to have a supported configuration.

2.3.3 N17, N15, N12 Main Unit
The main unit processes and displays data from modules, and optionally, among networked devices. 

2.3.3.1 N17, N15, N12 Front View

(4) DC-in connector: connects the DC adapter to run the secondary display. 

(5) Video output connector (VP): connects only to the VP3 connector on the back of the main unit when used as a 
separate primary display. 

(6) UDI label

(1) Alarm lamp:
When a physiological alarm or technical alarm occurs, this lamp lights and flashes corresponding 
with the alarm priority:

◆ High priority alarms: the lamp quickly flashes red.

◆ Medium priority alarms: the lamp slowly flashes yellow.

◆ Low priority alarms: the lamp lights in cyan without flashing.

(2) Display

(5) (4)

(3)

(2)

(1)
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2.3.3.2 N17, N15, N12 Left View

(3) Battery indicator:
◆ Yellow: the battery is being charged.

◆ Green: the battery is fully charged.

◆ Flashing green: the monitor operates on battery power.

◆ Off: no battery is installed, or the monitor is powered off and no AC power is connected.

(4) AC power indicator
◆ On: when AC power is connected.

◆ Off: when AC power is not connected. 

(5) Power switch
◆ Pressing this switch turns on the monitor.

◆ When the monitor is on, pressing and holding this switch turns off the monitor. 

                                           N17/N15                                  N12

 (1) Handle 

 (2) Module racks

(1)

(2)

(2)
(2)

(1)

(2)
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2.3.3.3 N17, N15, N12 Right View

(1) Handle

(2) Recorder

(2)

(1)
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2.3.3.4 N15, N12 Rear View 
 

(1) USB connectors

Connect approved USB devices, for example the keyboard, mouse, and barcode reader. 

(2) Equipotential Grounding Terminal

When using the monitor together with other devices, connect their equipotential grounding terminals together 
to eliminate the potential difference between them. 

(3) AC Power input

(4) Satellite module rack connector

For N15, connects the SMR and N1/ T1 docking station.

For N12, connects the N1/ T1 docking station.

(5) Nurse call connector 

It is a BNC connector. It connects the monitor to the hospital’s nurse call system through the nurse call cable (PN: 
8000-21-10361). Alarms from the monitor are sent to the nurse station through the nurse call system, if 
configured to do so. 

(6) Digital video connector: connects external display.

(7) Network Connector 

It is a standard RJ45 connector which connects the monitor to the central monitoring system (CMS) or other 
network devices.

(1)

(2)

(1)

(3)

(4)

(6)

(7)

(5)
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2.3.3.5 N17 Rear View

(3)(1)

(2) (7)

(6)

(10)

(9)

(5)

(8)

(4)

(1) Equipotential Grounding Terminal

When using the monitor together with other devices, connect their equipotential grounding terminals together 
to eliminate the potential difference between them. 

(2) AC Power input

(3) USB connectors

Connect approved USB devices, for example the keyboard, mouse, and barcode reader. 

(4) USB connectors: available only when iView module is configured. They connect approved USB devices to the 
iView system, for example keyboard and mouse. 

(5) Digital video connector: connects a mirrored external display.

(6) Digital video connector: 

Connects the iView display if the iView module is configured.

Connects an independent external display if the N17 does not have an iView.

(7) Network Connector 

It is a standard RJ45 connector which connects the monitor to the central monitoring system (CMS) or other 
network devices.

(8) Network Connector: available only when iView module is configured. It is a standard RJ45 connector which 
connects the iView system to an external network. 

(9) Satellite module rack (SMR) connector: connects the SMR or N1/T1 docking station.

(10) Nurse call connector 

It is a BNC connector. It connects the monitor to the hospital’s nurse call system through the nurse call cable (PN: 
8000-21-10361). Alarms from the monitor are sent to the nurse station through the nurse call system, if 
configured to do so. 
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2.3.4 Satellite Module Rack (SMR)
The SMR provides an interface between the monitor and external modules. The SMR has eight module slots. It is 
connected to the main unit through the SMR connector. 

The following pictures show the indicator and connectors on the SMR.

2.3.5 External Modules
The external modules are used to monitor the patient’s physiological parameters, record patient information 
and data, and connect external devices. The monitor provides the following modules: 

■ Parameter modules: acquires and processes the patient’s data and sends the data to the main unit. 

■ Recorder module: prints patient information, parameter measurements and waveforms. 

■ BeneLink module: connects external devices. The monitor outputs data from external devices through the 
BeneLink module.

2.3.5.1 Available Modules

Refer to 25.18 External Modules for available modules.

The monitor can simultaneously use maximum of three IBP modules and three Temp modules (besides the 
Temp and IBP of the MPM module), and two rSO2 modules. The other modules can only be used one at a time. 
Otherwise, the monitor will issue a module conflict prompt. Using MPM module, T1, or N1 at the same time will 
also result in module conflict. 

For example, if a CO2 module is already loaded and then another CO2 module is inserted, the monitor will then 
prompt module conflict. To solve the problem of module conflict, just remove a module. 

(1) SMR status indicator: illuminates when the SMR is powered on. 

(2) Monitor connector: connects to the Passport 17m/12m monitor. 

(3) Monitor connector: connects to the BeneVision monitor.

(1)

(2)         (3)
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2.3.5.2 Example Module

The parameter modules have similar structure: 

■ The parameter label is marked at the upper left corner.

■ Hard keys are located on the upper part.

■ Patient cable connectors are located at the lower part.

Take the MPM module as an example: 

(1) NIBP Start/Stop key: starts/stops NIBP measurement. 

(2) Zero hard key: enters the Zero IBP dialog.

(3) Analog out connector: outputs defibrillation synchronization pulse, ECG, and IBP analog 
signal.

(4) Module status indicator

◆ On: the module works properly. 

◆ Flashing: the module is initializing. 

◆ Off: the module is not connected or the module fails. 

(5) Connector for IBP cable 

(6) Connector for Temp probe

(7) Connector for NIBP cuff

(8) Connector for SpO2 cable

(9) Connector for ECG cable

   (1)                (2)               (3) 

(4)

(5)
(6)

(7)

(8)

(5)

(9)
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2.3.5.3 BeneVision N1

The BeneVision N1 is used as an MPM module when being connected to the monitor through the module rack 
(for N17, N15, N12), SMR or through the Dock.

2.3.5.4 T1 

The T1 is used as an MPM module when being connected to the monitor through the module rack (for N17, N15, 
N12), SMR or through the T1 docking station. 
 

(2)

(5)

(3)(1) (4)

(6)

(7)

(3)

(9)

(8)

(1) Power switch

(2) Sample line connector for sidestream 
CO2

(3) Temperature probe connector 

(4) Gas outlet

(5) ECG cable connector

(6) SpO2 sensor connector

(7) NIBP cuff connector

(8) Multifunctional connector: outputs 
analog ECG, IBP and defib 
synchronization signals.

(9) IBP cable connector

 (1)         (1)             

(2)

(4)

(6)

(5)

(3)

(1) Temperature probe connector 

(2) NIBP cuff connector

(3) ECG cable connector

(4) SpO2 sensor connector

(5) Multifunctional connector: outputs analog 
ECG, IBP, and defibrillation synchronization 
signals. 

(6) IBP cable connector
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2.3.6 Cable Management Kit
The cable management kit is installed at the bottom of the SMR. 

2.3.7 Input Devices 
The monitor allows data entry through touchscreen, keyboard, mouse, navigation knob, remote controller, and 
barcode reader. 

Only Mindray specified input devices should be used. For N22 and N19, the primary display and the secondary 
display can have independent mice and keyboards. When the secondary display is used as an extended display, 
one mouse and one keyboard can control both the primary display and the secondary display. 

For N22 and N19, you can use the navigation knob to operate some features of the monitor, such as scrolling 
through lists. The navigation knob is installed at the bottom of the display. The primary display and the 
secondary display can have independent navigation knobs. When the secondary display is configured as an 
extended display, you can use one navigation knob to control both the primary display and the secondary 
display. 

(1) Handle: can hold the NIBP cuff

(2) Cable hooks: can hold the cables and leadwires

(1)

(2)

(1) Alarm Reset hard key: resets the alarm system

(2) Main Menu hard key: enters the main menu.

(3) Navigation knob

(4) NIBP Start/Stop hard key: starts an NIBP measurement or stops the current NIBP 
measurement

(5) Alarm Pause hard key: pauses physiological alarm system

(1) (2)

(4)(5)

(3)
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2.3.8 Printing Devices
The monitor can use Mindray specified printer and/or recorder to output patient information and data.

N17, N15, N12 can be configured with a built-in recorder. If the built-in recorder is not available, an optional 
external recorder module is available.

For N22 and N19, to use the recorder, insert the recorder module into the SMR.

The printer can be connected to the monitor through the network to output patient reports. 
2 - 16  BeneVision N22/N19/N17/N15/N12 Patient Monitor Operator’s Manual



3 Getting Started

3.1 Equipment Preparation Safety Information

WARNING

• Use only installation accessories specified by Mindray.

• Connect only approved devices to this equipment. Devices connected to the equipment must meet 
the requirements of the applicable IEC standards (e.g. IEC 60950 safety standards for information 
technology equipment and IEC 60601-1 safety standards for medical electrical equipment). The 
system configuration must meet the requirements of the IEC 60601-1 medical electrical systems 
standard. Any personnel who connect devices to the equipment’s signal input/output port are 
responsible for providing evidence that the safety certification of the devices has been performed in 
accordance to the IEC 60601-1. If you have any questions, please contact Mindray. 

• The monitor and parameter monitoring accessories are suitable for use within the patient 
environment. For other equipment and accessories connected to the monitor, consult 
corresponding manufacturers for the suitability within the patient environment.

• If it is not evident from the equipment specifications whether a particular combination with other 
devices is hazardous, for example, due to summation of leakage currents, please consult the 
manufacturer or an expert in the field. A determination must be made that the proposed 
combination will not negatively affect the devices themselves or the patient's safety.

CAUTION

• The equipment should be installed by Mindray authorized personnel. 

• When disposing of the packaging material, be sure to observe the applicable waste control 
regulations and keep it out of children’s reach.

• Before use, verify whether the packages are intact, especially the packages of single use accessories. 
In case of any damage, do not apply it to the patient.

• Make sure that the equipment operating environment meets the specific requirements. Otherwise 
unexpected consequences, e.g. damage to the equipment, could result. 

• Avoid rough handling during transport.

NOTE

• This manual is based on the maximum configuration and therefore some contents may not apply to 
the product. If you have any question, please contact Mindray.

• Put the equipment in a location where it can be easily viewed and operated.

• Keep this manual in the vicinity of the equipment so that it can be referenced when needed.

• Save the packing case and packaging material as they can be used if the equipment must be 
reshipped.

• Many settings in the patient monitor are password protected. It is recommended to change the 
default passwords and keep the passwords safe. Passwords should only be changed by authorized 
personnel. Contact the department manager or biomedical engineering department for the 
passwords used at the facility.

3.2 Monitor Installation
The monitor can be installed in various ways as required. 

■ Wall mount

■ Installed on the medical supply unit
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■ Installed on the anesthesia machine

3.2.1 Unpacking and Checking
Before unpacking, examine the packaging carefully for signs of damage. If any damage is detected, contact the 
carrier, distributor, or Mindray.

If the packing case is intact, open the package and remove the equipment and accessories carefully. Check all 
materials against the packing list and check for any mechanical damage. Contact Mindray in case of any 
problems.

3.2.2 Environmental Requirements
The operating environment of the equipment must meet the requirements specified in this manual.

The environment where the equipment is used shall be reasonably free from noises, vibration, dust, corrosive, 
flammable and explosive substances. Moreover, to maintain good ventilation, the equipment shall be at least 2 
inches (5cm) away from around the cabinet.

When the equipment is moved from one place to another, condensation may occur as a result of temperature or 
humidity difference. In this case, never start the system before the condensation evaporates.

CAUTION

• Make sure that the equipment operating environment meets the specific requirements. Otherwise 
unexpected consequences, e.g. damage to the equipment, could result.

3.3 Setting Up the Equipment
Observance of this manual is a prerequisite for proper product performance and correct operation. It ensures 
patient and operator safety. 

3.3.1 Connecting the AC Mains
The monitor is powered by an AC power supply. Before connecting the equipment to the AC mains, check that 
the voltage and frequency ratings of the power line are the same as those indicated beside the AC power input.   

To use the AC power source, follow this procedure:

1. Connect the female end of the power cord with the AC power input. 

2. Connect the male end of the power cord with a wall AC outlet. 

3. Check that the AC indicator is on.

The AC indicator is off if the AC mains is not connected. When AC mains is connected, the AC indicator is 
illuminated in green.

WARNING

• Operate the equipment on battery power if the integrity of the protective earth conductor or the 
protective earthing system in the installation is in doubt.

CAUTION

• Always use the accompanying power cord delivered with the monitor.

• Before connecting the equipment to the AC mains, ensure that the voltage and frequency ratings of 
the power line are the same as those indicated beside the AC power input.

NOTE
• Use the cable retainer to secure the power cord to prevent it from falling off.
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3.3.2 Connecting the Input Devices
Connect the mouse, keyboard, navigation knob, and/or barcode reader to the USB ports if necessary.

3.3.3 Connecting the SMR
To connect the SMR, use the SMR cable (PN: 009-005121-00 or 009-005122-00) to connect the monitor 
connector on the rear of SMR to the SMR connector on the main unit.

3.3.4 Connecting Modules to the SMR

To connect a module to the SMR, follow this procedure:

1. With the module properly oriented, align the module insertion guide slot with the SMR insertion guide. 
Push the module into the SMR until there is a click.

2. Push the lock at the bottom of the module inwards to lock the module.

3.3.5 Removing Modules from the SMR
To remove a module from the SMR, follow this procedure:

1. Pull outwards on the lock at the bottom of the module to release the module.

2. Lift the latches at the bottom of the module and slide the module out of the SMR. Hold on the module 
securely to make sure it does not drop when it comes out.

 

CAUTION

• When removing modules, be careful not to drop them. Modules may be heavier than expected, so 
securely supporting a module with two hands during removal is recommended. 

(1) Latch

(2) Lock

(1)
(2)
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3.4 Turning on the Monitor
Before beginning measurements, turn on the monitor, perform the following inspections: 

1. Check the monitor, SMR and modules for any mechanical damage. Make sure that all external cables, plug-
ins and accessories are properly connected. 

2. Connect the power cord to the AC power source. 

3. Press the power switch to turn on the monitor. Secondary displays must be turned on separately.

When the monitor is turned on, the alarms are paused for two minutes. Then the alarm system is activated.

CAUTION

• Check that visual and auditory alarm signals are presented correctly when the equipment is 
powered on.

• Do not use the monitor for any monitoring procedure on a patient if you suspect it is not working 
properly, or if it is mechanically damaged. Contact the service personnel or Mindray. 

3.5 Operation and Navigation
Everything needed to operate the monitor is on its screen. Almost every element on the screen is interactive. 
Screen elements include parameter values, waveforms, quick keys, information fields, alarms fields, dialogs, and 
menus. Often you can access the same element in different ways. For example, you can access a parameter 
dialog by selecting the corresponding numeric area or waveform area, through the Menu hard key  on the 
parameter module, or through the Parameters Setup quick key.

3.5.1 Using the Touchscreen 
You can use the touchscreen to select a screen element by pressing directly on the monitor’s screen. 

3.5.1.1 Tapping or Swiping across the Screen
■ Tapping the screen 

◆ To select an item from menus or lists or select a quick key, tap on it with your finger.

◆ To enter a parameter menu, tap the corresponding numeric area or waveform area. For example, 
select the ECG numeric area or waveform area to enter the ECG menu.

■ Swiping the screen with a single finger

◆ To scroll through a list or a menu, swipe up or down.

◆ To show or expand the Minitrends screen or the EWS screen, swipe right across the corresponding 
screen.

◆ To contract or hide the Minitrends screen or the EWS screen, swipe left across the corresponding 
screen. 

■ Swiping across the screen with two fingers

◆ To switch to another screen, swipe left or right across the screen. For example, on the Normal screen, 
swipe with two fingers from left to right to switch to the Minitrends screen.

◆ To discharge a patient, swipe from top to bottom.

3.5.1.2 Locking the Touchscreen

To avoid accidental use, you can temporarily disable the touchscreen by holding and pressing the Main Menu 
quick key and sliding as directed by the arrow. A padlock symbol  displays at the top of the main menu quick 
key if the touchscreen is disabled. 

The touchscreen lock period is configurable. To do so, follow this procedure:

1. Access Display in either of the following ways:

◆ Select the Screen Setup quick key → select the Display tab.

◆  Select the Main Menu quick key → from the Display column select Display.

2. Set Screen Lock Duration.
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The touchscreen is enabled when the preset time is reached. To manually enable the touchsceen, hold and press 
the Main Menu quick key and slide as directed by the arrow.

CAUTION

• Check that the touchscreen is not damaged.broken, or loose. If there is any sign of damage, stop 
using the monitor and contact the service personnel. 

3.5.2 Using the On-Screen Keyboard
The on-screen keyboard enables information entry: 

■ Enter the information by selecting one character after another. 

■ Select the Backspace key  to delete single characters or select  to delete the entire entry. 

■ Select the Caps Lock key  to access uppercase letters. 

■ Select the Enter key  to confirm the entry and close the on-screen keyboard. 

If a conventional keyboard is connected to the monitor, you can use it instead of, or in combination with, the on-
screen keyboard.

3.5.3 Using the Navigation Knob (for N22/N19)
You can use the navigation knob and associated buttons to access the main menu, pause alarms, reset alarms, 
and start/stop NIBP measurements. 

3.5.4 Using the Barcode Reader
The monitor supports both a linear (1D) barcode reader and two-dimensional (2D) barcode reader. The barcode 
reader is connected to the monitor’s MSB connector (for N22/N19) or the USB connector (N17/N15/N12). 

NOTE

• Use the Mindray custom barcode reader to obtain all the available patient information from both 
the 2D and 1D barcodes. Using other barcode readers can only output the patient’s medical record 
number (MRN) and visit number.

3.5.4.1 Clearing Old Data Formats (for the Mindray Custom 2D Barcode Reader)

If you are using the Mindray custom 2D barcode reader (Model HS-1R or HS-1M), before using the it for the first 
time, clear old data formats and configure the barcode reader. To do so, follow this procedure:

1. Scan the engineering barcode to clear the previous data format. 

2. Scan the 2D engineering barcode which contains the hospital’s data format. 

NOTE

• Contact the scanner manufacturer or Mindray to obtain the barcodes for clearing data formats and 
programming the hospital’s data format. 

3.5.5 Using the Remote Controller
The remote controller can control the monitor by connecting the receiver of the remote controller to the 
monitor’s MSB connector (for N22/N19) or the USB connector (N17/N15/N12). For more information on how to 
use the remote controller, see the Instructions for Use delivered with the remote controller.

3.6 Screen Display
The following figure shows the normal screen:
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3.6.1 On-screen Symbols
The following table lists the on-screen symbols displayed on the system status information area:

(1)           (2)                                                                                       (3)                                (4)                         (5)

(9)

(6)

(7)

(8)

(1) Patient information area: displays patient information, including patient category, gender, department, room 
number, bed number, and so on. The displayed patient information is configurable. Selecting this area enters the 
Patient Management dialog. For more information, see 5.2.1 Entering the Patient Management Dialog.

(2) The current configuration: displays the name of the configuration that can be loaded from the main menu.

(3) Technical alarm information area: displays prompt messages at the top; displays technical alarm messages at the 
bottom.

(4) Physiological alarm information area: displays high priority physiological alarms at the top; displays medium and 
low priority physiological alarms at the bottom.

(5) System status information area: displays alarm symbol, battery status, network status, currently connected CMS, 
storage device status, and system time. For more information, see 3.6.1 On-screen Symbols.

(6) Parameter waveform area: displays parameter waveforms, measurement ranges, and magnification. Selecting a 
waveform enters the corresponding parameter dialog. 

(7) Parameter numerics area: displays parameter values, alarm limits, and alarm status. This area can also display the 
parameter list. For more information, see  3.9.3 Displaying the Parameter List. Selecting a parameter numeric block 
enters the corresponding parameter dialog. Selecting the parameter list enters Tabular Trends review.

(8) Parameter waveform/numerics area: unique area of the screen that can be configured to display either parameter 
numerics or parameter waveforms. Depending on the configuration, the tiles take on the characteristics of either 
area (6) or area (7).

(9) Quick key area: displays quick keys.

Symbol Description Symbol Description

Adult, male Adult, female

Pediatric, male Pediatric, female
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3.6.2 Dialogs
All dialogs have similar style and structure, see the figure below: 

 

Neonate, male Neonate, female

Wireless network is connected. The solid part 
indicates network signal strength.

Wireless network is not connected.

Wired network is connected. Wired network is not connected.

All the alarms are paused. Individual physiological alarms are turned off 
or the monitor is in the alarm off status. 

Audible alarm tones are paused. Audible alarm tones are turned off.

The alarm system is reset.  The battery is working correctly. The green 
portion represents the remaining charge.

The battery has low power and needs to be 
charged.

 The battery has critically low charge and 
needs to be charged immediately. Otherwise, 
the monitor will automatically shut down 
soon.

 The battery is being charged. No battery is installed.

Symbol Description Symbol Description

(1) Dialog heading 

(1)

(2)

(2)

(3)

(4)

(5)

(6)
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3.6.3 Quick Keys
The monitor provides quick keys for you to quickly access some functions. The quick key area is located at the 
bottom of the screen. Normally the quick key area displays 14 quick keys (12 quicks keys for N12). The Main 
Menu key is permanently located the right, and the More key is permanently located at the left. Selecting the 
More quick key shows more quick keys. The quick keys displayed on the screen are configurable.

3.6.3.1 Available Quick Keys

The following table shows available quick keys.

(2) subdialog tabs 

(3) Operation buttons

(4) Exit button: closes the current dialog.

(5) Main body area: includes dialog items and options.

(6)  Switch: 

◆ Green: the switch is on.

◆ Gray: the switch is off.

Symbol Label Function Symbol Label Function 

Main Menu Enters the main menu. Alarm Reset Resets the alarm system.

Alarm Pause Pauses the physiological 
alarm system (Availability 
depends on configuration 
of Pause in Maintenance 
→ Alarm → Pause/Reset 
dialog).

Audio Pause Pauses alarm tone 
(Availability depends on 
configuration of Pause in 
Maintenance → Alarm → 
Pause/Reset dialog). 

Screen Setup Enters the Screen Setup 
dialog.

Standby Enters the standby mode.

Manual Event Manually saves an event 
into the Events list.

Print Starts printing a real-time 
report.

NIBP Start/
Stop

Starts an NIBP 
measurement or stops the 
current NIBP 
measurement.

NIBP Measure Opens the NIBP Measure 
interval options.

NIBP STAT Starts a five-minute 
continuous NIBP 
measurement.

NIBP Stop All Stops all NIBP 
measurements.

Alarm Setup Enters the Alarm dialog. More Shows more quick keys.

Zero IBP Enters the Zero IBP dialog. C.O. Measure Opens the C.O. Measure 
screen.
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PAWP Opens the PAWP screen. Loops Opens the Loops screen.

Venipuncture Inflates the NIBP cuff to 
help venous puncture.

Start TOF Starts/stops TOF 
measurement.

Parameters 
Setup

Enters the Parameters 
Setup dialog.

Remote View Opens the Remote View 
screen to view other 
patients.

Review Enters the Review dialog 
to review historical data.

Minitrends Opens the Minitrends 
screen.

OxyCRG Opens the OxyCRG screen. ECG Full- 
Screen

Opens the ECG full screen.

Privacy Mode Enters the privacy mode. Night Mode Enters the night mode.

CPB Mode Enters the CPB mode. Intubation 
Mode

Enters the intubation 
mode.

Volume Enters the Volume dialog. Freeze Freezes waveforms.

Calculations Enters the Calculations 
dialog.

Load Config Enters the Load Config 
dialog.

Patient 
Management

Enters the Patient 
Management dialog.

Record Starts/Stops a recording.

Integrated 
Devices

Opens the Integrated 
Devices screen

Rotate Screen

(N22 and N19 
only)

Changes the screen 
orientation.

ECG Lead/Gain Enters the ECG Lead/Gain 
dialog.

Call Help Sends the Call Help signal 
over the network.

HemoSight Enters the HemoSight 
dialog.

EWS Opens the EWS screen.

GCS Enters the GCS dialog. SepsisSight Enters the SepsisSight 
dialog.

Symbol Label Function Symbol Label Function 
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3.6.3.2 Configuring the Displayed Quick Keys 

To select the quick keys for display, follow this procedure:

1. Access Quick Keys in either of the following ways:

◆ Select the Screen Setup quick key → the Select Quick Keys tab.

◆ Select the Main Menu quick key → from the Display column select Quick Keys.

2. Select the Current tab to configure the quick keys for display on the screen: From the top of this page, 
select a block location to show a certain quick key, and then select the quick key from the quick key list. For 
example, to show the Screen Setup quick key at the first block, select the first block, and then select 
Screen Setup from the list.

3. Select the More tab to configure the quick keys for display when the More quick key is selected.

3.7 Operating Modes
The monitor provides different operating modes. This section describes the different monitoring modes and 
standby modes.

3.7.1 Monitoring Mode
The monitoring mode is the most frequently used clinical mode for patient monitoring. When the monitor is 
turned on, it automatically enters the monitoring mode.

3.7.2 Privacy Mode
The privacy mode is a special clinical monitoring mode. In the privacy mode, the monitor does not display 
patient information and monitoring data. This provides controlled access to patient data and ensures 
confidentiality.

The privacy mode is only available when the patient admitted by the monitor is also monitored by the CMS. The 
monitor continues monitoring the patient, but patient data is only visible at the CMS.

3.7.2.1 Entering the Privacy Mode

To enter the privacy mode, choose either of the following ways:

■ Select the Privacy Mode quick key → select Ok.

■ Select the Main Menu quick key → from the Display column select Privacy Mode → select Ok.

The monitor has the following features after entering the privacy mode:

■ The screen turns blank. 

Discharge 
Patient

Enters the Discharge 
Patient dialog to 
discharge the patient and 
restore pre-configured 
default settings.

Discharged 
Patients

Enters the Discharged 
Patients dialog and 
displays previously 
discharged patients.

ECG 24h Sum Views the 24-hour ECG 
summary.

End Case 
Report

Prints the selected end 
case reports

Bedside 
Devices

Enters the Bedside 
Devices dialog.

Targeted Goal Opens the Targeted Goal 
screen.

BoA 
Dashboard

Opens the BoA 
Dashboard screen.

Resus Mode Enters the resus mode.

Symbol Label Function Symbol Label Function 
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■ Except for the low battery alarm, the monitor inactivates alarm tones and alarm lights for all other alarms.

■ The monitor suppresses all system sounds, including heart beat tone, pulse tone, and prompt tone. 

WARNING
. 

• In the privacy mode, all audible alarms are suppressed and the alarm light is deactivated at the 
monitor. Alarms are presented only at the CMS. Pay attention to potential risk.

NOTE
• The privacy mode is not available if the Department is set to OR.

• You cannot enter the privacy mode if a low battery alarm is active.

3.7.2.2 Exiting the Privacy Mode

The monitor automatically exit the privacy mode in any of the following situations:

■ The monitor disconnects from the CMS. 

■ The low battery alarm occurs.

You can also operate the touchscreen, mouse, or keyboard to manually exit the privacy mode.

3.7.3 Night Mode 
The night mode is a special clinical monitoring mode. The night mode reduces screen brightness, sound 
volumes, and pauses NIBP measurements. To avoid disturbing the patient, you can use the night mode.

3.7.3.1 Entering the Night Mode

To enter the night mode, follow this procedure:

1. Select the Night Mode quick key, or select the Main Menu quick key → from the Display column select 
Night Mode.

2. Change the night mode settings if necessary.

3. Select Enter Night Mode. 

The night mode settings are as follows by default:

■ Brightness: 1

■ Alarm Volume: 2 

■ QRS Volume: 1

■ Key Volume: 0

■ NIBP End Tone: Off

■ Stop NIBP: Off

CAUTION

• Verify the night mode settings before entering the night mode. Pay attention to the potential risk if 
the setting value is low.

3.7.3.2 Exiting the Night Mode

To cancel the night mode, follow this procedure:

1. Select the Night Mode quick key, or select the Main Menu quick key → from the Display column select 
Exit Night Mode.

2. Select Ok.
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NOTE

• If the monitor is connected to the CMS, it automatically exits the night mode if disconnected from 
the CMS.

• The monitor resumes the previous settings after exiting the night mode.

3.7.4 Standby Mode
You can temperately stops patient monitoring without switching off the monitor by entering the standby mode.

3.7.4.1 Entering the Standby Mode
1. Select the Standby quick key, or select the Main Menu quick key → from the Patient Management 

column select Standby. 

2. Define where the patient is by selecting a location in the drop down list when the monitor enters the 
standby mode.

3. Select Ok.

The monitor behaves as follows after entering the standby mode:

■ Stops all parameter measurements.

■ Disables all the alarms and prompt messages, except for the battery low alarm. 

■ Turns screen brightness to the dimmest after entering the standby mode for 30 seconds. 

WARNING

• Pay attention to the potential risk of placing the monitor to standby. In the standby mode, the 
monitor stops all parameter measurements and disable all the alarm indications, except for the 
battery low alarm.

3.7.4.2 Changing the Patient Location at Standby

To change the patient’s location, select patient location from the Standby screen.

3.7.4.3 Exiting the Standby Mode

To exit the standby mode, choose any of the following ways:

■ Select Resume Monitor to exit the standby mode and resume monitoring the current patient. 

■ Select Discharge Patient to discharge the current patient. 

If the monitor automatically enters the standby mode after a patient is discharged, choose any of the following 
ways to exit the standby mode:

■ Select Monitor to exit the standby mode and admit a new patient.

■ Select Patient Management to enter the patient information for preparing to admit a new patient.

When the monitor exits Standby mode and resumes monitoring, the alarms are paused for two minutes, after 
which the alarm system is activated.

3.7.5 Discharge Mode
The discharge mode is a special standby mode after a patient is discharged.

3.8 Configuring the Monitor
Configure the monitor before putting it in use.
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3.8.1 Setting the Screen Orientation (for N22 and N19)
Both the primary display and the secondary display can be installed vertically or horizontally. Set the screen 
orientation accordingly. To do so, follow this procedure:

1. Access Display in either of the following ways:

◆ Select the Screen Setup quick key → select the Display tab.

◆  Select the Main Menu quick key → from the Display column select Display.

2. Select Screen Orientation to set the screen orientation of the corresponding display.

◆ Portrait: if the display is vertically installed, set Screen Orientation to Portrait.

◆ Landscape: if the display is horizontally installed, set Screen Orientation to Landscape.

You can select the Rotate Screen quick key to quickly switch the screen orientation.

3.8.2 Setting the Date and Time
To set the system time, follow this procedure: 

1. Select the Main Menu quick key → from the System column select Time.

2. Set Date and Time.

3. Set Date Format.

4. If you want to use the 12-hour mode, switch off 24 Hour Time.

5. If you want to use daylight saving time, switch on Daylight Saving Time. You can manually switch on or off 
the daylight saving time only when the auto daylight saving time function is disabled. For more 
information, see 33.8.2 Enabling Auto Daylight Savings Time for details.

If the monitor is connected to a central monitoring system (CMS) or hospital clinical system (HIS), the date and 
time are automatically taken from the CMS. In this case, you cannot change the date and time on the monitor.

CAUTION

• Changing the date and time affects the storage of trends and events and may result in loss of data.

3.8.3 Adjusting the Screen Brightness
To adjust the screen brightness, follow this procedure: 

1. Access Display in either of the following ways:

◆ Select the Screen Setup quick key → select the Display tab.

◆  Select the Main Menu quick key → from the Display column select Display.

2. Set Brightness. If Brightness is set to Auto, the monitor automatically adjust the screen brightness 
according to the ambient light.

NOTE

• The brightness of the primary screen and secondary screen can be adjusted separately. 

3.8.4 Adjusting the Volume
■ Set Alarm Volume in either of the following ways:

◆ Select the Volume quick key.

◆ Select the Main Menu quick key → from the Alarm column select Setup.

■ Set Reminder Volume by selecting the Main Menu quick key → from the Alarm column select Setup.

■ Set QRS Volume in any of the following ways:

◆ Select the Volume quick key.

◆ From the ECG dialog select Setup.
BeneVision N22/N19/N17/N15/N12 Patient Monitor Operator’s Manual 3 - 13



◆ From the SpO2 dialog select PR Setup.

■ Select the Volume quick key to set Key Volume.

3.9 General Operation
This section describes the operations that are generally used when monitoring a patient.

3.9.1 Switching On or Off a Parameter
You can manually switch on or off a parameter when its module is connected. If setting parameter switches is 
not password protected, follow this procedure to set parameter switches:

1. Access Parameters On/Off in either of the following ways:

◆ Select the Screen Setup quick key → select the Parameters On/Off tab.

◆  Select the Main Menu quick key → from the Parameters column select Parameters On/Off.

2. Switch on or off desired parameters.

When a parameter is switched off, the monitor stops data acquisition and alarming for this measurement. 

NOTE

• When a parameter is manually switched off, you cannot monitor this parameter even if 
corresponding parameter module is plugged in and related accessories of this parameter are 
connected.

3.9.2 Displaying Parameter Numerics and Waveforms 
You can configure the parameter numerics, waveforms, and their sequence displayed on the normal screen. To 
do so, follow this procedure:

1. Access Tile Layout in either of the following ways:

◆ Select the Screen Setup quick key → select the Tile Layout tab.

◆  Select the Main Menu quick key → from the Display column select Tile Layout.

2. Select a parameter numeric area or waveform area, and then from the popup list select an element you 
want to display in this area. The parameters and waveforms you did not select will not displayed.

If you are using the independent secondary display, you can select parameter and waveform locations on the 
secondary display.

3.9.3 Displaying the Parameter List
You can display the trends of HR, SpO2, RR, and NIBP/IBP in the parameter numerics area. To do so, follow this 
procedure:

1. Access Tile Layout in either of the following ways:

◆ Select the Screen Setup quick key → select the Tile Layout tab.

◆  Select the Main Menu quick key → from the Display column select Tile Layout.

2. Select the parameter numerics area where you want to display the parameter list, and then from the popup 
list select Parameter List.

3.9.4 Accessing Parameter Setup Dialogs
Each parameter has a setup dialog in which you can adjust the alarm and parameter settings. You can enter a 
parameter setup dialog by using any of the following methods:

■ Select the parameter numeric area or waveform area.

■ Press the setup hard key  on the module front.

■ Select the Parameters Setup quick key, and then select the desired parameter.
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■ Select the Main Menu quick key → from the Parameters column select Setup → select the desired
parameter.

NOTE

• In this manual, we always use the first method to enter the setup dialog. But you can use any method 
you prefer.

3.9.5 Changing Measurement Colors
You can set the color of measurement values and waveforms for each parameter. To do so, follow this procedure:

1. Select Main Menu quick key → from the Parameters column select Parameter Color. 

2. Select the Current tab and set the colors of the currently monitoring measurement values and waveforms. 

3. Select the All tab and set the colors of measurement values and waveforms for all parameters.

3.10 Freezing Waveforms
During patient monitoring, the freeze feature allows you to freeze the currently displayed waveforms on the 
screen so that you can have a close examination of the patient’s status. Additionally, you can select any frozen 
waveform for recording.

3.10.1 Freezing Waveforms
To freeze waveforms, select the Freeze quick key. Except waveforms of the following screens, all displayed 
waveforms stop refreshing and scrolling after you select the Freeze quick key:

■ Minitrends screen

■ OxyCRG screen

■ Remote View screen

■ BoA Dashboard screen

■ EWS screen

3.10.2  Viewing Frozen Waveforms
To view the frozen waveforms, follow this procedure:

■ Select the   or  button in the Freeze screen.

■ Slide the frozen waveform leftward or rightward. 

At the lower right corner of the bottom-most waveform displays the freeze time. The initial frozen time is 0 s. 
With the waveforms scrolling, the freeze time changes at an interval of 1 second. For example, -2 s means  two 
seconds before the frozen time. This change will be applied for all waveforms on the screen.

NOTE
• You can view the frozen waveforms of up to 120 seconds.

3.10.3 Unfreezing Waveforms
To unfreeze the frozen waveforms, select the  button at the upper right corner of the Freeze Big 
Numerics.

3.10.4 Printing Frozen Waveforms
To print the frozen waveforms, select the  button at the upper left corner of the Freeze Big Numerics.
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3.11 N22 and N19 Secondary Display
The secondary display of N22/N19 has the following features:

■ Be able to connect independent input devices.

■ Provides visual and audible alarm indications.

The secondary display runs on independent AC mains through a DC adapter. To use the secondary display, turn 
it on and verify that it is connected before turning on the monitor. The secondary display does not support hot 
swapping. If the secondary display is disconnected from the main unit, the primary display will announce an 
alarm.

3.11.1 Connecting the Secondary Display Power Supply (for N22/N19)
You need a power adapter to convert the AC mains to DC so as to power the secondary display. Before 
connecting the power adapter, check that the power adapter meets the specification.

To connect the power supply, follow this procedure:

1. Connect one end of the power adapter to the DC-IN connector on the secondary display.

2. Connect the other end of the power adapter to the AC mains.

3. Check that the AC indicator on the secondary display is on.

CAUTION

• Use only Mindray-specified power adapters for powering Mindray displays. 

3.11.1.1 Setting Secondary Display Orientation (for N22/N19)

If the secondary display is an independent display or an extended display, you can set its orientation if necessary. 
See 3.8.1 Setting the Screen Orientation (for N22 and N19) for details. 

NOTE

• If the secondary display is a mirror display, its orientation is the same with the primary display and 
cannot be set separately. 

3.11.1.2 Setting Secondary Display Brightness (for N22/N19)

See 3.8.3 Adjusting the Screen Brightness for details. 

3.11.2 Setting the ECG Waveform Size for the Independent External Display (for N17/
N15/N12)
For N17/N15/N12 monitors, if the independent external display is connected, you can set the speed and 
amplitude scales of the ECG waveforms for displays of different dimensions to achieve the best display effect. To 
do so, follow this procedure:

1. From the independent external display screen, select the Main Menu quick key → from the System 
column select Maintenance → input the required password → select .

2. Select Display → select the Screen Size tab.

3. Select the screen size.

4. Adjust the speed and amplitude of the ECG waveform by setting the scale so that 1 cm on the scale is 
actually equal to one centimeter.

5. Restart the monitor.
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NOTE

• The setting of Screen Size for the independent external display takes effect only after the monitor 
restarts.

3.12 Using the iView System
The iView system provides a means of running clinical applications on a monitor for obtaining other patient 
data. The application data from the iView can show on the monitor’s display or on the iView display. 

For more information on iView, see iView System Operator’s Manual (PN: 046-012637-00). 

WARNING

• Some clinical applications may show data from another patient. Be aware that some of the data on 
the patient monitor display may not always be from a single patient.

• Applications running on the iView cannot act as a primary alarming device and cannot be relied 
upon for alarm notification. There may be no audible or visible indications apart from what is shown 
on the screen, and any data shown may be delayed.

CAUTION

• Always use AC mains to run the monitor if iView is in use.

• Ensure that any software installed on the iView complies with all relevant local regulations.

• iView is an independent PC platform that enables running third-party applications. The monitor 
runs independently of the iView, and vice versa.It is the user's responsibility to maintain iView 
security patches in compliance with hospital PC policy. The user’s IT administrator should determine 
what security patches and policies needed after third-party applications are installed.

3.13 Capturing the Screen
The monitor provides the function of screen capture. To capture the current screen display, follow this 
procedure:

1. Connect the USB drive to the monitor’s MSB connector (for N22/N19) or the USB connector (N17/N15/N12).

2. Press and hold the More quick key. Wait until it turns from blue to grey.

The captured pictures are automatically saved in the USB drive.

(1) Adjust the amplitude of the ECG waveform

(2) Adjust the speed of the ECG waveform

(2)

(1)
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3.14 Connecting the CMS
You can connect the monitor to the BeneVision CMS through wired LAN or wireless LAN. When connected to the 
CMS, the system provides the following function.

■ The monitor can transmit parameter values, waveforms, alarms, and events to the CMS. From the CMS, you 
can check the patient’s monitoring data and alarms.

■ The monitor can transmit parameter values and alarms from the connected external devices to the CMS. 
From the CMS you can check the patient’s monitoring data and alarms obtained from the connected 
external devices.

■ Patient information, alarm settings, and alarm status can be synchronized between the monitor and the 
CMS.

■ You can start or stop NIBP measurements from the CMS.

■ In case of network disconnection, the monitor can transmit the offline data to the CMS when the network is 
reconnected. 

For more information on the CMS, see the operator’s manual of corresponding central monitoring system.

To select a CMS, select the system status information area at the top right corner of the main screen. Select the 
desired CMS from the popup CMS list.

NOTE

• You can select CMS only when the Select CMS switch is on. For more information, see 
33.13.6 Enabling Selecting a CMS.

3.15 Connecting the eGateway
You can connect the monitor to the eGateway through wired LAN or wireless LAN to implement interaction 
between the monitor and external devices. When connected to the eGateway, the system provides the following 
functions:

■ The monitor can transmit parameter values, waveforms, alarm settings, and events to the eGateway.

■ The monitor can transmit parameter values and alarm settings received from the BeneLink-connected 
external devices to the eGateway. 

■ Clock can be synchronized between the monitor and the eGateway.

3.16 Connecting the Wireless Network
You can add up to five wireless networks for the monitor. For more information, see 33.13.4 Setting the Wireless 
Network.

If connecting the current wireless network fails, the monitor automatically connects other wireless networks in 
the order when they were added.

To manually switch the wireless network, from the system status information area on the top right conner of the 
screen select , and select the desired wireless network.

3.17 Disconnecting the Wireless Network
To disconnect the wireless network manually, follow this procedure:

1. Swipe the screen from top down with a single finger.

2. Select .

To reconnect the wireless network after it is disconnected manually, follow this procedure:

1. Swipe the screen from top down with a single finger.

2. Select .
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3.18 Turning Off the Monitor
Before turning off the monitor, perform the following check: 

1. Ensure that monitoring of the patient has been completed. 

2. Disconnect the cables and sensors from the patient.

3. Save or clear the patient data as required.

To turn off the monitor, press and hold the power switch for 3 seconds. 

CAUTION

• Press and hold the power switch for 15 seconds (for N22/N19) or 10 seconds (for N17/N15/N12) to 
forcibly shut down the monitor if it could not be shut down normally. This may cause loss of patient 
data.

NOTE

• Turning off the monitor does not disconnect the monitor from the AC mains. To completely 
disconnect the power supply, unplug the power cord.

• If a monitor is on during a power loss, then the monitor is automatically switched on when the power 
is restored. 

• In case of a temporary power failure, if the power is restored within 30 minutes, monitoring will 
resume with all active settings unchanged. If the monitor is without power for more than 30 
minutes, it behaves the same as if it were normally turned off.
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4 User Screens

The monitor provides different user screens to facilitate patient monitoring in different departments and clinical 
applications.

4.1 Choosing a Screen
The monitor enters the normal screen after it is powered on. The normal screen is most frequently used for 
patient monitoring. To select other screens, follow this procedure:

1. Access the Choose Screen tab in either of the following ways:

◆ Select the Screen Setup quick key.

◆  Select the Main Menu quick key → from the Display column select Choose screen.

2. Select the desired screen.

4.2 Normal Screen
The normal screen is most frequently used for patient monitoring. For general department, ICU, and CCU, normal 
screen is used by default.

4.2.1 Entering the Normal Screen
To enter the normal screen, choose any of the following ways:

■ Swipe left or right on the touchscreen with two fingers to switch to the normal screen.

■ Select the Screen Setup quick key → select the Choose Screen tab → select Normal Screen.

■ Select the Main Menu quick key → from the Display column select Choose Screen → select Normal 
Screen.

4.2.2 Configuring the Normal Screen 
You can configure the parameter numerics, waveforms, and their sequence displayed on the normal screen. To 
do so, follow this procedure:

1. Access Tile Layout in either of the following ways:

◆ Select the Screen Setup quick key.

◆  Select the Main Menu quick key → from the Display column select Tile Layout.

2. Select a parameter numeric area or waveform area, and then from the popup list select an element you 
want to display in this area. The parameters and waveforms you did not select will not displayed.

4.3 The Big Numerics Screen
The Big Numerics screen displays parameter numerics in big font size. The Big Numerics screen displays 
measurement values and waveforms of up to six parameters. You can configure the parameters and their layout 
on the big numeric screen. 

4.3.1 Entering the Big Numerics Screen
To enter the big numerics screen, choose any of the following ways:

■ Swipe left or right on the touchscreen with two fingers to switch to the big numerics screen.

■ Select the Screen Setup quick key → select the Choose Screen tab → select Big Numerics.

■ Select the Main Menu quick key → from the Display column select Choose Screen → select Big 
Numerics.
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4.3.2 Configuring the Big Numerics Screen 
To configure the big numerics screen, follow this procedure:

1. Access Choose Screen in either of the following ways:

◆ Select the Screen Setup quick key .

◆  Select the Main Menu quick key → from the Display column select Choose Screen.

2. Select the Big Numerics tab

3. Select a parameter numeric area or waveform area, and then from the popup list select an element to 
display in this area. 

■

4.4 Minitrends Screen
The Minitrends screen shows the recent graphic trends of parameters. 

4.4.1 Entering the Minitrends Screen
Choose one of the following methods to enter the Minitrends screen:

■ Swipe left or right on the touchscreen with two fingers to switch among the Minitrends screen, normal 
screen, and the big numerics screen. 

■ Select the Minitrends quick key. 

■ Select the Screen Setup quick key → Select the Choose Screen tab→ select Minitrends.

■ Select the Main Menu quick key → from the Display column select Choose Screen → select Minitrends.

For adult and pediatric patients, when the Minitrends screen is hidden as , you can also choose one of the 
following methods to quickly enter the Minitrends screen.

■ Swipe left or right across the touchscreen with two fingers until you switch to the Minitrends screen.

■ Swipe right across the touchscreen with a single finger. 

■ Select the  button.
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4.4.2 The Display of Minitrends Screen
 The following figure shows the minitrends screen. Your display may be configured to look slightly different.

4.4.3 Viewing the Long Trends
To expand the Minitrends screen to view the long trends, choose either of the following ways:

■ Select the  button.

■ Swipe right across the Minitrends screen with a finger.

4.4.4 Setting Minitrends Parameters
To set parameters, follow this procedure:

1. Enter the Minitrends screen.

2. Select the Setup button.

3. Set parameters. If you want to use the default parameters, select Default Parameter.

4.4.5 Setting the Minitrend Length
To set the Minitrend length, follow this procedure:

1. Enter the Minitrends screen.

 (1) Scale

(2) Routine Vital button. If the department is set to OR, then the Baseline button is displayed. 

(3) Routine Vital/Baseline

(4) Select this button to view the long trends, or contract the long trends screen to the Minitrends screen.

(5) Time line

(6) Alarm statistic area

(2)

(4)

(3)

(5)

(1)

(6)
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2. Select the Setup button.

3. Set the Minitrend Length.

4.4.6 Setting the Alarm Statistics Switch
The Minitrends screen can be configured to display the statistic number of physiological alarms in its lower half 
screen. To set the alarm statistics switch, follow this procedure:

1. Enter the Minitrends screen.

2. Select the Setup button.

3. Switch on or off the Alarm Statistics switch.

4.4.7 Setting the Alarm Statistics Duration
The time length within which the alarms statistics are made is configurable. To set the alarm statistics length, 
follow this procedure:

1. Enter the Minitrends screen.

2. Select the Setup button.

3. Set Alarm Statistics Duration.

4.4.8 Routine Vital/Baseline
The Routine vital/Baseline function is used for marking the parameter measurements of certain moment for later 
reference.  If the department is set to OR, then the Baseline button is available. For other departments, the 
Routine Vital button is available.

4.4.8.1 Manually Marking the Routine Vital/Baseline

To manually mark the Routine Vital/Baseline, follow this procedure:

1. Enter the Minitrends screen.

2. Select the Routine Vital button or Baseline button.

NOTE

• If you do not see the Baseline button or Routine Vital button in the Minitrends screen, you can select 
the Setup button and switch on the Baseline switch, or set the Routine Vital to Manual or Auto.

4.4.8.2 Configuring Automatic Routine Vital Settings

The monitor can automatically mark the routine vital sign values. To enable this function, follow this procedure:

1. Enter the Minitrends screen.

2. Select the Setup button.

3. Select Auto from the dropdown list of Routine Vital.

4. Select Time to set the time for marking the first routine vital sign values.

5. Select Interval to set the interval for marking the routine vital sign values.

4.5 The OxyCRG Screen
The monitor displays the OxyCRG screen by default when the neonatology department is selected. The OxyCRG 
screen is available in any department setting, but only when the patient size is set to Neo. This screen displays 6-
minute HR, SpO2 trends, CO2/Resp compressed waveform, ABD parameters, and the latest ABD events.

The OxyCRG function is intended for neonatal patents only.

4.5.1 Entering the OxyCRG Screen
To enter the OxyCRG screen, choose any of the following ways:
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■ Swipe left or right on the touchscreen with two fingers to switch to the OxyCRG screen.

■ Select the OxyCRG quick key.

■ Select the Screen Setup quick key → select the Choose Screen tab → select OxyCRG.

■ Select the Main Menu quick key → from the Display column select Choose Screen → select OxyCRG.

4.5.2 The Display of the OxyCRG Screen
The following figure shows the OxyCRG screen. Your display may be configured to look slightly different.

4.5.3 OxyCRG Events
The following table lists the ABD events and their criteria:

NOTE

• The monitor records all ABD events for OxyCRG review, but only red events displays in the ABD list of 
the OxyCRG screen.

 (1) HR, SpO2/SpO2b trend

(2) Resp/CO2 compressed waveform

(3) Event time

(4) Event type

(5) Parameter values of ABD events

(6) ABD event list: displays the latest red ABD events. Selecting the ABD event list area enters the OxyCRG review 
page.

(7) Mark button: opens the Mark dialog to edit the events.

(8) ABD event prompt area: displays parameter values of currently active OxyCRG events.

(1)

(2)

(3) (4) (5)

(6)

(7)(8)

Event type Description Remarks

A Apnea event: the apnea duration exceeds the threshold.

• A20: the apnea duration is greater or equal to 20 seconds.

• A15: the apnea duration is between 15 to 20 seconds (excluding 20 seconds).

• A10: the apnea duration is between 10 to 15 seconds (excluding 15 seconds).

A20 is a red event

B Low Heart Rate event: the duration of low heart rate exceeds the threshold. /

D Low SpO2 event: the duration of SpO2 Desat exceeds the threshold. /

BD Low Heart Rate and low SpO2 happen at the same time. /

AB Apnea and Low Heart Rate happens at the same time. Red event

AD Apnea and low SpO2 happen at the same time. Red event

ABD Apnea, Low Heart Rate, and low SpO2 happen at the same time. Red event
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4.5.4 The Display of the ABD Event Area
The ABD event area displays parameter values of currently active OxyCRG events and lists the latest red ABD 
events.

4.5.5 Setting OxyCRG Parameters
Select parameter trends or compressed waveform to set parameters and the compressed waveform you want to 
display. The selected parameters will be used for ABD event calculation.

4.5.6 Setting the Threshold of ABD Events
Select any parameter trend or the compressed waveform to perform the following setup:

■ Set the threshold of ABD events.

■ Set Event Storage Format:

◆ 1 min+3 min: stores data one minute before and three minutes after the event.

◆ 3 min+1 min: stores data three minutes before and one minute after the event.

◆ 2 min+2 min: stores data two minutes before and two minutes after the event.

The stored data includes the trends of the OxyCRG parameters, compressed waveform, alarm thresholds, NIBP, 
and Temp measurements.

4.5.7 Editing ABD Events
To edit ABD events, follow this procedure:

1. Select the Mark button to enter the Mark dialog box.

2. Drag the event list upwards and downwards to select the desired event.

3. Select the patient’s status when the event happened.

4. Select Save.

4.6 The Targeted Goal Screen
If you are concerned with specific parameters and their trends, you can use the Targeted Goal screen. The 
Targeted Goal screen focuses on the target parameter and displays parameter measurements in big numerics. 
You can easily identify whether parameter target is reached via a dashboard and review the statistics of the 
target parameter by sections.

The Targeted Goal screen displays parameter measurements and waveforms of ECG, SpO2, IBP, PI, PR, CO2, Resp, 
NIBP, and Temp. You can define the target parameter and secondary parameters. The measurements of these 
parameters displays in big numerics.

4.6.1 Entering the Targeted Goal Screen
To enter the Targeted Goal screen, choose any of the following ways:

■ Select the Screen Setup quick key → select the Choose Screen tab → select Targeted Goal screen.

■ Select the Main Menu quick key → from the Display column select Choose Screen → select Targeted 
Goal Screen.

■ If the Patient Category is set to Neo, swipe left or right on the touchscreen with two fingers to switch to 
the Targeted Goal screen.

4.6.2 The Display of the Targeted Goal Screen
 The following figure shows the Targeted Goal screen. Your display may be configured to look slightly different.
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4.6.3 Configuring the Targeted Goal Screen Layout
To configure the parameter numerics, waveforms, and their sequence displayed on the Targeted Goal screen, 
follow this procedure:

1. Access the Targeted Goal screen in either of the following ways:

◆ Select the Screen Setup quick key → select the Choose Screen tab → select Targeted Goal screen.

◆ Select the Main Menu quick key → from the Display column select Choose Screen → select 
Targeted Goal Screen.

2. Select a parameter numeric area or waveform area, and then from the popup list select an element to 
display in this area. The parameters and waveforms not selected will not displayed.

4.6.4 Operating the Targeted Goal Screen
You can access parameter setup and trends review from the Targeted Goal screen. To do so, follow this 
procedure:

■ Select the parameter trends area to enter the Tabular Trends review page.

■ Select the target parameter statistics area to enter the parameter statistics setup dialog. Set the range of 
each section and the target section.

■ Select the desired waveform area, parameter numeric area, or dashboard to enter corresponding 
parameter setup dialog.

(5)

(6)

(1)

(2)

(3)

(4)

(1) Parameter trends area: displays trends of the target parameter and secondary parameters. If the target 
parameter is Art, this area only lists the trend of arterial pressure.

(2) Target parameter statistics area: displays the statistics of the target parameter by sections.

(3) Other parameter area: displays parameter measurements and alarm limits of parameters other than the target 
parameter and secondary parameters.

(4) Target parameter area: displays the measurement of the target parameter in big numerics, as well as its target 
range, and alarm limits.

• If the target parameter is Resp or PR, parameter source is also displayed.

• The dashboard shows the target range in green. 

• The △ pointer below the dashboard indicates the current measurement value.

(5) Secondary parameters area: displays parameter measurement of secondary parameters in big numerics, as well 
as waveforms and alarm limits. If secondary parameters are Resp and PR, parameter sources are also displayed.

(6) Target parameter waveform area: displays the waveform of the target parameter.

• If the target parameter is Resp or PR, the waveform of the source parameter is displayed.

• If the target parameter is ECG, the fist ECG waveform is displayed by default.
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4.7 Remote View
On the monitor, you can observe alarm conditions and view real time physiological data from patients on other 
compatible remote networked monitoring devices, such as a bedside monitor or a telemetry device. 

A device from a remote site is called a remote device or bed. N22/N19/N17 can simultaneously watch up to 18 
remote devices. N15/N12 can simultaneously watch up to 12 remote devices. The monitor can show waveforms 
of one remote device.

You can watch the remote devices in the Remote View screen, or the alarm watch tiles on the main screen.

In the Remote View screen, you can view real time parameters and waveforms from one specific device, and 
watch the alarms of other monitored devices at the same time.

NOTE

• A particular monitor (for example Monitor #1) can be viewed by at most 32 remote devices at the 
same time, of which eight of those remote devices can watch Monitor #1’s waveforms.

4.7.1 Entering the Remote View Screen
To enter the Remote View screen, choose one of the following ways:

■ Select the Remote View quick key.

■ Select the bed at the alarm watch tile on the main screen. For more information, see 4.7.10.2 Displaying the 
Alarm Watch Tile on the Main Screen.

■ Select the Screen Setup quick key → select the Choose Screen tab → select Remote View.

4.7.2 About the Remote View
The following figure shows the Remote View screen.

(3)

(1)

(2)

(1) Alarm watch area

Displays all the monitored remote beds. Each bed displays the room number, bed number, connection 
status and alarm status. The background color indicates the alarm status on the corresponding bed.

Background Color Description

Green No alarm is occurring at the bed.

Red The remote device is disconnected or a high priority alarm is currently the highest alarm 
level on the bed. If the remote device is disconnected, the  icon is displayed.
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WARNING

• The data presented in the Remote View screen has a delay. Do not rely on this screen for real time 
data.

4.7.3 Adding a Bed
After adding the desired remote devices, then the alarms from these devices can be viewed on the monitor. To 
add a remote device, follow this procedure:

1. Enter the Select Bed dialog. To do so, choose either of the following ways:

◆ In the Remote View screen, select Select Bed. For more information, see 4.7.1 Entering the Remote 
View Screen.

◆ Select the  icon at the alarm watch tile if the tile is configured to display on the main screen.

2. In the Select Bed dialog, select a desired department. All the beds under this department will be listed.

3. Select a desired tile at the A-W1, A-W2 or A-W3 areas and then select a bed from the bed list. The selected 
bed will appear in the tile. 

NOTE

• The added bed is indicated by a check mark (√) at the left of the bed list.

4.7.4 Removing a Bed
To remove a remote device from remote monitoring, follow this procedure:

1. Enter the Select Bed dialog. Choose either of the following ways:

◆ In the Remote View screen, select Select Bed. For more information, see 4.7.1 Entering the Remote 
View Screen.

◆ Select the  icon in the alarm watch tile if the tile is configured to display on the main screen.

2. In the Select Bed dialog, select a bed at the A-W1, A-W2 or A-W3 areas, and then select Clear Bed. If you 
want remove all beds, select Clear All Beds.

4.7.5  Displaying the Main Bed
In the Remote View screen, you can select a bed in the alarm watch area, then the main body of the Remote 
View screen will display the real time monitoring screen of the device. 

4.7.6 Saving a Manual Event
You can initiate a manual event on the remote monitor by selecting Manual Event in the Remote View screen. 

4.7.7 Managing Alarms from Remote Devices
You can view and manage the alarms coming from remote devices.

Yellow The medium priority alarm is currently the highest alarm level on the bed.

Cyan The low priority alarm is currently the highest alarm level on the bed.

Grey The bed is in the standby mode.

Background Color Description

(2) Main area

Displays the patient’s information, alarm status and messages, waveforms, measurements, etc. of the selected bed. 
This bed is called main bed.

(3) Remote View setup button: select it to enters the Remote View setup menu.
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If the monitor and remote devices have alarms at the same time, the monitor presents alarms according to the 
following rules:

■ If the alarm tone pattern for the monitor is same as that for the remote devices, the monitor prioritizes all 
the alarms and sounds the highest alarm tone.

■ If the alarm tone pattern for the monitor is different from that for the remote devices, the monitor sounds 
the alarms in their corresponding tone. 

The monitor provides the same alarm tone pattern for the remote device alarms as those for the monitor alarms 
by default. You can change the alarm tone pattern of the remote monitor; see 33.3.5.5 Setting the Tone Pattern for 
Alarms from Remote Devices.

4.7.8 Resetting Alarms for Remote Devices
You can reset the alarms on the remote devices by selecting Alarm Reset in the Remote View screen. This 
function needs to be enabled. For more information, see 33.3.5.1 Resetting Alarms for Remote Devices.

4.7.9 Selecting Beds By Care Group
If configured, the monitor automatically selects beds in the same care group during the shift of care groups in 
the CMS. To enable this function, follow this procedure:

1. Enter the Select Bed window. Choose either of the following ways:

◆ In the Remote View window, select Select Bed. For more information, see 4.7.1 Entering the Remote 
View Screen for entering the Remote View window.

◆ Select the  icon in the alarm watch tile if the tile is configured to display on the main screen.

2. In lower left corner of the Select Bed window, select Select Beds By Care Group.

4.7.10 Alarm Watch 
The alarm watch function provides the alarm notification by color and sound. 

■ The monitor sounds the highest priority alarm tone from all the monitored remote devices.

■ The monitor displays the highest priority alarm in corresponding background color for each bed at the 
following areas:

◆ At the top of the Remote View. For more information, see 4.7.2 About the Remote View for details.

◆ On the main screen. For more information, see 4.7.10.1 About Alarm Watch Tile for details.

4.7.10.1 About Alarm Watch Tile

The main screen can display up to three alarm watch tiles, namely A-W1, A-W2 and A-W3. Each tile can 
accommodate up to six beds. 

The following figure shows the alarm watch tiles.

(1)

(5) (4)(3)

(2)(1)

(3)

(1) Alarm watch tile label

(2) Disconnection icon: when the remote device is disconnected, this icon displays at the tile, and the tile 
background color is red.

(3) Select bed icon: select it to enter the Select Bed dialog.
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The alarm watch tile is similar to alarm watch area in the Remote View. For more information, see 4.7.2 About the 
Remote View.

4.7.10.2 Displaying the Alarm Watch Tile on the Main Screen

To configure the alarm watch tile to be displayed on the monitor’s main screen, follow this procedure:

1. Select the Main Menu quick key → from the Display column select Choose Screen to enter the Screen 
Setup dialog.

2. Select the Tile Layout tab.

3. Select the numeric area where you want to display the alarm watch tile, and then in the drop-down list, 
select Alarm Watch→ A-W1, A-W2, or A-W3.

4.7.11 Auto Displaying the Alarm Bed
The monitor provides the function of automatically displaying the remote alarm bed. If this function is enabled, 
when a remote bed issues an alarm, the monitor automatically displays the monitoring information from this 
remote bed.

If multiple remote beds issue alarms, the monitor cyclically displays the alarm beds as per the preset interval and 
in the order of alarm time. 

The auto displaying alarm bed function is disabled by default. To enable this function, follow this procedure:

1.  From the Remote View screen, select  to enter the Remote View setup menu.

2. Switch on Rollup Alarm Beds.

3. Set Rollup Interval:

◆ Off: do not cyclically display the remote alarm beds. Once a new alarm is issued, the monitor 
automatically switches to the new alarm bed.

◆ 10 sec, 20 sec, or 30 sec: If multiple remote beds issue alarms, the monitor cyclically displays the 
alarm beds as per the preset interval and alarm priority in the order of alarm time. 

4. Set Alarm Priority:

◆ High Only: Only when a high priority alarm is issued, the monitor automatically switches to the alarm 
bed.

◆ High & Med: If Rollup Interval is set to Off and when a high priority alarm or medium priority alarm is 
issued, the monitor automatically switches to the alarm bed. If Rollup Interval is set to 10 sec, 20 sec, 
or 30 sec and multiple remote beds issue alarms, the monitor cyclically displays the alarm beds with 
higher priority in the order of alarm time. For example, if both high priority alarms or medium priority 
alarm are issued, only beds with high priority alarms are cyclically displayed. 

(4) More than one bed tile: when more than one bed is assigned to a tile, the tile displays the alarm status, 
connection status, etc.

(5) One bed tile: when only one bed is assigned to a tile, the tile displays the parameter value and alarm 
message from this bed, etc.
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5 Managing Patients

5.1 Starting Monitoring a Patient
After turning on the monitor, follow this procedure to monitor a patient:

1. Admit the patient.

2. Check patient settings. Make sure that alarm limits, patient category and paced status, and so on, are 
appropriate for the patient. Change them if necessary.

3. Perform desired measurements. For more information, see corresponding measurement chapters.

5.2 Admitting a Patient
The monitor admits a new patient in the following situations:

■ After a patient is manually discharged, the monitor automatically admits a new patient.

■ After being switched off for the selected time period, the monitor automatically discharges the previous 
patient and admits a new patient at startup.

■ If the monitor has not detected certain patient vital signs (ECG, SpO2, PR, RR, NIBP) for 30 minutes, it will 
prompt whether to start monitoring a new patient if any of the above vital signs are detected again. 

Always input patient information as soon as the patient is admitted. For more information, see 5.2.2 Editing 
Patient Information for details.

WARNING

• The default Patient Category setting is Adult, and Paced setting is Unspecified. Set Paced and check 
if the Patient Category setting is correct for the patient.

• For paced patients, set Paced to Yes. If it is incorrectly set to No, the monitor could mistake a pace 
pulse for a QRS and fail to alarm when the ECG signal is too weak.

• For non-paced patients, set Paced to No. 

5.2.1 Entering the Patient Management Dialog
Use any of the following methods to enter the Patient Management dialog:

■ Select the patient information area at the top left corner of the screen.

■ Select the Patient Management quick key.

■ Select the Main Menu quick key → from the Patient Management column select Patient Management.

5.2.2 Editing Patient Information
Edit patient information after a patient has been admitted, or when patient information is incomplete, or when it 
is necessary to change patient information:

To edit patient information, follow this procedure:

1. Enter the Patient Management dialog. For more information, see5.2.1 Entering the Patient Management 
Dialog.

2. Edit patient information as required.

If a barcode reader is connected to the monitor, scanning the patient’s barcode will enter the patient’s 
information.
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NOTE

• The monitor will reload the configuration if you change the patient category.

5.2.3 Loading Patient Information from the CMS
If the monitor is connected to the central monitoring system (CMS). You can load patient information from the 
CMS to the monitor. To do so, follow this procedure:

1. Enter the Find Patient dialog in either of the following ways:

◆ Select the Main Menu quick key → from the Patient Management column select Find Patient.

◆ From the Patient Management dialog select Find Patient.

2. Input query criteria.

3. Select Search. Then a list pops up, including all the patients that meet the query criteria.

4. Select a patient from the patient list, and then select Admit. Corresponding patient information in the 
monitor will be updated.

NOTE

• If ADT Query is switched on, input query criteria from the Discharged Patients page.

5.2.4 Loading Patient Information from the ADT Server
If the monitor is connected with the Admit-Discharge-Transfer (ADT) server through the eGateway. You can load 
patient information from ADT server to the monitor. 

To do so, follow this procedure:

1. Enter the Find Patient dialog in either of the following ways:

◆ Select the Main Menu quick key → from the Patient Management column select Find Patient.

◆ Select Find Patient from the Patient Management dialog.

2. Input query criteria.

3. Select Search. Then a list pops up, including all the patients that meet the query criteria.

4. Select a patient from the patient list, and then select Admit. Corresponding patient information in the 
monitor will be updated.

NOTE

• You can load patient information from the ADT server only when ADT Query is enabled. For more 
information, see 33.13.11 Using the ADT Gateway.

• The monitor can automatically upload the patient information from the ADT server when:

◆  The configured keywords of the monitor and the eGateway are the same.

◆ The IP address of the monitor is added to the eGateway configuration dialog.

• Loading patient information from the ADT server updates only patient information in the monitor. 
The patient’s monitoring data is not changed and the patient is not discharged.
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5.3 Transferring Patient
Patient settings and data can be transferred from a T1, BeneVision N1, or MPM module into this monitor. The 
patient settings and data includes patient information, trend data, alarm events, and parameter alarm limits. The 
N1 also allows transfer of full disclosure data.

The MPM allows transfer of patient information, such as patient ID, height, and weight, etc.

WARNING

• Do not discharge a patient on the bedside monitor before patient information is completely 
transferred. Discharging the patient during transfer will result in incomplete patient information.

NOTE

• The system automatically switches on the HR/PR (high, low) alarms and lethal arrhythmia alarms 
after transferring the patient data.

5.3.1 Data Storage Introduction
Familiarizing with the data respectively stored in the patient monitor, T1, N1, or MPM helps you understand the 
effects incurred by transferring patients with an T1, N1, or MPM.

Type of storage Can be stored in 
the monitor?

Can be transferred 
via MPM?

Can be 
transferred 
via T1?

Can be 
transferred 
via N1

Data Patient demographics Yes Yes Yes Yes

Trend data Yes Yes Yes Yes 

Calculation data Yes No No Yes

Event data Yes No Yes Yes

Full disclosure waveforms Yes No No Yes

Settings Monitor settings

(Alarm pause, alarm volume, 
etc.)

Yes No No No

Parameter settings

(Alarm limits, measurement 
setting, etc.)

Yes Yes Yes Yes
BeneVision N22/N19/N17/N15/N12 Patient Monitor Operator’s Manual 5 - 3



5.3.2 Transferring Patient Data
To transfer the patient data via N1/ T1/MPM, insert it into the SMR.

■ If the patient demographics in the monitor are consistent with those of in the N1/T1/MPM, N1/T1/MPM 
automatically uploads the data to the monitor.

■ If the patient demographics in the monitor are not consistent with those of in the N1/T1/MPM, and Data 
Transfer Strategy is set to Always Ask (for more information, see 33.2.3 Setting the Strategy of Transferring 
Patient Information), the monitor prompts the Select Patient dialog automatically. In this case, you need to 
select an operation (see the following table) according to the actual situation. If the Data Transfer Strategy 
is not set to Always Ask then the monitor will follow the strategy setting without prompting the user.

NOTE

• Selecting Apply Module Settings will transfer the N1/T1/MPM settings to the monitor along with the 
patient data. For more information, see5.4 Exporting Patient Data.

5.4 Exporting Patient Data
To export the data of the current patient and discharged patients, follow this procedure:

1. For N17/N15/N12, connect the USB drive to the monitor’s USB connector. For N22/N19, connect the USB 
drive to the monitor’s MSB connector.

2. Access the Discharged Patients dialog box by either of the following ways:

◆ Select the Discharged Patients quick key.

◆ Select the Main Menu quick key → from the Patient Management column select Discharged 
Patients.

3. From the patient list select desired patients.

4. Select Export Patient Data.

5.5 Deleting Patient Data
To delete the data of discharged patients, follow this procedure:

Operations Operation Description Examples of applications

Continue Patient in Monitor Continue to use the patient data in the 
monitor. This deletes all patient data in the 
N1/T1/MPM and copies all data in the 
monitor to the N1/T1/MPM.

1. Replace N1/T1/MPM during patient 
monitoring.

2. After the patient is admitted, connect the 
N1/T1/MPM.

Continue Patient in Module Continue to use the patient data in N1/T1/
MPM. The monitor discharges the patient, 
and automatically admits a new patient 
and copies all data from N1/T1/MPM.

You are monitoring a patient using N1/T1/
MPM, and you need to transfer the patient, 
e.g. from a ward (original monitor) to the 
operating room (destination monitor).

New Patient Select this option if you will use neither the 
information in the monitor nor that in the 
N1/T1/MPM. This deletes all data in the 
monitor and N1/T1/MPM and lets you 
admit a new patient on the monitor. In this 
case, you need to re-enter the patient 
demographics. The monitor will restore the 
settings according to the patient category.

Connect the N1/T1/MPM before admitting 
a new patient. However, the monitor and/
or N1/T1/MPM have stored the previous 
patient’s data and settings.

Same Patient Select this option if the patient information 
in the monitor and N1/T1/MPM are 
different but you are sure that it is the same 
patient. This merges the patient’s trend 
data in the monitor and N1/T1/MPM and 
copies the settings in N1/T1/MPM to the 
monitor as well.

A patient monitored with the N1/T1/MPM 
is moved to another department and again 
moved back.

However, the patient information stored in 
the N1/T1/MPM was altered before 
connected to the original monitor.
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1. Access the Discharged Patients dialog box by either of the following ways:

◆ Select the Discharged Patients quick key.

◆ Select the Main Menu quick key → from the Patient Management column select Discharged 
Patients.

2. From the patient list select desired patients.

3. Select Delete.

5.6 Stopping a Parameter Measurement
To stop monitoring a parameter, follow this procedure:

1. Remove corresponding sensor from the patient.

2. Disconnect the sensor from the patient cable.

3. Disconnect the patient cable from the parameter module.

5.7 Discharging a Patient
Before monitoring a new patient, discharge the previous patient. The technical alarms are reset, and monitor 
settings return to their defaults. For more information, see 32.3 Setting Default Patient Category. 

After a patient is discharged, the monitor automatically admits a new patient.

WARNING

• Always discharge the previous patient before starting to monitor a new patient. Failure to do so can 
lead to data being associated with the wrong patient.

 To manually discharge a patient, use any of the following methods to access the Discharge Patient dialog:

■ Swipe down the touchscreen with two fingers.

■ Select the Discharge Patient quick key.

■ Select the patient information area at the top left corner of the screen→ Discharge Patient.

■ Select the Patient Management quick key → Discharge Patient.

■ Select the Main Menu quick key → from the Patient Management column select Discharge.

Select a button in the Discharge Patient  dialog:

■ Print End Case Report: prints the end case report when the patient is discharged.

■ Discharge: clears the waveform data of the current patient. The monitor loads the default configuration 
and goes to the standby mode. The current patient becomes a discharged patient.

■ Clear Patient Data: discharges the current patient and clears the waveform data. The monitor still uses the 
current configuration and does not go to the standby mode. The current patient becomes a discharged 
patient.
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6 Interfacing with External Devices

6.1 BeneLink Introduction
BeneLink module is intended for connecting external devices, such as ventilators and anesthesia machines, to 
the monitor. It allows information (patient data, alarms, etc.) from external devices to be displayed, saved, 
recorded, or printed through the monitor. If the monitor is connected with the CMS or eGateway, information 
from external devices can also be transmitted to the CMS or eGateway.

For more information on connecting external devices via the BeneLink module, see BeneLink Module Operator’s 
Manual (PN: 046-011948-00).

 

6.2 BeneLink Safety Information

WARNING

• Devices of the same category cannot be connected to the BeneLink module simultaneously.

• The parameter labels used on the patient monitor may be different from those used on the external 
device.

• The alarms from external devices may be delayed before transmission to the patient monitor. 

• There can be differences between the alarm priorities displayed on the monitors and the priorities 
displayed on external devices interfaced through BeneLink. 

NOTE

• The alarm messages from external devices are derived from the open protocol of the corresponding 
external device. For more information about these alarms, please see the operator’s manual for the 
corresponding devices. 
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6.3 Differences in Displayed Values
In certain cases, there may be differences between the numerics displayed on the monitor and those on external 
devices. The table below lists some situations and possible reasons. 

NOTE

• When the pressure units are converted among cmH2O, hPa and mbar, the parameter values remain 
unchanged, for example, 1cmH2O=1hPa=1mbar, which may differ from some external devices.

6.4 Connecting an External Device
An external device is connected to the BeneLink module through an ID adapter. The ID adapter supports only its 
matching device. 

 

Situation Possible Reasons

Some parameter values are displayed as invalid 
values on the monitor.

The patient monitor and the external device may have different 
parameter configuration or displaying range of values. If the 
patient monitor displays a parameter not configured in the 
external device, or a parameter value from the external device 
exceeds the displaying range of the monitor, then the 
corresponding parameter value is displayed on the monitor as an 
invalid value. 

The monitor and external device display parameter 
values with different numbers of places of decimals.

The monitor displays parameter values from the external device 
based on the monitor displaying rules. Same parameter value is 
displayed differently when the monitor and the external device 
display numbers with different precision.

Non-continuously measured values and 
continuously measured values have the same 
displaying mode in the patient monitor.

For non-continuously measured values, the monitor displays the 
latest measured values until a new measurement is transmitted 
by the external device.

Parameter values displayed on the patient monitor 
and those displayed in the external device are 
slightly different.

Some parameter values are converted to different units when 
transmitted to the monitor. Sometimes, values from the external 
device may be delayed before transmission to the patient 
monitor.

(1) BeneLink Module (2) Label

(3) RJ45 connecting cable (4) ID Adapter

(5) External device (6) Serial port adapting cable (optional)

 

(5)

(6)

(4)(3)

(2)

(1)
6 - 2  BeneVision N22/N19/N17/N15/N12 Patient Monitor Operator’s Manual



To connect an external device, follow this procedure:

1. Insert the BeneLink module into the SMR.

2. Connect the ID adapter that matches the external device to the BeneLink module with an RJ45 connecting 
cable.

3. Plug the ID adapter into the RS232 port on the external device. Some external devices may have ports 
incompatible with the ID adapter. In this case, a serial port adapting cable is required. 

4. Stick a device name label to the RJ45 connecting cable at the end close to the BeneLink module. When the 
BeneLink module is connected to several external devices, you can tell devices easily with these labels. 
Switch on the external device.

After the external device is connected to the monitor, the indicators on both the ID adapter and the BeneLink 
module illuminate to show that the monitor successfully communicates with the external device.

CAUTION

• First installation and debugging should be executed by Mindray service personnel or an authorized 
technician. 

• Please check the compatibility of the external device and the ID adapter before connection. 
Otherwise, unpredictable system failure may result.

• Ports on the BeneLink module are not conventional network connectors. They are intended for 
connecting with the serial port of designated devices only. Do not connect them to network 
interfaces.

6.5 Accessing the Integrated Devices Screen
You can view the information of external devices in the Integrated Devices screen of the monitor. The 
Integrated Devices screen provides information of both individual device and multi devices. To access the 
Integrated Devices screen, follow this procedure:

■  Select the Integrated Devices quick key.

■ Select the Screen Setup quick key → select Integrated Devices.

■ Select the Main Menu quick key → from the Display column select Choose Screen →select Integrated 
Devices.

■ Select the numeric area or waveform area of any parameter from the external device →select Integrated 
Devices button.

The Integrated Devices screen has the following features:

■ For the parameters measured by the external device, the measurements display directly after the 
parameter labels. 

■ For the parameters controlled by the external device, the settings are enclosed in parenthesis after 
parameter labels. 
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■ For the parameters measured and controlled by the external device, measurements and settings are 
displayed after parameter labels, and settings are also enclosed in parenthesis. For example, PEEP 18 (20), 
in which PEEP is parameter label, 18 is the measurement, and (20) is the setting.

NOTE

• Parameters in the Integrated Devices screen are displayed in the order as shown in the selection 
dialog. If the screen cannot display all the selected parameters, the parameter with higher positions 
(from top to bottom and from left to right) in the Select Parameter dialogue are displayed. 

6.6 Displaying Parameters from External Devices
This monitor can display parameters from external devices in the main screen:

■ Display waveforms from external devices in the waveform area.

■ Display labels and measurements of parameters from external devices in the numeric area.

■ Display respiratory loops of parameters from external deivices in the Loops screen.

The following is an example of parameters (from TOF-Watch SX monitor) displayed in the numeric area of the 
main screen.

 

NOTE

• When displayed in the monitor main screen, parameter labels of external devices are prefixed with 
the plug sign “+”. For example, if SpO2 is from an external device, its label is displayed as “+SpO2”, 
and its waveform label is displayed as “+Pleth”.

• If a parameter can be obtained either from the monitor or an external device, the measured value, 
waveform or loops coming from the monitor will be displayed preferentially.

6.6.1 Setting Waveform Properties for Parameters from External Devices
To set the waveform properties  for parameters from external devices, follow this procedure:

1. Access the parameter setup dialog by selecting its waveform area or numeric area.

2. Set Speed or Scale.

(1) Parameter unit (2) Parameter label

(3) Parameter measurement (4) Response amplitude of stimulation

(5) Skin temperature (6) Measurement interval

(7) Measurement countdown (8) Time of last measurement

(1) (6)

(5)

(8) (7)

(2) (3) (4)
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6.6.2 Setting Alarms from External Devices
To enable or disable the storage, display, and sound of the external device alarms of a certain priority and 
category, follow this procedure:

1. From the Integrated Devices screen select Setup.

2. Set switches as desired.

If the storage, display, or audio settings of a specific alarm are different from its category or priority, set them 
individually by adding the Alarm ID to the alarm list. To do so, follow this procedure:

1. From the Integrated Devices screen select Setup.

2. Input the Alarm ID for this alarm, and select Add.

To delete a specific external device alarm, select the desired Alarm ID, and select Delete.

Refer to the BeneLink Module Operator’s Manual (PN: 046-011948-00) for the list of supported alarms and 
Alarm IDs.

6.6.3 Setting Parameters from External Devices for Display
To select parameters displayed in the Integrated Devices screen, follow this procedure:

1. From the Integrated Devices screen select Select Parameter.

2. Select desired parameters.

In the main screen, the numeric area of some parameters from an external device, for example the +Paw 
parameter, can display multiple parameters. To select parameters for display, follow this procedure:

1. Select the numeric area of the parameter from the external device.

2. Select the Select Parameter tab.

3. Select the parameters for display.

6.6.4 Setting Units for Parameters from External Devices
To set units for parameters from external devices, follow this procedure:

1. Select the numeric area or waveform area of any parameter from the external device.

2. Select the Unit tab.

3. Set the unit for O2, CO2, Pressure or Temp.

6.6.5 Accessing the Loops Screen
To access the Loops screen, follow this procedure:

1. Select the numeric area or waveform area of +Paw, +Flow, or +Vol to enter its corresponding setup dialog.

2. Select the Loops button.

NOTE

• The monitor only displays real-time loops of the external device, and these loops cannot be 
displayed or saved as reference loops.

6.7 Viewing Alarms from External Devices
If the patient monitor is configured to do so, the monitor displays alarms from external devices in the 
physiological and technical alarm information areas. A plus sign “+” is added before each alarm message from 
external devices.
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6.8 Viewing Parameter Trends from External Devices 
If the patient monitor is configured to do so, the monitor saves parameters trends and alarm events from 
external devices. You can review these data in the Tabular Trends, Graphic Trends, Events and Full Disclosure 
pages in the Review screen.The monitor adds a “+” before the parameter label of external devices.

For more information, see 26 Review.

NOTE

• Parameters from external devices are saved and displayed according to the time on the monitor.

6.9 Recording and Printing Parameter Trends from External Devices
You can record or print parameter trends from external devices. For more information, see 26 Review, 
29 Recording, and 30 Printing. 
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7 Using with the Telemetry Monitor

7.1 Introduction
You can connect a TM80 telemetry monitor (hereinafter called the telemetry) with the N Series monitor 
(hereinafter called the monitor) to measure the ECG, Resp, and SpO2 of ambulatory adult and pediatric patients. 
If the telemetry is connected to the BP10 NIBP module, the NIBP measurements can also be transferred to the N 
Series monitor via the telemetry. 

The telemetry is connected with the monitor via the wireless network. The process of connecting the telemetry 
and the monitor is called  "pairing”. After the telemetry is paired with the monitor, you can view the 
measurement data from the telemetry on the monitor’s screen.

7.1.1 Pairing Procedure
Before pairing the telemetry and the monitor, verify the network settings of both the telemetry and the monitor. 
Ensure that the telemetry and the monitor are in the same network.

To pair the telemetry with the monitor, follow this procedure:

1. Access the Bedside Devices dialog in either of the following ways:

◆ Select the Bedside Devices quick key.

◆ Select the Main Menu quick key → from the Parameters column select Bedside Devices.

2. Select + to enter the Add Device dialog. Select Refresh if you want to refresh the unpaired telemetries list.

◆ From the All Unpaired tab or the Unpaired in Current Dept. tab, select the telemetry you want to 
pair.

◆ In the search box, input the device name, the patient’s MRN, department, or bed number, and then 
select Search. Select the desired telemetry from the search results.

3.  Select Pair and follow the on-screen instructions:

a Select Confirm to start pairing the selected telemetry with the monitor.

b Select patient.

◆  Use Patient in Monitor: uses the patient data in the monitor and deletes patient data in the 
telemetry.

◆ Use Patient in Telemetry: uses the patient data in the telemetry and deletes patient data in the 
monitor.

◆ New Patient: discharges the current patient and admits a new patient. The new patient will be 
monitored.

c Check that the message “This telemetry is pairing with patient monitor XX, are you sure?” is displayed 
on the desired telemetry. Select Yes. 

4. At the completion of pairing, the message “Paired successfully” is displayed on the monitor. Close the 
Pairing and the Bedside Devices dialogs.

After pairing with the telemetry, on the monitor, labels of parameters from the telemetry are followed by “-T”, for 
example ECG-T, indicating that these parameters come from the telemetry. 

CAUTION

• Make sure that correct telemetry is selected for pairing with the monitor.

• If the wireless network signal is poor, the monitor may have the risk of data loss.

NOTE
• The telemetry is not intended for monitoring neonatal patients.
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• By default the device name of the telemetry is its serial number. If you need to change the name of 
the telemetry, refer to the operator’s manual of the corresponding telemetry.

7.2 Binding the Telemetry with the Monitor
After the telemetry is paired with the monitor, discharging the patient from either device automatically unpairs 
the telemetry and the monitor. If you need the monitor and the telemetry to remain paired after the patient is 
discharged, bind the two devices. To do so, enter the Bedside Devices dialog and select the unlock symbol  
on the top left corner. After the two devices are bound together, the lock symbol turns to be locked .

To release the binding of the monitor and the telemetry, select the lock symbol . Then the two devices are 
unbound and the lock symbol changes to be unlocked .

7.3 Unpairing the Telemetry and the Monitor
If you do not need to connect the monitor and the telemetry to monitor the patient, you can unpair them. After 
the monitor and the telemetry are unpaired, the CMS receives patient data from the monitor or the telemetry if 
connected.

7.3.1 Unpairing the Telemetry and the Monitor via the Monitor
To unpair the telemetry from the monitor, follow this procedure:

1. Access the Bedside Devices dialog in either of the following ways:

◆ Select the Bedside Devices quick key.

◆ Select the Main Menu quick key → from the Parameters column select Bedside Devices.

2. Select Unpair.

3. Select which device is used to continue monitoring the patient.

◆ Monitor: the monitor is used to continue monitoring the patient.The telemetry enters standby.

◆ Telemetry: the telemetry is used to continue monitoring the patient. The monitor enters standby.

4. Close the Unpair and the Bedside Devices dialogs.

7.3.2 Unpairing the Telemetry and the Monitor via the telemetry
To unpair the monitor from the telemetry, follow this procedure:

1. Press the main menu button  on the front panel of the telemetry.

2. If prompted, input the password for the screen lock dialog. When Screen Lock is set to Off, skip this step.

3. Select Unpair.

4. Select which device is used to continue monitoring the patient.

◆ Telemetry: the telemetry is used to continue monitoring the patient. The monitor enters standby.
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◆ Monitor: the monitor is used to continue monitoring the patient. The telemetry enters standby.

◆ Cancel: do not unpair the telemetry and the monitor.

7.4 Troubleshooting

Problem Possible Cause Corrective Action

Telemetry Disconnected The telemetry is out of the wireless 
network coverage area.

Put the telemetry in the Wi-Fi coverage area.

The telemetry is powered off. Power on the telemetry.

The monitor is not connected to the 
network or network settings are 
incorrect.

Verify that the monitor’s network settings are 
correct and the monitor is connected to the 
network.

The telemetry is not connected to the 
wireless network or wireless network 
settings are incorrect.

Verify that the telemetry’s network settings 
are correct and the telemetry is connected to 
the wireless network.

The exchanger network connected by 
the telemetry and the monitor does not 
support multicast data transfer.

Contact the service personnel.

After the telemetry is paired 
with the monitor, ECG and 
Pleth waveforms from the 
telemetry are not properly 
displayed on the monitor 
screen.

Wireless signal interference exists. ■ Put the telemetry in the wireless 
coverage area.

■ Check the interference source and 
reduce or eliminate interference.

Wireless signals are weak. ■ Put the telemetry in the wireless 
network coverage area with strong 
signals.

■ Remove any metallic obstructions that 
stand between the telemetry and the 
monitor.

Insufficient network bandwidth or 
greater network delay leads to data 
transfer delay.

Contact the service personnel.

The telemetry occasionally 
goes offline.

Wireless signal interference exists. ■ Put the telemetry in the wireless 
network coverage area.

■ Check the interference source and 
reduce or eliminate interference.

Wireless signals are weak. ■ Put the telemetry in the wireless 
network coverage area with strong 
signals strength.

■ Remove any metallic obstructions 
between the telemetry and the 
monitor.

Insufficient network bandwidth or 
greater network delay leads to data 
transfer delay.

Contact the service personnel.

Telemetry Low Battery or 
Telemetry Battery Depleted

The telemetry battery charge is low or 
depleted.

Replace the battery with a known good one.
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8 Alarms

8.1 Alarm Introduction
This chapter describes alarm functions and alarm settings.

8.2 Alarm Safety Information

WARNING

• A potential hazard can exist if different alarm presets and default configuration settings are used for 
the same or similar equipment in the same care area, for example an intensive care unit or cardiac 
operating room.

• If the monitor is connected to the central monitoring system (CMS) or other monitors, alarms can be 
presented and controlled remotely. Remote suspension, inhibition, or reset of monitor alarms via 
the CMS or other monitors may cause a potential hazard. For more information, see the operator’s 
manuals for the CMS and the other monitors. 

• The monitors in the care area may each have different alarm settings to suit different patients. 
Always check that the alarm settings are appropriate for the patient before starting the monitoring. 
Always make sure that necessary alarm limits are active and set according to the patient's clinical 
condition.

• Setting alarm limits to extreme values may cause the alarm system to become ineffective. For 
example, setting the SpO2 high alarm limit to 100%, is equivalent to switching the alarm off. 

• When the alarm sound is switched off, the monitor gives no alarm tones even if a new alarm occurs. 
Be careful when considering to switch off the alarm sound. When the alarms are off or while alarm 
audio is paused either temporarily or indefinitely, observe the patient frequently.

• When monitoring patients that are not continuously attended by a clinical operator, properly 
configure the alarm system and adjust alarm settings as per the patient's condition. 

• Do not rely exclusively on the audible alarm system for monitoring. Adjustment of alarm volume to a 
low level may result in a hazard to the patient. 

8.3 Understanding the Alarms

8.3.1 Alarm Categories 
The monitor has two different types of alarms: physiological alarms and technical alarms. 

■ Physiological alarms are triggered by patient measurement exceeding the parameter limits, or by an 
abnormal patient conditions.

■ Technical alarms are triggered by an electrical, mechanical, connectivity, or other monitor abnormal 
operation, or by failure of a sensor or component. Technical alarm conditions may also be caused when an 
algorithm cannot classify or interpret the available data.

Apart from the physiological and technical alarms, the monitor can also prompt with some messages describing 
the system status or patient status. 

8.3.2 Alarm Priorities
By severity, the alarms are classified into the following priority levels:

■ High priority alarms: indicate a life threatening situation or a severe device malfunction. High priority 
alarms require an immediate response.

■ Medium priority alarms: indicate abnormal vital signs or a device malfunction. Medium priority alarms 
require a timely response.
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■ Low priority alarms: indicate a discomfort condition, a device malfunction, or an improper operation. Low 
priority alarms require you to be aware of this condition.

■ Messages: provides additional information on the patient or the equipment.

8.3.3 Alarm Indicators
When an alarm occurs, the monitor indicates it through visual or audible alarm indications. For more 
information, see the following table.

NOTE

• When multiple alarms of different priority levels occur simultaneously, the monitor selects the 
highest priority alarm to light the alarm lamp and issue the alarm tone.

• When multiple alarms of different priority levels occur simultaneously and should be displayed in 
the same area, the monitor only displays the messages from the highest priority alarm.

• When multiple alarms of the same priority levels occur simultaneously alarm messages are 
displayed cyclically.

• Some physiological alarms, such as Asystole, are exclusive. They have identical alarm tones and 
alarm lights with normal high level physiological alarms, but their alarm messages are displayed 
exclusively. That is, when an exclusive physiological alarm and a normal high level physiological 
alarm are triggered simultaneously, only exclusive physiological alarm message will be displayed.

Alarm Indicator High Priority 
Alarm

Medium 
Priority Alarm

Low Priority 
Alarm

Message Comments

Alarm lamp Red

Flashing 
frequency: 1.4 - 
2.8 Hz

Duty cycle: 20 - 
60% on

Yellow

Flashing 
frequency: 0.4 - 
0.8 Hz

Duty cycle: 20 - 
60% on

Cyan

No flashing

Duty cycle: 
100% on

None None

Audible 
tone 
pattern

ISO Repeat pattern 
of triple + 
double + triple 
+ double beeps 

Repeat pattern 
of triple beeps 

Single beep None None

Mode 1 Repeat pattern 
of high-pitched 
single beep 

Repeat pattern 
of double beeps

Low-pitched 
single beep

None

Mode 2 Repeat pattern 
of high-pitched 
triple beeps 

Repeat pattern 
of double beeps

Low-pitched 
single beep

None

Alarm message White text 
inside a red box

Black text inside 
a yellow box

Black text inside 
a cyan box

White 
text

Alarm messages are 
displayed in the alarm 
information area at the 
top of the screen. You 
can select the alarm 
messages to show the 
alarm list.

Alarm priority 
indicator

*** ** * None The indicator appears in 
front of the 
corresponding alarm 
message.

Parameter value White text 
inside a flashing 
red box

Black text inside 
a flashing 
yellow box

Black text 
inside a flashing 
cyan box 

None None
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8.3.4 Alarm Status Symbols 
Apart from the alarm indicators as described in 8.3.3 Alarm Indicators, the monitor uses the following symbols 
to indicate the alarm status: 

8.4 Accessing On-screen Help for Technical Alarms (AlarmSight)
In the technical alarm list, alarm messages followed by Detail include help messages or pictures to help you 
identify the problem. This function is called AlarmSight. To access AlarmSight, follow this procedure:

1. Select an alarm displaying in the technical alarm information area to enter the Alarms dialog.

2. From the alarm list select the desired alarm. 

NOTE

•  If there are no displayed alarms, then selecting the technical alarm area will not open any dialogs.

8.5 Checking the Physiological Alarms List
If the patient monitor has more than one physiological alarm, you can see the physiological alarm list by 
selecting the physiological alarm information area to enter the Alarms dialog. If there is only one physiological 
alarm, selecting the physiological alarm information area enters the Review dialog for the event created by this 
alarm.

8.6 Changing Alarm Settings
Alarms settings can be changed by selecting Main Menu and choosing from the list in the Alarm column.

8.6.1 Setting Parameter Alarm Properties
To set parameter alarm properties, follow this procedure:

Alarm pause: indicates that all the alarms are paused.

Alarm off: indicates that individual measurement alarms are turned off or the system is in the 
alarm off status. 

Audio pause: indicates that audible alarm tones are paused.

Audio off: indicates that audible alarm tones are turned off.

 Alarm reset: indicates that the alarm system is reset.
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1. Access the Limits page in either of the following WAYS:

◆ Select the Alarm Setup quick key.

◆ Select the Main Menu quick key → from the Alarm column select Limits.

2. Enter the password if required.

3. Select a parameter tab and set alarm properties as desired.

You can also change the alarm properties of individual parameter from the corresponding parameter dialog.

NOTE
• The monitor can be configured to require an password or login to change alarm settings. For more 

information, refer to 33.14.3 Selecting Password for User Authentication.

8.6.2 Changing the Alarm Volume

To change the alarm volume, follow this procedure:

1. Access the Setup page in either of the following ways:

◆ Select the Alarm Setup quick key → select the Setup tab.

◆ Select the Main Menu quick key → from the Alarm column select Setup.

2. Set Alarm Volume. The alarm volume can be set from X to 10, in which X is the minimum volume allowed 
by your department, and 10 is the maximum volume.

3. Select High Alarm Volume to set the volume of the high priority alarm.

4. Select Reminder Volume to set the volume of the reminder tone. 

NOTE

• Alarm volume can only be set to 0 if the monitor is connected to a Central Monitoring System.

• When the alarm volume is set to 0, the alarm sound is turned off and the audio off symbol appears 
on the screen.

• You cannot set the volume of high priority alarms if Alarm Volume is set to 0. 

• You can set the Alarm Volume to 0 only when your monitor is connected to the CMS. If your monitor 
is not connected to the CMS, the lowest setting of Alarm Volume is 1.

• When the monitor is connected to the CMS and Alarm Volume is set to 0, Alarm Volume 
automatically changes to 2 if the CMS is disconnected.
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8.6.3 Setting the Auto Limits for New Patient Switch
If the Auto Limits for New Patient function is enabled, a dialog box can pop up to ask you whether to set alarm 
limits based on the latest parameter measurements for a newly admitted patient. To set the Auto Limits for New 
Patient switch, follow this procedure:

1. Enter the alarm setup page in any of the following ways:

◆ Select the Alarm Setup quick key → select the Setup tab.

◆ Select the Main Menu quick key → from the Alarm column select Setup.

2. Set the Auto Limits for New Patient switch. 

When Auto Limits for New Patient is switched on, the confirmation dialog box pops up if all of the following 
requirements are met: 

■ Within 10 minutes after the patient is admitted.

■ Continuous measurements are stable.

■ An NIBP measurement has been taken.

■ HR alarm switch is on.

■ No lethal alarms are triggered.

■ The patient is not in poor perfusion condition.

■ Alarm limits of no parameters were manually changed. 

■ The monitor is not in intubation mode, private mode, or CPB mode. 

NOTE

• The Auto Limits for New Patient function is intended for newly admitted patients only.

• The automatically set alarm limits take effect only after being confirmed.

8.6.4 Initiating Auto Alarm Limits
The monitor provides the auto alarm limits function to automatically adjust alarm limits according to the 
patient’s vital signs. When auto limits are selected, the monitor calculates safe auto limits based on the latest 
measured values. To get accurate auto alarm limits, collect a set of measured vital signs as a baseline. 

To initiate auto alarm limits, follow this procedure:

1. Access the Limits page in either of the following ways:

◆ Select the Alarm Setup quick key.

◆ Select the Main Menu quick key → from the Alarm column select Limits.

2. From the Limits page, select Auto Limits at the left bottom.

3. Select Ok from the popup dialog box.

Then the monitor will automatically calculate alarm limits based on the latest measured values. Before applying 
these automatically created alarm limits, confirm if they are appropriate for the patient from the Limits dialog. If 
not, you can adjust them manually. These alarm limits will remain unchanged until you select auto limits again or 
adjust them manually.

The monitor calculates auto limits based on the following rules:

Module Parameter Lower Limit Upper Limit Auto Limit Range

Adult/
pediatric

Neonate Adult/
pediatric

Neonate

ECG HR/PR 
(bpm)

HR × 0.8 or 40 
(whichever is 
greater)

(HR - 30) or 90 
(whichever is 
greater)

HR × 1.25 or 
240 
(whichever is 
smaller)

(HR + 40) or 
200 
(whichever is 
smaller)

Adult/pediatric: 35 to 240

Neonate: 55 to 225
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Resp RR (rpm) RR × 0.5 or 6 
(whichever is 
greater)

(RR - 10) or 30 
(whichever is 
greater)

(RR × 1.5) or 
30 (whichever 
is smaller)

(RR + 25) or 
85 (whichever 
is smaller)

Adult/pediatric: 6 to 55

Neonate: 10 to 90

SpO2 SpO2 (%) Same as the 
default alarm 
limit

Same as the 
default alarm 
limit

Same as the 
default alarm 
limit

Same as the 
default alarm 
limit

Same as the 
measurement range

NIBP NIBP-S 
(mmHg)

(SYS × 0.68 + 
10) 

(SYS - 15) or 
45 (whichever 
is greater)

(SYS × 0.86 + 
38) 

(SYS + 15) or 
105 
(whichever is 
smaller)

Adult: 45 to 270

Pediatric: 45 to 185

Neonate: 35 to 115

NIBP-D 
(mmHg)

(Dia × 0.68 + 
6) 

(Dia - 15) or 
20 (whichever 
is greater)

(Dia × 0.86 + 
32) 

(Dia + 15) or 
80 (whichever 
is smaller)

Adult: 25 to 225

Pediatric: 25 to 150

Neonate: 20 to 90

NIBP-M 
(mmHg)

(Mean × 0.68 
+ 8) 

(Mean - 15) or 
35 (whichever 
is greater)

(Mean × 0.86 
+ 35) 

(Mean + 15 or 
95) 
(whichever is 
smaller)

Adult: 30 to 245

Pediatric: 30 to 180

Neonate: 25 to105

Temp

(xx refers 
to 
temperat
ure site)

Txx (°C) (Txx - 0.5) (Txx - 0.5) (Txx + 0.5) (Txx + 0.5) 1 to 49 

ΔT (°C) Same as the 
default alarm 
limit

Same as the 
default alarm 
limit

Same as the 
default alarm 
limit

Same as the 
default alarm 
limit

Same as the 
measurement range

IBP: ART/
Ao/UAP/
BAP/FAP/
LV/P1-P4 
(Arterial 
pressure)

IBP-S 
(mmHg)

SYS × 0.68 + 
10

(SYS - 15) or 
45 (whichever 
is greater)

SYS × 0.86 + 
38 

(SYS + 15) or 
105 
(whichever is 
smaller)

Adult: 45 to 270

Pediatric: 45 to 185

Neonate: 35 to 115

IBP-D 
(mmHg

(Dia × 0.68 + 
6)

(Dia - 15) or 
20 (whichever 
is greater)

(Dia × 0.86 + 
32)

(Dia + 15) or 
80 (whichever 
is smaller)

Adult: 25 to 225

Pediatric: 25 to 150

Neonate: 20 to 90

IBP-M 
(mmHg)

Mean × 0.68 + 
8 

(Mean - 15) or 
35 
(whichever is 
greater)

Mean × 0.86 + 
35

(Mean + 15) 
or 95 
(whichever is 
smaller)

Adult: 30 to 245

Pediatric: 30 to180

Neonate: 25 to 105

IBP: PA IBP-S 
(mmHg)

SYS × 0.75 SYS × 0.75 SYS × 1.25 SYS × 1.25 3 to 120

IBP-D 
(mmHg

Dia × 0.75 Dia × 0.75 Dia × 1.25 Dia × 1.25 3 to 120

IBP-M 
(mmHg)

Mean × 0.75 Mean × 0.75 Mean × 1.25 Mean × 1.25 3 to 120

IBP: CPP CPP 
(mmHg)

CPP × 0.68 + 8 (CPP-15) or 
35, 
(whichever is 
greater)

CPP × 0.86 + 
35

(CPP+15) or 
95, 
(whichever is 
smaller)

Adult: 20 to 235

Pediatric: 25 to175

Neonate: 25 to 100

IBP: CVP/
LAP/
RAP/
UVP/P1-
P4 
(Venous 
pressure)

IBP-M 
(mmHg)

Mean × 0.75 Mean × 0.75 Mean × 1.25 Mean × 1.25 3 to 40

Module Parameter Lower Limit Upper Limit Auto Limit Range

Adult/
pediatric

Neonate Adult/
pediatric

Neonate
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CO2 EtCO2 
(mmHg)

0 to 32: 
remains the 
same

0 to 32: 
remains the 
same

0 to 32: 
remains the 
same

0 to 32: 
remains the 
same

Same as the 
measurement range

33 to 35: 29 33 to 35: 29 33 to 35: 41 33 to 35: 41 Same as the 
measurement range

36 to 45: 
(etCO2 - 6)

36 to 45: 
(etCO2 - 6)

36 to 45: 
(etCO2 + 6)

36 to 45: 
(etCO2 + 6)

Same as the 
measurement range

46 to 48: 39 46 to 48: 39 46 to 48: 51 46 to 48: 51 Same as the 
measurement range

>48: remains 
the same

>48: remains 
the same

>48: remains 
the same

>48: remains 
the same

Same as the 
measurement range

FiCO2 None None Same as the 
default alarm 
limit

Same as the 
default alarm 
limit

Same as the 
measurement range

awRR 
(rpm)

awRR × 0.5 or 
6 (whichever 
is greater)

(awRR - 10) or 
30 (whichever 
is greater)

awRR × 1.5 or 
30 (whichever 
is smaller)

(awRR+25) or 
85 rpm 
(whichever is 
smaller)

Adult/pediatric: 6 to 55

Neonate: 10 to 90

AG EtCO2 Same as the CO2 module

FiCO2 Same as the CO2 module

awRR 
(rpm)

awRR × 0.5 or 
6 (whichever 
is greater)

(awRR - 10) or 
30 (whichever 
is greater)

awRR × 1.5 or 
30 (whichever 
is smaller)

awRR+25 or 
85 (whichever 
is smaller)

Adult/pediatric: 6 to 55

Neonate: 10 to 90

FiAA/EtAA Same as the 
default alarm 
limit

Same as the 
default alarm 
limit

Same as the 
default alarm 
limit

Same as the 
default alarm 
limit

Same as the 
measurement range

FiO2/EtCO2 Same as the 
default alarm 
limit

Same as the 
default alarm 
limit

Same as the 
default alarm 
limit

Same as the 
default alarm 
limit

Same as the 
measurement range

FiN2O/
EtN2O

Same as the 
default alarm 
limit

Same as the 
default alarm 
limit

Same as the 
default alarm 
limit

Same as the 
default alarm 
limit

Same as the 
measurement range

C.O. TB (°C) Adult: (TB - 1)

Pediatric: N/A

N/A Adult: (TB + 1)

Pediatric: N/A

N/A Same as the 
measurement range

C.I. N/A N/A N/A N/A N/A

TFC N/A N/A N/A N/A N/A

SvO2 SvO2 (%) SvO2- 5 N/A SvO2 + 5 N/A Same as the 
measurement range

ScvO2 (%) ScvO2 - 5 N/A ScvO2 + 5 N/A Same as the 
measurement range

rSO2 rSO2 Same as the 
default alarm 
limit

Manual 
mode: same 
as the default 
alarm limit

Auto mode: 
remains 
unchanged

Same as the 
default alarm 
limit

Manual 
mode: same 
as the default 
alarm limit

Auto mode: 
remains 
unchanged

15 to 95

Module Parameter Lower Limit Upper Limit Auto Limit Range

Adult/
pediatric

Neonate Adult/
pediatric

Neonate
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8.6.5 Setting the Apnea Delay Time
To set the apnea delay time, follow this procedure:

1. Access the Setup page in either of the following ways:

◆ Select the Alarm Setup quick key → select the Setup tab.

◆ Select the Main Menu quick key → from the Alarm column select Setup.

2. Select Apnea Delay to set the apnea delay time.

8.6.6 Switching On or Off V-Tach Latching
When V-Tach Latching Lock is switched on, you can switch on or off V-Tach Latching. To do so, follow this 
procedure:

1. Access the Setup page in either of the following ways in either of the following ways:

◆ Select the Alarm Setup quick key → select the Setup tab.

◆ Select the Main Menu quick key → from the Alarm column select Setup.

2. Switching on or off V-Tach Latching.

For information on the V-Tach Latching function, see 33.3.4 Latching Physiological Alarms.

8.6.7 Restoring the Default Alarm Settings
To reset all alarm settings to the defaults, follow this procedure:

1. Access the Alarm page in either of the following ways:

◆ Select the Alarm Setup quick key.

◆ Select the Main Menu quick key → from the Alarm column select Limits.

2. On the Limits page, select Defaults at the bottom.

8.6.8 Setting the Length of Printed Waveforms
You can define the length of printed waveforms when an alarm is triggered. To do so, follow this procedure:

1. Access the Setup page in either of the following ways:

◆ Select the Alarm Setup quick key → select the Setup tab.

◆ Select the Main Menu quick key → from the Alarm column select Setup.

2. Set Printing Duration On Alarm.

8.7 Pausing Alarms/Pausing Alarm Tones 
You can either pause alarms or pause alarm tones. This depends on the pause setting. To set the pause function, 
refer to 33.3.3 Defining the Pause Function.

8.7.1 Pausing Alarms
If the Pause function is configured to alarm pause, pressing the Alarm Pause quick key can temporarily disable 
alarm indicators. For the configuration of the pause function, see 33.3.3 Defining the Pause Function. When alarms 
are paused, the following rules are followed:

■ No physiological alarm will be presented.

■ For technical alarms, alarm sounds are paused, but alarm lamps and alarm messages continue to be 
presented.

■ The remaining alarm pause time is displayed in the physiological alarm information area.

■ The alarm pause symbol is displayed in the system information area.

When the alarm pause time expires, the alarm paused state is automatically deactivated. You can also cancel the 
alarm paused state by pressing the Alarm Pause quick key again. 
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8.7.1.1 Prolonging the Alarm Pause Time

If enabled, you can temporarily prolong the alarm pause time after the monitor enters the alarm paused state. 
This capability is disabled by default. To prolong the alarm pause time, follow this procedure:

1. In the physiological alarm information area, select the alarm pause countdown.

2. Select Pause 5 min, Pause 10 min, or Pause 15 min.

NOTE

• Prolonging alarm pause time does not affect the setting of alarm pause time.

8.7.1.2 Switching Off All Alarms

If Pause Time is set to Permanent (see section 33.3.3.1 Setting the Alarm Pause Time/Alarm Tone Pause Time), 
pressing the Alarm Pause quick key permanently switches off all alarms. The alarm off state has the following 
features:

■ Physiological alarms are switched off. The alarm lamp does not flash and alarm sound is not issued.

■ Alarm sound of technical alarms is switched off, but alarm lamp flashes and alarm messages are presented.

■ The message Alarm Off with red background is displayed in the physiological alarm information area.

■ The alarm off symbol is displayed in the system status information area.

To exit the alarm off state, press the Alarm Pause quick key again. 

WARNING

• Pausing or switching off alarms may result in a hazard to the patient. 

8.7.2 Pausing Alarm Sound
If the Pause function is configured to Audio Pause, pressing the Audio Pause quick key pauses alarm tone and 
sets the quick key to be highlighted. For the configuration of the pause function, see section 33.3.3 Defining the 
Pause Function. When alarm tones are paused, the following rules are followed:

■ The sound of all physiological alarms and technical alarms are switched off. 

■ The remaining audio pause time is displayed in the physiological alarm information area. 

■ The audio pause symbol is displayed in the system information area.

When the audio pause time expires, the audio paused state is automatically deactivated. You can also cancel the 
audio paused state by pressing the highlighted Audio Pause quick key again. 

8.7.2.1 Prolonging the Alarm Tone Pause Time

If enabled, you can temporarily prolong the alarm tone pause time after the monitor enters the alarm tone 
paused state. This capability is disable by default. To prolong the audio pause time, follow this procedure:

1. In the physiological alarm information area, select the alarm pause countdown.

2. Select the alarm tone pause time. Options may include Pause 5 min, Pause 10 min, or Pause 15 min.

NOTE
• Prolonging alarm pause time does not affect the setting of alarm tone pause time. 

8.7.2.2 Switching Off Alarm Sound 

If Pause Time is set to Permanent (see section 33.3.3.1 Setting the Alarm Pause Time/Alarm Tone Pause Time), 
pressing the Audio Pause quick key permanently switches off all alarm sound. The audio off state has the 
following features:

■ Alarm sound of both physiological alarms and technical alarms is switched off.

■ The audio off symbol is displayed in the system information area.
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To exit the audio off state, press the Audio Pause quick key again. 

WARNING

• Pausing or switching off alarm sound may result in a hazard to the patient. 

8.8 Resetting Alarms
Press the Alarm Reset quick key to reset the alarm system. When the alarm system is reset, the alarm reset 
symbol displays in the system status information area for alarm symbols.

NOTE

• If a new alarm is triggered after the alarm system is reset, the alarm reset icon will disappear and the 
alarm light and alarm tone will be reactivated. 

8.8.1 Resetting Physiological Alarms
For physiological alarms, when the alarm system is reset, the following occur:

■ The alarm sound is silenced.

■ A √ appears before the alarm message.

■ The color of the parameter numeric background corresponds with the alarm priority, but the parameter 
numeric does not flash.

8.8.2 Resetting Technical Alarms
For technical alarms, when the alarm system is reset, the following occur:

■ Some technical alarms are cleared. The monitor gives no alarm indications.

■ Some technical alarms are changed to prompt messages.

■ For some technical alarms, the alarm is silenced and a √ appears before the alarm message. 

For details about the indications of technical alarms when the alarm system is reset, see D.2 Technical Alarm 
Messages.

8.9 Latching Alarms
The latching setting for physiological alarms defines how alarm indicators behave if you do not reset the alarms. 

■ If you do not “latch” physiological alarms, their alarm indications disappear when the alarm condition ends. 

■ If you “latch” physiological alarms, all visual and audible alarm indications remain (if configured) until the 
alarms are reset. For latched alarms the time when the alarm is last triggered is displayed behind the alarm 
message. 

The monitor can be set to separately latch visual indications or simultaneously latch the visual and the audible 
indications. 

■ When visual indications are latched, visual indications, including alarm lamp, alarm message and its 
background remain when the alarm condition ends and the time when the alarm last triggered is displayed 
behind the alarm message.

■ When audible indications are latched, the monitor continues to issues alarm sounds when the alarm 
condition ends.

To set how you want to latch the physiological alarms, see section 33.3.4 Latching Physiological Alarms.

NOTE

• Changing alarm priority may affect the latching status of the corresponding alarm. Determine if you 
need to adjust the latching status for the specific alarm when you have changed its alarm priority.

• When the alarm system is reset, latched physiological alarms are cleared.
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8.10 Nurse Call
The monitor provides a nurse call connector to output a nurse call signal when a user-defined alarm occurs. To 
obtain a nurse call signal, use the nurse call cable to connect the hospital nurse call system with the monitor’s 
nurse call connector.

Alarms are indicated on the nurse call device only when the following conditions are met:

■ The nurse call system is enabled.

■ A user-defined alarm occurs.

■ Alarms are not paused or reset.

WARNING

• Do not rely exclusively on the nurse call system for alarm notification. Remember that the most 
reliable alarm notification combines audible and visual alarm indications with the patient’s clinical 
condition.

8.11 Calling for Help
This monitor can be configured to call monitors in the same department, the central station, and the nurse call 
system so that nearby doctors and nurses can come for help.

8.11.1 Issuing the Call Help Signal
To call help, select the Call Help quick key and select Ok from the popup dialog box. If Ok is not selected within 5 
seconds then the monitor will automatically send out the call help signal.

After the call help signal is sent out, the Call Help quick key flashes in red. Select the Call Help quick key again to 
stop the call help signal.

Monitors receiving the call help signal issue a sound and a dialog box pops up indicating which monitor is calling. 
Select Ok to acknowledge the call and stop the sound at this monitor.

NOTE
• The call help function works only when the monitor is connected to the network.

• The call help sound may disturb patients in the same department.

8.12 CPB Mode 
The CPB (Cardiopulmonary Bypass) mode is activated only if you set the department to OR. 

In the CPB mode, except for EEG, NMT, tcGas, and rSO2 related alarms, all the physiological alarms and technical 
alarms are switched off. So when performing CPB, you can put the monitor in the CPB mode to inactivate 
unnecessary alarms. 

8.12.1 Entering the CPB Mode
To enter the CPB mode, choose either of the following ways: 

■ Select the CPB Mode quick key.

■ Select the Main Menu quick key → from the Alarm column select CPB Mode.

In the CPB mode, CPB Mode is displayed in the physiological alarm area with a red background color.

NOTE
• When the CPB mode is entered, the monitor stops all NIBP measurements. You can restart NIBP 

measurements after entering the CPB mode. 
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8.12.2 Exiting the CPB Mode
To exit the CPB mode, choose either of the following ways: 

■ Select the CPB Mode quick key.

■ Select the Main Menu quick key → from the Alarm column select Exit CPB Mode.

8.13 Intubation Mode
Intubation mode is available for Resp, CO2, and AG monitoring. When performing intubation during general 
anesthesia, you can put the monitor in the intubation mode in order to inactivate unnecessary alarms.

In the intubation mode, Resp, CO2, and AG related physiological alarms are switched off. 

8.13.1 Entering the Intubation Mode
To enter the intubation mode, choose either of the following ways: 

■ Select the Intubation Mode quick key.

■ From the bottom of the Resp, CO2, or AG dialog, select Intubation Mode. 

■ Select the Main Menu quick key → from the Alarm column select Intubation Mode.

8.13.2 Exiting the Intubation Mode
To exit the intubation mode, choose either of the following ways: 

■ Select the Intubation Mode quick key.

■ From the bottom of the Resp, CO2, or AG dialog, select Exit Intubation Mode. 

■ Select the Main Menu quick key from the Alarm column → select Exit Intubation Mode.

8.14 Testing Alarms
The monitor automatically performs a selftest at startup. Check that an alarm tone is heard, the alarm lamp 
illuminates, one after the other, in red, yellow, and cyan. This indicates that the visible and audible alarm 
indicators function correctly.

To further test individual measurement alarms, perform measurements on yourself or using a simulator. Adjust 
alarm limits and check that appropriate alarm behavior is observed.
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9 Monitoring ECG, Arrhythmia, ST and QT

9.1 ECG Introduction
The electrocardiogram (ECG) measures the electrical activity of the heart and displays it on the monitor as 
waveforms and numerics. ECG monitoring provides 3-, 5-, 6-, and 12-lead ECG monitoring, ST-segment analysis, 
arrhythmia analysis, QT/QTc measurements, and optional 12-lead resting analysis via the Glasgow algorithm.

The associated module incorporating ST analysis has the ST label. 

The associated module incorporating 12-lead has the 12-lead label.

9.2 ECG Safety Information

WARNING

• This equipment is not intended for direct cardiac application.

• Ensure that the conductive parts of ECG electrodes and associated connectors, including the neutral 
electrode, do not come into contact with any other conductive parts including earth.

• Always use defibrillation-proof ECG cables during defibrillation.

• Do not touch the patient, or metal devices connected to the patient, during defibrillation.

• To minimize the hazard of burns during high-frequency surgical procedures, ensure that the 
monitor’s cables and transducers never come into contact with the electrosurgery unit (ESU).

• To minimize the hazard of burns during use of high-frequency surgical unit (ESU), the ECG 
electrodes should not be located between the surgical site and the ESU return electrode. 

CAUTION

• Only use parts and accessories specified in this manual. Follow the instructions for use and adhere to 
all warnings and cautions.

• Periodically inspect the electrode application sites to ensure skin integrity. If the skin quality 
changes, replace the electrodes or change the application site.

• Interference from an ungrounded instrument near the patient or electrosurgery usage can induce 
noise and artifact into the waveforms.

(1) ECG cable connector          (2) ST label               (3) 12-lead label                 (4) Glasgow label

(1) (1)(1)

(2) (3) (4)
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9.3 ECG Display
The following figures show the ECG waveform and numeric areas. The display may be configured to look slightly 
different.

 

9.4 Preparing for ECG Monitoring

9.4.1 Preparing the Patient Skin
Proper skin preparation is necessary to ensure good signal quality at the electrode sites, as the skin is a poor 
conductor of electricity. To properly prepare the skin, choose flat areas and then follow this procedure:

1. Shave hair from skin at chosen electrode sites. 

2. Gently rub skin surface at sites to remove dead skin cells. 

3. Thoroughly cleanse the site with a mild soap and water solution. We do not recommend using ether or 
pure alcohol, because this dries the skin and increases the resistance. 

4. Dry the skin completely before applying electrodes. 

9.4.2 Applying Electrodes and Connecting the Patient
To connect ECG cables, follow this procedure:

1. Check that electrode packages are intact and the electrodes are not past the expiry date. Ensure the 
electrode gel is moist. If you are using snap electrodes, attach the snaps to the electrodes before placing 
electrodes on the patient.

2. Place the electrodes on the prepared sites. Ensure that all electrodes have good skin contact.

(1) ECG lead label of the displayed waveform (2) ECG waveform gain

(3) ECG filter mode (4) Notch filter status

(5) Paced status: If Paced is set to Yes,  is displayed. If Paced is set to No,  is displayed.

(6) HR/PR alarm message

(7) Pace pulse marker: If Paced is set to Yes, pace pulse markers “|” are displayed corresponding to detected 
pacer for each beat.

(1) Parameter label (2) HR measurement unit

(3) HR alarm limits (4) HR value

(1)                                 (2)                             (3)                                  (4)                                 (5)                                (6)

(7)

(1)
(2)

(3)

(4)
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3. Connect the leadwires to the patient cable if not already connected.

4. Plug the patient cable into the ECG connector.

CAUTION

• Never mix patient electrode types or brands. This may lead to impedance mismatches issues.

NOTE

• When applying the electrodes, avoid bony area, obvious layers of fat, and major muscles. Muscle 
movement can result in electrical interference. Applying electrodes on major muscles, for example 
on muscles of the thorax, may lead to erroneous arrhythmia alarms due to excessive muscle 
movement. 

9.4.3 Lead Wire Color Code
The following table lists the color coding of leadwires for AHA standards:

9.4.4 ECG Electrode Placements
In this section, electrode placement is illustrated using the AHA naming convention.

9.4.4.1 3-leadwire Electrode Placement

The following is the electrode configuration when a 3-leadwire cable is 
used:

■ RA placement: directly below the clavicle and near the right 
shoulder.

■ LA placement: directly below the clavicle and near the left 
shoulder.

■ LL placement: on the left lower abdomen.

Lead Label Color

Right arm RA White

Left arm LA Black

Right leg (neutral) RL Green

Left leg LL Red

Chest 1 V1 Brown/Red

Chest 2 V2 Brown/Yellow

Chest 3 V3 Brown/Green

Chest 4 V4 Brown/Blue

Chest 5 V5 Brown/Orange

Chest 6 V6 Brown/Violet

RA LA

LL
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9.4.4.2 5-leadwire and 6-leadwire Electrode Placement

The following is the electrode configuration for a 5-leadwires cables:

■ RA placement: directly below the clavicle and near the right 
shoulder.

■ LA placement: directly below the clavicle and near the left 
shoulder.

■ RL placement: on the right lower abdomen.

■ LL placement: on the left lower abdomen.

■ V placement: on the chest in any of the V1 to V6 positions.

For 6-leadwire placement, you can use the position for the 5 -
leadwire placement but with two chest leads. The two chest leads (Va 
and Vb) can be positioned at any two of the V1 to V6 positions. For 
more information, see 9.4.4.3 Chest Electrode Placement. The Va and 
Vb lead positions are configurable. For more information, see 
9.5.3.3 Changing Va and Vb Labels.

9.4.4.3 Chest Electrode Placement

The chest electrode can be placed at the following positions:

■ V1 placement: on the fourth intercostal space to the right of 
the sternum.

■ V2 placement: on the fourth intercostal space to the left  of 
the sternum.

■ V3 placement: midway between the V2 and V4 electrode 
positions.

■ V4 placement: on the fifth intercostal space at the left 
midclavicular line.

■ V5 placement: on the left anterior axillary line, horizontal with 
the V4 electrode position.

■ V6 placement: on the left midaxillary line, horizontal with the V4 electrode position.

■ V3R-V6R placement: on the right side of the chest in positions corresponding to those on the left.

NOTE

• For the 5-leadwire and 6-leadwire placement, place the precordial electrode according to the 
physician's preference.

RA

V

RL

LA

LL

V1

V6

V5

V4

V2 V3VE
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9.4.4.4 10-leadwire Electrode Placement

12-lead ECG uses 10 electrodes, which are placed on the patient’s four limbs 
and chest. The limb electrodes should be placed on the limb extremities and 
the chest electrodes placed according to the physician’s preference. The figure 
at right illustrates the conventional 10-leadwire electrode placement.

9.4.4.5 Lead Placement for Pacemaker Patients

The recommended lead placement for monitoring a pacemaker patient is as follows.

A pacemaker patient usually requires a different electrode patch placement configuration than a non-
pacemaker patient.

Do not place an ECG electrode directly over the pacemaker generator. Place the electrode patches 2 to 3 inches 
away from the pacemaker generator area. For example, if the pacemaker generator is located in the left 
subclavian area, relocate the Left Arm electrode closer in towards the center of the chest.

9.4.4.6 Lead Placement for Surgical Patients

The surgical site should be taken into consideration when placing electrodes on a surgical patient. For example, 
for open-chest surgery, the chest electrodes can be placed on the lateral chest or back. To reduce artifacts and 
interference from electrosurgical units, you can place the limb electrodes close to the shoulders and lower 
abdomen and the chest electrodes on the left side of the mid-chest. Do not place the electrodes on the upper 
arm. Otherwise, the ECG waveform will be very small.

WARNING

• To reduce the hazard of burns during use of electrosurgical units (ESU), the ECG electrodes should 
not be located between the surgical site and the ESU return electrode. 

• Never entangle the ESU cable and the ECG cable together.

3-leadwire Electrode Placement 5-leadwire Electrode Placement

RA LA

LL

Pacemaker

RA LA

LL
RL

Pacemaker

V1
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• When using ESU, never place ECG electrodes near the grounding plate of the ESU, as this can cause a 
lot of interference on the ECG signal.

• When using ESU, ensure proper contact of the ESU return electrode to the patient to avoid burns at 
monitor measurement sites. Also ensure that the ESU return electrode is near the operating area.

9.4.5 Choosing the ECG Lead Type 
To choose ECG lead type, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab.

3. Set Lead Set according to the lead type you are going to use. The default lead type is Auto. In this case, the 
monitor automatically detects the lead type. 

9.4.6 Checking Paced Status
It is important to correctly set the patient’s paced status before you start monitoring ECG. The paced symbol  
is displayed when Paced is set to Yes. Pace pulse markers “|” are displayed on each ECG waveform whenever  a 
pacer signal is detected. If Paced is set to No or unspecified, the symbol  will be shown in the ECG waveform 
area.

To change the paced status, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Pacer tab.

3. Set Paced to Yes or No. 

You can also change the patient’s paced status from the Patient Management dialog. For more information, see 
5.2.1 Entering the Patient Management Dialog.

If you did not set the paced status, the monitor issues a prompt tone when pace pulse is detected. At the same 
time, the paced symbol  flashes and the message Please check if the patient has a pacemaker? appears in 
the ECG waveform area. Check and set the patient’s paced status.

WARNING

• For paced patients, you must set Paced to Yes. If it is incorrectly set to No, the monitor could mistake 
a pace pulse for a QRS complex and fail to alarm when the ECG signal is too weak. On ventricular 
paced patients, episodes of ventricular tachycardia may not always be detected. Do not rely entirely 
upon the system’s automated arrhythmia detection algorithm.

• False low heart rate or false asystole alarms may result with certain pacemakers because of 
pacemaker artifacts, such as electrical overshoot of the pacemaker overlapping the true QRS 
complexes.

• Do not rely entirely on rate meter alarms when monitoring patients with pacemakers. Always keep 
these patients under close surveillance.

• The auto pacer recognition function is not applicable to pediatric patients, neonatal patients, and 
patients with NMT monitoring.

9.4.7 Enabling Pacer Rejection
To eliminate the pacing pulse from the ECG waveform of paced patients, it is recommended to enable the pace 
pulse rejection function. The pace pulse rejection function is disabled by default. To enable this function, follow 
this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Pacer tab.

3. Switch on Pacer Reject. 
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NOTE

• When pace pulses are detected, the pace pulse markers “|” are shown on the ECG waveforms. Pacer 
Rejection setting has no impact on the display of pace pulse markers “|”.

• You can switch on pacer rejection only when Paced is set to Yes. If Paced is set to no, the Pacer Reject 
function is disabled. 

9.5 Changing ECG Settings

9.5.1 Choosing an ECG Screen
When monitoring ECG, several display options are available.

■ For 3-lead ECG monitoring, only normal screen is available.

■ For 5-lead ECG monitoring, besides the normal screen, you can also choose Full-screen (7-lead) or Half 
Screen (7-lead). 

■ For 6-lead ECG monitoring, besides the normal screen, you can also choose Full-screen (8-lead) or Half 
Screen (8-lead).

■ For 12-lead ECG monitoring, besides the normal screen, you can also choose Full-screen (7-lead), Half 
Screen (7-lead), or 12-Lead (12-lead analysis). 

To choose the desired screen configuration, follow this procedure: 

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select Full-Screen, Half-Screen, or 12-Lead. 

To return to the normal screen, press the highlighted button to unselect that screen.

Alternately you can choose the desired screen configuration as follows:

1. Select the Screen Setup quick key → Choose Screen or select the Main Menu quick key → from the 
Display column select Choose Screen.

2. Select ECG Full-Screen, ECG Half-Screen, or ECG 12-Lead.

9.5.2 Setting ECG Alarm Properties
To select the desired ECG alarm options, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Alarm tab.

3. Select the desired alarm options.

9.5.3 Changing ECG Wave Settings

9.5.3.1 Selecting the Leads of Displayed ECG Waveforms 

To select the desired ECG waveforms to be displayed, follow this procedure: 

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab.

3. Select ECG to set the lead of each displayed ECG waveform. 

4. If more than three ECG waveforms are to be displayed, select the More Leads tab, and then select ECG to 
set leads of other ECG waveforms. 

For optimal ECG analysis, select leads with the following characteristics:

■ The QRS complex should be either completely above or below the baseline and it should not be biphasic.

■ The QRS complex should be tall and narrow.

■ The P waves and T waves should be less than 0.2mV. 
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CAUTION

• Ensure that you have selected the optimal leads with the best waveform amplitude and the highest 
signal-to-noise ratio. Selecting the optimal leads is important for detecting beats, classifying beats, 
and detecting ventricular fibrillation. 

9.5.3.2 Changing ECG Waveform Size

If the ECG waveform is too small or clipped, you can change its size by selecting the appropriate Gain setting. To 
do so, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab.

3. Select ECG Gain to set the size of each ECG waveform. 

4. If more than three ECG waveforms are displayed, select the More Leads tab, and then select ECG Gain to 
change the sizes of other ECG waveforms. If you select Auto, the monitor automatically adjusts the size of 
the ECG waveforms for all the leads. 

9.5.3.3 Changing Va and Vb Labels

When monitoring ECG with 6-leadwire. You can change the labels of Va and Vb leads. To do so, follow this 
procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab.

3. Set Va and Vb according to the locations of the Va and Vb electrode sites. Default settings are Va and Vb. 

9.5.3.4 Changing ECG Waveform Speed

To change ECG waveform speed, follow this procedure: 

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab.

3. Set the desired Speed. 

9.5.3.5 Setting the ECG Filter 

To set the appropriate ECG waveform filter mode, follow this procedure: 

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab.

3. Set Filter. 

◆ Diagnostic: use when diagnostic quality ECG is required. The unfiltered ECG waveform is displayed so 
that changes such as R-wave notching or discrete elevation or depression of the ST segment are 
visible.

◆ Monitor: use under normal monitoring conditions.

◆ Surgery: use when the signal is distorted by high frequency or low frequency interference. High 
frequency interference usually results in large amplitude spikes making the ECG signal look irregular. 
Low frequency interference usually leads to wandering or rough baseline. The surgery filter reduces 
artifacts and interference from electrosurgical units. Under normal measurement conditions, 
selecting Surgery may suppress certain features or details of the QRS complexes.

◆ ST: recommended for ST monitoring.

9.5.3.6 Switching On or Off the Notch Filter

The notch filter removes the line frequency interference. To switch on or off the notch filter, follow this 
procedure:
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1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab.

3. Switch on or off Notch Filter.

NOTE

• The notch filter can only be switched on or off when ECG Filter is set to Diagnostic. In other filter 
modes, the notch filter is always on.

9.5.4 Disabling the Smart Lead Off Function
The monitor provides the smart lead off function. When the lead corresponding to the first ECG wave gets 
detached but another lead is available, the monitor automatically switches to the available lead to recalculate 
heart rate, and to analyze and detect arrhythmias. When you reconnect the detached leads, the monitor 
automatically switches back to the original lead. 

The smart lead off function is enabled by default. To disable this function, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab.

3. Switch off Smart Lead.

9.5.5 Adjusting the QRS Volume
To adjust the QRS volume, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab.

3. Set QRS Volume.

When valid SpO2 measurements are available, the monitor adjusts the pitch of QRS tone based on the SpO2 
value.

9.5.6 Adjusting the Minimum QRS Detection Threshold 
To avoid false asystole alarm due to low R wave amplitude, and to avoid tall T waves and P waves being mistaken 
for QRS complexes, the monitor provides a means to manually adjust the minimum QRS detection threshold. 

To adjust the minimum QRS detection threshold, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab and set Filter to Monitor.

3. Select the QRS Threshold tab.

4. Select up or down arrow buttons to adjust the minimum threshold for QRS detection. Selecting Default 
resets the QRS threshold to the default value (0.16 mV).

CAUTION

• The setting of the QRS detection threshold can affect the sensitivity for arrhythmia, ST, QT/QTc 
detection, and heart rate calculation.

• If the QRS amplitude is low, the monitor might not be able to detect the beats and false asystole calls 
may occur.

NOTE

• The minimum QRS detection threshold can only be adjusted when the ECG filter is set to Monitor.
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9.6 Monitoring Arrhythmia 
Arrhythmia monitoring is intended for adult and pediatric patients.

9.6.1 Arrhythmia Safety Information

WARNING

• Heart rate reading may be affected by cardiac arrhythmias. Do not rely entirely on heart rate alarms 
when monitoring patients with arrhythmias. Always keep these patients under close surveillance.

• The arrhythmia analysis program may incorrectly identify the presence or absence of an arrhythmia. 
Therefore, a physician must analyze the arrhythmia information with other clinical findings.

• Atrial fibrillation (Afib) detection function is not intended for pediatric and neonatal patients.

CAUTION

• Since the arrhythmia detection algorithm sensitivity and specificity are less than 100%, it is possible 
for false arrhythmias to be detected and true arrhythmia events to not be detected. The possibility 
increases when the signal is noisy.

• The ECG size and minimum QRS detection threshold settings affect arrhythmia detection and heart 
rate calculation sensitivity.

• If QRS amplitude is low, the monitor might be unable to calculate heart rate and thus create false 
asystole calls. During the learning phase of the algorithm, arrhythmia detection may not be 
available. It is recommended to closely monitor patient condition during, and for several minutes 
after, the learning phase to allow the algorithm to reach optimal detection performance.

9.6.2 Arrhythmia Events
This section lists all arrhythmia events and their criteria.

9.6.2.1 Lethal Arrhythmia Events

9.6.2.2 Nonlethal Arrhythmia Events

Arrhythmia message Description

Asystole No QRS complex detected within the set time interval in the absence of ventricular 
fibrillation or chaotic signal.

V-Fib/V-Tach A fibrillatory wave for 6 consecutive seconds.

A dominant rhythm of adjacent PVCs and the ventricular rate is greater than the V-tach rate 
limit.

V-Tach The number of consecutive PVCs is greater than or equal to the V-Tach PVCs limit, and the 
ventricular rate is greater than or equal to the V-Tach rate limit.

Arrhythmia message Description

Vent Brady The number of consecutive PVCs is greater than or equal to V brady PVC limit and the 
ventricular rate is less than the V-Brady Rate limit.

Extreme Tachy The heart rate is greater than the extreme tachycardia limit. 

Extreme Brady The heart rate is less than the extreme bradycardia limit.

R on T R on T PVC is detected.

Run PVCs More than two consecutive PVCs, but lower than the V-Brady PVCs limit, and the ventricular 
rate is lower than the V-Tach rate limit.

Couplet A Pair of PVCs detected in between normal beats.
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*N: normal beat; V: ventricular beat

9.6.3 Displaying Arrhythmia Information
You can display the arrhythmia information in the numeric area. To do so, follow this procedure: 

1. Access Tile Layout using either of the following ways:

◆ Select the Screen Setup quick key → select the Tile Layout tab.

◆  Select Main Menu quick key → from the Display column select Tile Layout.

2. Click the numeric area where you want to display the arrhythmia information, and then select ECG → 
Arrhythmia. 

9.6.4 Changing Arrhythmia Settings 

9.6.4.1 Changing Arrhythmia Alarm Settings

To set the arrhythmia alarm properties, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Arrhythmia tab→ Alarm tab.

3. Set alarm properties as desired.

Multiform PVC Multiform PVCs detected in Multif. PVC's Window (which is adjustable).

PVC One PVC detected in between normal beats.

Bigeminy A dominant rhythm of N, V, N, V, N, V*.

Trigeminy A dominant rhythm of N, N, V,N, N, V, N, N, V*.

Tachy The heart rate is greater than the tachycardia limit. 

Brady The heart rate is lower than the bradycardia limit. 

Pacer Not Capture No QRS complex detected for 300 ms following a pace pulse (for paced patients only).

Pacer Not Pacing No pace pulse detected for 1.75 x average R-to-R intervals following a QRS complex (for 
paced patients only).

Missed Beat At least 3 consecutive Ns*, and

The current RR interval is greater than 1.5 x previous RR interval, and

The next RR interval is lower than 1.5 x average RR interval, and

HR lower than 100 and the current RR interval is greater than 1.75 x average RR interval , or 
HR is greater than or equal to 100 and the current RR interval is greater than 1000 ms.

Nonsus V-Tach The number of consecutive PVCs is lower than the V-Tach PVCs limit but greater than 2, and 
the ventricular rate is greater than or equal to the V-Tach Rate limit. 

Vent Rhythm The number of consecutive PVCs is greater than or equal to the V-Brady PVCs limit, and 
ventricular rate is greater than or equal to the V-Brady Rate limit but lower than V-Tach Rate 
limit. 

Pause No QRS complex is detected within the set pause time threshold.

Irr Rhythm Consistently irregular rhythm (N*, irregular RR interval change is greater than 12.5%)

A-Fib (for adult only) P wave is absent and normal beat RR intervals are irregular.

PVCs/min PVCs/min exceeds high limit.

Pauses/min Pauses/min exceeds high limit.

Irr Rhythm End Irregular rhythm no longer detected for the irregular rhythm end delay time.

A-Fib End (for adult only) Atrial fibrillation no longer detected for the A-Fib end delay time.

Arrhythmia message Description
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NOTE

• You can switch off lethal arrhythmia alarms only when the monitor is set to enableLethal Arrh 
Alarms Off. For more information, see 33.3.10.1 Setting the Lethal Arrhythmia Alarms Switch.

• The priority of lethal arrhythmia alarms is always high. It cannot be altered.

9.6.4.2 Changing Arrhythmia Alarm Threshold Settings

You can change threshold settings for certain arrhythmia alarms. When an arrhythmia exceeds its threshold, an 
alarm will be triggered. To do so, follow this procedure: 

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Arrhythmia tab → select the Threshold tab.

3. Enter the password if required. For more information, refer to 33.14.3 Selecting Password for User 
Authentication. 

4. Set the threshold for the desired arrhythmia alarms.

NOTE

• The asystole delay time relates to ECG relearning. When heart rate is less than 30 bpm, it is 
recommended to set Asystole Delay to 10 sec. 

9.6.4.3 Arrhythmia Threshold Range

9.6.4.4 Setting Thresholds for PVC-Related Alarms

PVC-related alarms are detected on the basis of the current PVC rate and the number of consecutive PVCs. 

To set the required thresholds for PVC-related alarms, follow this procedure: 

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Arrhythmia tab → select the More Threshold tab.

Arrhythmia Threshold Range

Asystole Delay 3 sec to 10 sec

Tachy (HR High) 60 bpm to 295 bpm

Brady (HR Low) 16 bpm to 120 bpm

Extreme Tachy 65 bpm to 300 bpm

Extreme Brady 15 bpm to 115 bpm

Multif PVCs Window 3 beats to 31 beats

V-Tach Rate 100 bpm to 200 bpm

V-Brady Rate 15 bpm to 60 bpm

V-Tach PVCs 3 beats to 99 beats

V-Brady PVCs 3 beats to 99 beats

PVCs/min 1 to 100

Pauses/min 1 to 15

Pause Threshold 1.5 sec, 2.0 sec, 2.5 sec, 3.0 sec

AF/Irr Rhy End Time 0 min, 1 min, 2 min, 3 min, 4 min, 5 min, 10 min, 15 min, 30 
min
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3. Enter the password if required. For more information, refer to 33.14.3 Selecting Password for User 
Authentication.

Adjust V-Tach PVCs, V-Tach Rate, V-Brady PVCs, and V-Brady Rate as necessary to set the thresholds for the 
desired PVC-related alarms.

The following figure illustrates the conditions under which PVC alarms will be generated if V-Tach PVCs is set to 
6, V-Tach Rate is set to 130, V-Brady PVCs is set to 5, and V-Brady Rate is set to 40.

■ If the number of consecutive PVCs is greater than or equal to the V-Tach PVCs limit (6), and the ventricular 
rate (Vent Rate) is greater than or equal to the V-Tach Rate limit (130), a V-Tach alarm is generated.

■ If the number of consecutive PVCs is lower than the V-Tach PVCs limit (6) but greater than 2, and the 
ventricular rate is greater than or equal to the V-Tach Rate limit (130), a Nonsus V-Tach alarm is generated.

■ If the number of consecutive PVCs is greater than or equal to the V-Brady PVCs limit (5), and the ventricular 
rate is lower than the V-Tach Rate limit (130) but greater than or equal to the V Brady Rate limit (40), a Vent 
Rhythm alarm is generated.

■ If the number of consecutive PVCs is lower than the V-Brady PVCs limit (5) but greater than 2, and the 
ventricular rate is lower than the V-Tach Rate limit (130), a Run PVCs alarm is generated.

■ If the number of consecutive PVCs is greater than or equal to the V-Brady PVCs limit (5), and the ventricular 
rate is lower than the V Brady Rate limit (40), a Vent Brady alarm is generated.

9.6.5 Intelligent Arrhythmia Alarm
Normally, an arrhythmia alarm is presented when an alarm condition is detected. However, there are certain 
situations that can inhibit audible and visible alarm indications even though an alarm condition was detected. 
For more information, see 9.6.5.1 Arrhythmia Alarm Chains and 9.6.5.2 Arrhythmia Alarm Shielding Rules.
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9.6.5.1 Arrhythmia Alarm Chains

If multiple alarms overlap, announcing all of the detected alarm conditions would be confusing, and a more 
serious condition might be overlooked. So arrhythmia alarms are prioritized by alarm "chains".

9.6.5.2 Arrhythmia Alarm Shielding Rules

The following table explains how audible and visual alarms are indicated during arrhythmia alarm shielding 
period.

Asystole

V Fib/V Tach

V Tach / Vent Brady

Extreme Tachy/
Extreme Brady

Pause

Nonsus V Tach / 
Vent Rhythm

Tachy/Brady

Run PVCs

Couplet

R on T

Bigeminy

Trigeminy

Multiform PVC

PVC

Pacer not Capture / 
Pacer not Pacing / 

Missed Beat

HR High / 
HR Low

Pauses/min
A Fib/

A Fib End

Irr. Rhythm/
Irr.Rhythm End

PVCs/min

PVC Alarm Chain
Beat Detection 

Alarm Chain
Rate Alarm Chain A Fib Alarm Chain

H
igh  Priority

M
edium

Priority

Previous alarm Current alarm Alarm indication

Alarm in high priority 
chain

Alarm in high priority chain Alarm light and alarm tone

Alarm in medium priority chain During the shielding period, alarm light and alarm 
tone are disabled. When the shielding period is 
reached, alarm light and alarm tone are 
reactivated.

Alarm in medium 
priority chain 

Alarm in high priority chain Alarm light and alarm tone

Alarm in the same medium priority 
chain, but with higher priority 

Alarm light and alarm tone

The same alarm reoccurs During the shielding period, alarm light and alarm 
tone are disabled. When the shielding period is 
reached, alarm light and alarm tone are 
reactivated. 

Alarm in the same medium priority 
chain, but with lower priority

During the shielding period, alarm light and alarm 
tone are disabled. When the shielding period is 
reached, alarm light and alarm tone are 
reactivated.

Alarm in other medium priority chain Alarm light and alarm tone
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9.6.5.3 Arrhythmia Alarm Refractory Period

For the following eight alarms in medium priority chain, there is a 30-second refractory period. That is to say, if 
the same alarm is not presented within 30 seconds after the previous alarm disappears.

■ Couplet

■ R on T

■ PVCs/min High

■ Multiform PVCs

■ PVC

■ Missed Beat

■ Pacer not Capture

■ Pacer not Pacing

9.7 ST Segment Monitoring
ST segment analysis is intended for adult, pediatric and neonatal patients. To use this feature, the MPM must be 
labeled to support ST analysis, see 9.1 ECG Introduction.  

9.7.1 ST Safety Information

WARNING

• ST segment deviation values may be affected by such factors as certain drugs or metabolic and 
conduction disturbances.

• ST deviation is often calculated at a fixed offset from the J point. Changes in heart rate may affect ST.

•  The significance of ST segment changes needs to be determined by a physician.

• This monitor provides information regarding changes in ST deviation levels. The clinical significance 
of the ST level change information should be determined by a physician.

9.7.2 Enabling ST Monitoring
The ST monitoring function is disabled by default. Before you start ST monitoring, enable the ST function. To do 
so, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the ST tab→ select the Setup tab.

3. Switch on ST Analysis.

Reliable ST monitoring cannot be ensured under the following situations:

■ You are unable to get a lead that is not noisy.

■ Arrhythmias, such as atrial fibrillation or atrial flutter, which may cause an irregular baseline.

■ The patient is continuously ventricularly paced.

■ The patient has left bundle branch block.

In these cases, you may consider switching off ST monitoring.

9.7.3 Displaying ST Deviation Numerics
To display ST numerics, follow this procedure:

1. Access Tile Layout by either of the following ways:

◆ Select the Screen Setup quick key → select the Tile Layout tab.

◆  Select Main Menu quick key → from the Display column select Tile Layout.

2. Click the numeric area where you want to display the ST numerics, and then select ECG → ST. 
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The ST parameter display area is configured differently according to the ECG cable used: 

■ When you are using the 3-lead ECG leadwires, a separate ST numeric area does not appear on the display. 
The ST deviation value displays in the ECG numeric area.

■ When you are using the 5-lead ECG leadwires, the ST numeric area displays 7 ST deviation values: ST-I, ST-II, 
ST-III, ST-aVR, ST-aVL, ST-aVF, ST-V.

■ When you are using the 6-lead ECG leadwires, the ST numeric area displays 8 ST deviation values: ST-I, ST-II, 
ST-III, ST-aVR, ST-aVL, ST-aVF, ST-Va, ST-Vb.

■ When you are using the 12-lead ECG leadwires, the ST numeric area displays12 ST deviation values: ST-I, ST-
II, ST-III, ST-aVR, ST-aVL, ST-aVF, ST-V1, ST-V2, ST-V3, ST-V4, ST-V5, ST-V6.

This example shows the ST numeric area when 5-lead ECG cable is used. The monitor screen may look slightly 
different:

9.7.4 Displaying ST Segments in the Waveform Area 
You can display ST segments in the waveform area. To do so, follow this procedure: 

1. Access Tile Layout by either of the following ways:

◆ Select the Screen Setup quick key → select the Tile Layout tab.

◆  Select Main Menu quick key → from the Display column select Tile Layout.

2. Select the waveform area where you want to display the ST segments, and then select ECG → ST.

(1) Parameter label (2) ST measurement unit 

(3) ST alarm off symbol (4) Lead labels

(5) ST numerics: a positive value indicates ST segment elevation, and a negative value indicates ST 
segment depression.

(4)               (5)  

(1)
(2)

(3)
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ST segment shows a QRS complex segment for each measured ST lead. The current ST segment is drawn in the 
same color as the ECG wave, usually green, superimposed over the stored reference segment, drawn in a 
different color. The information is updated once every ten seconds. 

9.7.5 Entering the ST View 
In ST View mode a complete QRS segment for each ST lead is displayed. The color of the current ST segments 
and ST deviation values is consistent with the color of the ECG waveforms, normally green. The color of the 
baseline ST segments and ST deviation values is white. 

To enter the ST View, follow this procedure: 

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the ST tab.

3. From the bottom of the dialog, select ST View.

9.7.6 Saving the Current ST Deviation and Segment as Baseline 
ST deviation is typically monitored as a relative change from a baseline value. Set an ST baseline when ST 
deviation values become stable. If you did not set the ST baseline, the monitor automatically saves the baseline 
when valid ST deviation values appear for 5 minutes. To set the ST baseline, follow this procedure:

1. From the ST View, select Set Baseline.

2. From the pop-up dialog box, select Ok to set the current ST segments and values as the baseline.

From the ST View, you can also perform the following operations:

■ Display or hide ST baseline by selecting Display Baseline or Hide Baseline.

■ Display or hide the position of ISO point, J point and ST point by selecting Display Marker or Hide Marker.

CAUTION

• Updating ST baseline affects ST alarms.

(1) ST lead (2) Current ST deviation value

(3) Baseline ST deviation value (4) 1 mV scale

(5) Current ST segment (green) and baseline ST segment (white) 

(1)                                (2)  

(3)

(4)                            (5)     
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9.7.7 Entering the ST Graphic
To display ST Graphic, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the ST tab.

3. Select ST Graphic.

The following figure shows the ST Graphic when ST Alarm Mode is set to Absolute. The height of the bar 
indicates the ST deviation value of corresponding ST lead. The color of the bar indicates ST alarm status: green 
indicates that corresponding ST deviation value is within alarm limits; cyan, yellow and red indicate that the ST 
deviation value exceeds the alarm limits. The color matches ST alarm priority.

The following figure shows the ST Graphic when ST Alarm Mode is set to Relative. The height of grey bar 
indicates the baseline ST deviation value and the green bar (cyan, yellow or red if an alarm occurs) indicates 
relative ST from that baseline. 

9.7.8 Changing ST Settings

9.7.8.1 Setting ST Alarm Properties

To set ST alarm properties, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the ST tab→ Alarm tab.

3. Set ST Alarm Mode to Absolute or Relative.

◆ Absolute: you can separately set the alarm properties for each ST alarm for each lead.

◆ Relative: you can set the alarm properties for ST Single and ST Dual alarms.

4. Set ST alarm properties.
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9.7.8.2 Changing Leads for ST Display

The monitor automatically selects the three most deviated leads for ST display. You can also manually select the 
leads. To do so, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the ST tab → select the Setup tab.

3. Set ST Segment. You can select up to 3 leads. 

9.7.8.3 Showing ISO Point, J Point, and ST Point Markers 

In the waveform area, the ISO point, J point, and ST point marker do not display on the ST segments by default. 
To display these markers, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the ST tab→ select the Setup tab.

3. Switch on Show Markers. 

9.7.9 Adjusting ST Measurement Points

9.7.9.1 About ST Point, ISO Point, and J Point

The ST deviation value for each beat is the potential difference between the isoelectric (ISO) point and the ST 
point. The ISO point provides the baseline. The ST point is located between the J point and the start of the T-
wave. The J point is the end of the QRS complex. As the ST point is at a fixed distance away from the J point (40, 
60, 80 etc msec), manually adjusting the J point helps you correctly position the ST point.

9.7.9.2 Setting ST Point, ISO Point, and J Point

CAUTION

• If Auto Adjust is Off, or if the patient's heart rate or ECG morphology changes significantly, the ISO 
and ST points need to be occasionally adjusted because this may affect the QT interval and thus the 
location of the ST point. False ST segment depression or elevation may occur if the isoelectric point 
or the ST point is incorrectly set.

• Always ensure that the locations of ST points are appropriate for the patient.

To set the ST point, ISO point, and J point, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the ST tab→ select the Adjust tab.

3. Set ST Point.

The setting for Auto Adjust defines the method of adjusting the ISO and J point locations. Auto Adjust is 
enabled by default. In this case, the locations of the ISO point and J point are automatically determined by the 

(1) ISO point                                (2) J point (3) ST point (4) ST deviation   

P

R

Q

S

T(1) (2) (3) (4)
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algorithm. When Auto Adjust is disabled, you need to manually adjust the position of the ISO point and J point 
using the arrows at the right sides of ISO and J. 

■ The ISO point (isoelectric) location shown is relative to the R-wave peak. Position the ISO point in the 
middle of the flattest part of the waveform (between the P and Q waves).

■ The J point location is indicated relative to the R-wave peak. Position the J point at the end of the QRS 
complex and the beginning of the ST segment.

■ The ST point is positioned a fixed distance from the J point. Position the ST point relative to the J point at 
J+60/80ms, J+40ms, J+60ms or J+80ms. When J+60/80ms is selected, the ST point will be positioned 80 
ms (heart rate 120 bpm or less) or 60 ms (heart rate more than 120 bpm) from the J point.

9.8 QT/QTc Interval Monitoring 
The QT interval is the time between the beginning of the Q-wave and the end of the T-wave. It represents the 
total duration of the depolarization (QRS duration) and repolarization (ST-T) phases of the ventricles. QT interval 
monitoring can assist in the detection of long QT syndrome.

The QT interval has an inverse relationship to heart rate. Faster heart rates shorten QT interval and slower heart 
rates prolong QT interval. Therefore, several formulas are commonly used to correct the QT interval for heart 
rate. The heart rate corrected QT interval is abbreviated as QTc. 

QT/QTc interval monitoring is intended for adult, pediatric, and neonatal patients.

9.8.1 QT/QTc Monitoring Limitations
Some conditions may make it difficult to achieve reliable QT/QTc monitoring, for example:

■ R-wave amplitudes are too low

■ The presence of frequent ventricular ectopic beats

■ RR intervals are unstable

■ P-waves tending to encroach on the end of the previous T-wave at high heart rates

■ The T-wave is very flat or T-wave are not well defined

■ The end of the T-wave is difficult to delineate because of the presence of U-waves

■ QTc measurements are not stable

■ In the presence of noise, asystole, ventricular fibrillation, atrial fibrillation, or ECG lead off

For reliable QT/QTc monitoring, choose lead with good T-wave amplitude and no visible flutter activity, and 
without a predominant U-wave or P-wave.

Some conditions such as left or right bundle branch block or ventricular hypertrophy can lead to a widened QRS 
complex. If a long QTc is observed you should verify it to ensure that it is not caused by QRS widening.

Because normal beats followed by ventricular beats are not included in the analysis, no QT measurement will be 
generated in the presence of a bigeminy rhythm.

If the heart rate is extremely high (over 150 bpm for adults and over 180 bpm for pediatrics and neonates), QT 
will not be measured. When the heart rate changes, it can take several minutes for the QT interval to stabilize. For 
reliable QTc calculation it is important to avoid measurements when the heart rate is changing.

9.8.2 Enabling QT/QTc Monitoring
The QT monitoring function is disabled by default. Before you start QT monitoring, enable the QT function. To do 
so, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the QT tab→ select the Setup tab.

3. Switch on QT Analysis.
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9.8.3 Displaying QT Numerics and Segments
To display QT numerics and Segments, follow this procedure:

1. Access Tile Layout by either of the following ways:

◆ Select the Screen Setup quick key → select the Tile Layout tab.

◆ Select Main Menu quick key → from the Display column select Tile Layout.

2. Click the parameter numeric area where you want to display the QT numerics, and then select ECG → QT/
QTc. 

NOTE

• QTc values are calculated based on the QT-HR, not the ECG HR. To view the QT-HR, open the QT View. 
For more information, see 9.8.4 Entering the QT View.

The following picture shows the QT numeric area. The monitor screen may look slightly different:

9.8.4 Entering the QT View
QT View shows the current and baseline QT parameter values and waveforms. To enter QT View, follow this 
procedure: 

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the QT tab.

3. Select QT View.

The following picture shows a typical QT view. 

■ The current waveform is shown in the upper half in green. 

■ The baseline waveform is shown below in white. 

(1) QTc alarm limit (if QTc alarm is off, the alarm off symbol is displayed) 

(2) Parameter label (3) QTc value

(4) ΔQTc value (the difference between the current and baseline QTc values) 

(5) QT value (6) QT-HR value

(4)

(2)

(1)

(6)

(3)

(5)
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■ The waveform of selected lead is highlighted, while the waveforms of other leads are in light green or light 
gray.

■ The start of the QRS complex and the end of the T wave are marked with a vertical line.

■ In some conditions, no QT measurement can be made. Then the cause of failed QT measurement is shown 
at the bottom of the QT numerics area and the message “Cannot Analyze QT” is shown in the technical 
alarm area. 

Select the left or right arrow to switch leads, and the corresponding waveform will be highlighted.

9.8.5 Saving the Current QTc as Baseline 
In order to quantify changes in the QTc value, you can set a QTc baseline. If no baseline has been set for this 
patient within the first five minutes after getting valid QT values, the monitor will automatically set a baseline. To 
set the current values as baseline, follow this procedure:

1. From the QT View, select Set Baseline.

2. From the pop-up dialog box, select Ok. This baseline will then be used to calculate ΔQTc.

If you set a new baseline the previous baseline is discarded. 

From the QT View, you can also perform the following operations:

■ Select the left or right arrow to select a lead label to highlight corresponding waveform. 

■ Select Display Baseline or Hide Baseline to display or hide the baseline waveform.

CAUTION

• Updating QTc baseline affects the ∆QTc value and alarm.

9.8.6 Changing QT Settings

9.8.6.1 Setting QT Alarm Properties

To set QT alarm properties, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the QT tab→ select the Alarm tab.

3. Set QTc and ΔQTc alarm properties.

9.8.6.2 Selecting Leads for QT Calculation

You can select one lead or all leads for QT calculation. To do so, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the QT tab→ select the Setup tab.

3. Set QT Leads. All is selected by default. This means all leads are used for QT calculation.

9.9 ECG Relearning
Changes in ECG beat morphology could result in incorrect arrhythmia alarms and/or inaccurate heart rate. ECG 
relearning allows the monitor to learn the new dominant beat morphology and thus reduce false arrhythmia 
alarms and inaccurate HR values. Once learning is complete, the dominant QRS complex is stored as a reference 
template. The reference template is used as the normal morphology of that patient and it is compared with 
incoming beats to identify possible arrhythmias. 

9.9.1 Auto ECG Relearning
Auto arrhythmia relearning happens in the following situation: 

■ The ECG lead type or lead label is changed. 
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■ ECG leads are off and are not reconnected within 60 seconds.

■ The patient‘s paced status is changed. 

9.9.2 Initiating an ECG Relearning Manually
If you suspect that false arrhythmia alarms are presented, you may need to manually initiate an ECG relearn. To 
do so, follow this procedure:

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select Relearn.

CAUTION

• Initiate ECG relearning only during periods of predominantly normal rhythm and when the ECG 
signal is relatively noise-free. If ECG learning takes place during arrhythmias, the ectopic beats may 
be incorrectly learned as normal QRS complexes. This may result in missed detection of subsequent 
arrhythmia events. 

9.10 Defibrillation Synchronization Pulse Output 
The 12-lead MPM module provides an analog out connector to output synchronization pulses for defibrillators. If 
a defibrillator is connected, it receives a synchronization pulse (100 ms, +5 V) through the analog out connector 
each time an R-wave is detected. The 3/5/6 lead MPM module does not offer this output.

WARNING

• According to IEC 60601-2-4: 2010, the peak of the synchronized defibrillator discharge should be 
delivered within 60 ms of the peak of the R wave. The signal at the ECG output (sync pulse) on the 
monitor is delayed by maximum of 30 ms. the biomedical engineer should verify that the ECG/
Defibrillator combination does not exceed recommended maximum delay of 60 ms.

• Before defibrillation, ensure that both defibrillator and monitor have passed the system test and 
can be safely used together.

9.11 ECG Troubleshooting
This section lists some of the problems that might be encountered during ECG monitoring. If you encounter 
problems when using the monitor or accessories, check the table below before requesting for services. If the 
problem persists after you have taken corrective actions, contact the service personnel.

NOTE

• For the physiological and technical alarm messages, see D Alarm Messages.

Problem Corrective Actions

Noisy ECG traces 1. Check that the electrodes are not detached or dry. Replace with fresh and 
moist electrodes if necessary. 
2. Check that leadwires are not defective. Replace leadwires if necessary.
3. Check that the patient cable or leadwires are not routed too close to other 
electrical devices. Move the patient cable or leadwires away from electrical 
devices and their cables if necessary. 

Excessive electrosurgical Interference Use ESU-proof ECG cables. For more information, see 25.1 ECG Accessories. 

Muscle Noise Inadequate skin preparation, tremors, tense subject, and/or poor electrode 
placement. 
1. Perform skin preparation again and re-place the electrodes. For more 
information, see 9.4.1 Preparing the Patient Skin and 9.4.2 Applying Electrodes 
and Connecting the Patient.
2. Apply fresh, moist electrodes. Avoid muscular areas. 
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Intermittent Signal 1. Check that cables are properly connected. 
2. Check that electrodes are not detached or dry. Perform skin preparation 
again as described in 9.4.1 Preparing the Patient Skin and apply fresh and 
moist electrodes. 
3. Check that the patient cable or leadwires are not damaged. Change them 
if necessary. 

Excessive alarms: heart rate, lead fault 1.  Check that electrodes are not dry. Perform skin preparation again and 
re-place the electrodes. For more information, see 9.4.1 Preparing the 
Patient Skin and 9.4.2 Applying Electrodes and Connecting the Patient. 

2. Check for excessive patient movement or muscle tremor. Reposition the 
electrodes. Replace with fresh and moist electrodes if necessary. 

Low Amplitude ECG Signal 1. Check that the ECG gain is not set too low. Adjust the gain as required. 
For more information, see 9.5.3.2 Changing ECG Waveform Size.

2. Perform skin preparation again and re-place the electrodes. For more 
information, see 9.4.1 Preparing the Patient Skin and 9.4.2 Applying 
Electrodes and Connecting the Patient.

3. Check electrode application sites. Avoid bone or muscular area. 
4. Check that electrodes are not dry or used for a prolonged time. Replace 

with fresh and moist electrodes if necessary. 

No ECG Waveform 1. Check that the ECG gain is not set too low. Adjust the gain as required. 
For more information, see 9.5.3 Changing ECG Wave Settings. 

2. Check that the leadwires and patient cables are properly connected. 
3. Change cable and lead wires if necessary. 
4. Check that the patient cable or leadwires are not damaged. Change them 

if necessary. 

Base Line Wander 1. Check for excessive patient movement or muscle tremor. Secure 
leadwires and cable. 

2. Check that electrodes are not detached or dry and replace with fresh and 
moist electrodes if necessary. For more information, see 9.4.1 Preparing 
the Patient Skin and 9.4.2 Applying Electrodes and Connecting the Patient. 

3. Check for ECG filter setting. Set ECG Filter mode to Monitor to reduce 
baseline wander on the display.

Problem Corrective Actions
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10 Resting 12-Lead ECG Analysis

10.1 Resting 12-Lead ECG Analysis Introduction
The monitor can be configured with the Glasgow 12-lead resting ECG analysis algorithm. The MPM module or N1 
incorporating the Glasgow algorithm is labelled with the logo of Glasgow as shown in 9.1 ECG Introduction.

The Glasgow algorithm is intended for adult, pediatric, and neonatal patients. 

10.2 Entering the 12-Lead Screen
To enter the 12-Lead screen, follow this procedure: 

1. Select the ECG numeric area or waveform area to enter the ECG dialog.

2. From the bottom of the ECG dialog, select 12-Lead.

You can also enter the 12-Lead screen by following this procedure:

■ Select the Screen Setup quick key → select the Choose Screen tab → select ECG 12-Lead.

■  Select Main Menu quick key → from the Display column select Choose Screen → select ECG 12-Lead.

NOTE
• The ECG 12-Lead screen is available only when the Glasgow algorithm is configured (associated 

module has the Glasgow label) and Lead Set is set to Auto or 12-Lead.

10.3 Initiating Resting 12-Lead ECG Analysis
Before initiating 12-lead ECG analysis, check that all electrodes are correctly connected to the lead wires and the 
ECG trunk cable is properly connected. Check that patient information is correct. Keep the patient still.

To initiate 12-Lead ECG analysis, select Analyze from the bottom left of the 12-Lead screen. 

10.4 Changing 12-Lead ECG Analysis Settings
On the ECG 12-Lead screen, you can set the high frequency filter, baseline drift removal (BDR) filter, and the 
waveform layout.

10.4.1 Setting the High Frequency Filter
The high frequency filter attenuates muscle artifact by restricting the included frequencies.  The setting of the 
high frequency filter is 35 Hz by default. To change the setting, follow this procedure: 

1. On the ECG 12-Lead screen, select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab.

3. Set High-Freq Cut-off.

The high frequency filter is a low-pass filter. That is to say, signal frequencies higher than the set frequency are 
filtered out. For example, if you set High-freq Cutoff to 35 Hz, then signal below 35 Hz is kept in the signal and 
signal exceeding 35 Hz is attenuated.

10.4.2 Setting the Baseline Drift Removal Filter
The baseline drift removal (BDR) filter suppresses most baseline drift interference and also is able to preserve the 
fidelity of the ST-segment level. BDR is switched on by default. To set the BDR, follow this procedure:

1. On the ECG 12-Lead screen, select the ECG numeric area or waveform area to enter the ECG dialog.
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2. Select the Setup tab.

3. Switch on or off Baseline Drift Removal as desired. If BDR is switched off, the 0.05 Hz high pass filter is 
used. 

NOTE

• BDR introduces around 1-second delay. Using BDR is recommended except when the delay is 
unacceptable.

10.4.3 Setting the 12-Lead Waveform Layout 
To set the 12-lead waveform layout, follow this procedure:

1. On the ECG 12-Lead screen, select the ECG numeric area or waveform area to enter the ECG dialog.

2. Select the Setup tab.

3. Set Waveform Layout.

◆ Standard: the waveform sequence is I, II, III, aVR, aVL, aVF, V1, V2, V3, V4, V5, V6.

◆ Cabrera: the waveform sequence is aVL, I, -aVR, II, aVF, III, V1, V2, V3, V4, V5, V6.  

For the Glasgow algorithm, the sequence of the chest leads depends on the setting of V3 Placement. If V3 
placement is set to V4R, the sequence of chest leads is V4R, V1, V2, V4, V5, V6.

10.4.4 Editing Patient Information
Some patient information may directly affect ECG analysis. Complete and correct patient information is helpful 
for accurate diagnosis and treatment of the patient. Enter patient information before starting a resting ECG 
analysis.

To enter patient information, follow this procedure:

1. On the ECG 12-Lead screen, select Setup to enter the 12-Lead Setup dialog.

2. On the Patient Demographics page, input or edit patient information.

NOTE

• Saving information will also save the information as though it was entered in the Patient 
Management dialog.

• Changes are not saved until you press Save. So changing to another tab without saving and then 
pressing the exit button “X” will lose any changes.

• Check that patient information is correct before starting a resting 12-lead analysis. 

• Using pediatric lead placement V4R, V1, V2, V4 - V6 is recommended if the patient is under 16 years 
of age. Please record V4R using the V3 electrode. Also set V3 Electrode to V4R. This is a normal 
practice for a patient of this age. 

10.4.5 Setting Tachycardia and Bradycardia Thresholds 
To set tachycardia and bradycardia thresholds, follow this procedure:

1. On the ECG 12-Lead screen, select Setup to enter the 12-Lead Setup dialog.

2. Select the Setup tab.

3. Set Tachy and Brady.

NOTE

• The tachycardia threshold only applies to patients whose age exceeds 180 days.

• The bradycardia threshold only applies to patients whose age exceeds 2191 days (6 years).
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10.4.6  Setting the 12-Lead Interpretation Report
To set the 12-lead interpretation report, follow this procedure:

1. On the ECG 12-Lead screen, select Setup to enter the 12-Lead Setup dialog.

2. Select the Report tab.

3. Set the format and items included in the 12-lead interpretation report.

10.5 Saving the 12-Lead Interpretation Report
At the completion of 12-lead ECG interpretation, select Save to save the report. You can review the saved 12-
lead interpretation reports. For more information, see 26.2.11 12-Lead ECG Review Page.

10.6 Printing the 12-Lead Interpretation Report
At the completion of 12-lead ECG interpretation, select Print or Record to output the report via the printer or 
recorder. 

10.7 Exiting the ECG 12-Lead Screen
To exit the ECG 12-Lead screen, select Exit on the ECG 12-Lead screen.
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11 Monitoring Impedance Respiration (Resp)

11.1 Resp Introduction
Impedance respiration is measured across the thorax. When the patient is breathing or ventilated, the volume of 
air changes in the lungs, resulting in impedance changes between the electrodes. Impedance respiration rate 
(RR) is calculated from the signal representing these impedance changes, and a respiration waveform is 
displayed on the patient monitor screen.

Impedance respiration monitoring is intended for adult, pediatric and neonatal patients. 

Respiration may also be measured using a CO2 module or anesthetic gas (AG) module. Refer to 19 Monitoring 
Carbon Dioxide (CO2) and 20 Monitoring Anesthetic Gas (AG) for respiration information specific to those modules.

11.2 Impedance Resp Safety Information

WARNING

• When monitoring the patient’s impedance respiration, do not use ESU-proof ECG cables. The 
monitor cannot measure impedance respiration with ESU-proof ECG cables.

• If you do not set the detection level for the respiration correctly in manual detection mode, it may 
not be possible for the monitor to detect apnea. If you set the detection level too low, the monitor is 
more likely to detect cardiac activity, and to falsely interpret cardiac activity as respiratory activity 
in case of apnea. 

• The respiration measurement does not recognize the cause of apnea. It only indicates an alarm if a 
pre-adjusted time has elapsed without a breath being detected since the last detected breath. 
Therefore, it cannot be used for diagnostic purpose.

• If operating under conditions according to the EMC Standard IEC 60601-1-2 (Radiated Immunity 3V/
m), field strengths above 3V/m may cause erroneous measurements at various frequencies. 
Therefore, it is recommended to avoid the use of electrically radiating equipment in close proximity 
to the impedance respiration measurement unit.

• The current used to measure impedance respiration may cause rate changes in Minute Ventilation 
Rate Responsive Pacemakers. If you suspect the patient monitor is affecting the pacemaker rate 
then replace the ECG cable with an ECG cable that contains ESU filters.

CAUTION

• Only use parts and accessories specified in this manual. 

• Impedance respiration monitoring is not for use on patients while they are active, as this can cause 
false alarms.
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11.3 Resp Display

NOTE
• If ESU-proof ECG cables are used, the Resp waveform area will display the message “Check Leads”. 

Replace the ECG cable if necessary.

11.4 Preparing for Impedance Resp Monitoring 

11.4.1 Preparing the Patient
Follow this procedure to prepare the patient:

1. Shave hair from skin at chosen sites. 

2. Gently rub skin surface at sites to remove dead skin cells. 

3. Thoroughly cleanse the site with a mild soap and water solution. 

4. Dry the skin completely before applying the electrodes.

CAUTION

• Proper skin preparation is necessary for good signal quality at the electrode site, as the skin is a poor 
conductor of electricity.

(1) Resp waveform gain (2) Resp lead label (3) Alarm limits

(4) Respiration rate (RR) (5) RR source

(1) (5)(4)(3)(2)
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11.4.2 Placing the Electrodes
Impedance respiration is acquired using standard ECG electrodes and cables. Either lead I (RA-LA) or lead II (RA-
LL) can be used.

For more information, see 9.4.4 ECG Electrode Placements.

CAUTION

• Correct electrode placement can help to reduce interference from cardiac related impedance 
changes: avoid including the liver area and the ventricles of the heart between the respiratory 
electrodes. This is particularly important for neonates. 

• Some patients with restricted movements breathe mainly abdominally. In these cases, you may 
need to place the left leg electrode on the left abdomen at the point of maximum abdominal 
expansion to optimize the respiratory waveform. 

• Some patients (especially neonates) expand their chests laterally, causing a negative intrathoracic 
pressure. In these cases, it is better to place the two respiration electrodes in the right midaxillary 
and the left lateral chest areas at the patient’s maximum point of the breathing movement to 
optimize the impedance respiration waveform. 

• To optimize the impedance respiration waveform, place the RA and LA electrodes horizontally when 
monitoring respiration with ECG Lead I; place the RA and LL electrodes diagonally when monitoring 
respiration with ECG Lead II. 

• Periodically inspect electrode application sites to ensure skin integrity. If the skin quality changes, 
replace the electrodes or change the application site. 

NOTE

• Store the electrodes at room temperature. Open the electrode package immediately prior to use. 

• Check that the electrode packages are intact and that the electrodes are not past the expiration 
date. Ensure the electrode gel is moist.

                                           (1) Lead I                                                                 (2) Lead II

(1) (2)
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11.5 Changing Resp Settings

11.5.1 Setting the Resp Alarm Properties
To set the Resp alarm properties, follow this procedure:

1. Select the Resp numeric area or waveform area to enter the Resp dialog.

2. Select the Alarm tab.

3. Enter the password if required. For more information, refer to 33.14.3 Selecting Password for User Authentica-
tion.

4. Set alarm properties as desired.

11.5.2  Setting the RR Source
To set RR source, follow this procedure:

1. Select the Resp numeric area or waveform area to enter the Resp dialog.

2. Select the Setup tab.

3. Choose RR Source from the dropdown list.

When you select Auto, the monitor automatically selects the RR source following order of priority: first CO2, and 
then ECG. When the manually selected RR source is not available, the monitor automatically switches the RR 
Source to Auto. 

11.5.3 Choosing the Respiration Lead
To set the respiration lead, follow this procedure:

1. Select the Resp numeric area or waveform area to enter the Resp dialog.

2. Select the Setup tab.

3. Set Resp Lead.

If you cannot get an acceptable impedance Resp waveform or you suspect the veracity of the Resp value after 
choosing the Resp lead, you may need to adjust the electrode placement.

11.5.4 Setting the Resp Waveform Size
To set the Resp waveform size, follow this procedure:

1. Select the Resp numeric area or waveform area to enter the Resp dialog.

2. Select the Setup tab.

3. Set Gain.

11.5.5 Setting the Resp Waveform Speed
To set the Resp waveform speed, follow this procedure:

1. Select the Resp numeric area or waveform area to enter the Resp dialog.

2. Select the Setup tab.

3. Set Speed.
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11.5.6 Setting the Auto Detection Switch
To set the auto detection switch, follow this procedure:

1. Select the Resp numeric area or waveform area to enter the Resp dialog.

2. Select the Setup tab.

3. Switch on or off Auto Threshold Detection.

◆ If Auto Threshold Detection is switched on,  the monitor automatically adjusts the Resp waveform 
detection level, or threshold. 

◆  If Auto Threshold Detection is switched off, you have to manually adjust the Resp waveform 
threshold. For more information, see 11.5.7 Adjusting the Resp Waveform Detection Threshold.

In the auto threshold detection mode, if you are monitoring Resp and the ECG parameter is switched off, the 
monitor cannot compare the heart rate and Resp rates to detect cardiovascular artifact. The respiration 
detection level is automatically set higher to prevent the detection of cardiovascular artifact as respiration.

In the manual detection mode (where auto threshold detection is off ), cardiovascular artifact can, in certain 
situations, trigger the respiration rate counter. This may lead to a false indication of a high respiration or an 
undetected apnea condition. If you suspect that cardiovascular artifact is being registered as respiratory activity, 
raise the detection level above the zone of cardiovascular artifact. If the Resp wave is so small that raising the 
detection level is not possible, you may need to optimize the electrode placement.

11.5.7 Adjusting the Resp Waveform Detection Threshold
Use the manual detection mode (where auto threshold detection is off ) in the following situations:

■ The respiration rate and the heart rate are close.

■ Patients have intermittent mandatory ventilation.

■ Respiration is weak. Try repositioning the electrodes to improve the signal.

To set the Resp waveform threshold to the desired level, follow this procedure:

1. Select the Resp numeric area or waveform area to enter the Resp dialog.

2. Select the Threshold tab.

3. Select the up and down arrows below Upper Line and Lower Line to define the Resp waveform threshold.

Once set, the detection level will not adapt automatically to different respiration depths. It is important to 
remember that if the depth of breathing changes, you may need to change the detection level.
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12 Monitoring Pulse Oxygen Saturation (SpO2)

12.1 SpO2 Introduction

Pulse Oxygen Saturation (SpO2) monitoring is a non-invasive technique used to measure the amount of 
oxygenated hemoglobin and pulse rate by measuring the absorption of selected wavelengths of light. The light 
generated in the emitter side of the probe is partly absorbed when it passes through the monitored tissue. The 
amount of transmitted light is detected in the detector side of the probe. When the pulsative part of the light 
signal is examined, the amount of light absorbed by the hemoglobin is measured and the pulse oxygen 
saturation can be calculated. This device is calibrated to display functional oxygen saturation.

SpO2 monitoring is intended for adult, pediatric and neonatal patients.

You can simultaneously measure SpO2 from two different measurement sources: the MPM module and the SpO2 
module. The measurement from the MPM module is labelled as SpO2 and the measurement from the SpO2 
module is labelled as SpO2b. 

The monitor can be configured with Masimo SpO2 or Nellcor SpO2:

■ Masimo SpO2: the connector is purple and the logo of Masimo SET is on the module’s front panel.

■ Nellcor SpO2: the connector is grey and the logo of Nellcor is on the module’s front panel.

NOTE

• If you need to measure SpO2 by both the MPM module and the SpO2 module, select the same type of 
SpO2. Otherwise, the SpO2 module will be disabled. For example, if an MPM module configured with 
the Nellcor SpO2 and an SpO2 module configured with the Masimo SpO2 are simultaneously 
applied, the SpO2 module will be automatically disabled.

• The SpO2 extension cable used must be compatible with the SpO2 sensor connectors used. For 
example, only the Masimo SpO2 extension cable can be connected to the Masimo SpO2 sensor 
connectors.

• Measurement accuracy verification: The SpO2 accuracy has been verified in human experiments by 
comparing with arterial blood sample reference measured with a CO-oximeter. Pulse oximeter 
measurement are statistically distributed and about two-thirds of the measurements are expected 
to come within the specified accuracy range compared to CO-oximeter measurements.

• A functional tester or SpO2 simulator can be used to determine the pulse rate accuracy.

• A functional tester or SpO2 simulator cannot be used to assess the SpO2 accuracy.

(1) Connector of Masimo SpO2 (2) Connector of Nellcor SpO2

T1

T2

ECG NIBP

IBP2

SpO2

MP1Platinum

T1

T2

ECG NIBP

IBP2

SpO2

MP1Platinum

     (2)                      
 

(1)
BeneVision N22/N19/N17/N15/N12 Patient Monitor Operator’s Manual 12 - 1



12.2 SpO2 Safety Information

WARNING

• When a trend toward patient deoxygenation is indicated, analyze the blood samples with a 
laboratory co-oximeter to completely understand the patient’s condition.

• Do not use SpO2 sensors during magnetic resonance imaging (MRI). Induced current could 
potentially causes burns. The sensor may affect the MRI image, and the MRI unit may affect the 
accuracy of the oximetry measurements. 

• Prolonged continuous monitoring may increase the risk of undesirable changes in skin 
characteristics, such as irritation, reddening, blistering or burns. Inspect the sensor site every two 
hours and move the sensor if the skin quality changes. Change the application site every four hours. 
For neonates, or patients with poor peripheral blood circulation or sensitive skin, inspect the sensor 
site more frequently.

• If the sensor is too tight because the application site is too large or becomes too large due to edema, 
excessive pressure for prolonged periods may result in venous congestion distal from the 
application site, leading to interstitial edema and tissue ischemia. 

• When patients are undergoing photodynamic therapy they may be sensitive to light sources. Pulse 
oximetry may be used only under careful clinical supervision for short time periods to minimize 
interference with photodynamic therapy. 

• Setting alarm limits to extreme values may cause the alarm system to become ineffective. For 
example, high oxygen levels may predispose a premature infant to retrolental fibroplasia. If this is a 
consideration, do not set the high alarm limit to 100%, which is equivalent to switching off the 
alarm. 

• SpO2 is empirically calibrated in healthy adult volunteers with normal levels of carboxyhemoglobin 
(COHb) and methemoglobin (MetHb). 

• To protect from electric shock, always remove the sensor before bathing the patient. 

• The pulse oximetry function of the bedside monitor should not be used for apnea monitoring. 

•  The pulse oximetry function of the bedside monitor should not be used for arrhythmia analysis.

CAUTION

• Change the application site or replace the sensor and/or patient cable when a persistent SpO2 Low 
Signal Quality message is displayed on the equipment. These messages may indicate that patient 
monitoring time is exhausted on the patient cable or sensor.

• Replace the cable or sensor when a “SpO2 Sensor Off”, “SpO2 No Sensor”, or “SpO2 Low Signal 
Quality” message is consistently displayed while monitoring consecutive patients after completing 
troubleshooting steps listed in this manual. 

• Variation in measurements may be profound and may be affected by sampling technique as well as 
the patient's physiological conditions. Any results exhibiting inconsistency with the patient’s clinical 
status should be repeated and/or supplemented with additional test data. Blood samples should be 
analyzed by laboratory instruments prior to clinical decision making to completely understand the 
patient’s condition.

• Use only SpO2 sensors specified in this manual. Follow the SpO2 sensor’s instructions for use and 
adhere to all warnings and cautions.

• Do not place the patient monitor where the controls can be changed by the patient. 

• If using pulse oximetry during full body irradiation, keep the sensor out of the radiation field. If the 
sensor is exposed to the radiation, the reading might be inaccurate or the device might read zero for 
the duration of the active irradiation period. 

NOTE

• Additional information specific to the Masimo sensors compatible with the equipment, including 
information about parameter/measurement performance during motion and low perfusion, may be 
found in the sensor's directions for use (DFU).
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• Masimo cables and sensors are provided with X-Cal™ technology to minimize the risk of inaccurate 
readings and unanticipated loss of patient monitoring. Refer to the Cable or Sensor DFU for the 
specified duration of the patient monitoring time.

12.3 SpO2 Measurement Limitations

The following factors may influence the accuracy of SpO2 measurement:

■ Patient physiological characteristics:

◆ Cardiac arrest 

◆ Hypotension 

◆ Darkly pigmented skin

◆ Shock

◆ Severe vasoconstriction

◆ Hypothermia

◆ Severe anemia

◆ Ventricular septal defects (VSDs)

◆ Venous pulsations

◆ Poor perfusion

◆ Dysfunctional hemoglobin, such as carboxyhemoglobin (COHb) and methemoglobin (MetHb)

◆ Elevated levels of bilirubin

◆ Vasospastic disease, such as Raynaud’s, and peripheral vascular disease

◆ Hemoglobinopathies and synthesis disorders such as thalassemias, Hb s, Hb c, sickle cell, etc.

◆ Hypocapnic or hypercapnic conditions

◆ Birthmark(s), tattoos, skin discolorations, moisture on skin, deformed or abnormal fingers. etc.

■ Interfering substances:

◆ Intravascular dyes (such as indocyanine green, methylene blue, indigo carmine, etc.)

◆ Dyes in the measure site, such as nail polish

■ Environmental conditions:

◆ Excessive ambient light

◆ Electrosurgery equipment

◆ Defibrillation (may cause inaccurate reading for a short amount of time)

◆ Excessive patient/sensor motion

◆ Electromagnetic field

◆ Arterial catheters and intra-aortic balloon

■ Others

◆ Inappropriate positioning of the SpO2 sensor, or use of incorrect SpO2 sensor

◆ Cuff or arterial blood pressure measurement device on the same limb as the SpO2 sensor 
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12.4 SpO2 Display

NOTE

• PI is displayed for Masimo SpO2.

12.5 Preparing for SpO2 Monitoring 

To prepare to monitor SpO2, follow this procedure:

1. Select an appropriate sensor according to the module type, patient category and weight.

2. Clean the contact surface of the reusable sensor.

3. Remove colored nail polish from the application site.

4. Apply the sensor to the patient according to the instruction for use of the sensor.

5. Select an appropriate extension cable according to the connector type and plug the cable into the SpO2 
connector.

6. Connect the sensor to the extension cable.

CAUTION

• Do not apply sensor too tightly as this results in venous pulsation which may severely obstruct 
circulation and lead to inaccurate measurements. 

• At elevated ambient temperatures, be careful with measurement sites that are not well perfused, 
because this can cause burns after prolonged application.

• Avoid placing the sensor on extremities with an arterial catheter, an NIBP cuff or an intravascular 
venous infusion line. 

• For neonatal patients, make sure that all sensor connectors and adapter cable connectors are 
outside the incubator. The humid atmosphere inside can cause inaccurate measurements. 

(1)                                                                                                                                          (2)                 (3)

(4)                                                               

(1)                                                                                                                                            (2)                (3)

(5)                                                               

(4)                                                               

(6)                                                               

(1) Pleth waveform (Pleth/Plethb): visual indication of patient’s pulse. The waveform is not normalized.

(2) Oxygen saturation of arterial blood (SpO2/SpO2b): percentage of oxygenated hemoglobin in relation to the sum of 
oxyhemoglobin and deoxyhemoglobin.

(3) Perfusion indicator: the pulsatile portion of the measured signal caused by arterial pulsation.

(4) Perfusion index (PI): gives the numerical value for the pulsatile portion of the measured signal caused by arterial 
pulsation. PI is an indicator of the pulsatile strength. You can also use it to assess the SpO2 signal strength. 

(5) Pulse rate (derived from the pleth wave): detected pulsations per minute.

(6) SpO2 difference (∆SpO2): SpO2Δ SpO2 SpO2b–=
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NOTE

• Up to two measurement sites are available simultaneously.

12.6 Changing the SpO2 Settings

NOTE
• The settings of in the SpO2 module and SpO2b module are linked.

12.6.1 Changing the SpO2 Alarm Settings

To change the SpO2 alarm settings, follow this procedure:

1. Select the SpO2 numeric area or waveform area to enter the SpO2 dialog.

2. Select the Alarm tab.

3. Enter the password if required. For more information, refer to 33.14.3 Selecting Password for User 
Authentication.

4. Set the alarm properties as desired.

For SpO2b, you can also set alarm properties for ∆SpO2.

NOTE

• The desat alarm is a high level alarm notifying you of potentially life threatening drops in oxygen 
saturation. When the SpO2 value is below the desat alarm limit and desat alarm switch is set on, the 
message “SpO2 Desat” is displayed.

• You can switch off the SpO2 Desat alarm only when the SpO2 Desat Alarm Off is enabled. For more 
information, see section 33.3.7.6 Setting the Switch of the SpO2 Desat Alarm Off.

12.6.2 Nellcor SatSecondsTM Alarm Management
With traditional alarm management, high and low alarm limits are set for monitoring oxygen saturation. During 
monitoring, once an alarm limit is violated, an audible alarm immediately sounds. When the patient SpO2 
fluctuates near an alarm limit, the alarm sounds each time the limit is violated. Such frequent alarms can be 
distracting. Nellcor’s SatSeconds alarm management technique is used to reduce these nuisance alarms.

The SatSeconds feature is available with the Nellcor SpO2 to decrease the likelihood of false alarms caused by 
motion artifacts. With SatSeconds alarm management, high and low alarm limits are set in the same way as 
those with traditional alarm management. A SatSeconds limit is also set. The SatSeconds limit controls the 
amount of time that SpO2 saturation may be outside the set limits before an alarm sounds. 

The method of calculation is as follows: the percentage points of the SpO2 saturation falling outside the alarm 
limit is multiplied by the number of seconds remaining outside the limit. This can be stated as the equation:

SatSeconds = Points × Seconds

Only when the SatSeconds limit is reached, the monitor gives a SatSeconds alarm. For example, the figure below 
demonstrates the alarm response time with a SatSeconds limit set at 50 and a low SpO2 limit set at 90%. In this 
example, the patient SpO2 drops to 88% (2 points) and remains there for 2 seconds. Then it drops to 86% (4 
points) for 3 seconds, and then to 84% (6 points) for 6 seconds. The resulting SatSeconds are:

% SpO2 Seconds SatSeconds

2× 2= 4

4× 3= 12

6× 6= 36

Total SatSeconds= 52
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After approximately 11 seconds, a Sat-Second alarm would sound, because the limit of 50 SatSeconds would 
have been exceeded.

Saturation levels may fluctuate rather than remaining steady for a period of several seconds. Often, the patient 
SpO2 may fluctuate above and below an alarm limit, re-entering the non-alarm range several times. During such 
fluctuation, the monitor integrates the number of SpO2 points, both positive and negative, until either the 
SatSeconds limit is reached, or the patient SpO2 re-enters the non-alarm range and remains there. 

NOTE
• The SpO2 Too Low or SpO2 Too High alarm is presented in the case that SpO2 value violates the alarm 

limits 3 times within one minute even if the setting of SatSeconds is not reached. 

To set the SatSeconds, follow this procedure:

1. Select the SpO2 numeric area or waveform area to enter the SpO2 dialog.

2. Select the Alarm tab.

3. Set Sat-Seconds.

12.6.3 Setting SpO2 Sensitivity (for Masimo SpO2)

For Masimo SpO2, selects the Sensitivity as per signal quality and patient motion.

Normal sensitivity is the recommended for patients who are experiencing some compromise in blood flow or 
perfusion. It is advisable for care areas where patients are observed frequently, such as the intensive care unit 
(ICU). 

Adaptive Probe Off Detection (APOD) sensitivity is the recommended sensitivity mode where there is a high 
probability of the sensor becoming detached. It is also the suggested mode for care areas where patients are not 
visually monitored continuously. This mode delivers enhanced protection against erroneous pulse rate and 
arterial oxygen saturation readings when a sensor becomes inadvertently detached from a patient due to 
excessive movement.

Maximum sensitivity is recommended for use on patients with weak signals (e.g. high ambient noise and/or 
patients with very low perfusion) and for use during procedures or when clinician and patient contact is 
continuous such as in higher acuity settings.

To set SpO2 sensitivity, follow this procedure:

1. Select the SpO2 numeric area or waveform area to enter the SpO2 dialog.

2. Select the Setup tab.

3. Set Sensitivity to Maximum, Normal, or APOD.

%SpO2                                                               

Seconds                                                         
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CAUTION

• When using the Maximum Sensitivity setting, performance of "Sensor Off" detection may be 
compromised. If the equipment and the sensor becomes detached from the patient, the potential 
for false readings may occur due to environmental noise such as light, and vibration.

• Configuring the monitor to “Load Latest Configuration” as the default configuration may result in 
Masimo SpO2 being set to Maximum sensitivity mode on power up or after admitting a new patient. 
Maximum sensitivity is recommended for use during procedures or when clinician and patient 
contact is continuous, such as in higher acuity settings. Maximum sensitivity is not recommended 
for care areas where patients are not monitored visually as “Sensor Off” detection may be 
compromised. Refer to Section 32.4 Setting Default Configuration for managing configuration.

12.6.4 Enabling FastSAT (for Masimo SpO2)

FastSAT enables rapid tracking of arterial oxygen saturation changes as may be required in urgent situations. 
When FastSAT is switched on, the averaging algorithm evaluates all the SpO2 values and provides an averaged 
SpO2 value that is a better representation of the patient’s current oxygen saturation status. 

The reliability of FastSAT is dependent on the setting for the averaging time and the input signal. FastSAT is 
disabled by default. To enable FastSAT, follow this procedure:

1. Select the SpO2 numeric area or waveform area to enter the SpO2 menu.

2. Select the Setup tab.

3. Switch on FastSAT.

12.6.5 Displaying SIQ (for Masimo SpO2)

The signal quality indicator (SIQ) displays below the Pleth waveform. The SIQ is conveyed by vertical bars. The 
height of the bar provides an assessment of the confidence in the displayed SpO2 value. The SpO2 SIQ can also 
be used to identify the occurrence of a patient ‘s pulse.

The following picture shows the SpO2 SIQ:

 To show SpO2 SIQ, follow this procedure:

1. Select the SpO2 numeric area or waveform area to enter the SpO2 menu.

2. Select the Setup tab.

3. Switch on Display SIQ.

12.6.6 Changing Averaging Time (for Masimo SpO2)

The SpO2 value displayed on the monitor screen is the average of data collected within a specific time. The 
shorter the averaging time is, the quicker the monitor responds to changes in the patient’s oxygen saturation 
level. Contrarily, the longer the averaging time is, the slower the monitor responds to changes in the patient’s 
oxygen saturation level, but the SpO2 measurement is more stable. For critically ill patients, selecting a shorter 
averaging time will help with understanding the patient’s state. 

To set the averaging time, follow this procedure:

1. Select the SpO2 numeric area or waveform area to enter the SpO2 dialog.

2. Select the Setup tab.

3. Set Averaging.

(1) Signal quality indicator (SIQ)

(1)                                                               
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12.6.7 Monitoring SpO2 and NIBP Simultaneously

When monitoring SpO2 and NIBP on the same limb simultaneously, you can switch on NIBP Simul to lock the 
SpO2 alarm status until the NIBP measurement ends. If you switch off NIBP Simul, low perfusion caused by NIBP 
measurement may lead to inaccurate SpO2 readings and therefore cause false physiological alarms. 

To set the NIBP Simul, follow this procedure:

1. Select the SpO2 numeric area or waveform area to enter the SpO2 dialog.

2. Select the Alarm tab.

3. Set NIBP Simul.

12.6.8 Changing the Sweep Speed of the Pleth Waveform
To set the sweep speed of Pleth waveform, follow this procedure:

1. Select the SpO2 numeric area or waveform area to enter the SpO2 dialog.

2. Select the Setup tab.

3. Set Speed.

12.7 Changing the PR Settings

12.7.1 Changing the PR Alarm Settings
To change the PR alarm settings, follow this procedure:

1. Select the SpO2 numeric area or waveform area to enter the SpO2 dialog.

2. Select the PR tab.

3. Enter the password if required. For more information refer to 33.14.3 Selecting Password for User 
Authentication.

4. Set the alarm properties as desired.

12.7.2 Changing the QRS Volume
If the Alarm Source is set to PR, the QRS tone is derived from PR measurements. To set the QRS volume, follow 
this procedure:

1. Select the SpO2 numeric area or waveform area to enter the SpO2 dialog.

2. Select the PR tab.

3. Select the Setup tab.

4. Set QRS Volume.

If the SpO2 value is valid, the monitor also adjusts the QRS tone (pitch tone) according to the SpO2 value. For 
information, see 33.15.3 Setting the SpO2 Tone Mode.

NOTE

• Changing the QRS volume settings in the PR Setup page also changes the QRS volume settings in the 
Setup page of the ECG dialog.

12.7.3 Setting the PR Source
Current pulse source is displayed in the PR numeric area if current PR source is not SpO2. The PR from current 
pulse source has the following characteristics: 

■ PR is stored in the monitor’s database and can be reviewed in the graphic and tabular trends.In  graphic 
trends, as the PR curve has the same color as that of current PR source.

■ PR is sent via the network to the CMS, if available. 

To set which parameter is used as a PR source, follow this procedure: 
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1. Select the SpO2 numeric area or waveform area to enter the SpO2 dialog.

2. Select the PR tab.

3. Select the Setup tab.

4. Set PR Source.

The dropdown list of the PR Source displays the currently available PR sources from top to bottom by priority. 
When you select Auto, the system will automatically select the first option as the PR source. If the current PR 
source is unavailable, the system will automatically switch PR Source to Auto. When you select IBP, the system 
will automatically select the first pressure label as the PR source. 

12.7.4 Showing/Hiding PR

You can set whether to display the PR value in the SpO2 parameter area. To do so, follow this procedure:

1. Select the SpO2 numeric area or waveform area to enter the SpO2 menu.

2. Select the PR tab.

3. Select the Setup tab.

4. Switch on or off Display PR.

12.8 Displaying SpO2 Statistics

You can show SpO2 statistics for a defined period of time. To do so, follow this procedure:

1. Access the Tile Layout in either of the following ways:

◆ Select the Screen Setup quick key → select the Tile Layout tab.

◆  Select the Main Menu quick key → from the Display column select Tile Layout.

2. Select the parameter numeric area where you want to display SpO2 statistics, and then from the popup list 
select SpO2 → SpO2 Statistics.

The following figure shows the SpO2 statistics area.

12.8.1 Selecting the Range of each SpO2 Section and the Target Section

To define the SpO2 range of each section, follow this procedure:

1. Select the SpO2 statistics area.

2. In the To column set the SpO2 value at which each section ends. Changing the value in the To column 
automatically changes the value in the From column of the next section.

3. In the Target column select the section to be used as the target section. The target section is highlighted in 
green in the SpO2 statistics area. 

12.8.2 Selecting the SpO2 Statistics Length

The time period over which the SpO2 statistics are calculated is configurable. From the SpO2 statistics area, select 
a new duration from the popup menu.

(1) Duration of SpO2 statistics

(2) Results of SpO2 statistics

(3) Sections for statistics: The section in green indicates the target range.

(1)

(2)
(3)
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12.9 SpO2 Troubleshooting

This section lists the problems that might occur. If you encounter the problems when using the equipment or 
accessories, check the table below before requesting service. If the problem persists, contact your service 
personnel.

NOTE

• For the physiological and technical alarm messages, see Appendix D Alarm Messages.

12.10  Nellcor Information
 

Nellcor Patents

This posting serves as notice under 35 U.S.C.§287(a) for Covidien patents: http://www.covidien.com/patents.

No Implied License

Possession or purchase of this device does not convey any express or implied license to use the device with 
unauthorized replacement parts which would, alone, or in combination with this device, fall within the scope of 
one or more of the patents relating to this device.

Problem Solution

Do not see SpO2 numeric area or waveform area 
on the main screen

1.   Check that the SpO2 is set to display in the Screen Setup → → 
Tile Layout page. For more information, see 3.9.2 Displaying 
Parameter Numerics and Waveforms.
2. Check that the SpO2 parameter switch is enabled. If not, enable the 
SpO2 measurement.For more information, see 3.9.1 Switching On or 
Off a Parameter.
3. Check that the cable connections of the SpO2 sensor and the 
extension cable are tight. Replace the SpO2 sensor or the extension 
cable if needed.

Dashes “- -” display in place of numerics 1. Check that the cable connections of SpO2 sensor and the 
extension cable are tight. Replace the SpO2 sensor or the extension 
cable if needed.
2. Reconnect the SpO2 sensor if the alarm SpO2 Sensor Off appears. 
3. Check the PI value. If the PI value is too low, adjust the SpO2 sensor, 
or apply the sensor to a site with better perfusion.
4. Move the sensor to a place with weaker ambient light, or cover the 
sensor to minimize the ambient light if the alarm SpO2 Too Much 
Light appears.

Low amplitude SpO2 signal 1. The SpO2 sensor and NIBP cuff are placed on the same limb. 
Change the monitoring site if necessary.
2. Check the PI value. If the PI value is too low. Adjust the SpO2 sensor, 
or apply the sensor to a site with better perfusion.

SpO2 value is inaccurate 1. Check the patient’s vital signs.
2. Check for conditions that may cause inaccurate SpO2 readings. For 
more information, see 12.3 SpO2 Measurement Limitations.
3. Check the monitor, the SpO2 module or the MPM for proper 
functioning.
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12.11 Masimo Information
 

Masimo Patents

This posting serves as notice under 35 U.S.C.§287(a) for Masimo patents: http://www.masimo.com/patents.htm.

No Implied License

Possession or purchase of this device does not convey any express or implied license to use the device with 
unauthorized sensors or cables which would, alone, or in combination with this device, fall within the scope of 
one or more of the patents relating to this device. 

12.12 Masimo End-User License Agreement
THIS DOCUMENT IS A LEGAL AGREEMENT BETWEEN YOU (“PURCHASER”) AND SHENZHEN MINDRAY. IF YOU DO 
NOT AGREE TO THE TERMS OF THIS AGREEMENT, PROMPTLY RETURN THE ENTIRE PACKAGE, INCLUDING ALL 
ACCESSORIES, IN THEIR ORIGINAL PACKAGE, WITH YOUR SALES RECEIPT TO SHENZHEN MINDRAY FOR A FULL 
REFUND.

1. Grant of License. In consideration of payment of the license fee, which is part of the price paid for this 
product, Shenzhen Mindray grants to Purchaser a nonexclusive, nontransferable license, without right to 
sublicense, to use the copy of the incorporated software/firmware, and documentation in connection with 
Purchaser's use of the Masimo Products for their labeled purpose. Shenzhen Mindray reserves all rights not 
expressly granted to Purchaser.

2. Ownership of Software/Firmware. Title to, ownership of, and all rights and interests in, any Masimo 
software and/or firmware and the documentation, and all copies thereof, remain at all times vested in 
Masimo Corporation, licensor to Shenzhen Mindray, and they do not pass to Purchaser.

3. Assignment. Purchaser shall not assign or transfer this License, in whole or in part, by operation of law or 
otherwise, without Shenzhen Mindray's prior written consent; any attempt without such consent, to assign 
any rights, duties or obligations arising hereunder shall be void.

4. Copy Restrictions. The software/firmware, mask works, circuit board layouts, and accompanying written 
materials are copyrighted. Unauthorized copying of the software, including software that has been 
modified, merged, or included with other software, or other written materials is expressly forbidden. You 
may be held legally responsible for any copyright infringement that is cause or incurred by your failure to 
abide by the terms of this license. Nothing in this license provides any rights beyond those provided by 17 
U.S.C. §117.

5. Use Restriction. As the Purchaser, you may physically transfer the products from one location to another 
provided that the software/firmware is not copied. You may not electronically transfer the software/
firmware from the products to any other device. You may not disclose, publish, translate, release distribute 
copies of, modify, adapt, translate, reverse engineer, decompile, disassemble, or create derivative works 
based on the Masimo Product, the software/firmware, or the written materials without the prior written 
consent of Masimo. Masimo Sensors that are designated for single use are licensed under Masimo patents 
for use on a single patient only, and are not sold. There is no license, implied or otherwise, that would allow 
use of single use Masimo Sensors beyond their intended single use. After use of single use Masimo Sensors, 
there is no further license granted by Masimo to use the sensors and they must be discarded.

6. Transfer Restrictions. The software/firmware is licensed to the Purchaser, and may not be transferred to 
anyone, except other end-users, without the prior written consent of Shenzhen Mindray. In no event may 
you transfer, assign, rent, lease, sell, or otherwise dispose of the software/firmware or the products on a 
temporary basis.

7. Beneficiary. Masimo Corporation is a Beneficiary of this Agreement and has the right to enforce its 
provisions.

U.S. Government Rights: If you are acquiring software (including the related documentation) on behalf of any 
part of the United States Government, the following provisions apply: the software is deemed to be “commercial 
software” and “commercial computer software documentation,” respectively pursuant to DFAR Section 227.7202 
FAR 12.212, as applicable. Any use, modification, reproduction, release, performance, display or disclosure of the 
software (including the related documentation) by the U.S. Government or any of its agencies shall be governed 
solely by the terms of this Agreement and shall be prohibited except to the extent expressly permitted by the 
terms of this agreement.
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13 Monitoring Temperature (Temp)

13.1 Temperature Introduction
The monitor can continuously monitor the patient’s skin temperature and core temperature by the MPM module 
and the Temp modules. Thermally sensitive resistors (thermistors) are used, and are based on the principle that 
electrical resistance of the thermistor changes as temperature changes. The resistance change of the thermistors 
is used to calculate the temperature. 

You can connect an MPM module and up to three Temp modules. Up to eight temperature sites can be 
monitored simultaneously and the difference between two measured sites is calculated.

Temperature monitoring is intended for adult, pediatric and neonatal patients.
.

13.2 Temperature Safety Information

CAUTION

• Verify that the probe detection program works correctly before monitoring. Remove the 
temperature probe cable from the temperature probe connector, and check that the monitor can 
display the alarm messages and give alarm tones correctly.

13.3 Temperature Display 
The following figure shows the Temp numeric area for temperature monitoring with the MPM module or Temp 
module. Your display may be configured to look different.

T1

T2

ECG NIBP

IBP2

SpO2

MP1Platinum

(1)

(1)
(1)

(1)

(2)(2)

(1) Temperature probe connector (2) Temp dialog hard key

(1) Temperature site (2) Temperature alarm limits             (3) Temperature value

(3)

(1)

(3)

(4)(2)

(1)

(2)
BeneVision N22/N19/N17/N15/N12 Patient Monitor Operator’s Manual 13 - 1



13.4 Preparing for Temperature Monitoring
To prepare temperature monitoring, follow this procedure:

1. Select an appropriate probe for your patient according to patient category and measured site.

2. Plug the probe or temperature cable to the temperature connector. If using a disposable probe, connect 
the probe to the temperature cable.

3. Follow the probe manufacturer’s instructions to connect the probe to the patient.

13.5 Changing Temperature Settings

13.5.1 Setting the Temperature Alarm Properties 
To set the temperature alarm properties, follow this procedure:

1. Select the temperature numeric area to enter the Temp dialog.

2. Select the Alarm tab.

3. Enter the password if required. For more information, refer to 33.14.3 Selecting Password for User 
Authentication.

4. Set the alarm properties as desired.

13.5.2 Selecting the Temperature Label 
Select the temperature label according to the measurement site. To do so, follow this procedure:

1. Select the temperature numeric area to enter the Temp dialog.

2. Select the Setup tab.

3. Set the temperature label. 

13.5.3 Displaying the Temperature Difference 
To display the temperature difference between two measurement sites monitored by the same temperature 
module, switch on ∆T. To do so, follow this procedure:

1. Select the temperature numeric area to enter the Temp dialog.

2. Select the Setup tab.

3. Switch on ∆T.

(4) Temperature difference (∆T): Difference between two temperature sites. It displays only when ∆T is 
switched on.

Label Description Label Description

T1 Temperature of application site 1 T amb Ambient temperature

T2 Temperature of application site 2 T airw Airway temperature

T skin Skin temperature T vesic Vesical temperature

T core Core temperature T blood Blood temperature

T axil Axillary temperature T myo Myocardial temperature

T naso Nasopharyngeal temperature T tymp Tympanic temperature

T eso Esophageal temperature T cereb Cerebral temperature

T rect Rectal temperature
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13.6 Temperature Troubleshooting
This section lists the problems that might occur. If you encounter the problems when using the equipment or 
accessories, check the table below before requesting service. If the problem persists, contact your service 
personnel.

NOTE

• For the physiological and technical alarm messages, see Appendix D Alarm Messages.

Problem Solution

Do not see Temp numeric area on the main 
screen

1.  Check that if the Temp parameter switch is enabled. If not, enable 
the Temp measurement. For more information, see 3.9.1 Switching 
On or Off a Parameter.

2. Check that the connections of the temperature probe and the 
temperature cable are tight.

Measurement fails/’--’ is displayed in the Temp 
numeric area

1. If using a disposable probe, check the connection between the 
probe and the temperature cable.

2. Try using a known good probe in case the sensor is damaged.
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14 Monitoring Noninvasive Blood Pressure (NIBP)

14.1 NIBP Introduction
The monitor uses the oscillometric method for measuring Non-Invasive Blood Pressure (NIBP). NIBP 
measurement is based on the principle that pulsatile blood flow through an artery creates oscillations of the 
arterial wall. The oscillometric device uses a blood pressure cuff to sense these oscillations that appear as tiny 
pulsations in cuff pressure. The oscillometric devices measure the amplitude of pressure changes in the 
occluding cuff as the cuff deflates from above systolic pressure. The amplitude suddenly increases as the pulse 
breaks through the occlusion in the artery. As the cuff pressure decreases further, the pulsations increase in 
amplitude, reach a maximum (which approximates to the mean pressure), and then diminish. The oscillometric 
method measures the mean pressure and determines the systolic and diastolic pressures.

The NIBP module is integrated into the MPM module. NIBP monitoring is intended for adult, pediatric, and 
neonatal patients.

NOTE
• Blood pressure measurements determined with this device are equivalent to those obtained by a 

trained observer using the cuff/stethoscope auscultatory method or an intra-arterial blood pressure 
measurement device, within the limits prescribed by the American National Standard: manual, 
electronic, or automated sphygmomanometers. 

• NIBP measurement can be performed during electro-surgery and discharge of a defibrillator.

14.2 NIBP Safety Information

WARNING

• Be sure to select the correct patient category setting for your patient before NIBP measurement. Do 
not apply the higher adult settings for pediatric or neonatal patients. Otherwise, it may present a 
safety hazard.

• Do not measure NIBP on patients with sickle-cell disease or on the limb where skin damage has 
occurred or is expected.

• Use clinical judgment to determine whether to perform frequent unattended blood pressure 
measurements on patients with severe blood clotting disorders because of the risk of hematoma in 
the limb fitted with the cuff.

• Do not use the NIBP cuff on a limb with an intravenous infusion or arterial catheter in place. This 
could cause tissue damage around the catheter when the infusion is slowed or blocked during cuff 
inflation.

• Do not apply cuff on the arm on the side of a mastectomy.

(1) NIBP cuff connector

T1

T2

ECG NIBP

IBP2

SpO2

MP1Platinum

(1)
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• Continuous cuff pressure due to connection tubing kinking may cause blood flow interference and 
result in harmful injury to the patient.

• NIBP reading can be affected by the measurement site, the position of the patient, exercise, or the 
patient's physiologic condition. If you doubt the NIBP measurements, determine the patient’s vital 
signs by alternative means, and then verify that the monitor is working correctly.

• Devices that exert pressure on tissue have been associated with purpura, ischemia, and neuropathy. 
Inspect the application site regularly to ensure skin quality and inspect the extremity of the cuffed 
limb for normal color, warmth and sensitivity. If the skin quality changes, or if the extremity 
circulation is being affected, move the cuff to another site or stop the blood pressure measurements 
immediately. Check more frequently when making automatic or STAT measurements. Auto NIBP 
measurements with one and two minute intervals are not recommended for extended periods of 
time.

• Do not modify or replace connectors of the NIBP air hose except with mindray-approved connectors. 
Use neonatal and infant cuffs with CM1901 hoses only. Use pediatric/adult cuffs with CM1903 hoses 
only.

• Never connect intra-arterial or intra-venous lines, or any other incompatible connectors to the NIBP 
hose. This can cause serious injury or death.

• NIBP diagnostic significance must be decided by the hospital’s clinician staff.

CAUTION
 

• Measuring NIBP on patients connected to an Intra Aortic Balloon Pump (IABP) machine may result in 
the NIBP measurement, including PR, to be inaccurate or fail.

• Only use parts and accessories specified in this manual. Follow the instructions for use and adhere to 
all warnings and cautions.

• Using IABP may cause NIBP, including PR, measurements inaccurate or failed.

• Accuracy of NIBP measurement depends on using a cuff of proper size. It is essential to measure limb 
circumference and choose a cuff with proper size.

14.3 NIBP Measurement Limitations
Measurements are impossible with heart rate extremes of less than 30 bpm or greater than 300 bpm, or if the 
patient is on a heart-lung machine. The measurement may be inaccurate or impossible in the following 
situations:

■ Regular arterial pressure pulses are hard to detect

■ Excessive and continuous patient movement such as shivering or convulsions

■ Cardiac arrhythmias

■ Rapid blood pressure changes

■ Severe shock or hypothermia that reduces blood flow to the peripheries

■ On an edematous extremity

■ Obesity, where a thick layer of fat surrounding a limb dampens the oscillations coming from the artery

NOTE

• The effectiveness of this sphygmomanometer has not been established in pregnant women, 
including pre-eclamptic patients.

14.4 Measurement Modes
The monitor provides the following NIBP measurement modes:

■ Manual: measurement on demand.

■ Auto: repeated measurements at set interval.

■ STAT: continual rapid series of measurements over a five-minute period.

■ Sequence: continually automatic measurement at set durations and intervals. 
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14.5 NIBP Display
The NIBP display shows only numerics. 

NOTE

• If NIBP measurement fails, “XX” is displayed; if NIBP measurement is not taken or NIBP 
measurement exceeds its measurement ranges, “--” is displayed.

• NIBP numerics in black color with a light outline indicate that the measurement is old and exceeds 
the configured NIBP Measurement Timeout time (see section 33.5.10 Setting Parameter 
Measurement Timeout). These NIBP values are not recommended for reference.

14.6 Preparing for NIBP Measurements

14.6.1 Preparing the Patient for NIBP Measurements
In normal use, perform NIBP measurement on a patient who is in the following position:

■ Comfortably seated

■ Legs uncrossed

■ Feet flat on the floor

■ Back, arm and feet supported 

NOTE
• It is recommended that the patient remains calm and relaxes as much as possible before performing 

the measurement and that the patient does not talk during the measurement.

  (3)                       (4)                                                                 (5)      

  (10)                              (9)

  (2) 

  (1) 

(6)

(7)

(8)

(11)

(1) Systolic pressure alarm limits

(2) NIBP unit: mmHg or kPa

(3) The last NIBP measurement time

(4) Time to the next measurement (for Auto mode and Sequence mode)

(5) Measurement mode: for Auto NIBP, interval is displayed; for Sequence mode, the current phase and interval are displayed

(6) Diastolic pressure

(7) Diastolic pressure alarm limits

(8) Mean pressure alarm limits

(9) Mean pressure (displayed after measurement completed) or cuff pressure (displayed during the measurement)

(10) Systolic pressure

(11) Pulse Rate
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• Other factors that have been shown to result in an overestimation of blood pressure are labored 
breathing, full bladder, pain etc.

14.6.2 Placing the NIBP Cuff
To place the NIBP cuff, follow this procedure:

1. Verify that the patient category setting is correct. 

2. Connect the air tubing to the NIBP connector. 

3. Select an appropriately sized cuff for the patient, and then wrap it around the limb directly over the 
patient’s skin as follows:

a Determine the patient’s limb circumference.

b Select an appropriate cuff by referring to the limb circumference marked on the cuff. The width of the 
cuff should be 40% (50% for neonates) of the limb circumference, or 2/3 of the length of the upper 
arm or the thigh. The inflatable part of the cuff should be long enough to encircle to overlap at least 
50% to 80% of the limb. 

c Apply the cuff to the patient’s upper arm or leg and make sure the Φ marking on the cuff matches the 
artery location. The cuff should fit snugly, but with enough room for two fingers to be placed 
between the cuff and the patient’s arm (on adults), and loosely on neonates with little or no air 
present within the cuff. Otherwise it may cause discoloration and ischemia of the extremities. Make 
sure that the cuff index line falls within the range markings on the cuff. If it does not, use a cuff that fits 
better.

d Middle of the cuff should be at the level of the right atrium of the heart. If it is not, use the 
measurement correction formula to correct the measurement. For more information, see 
14.8.7 Setting the NIBP Display Format.

4. Connect the cuff to the air tubing. Avoid compression or restriction of pressure tubes. Air must pass 
unrestricted through the tubing.

CAUTION

• Do not touch or apply external pressure against the cuff and air tubing during NIBP measurement. 
This may cause inaccurate blood pressure values. 

• Use care when placing the cuff on an extremity used for monitoring other patient parameters.

14.7 Starting and Stopping NIBP Measurements
Start and stop NIBP measurement by selecting the NIBP quick keys or from the NIBP dialog.

Task By Quick Key From NIBP dialog

Start a manual measurement NIBP Start/Stop quick key Start NIBP button

Start auto NIBP series NIBP Start/Stop quick key Setup tab → set Interval → Start NIBP 
button

NIBP Measure quick key →select 
Interval

Start NIBP sequence 
measurement

NIBP Measure quick key  → 

Sequence
Sequence tab → set NIBP sequence 
→Start NIBP button

Start STAT measurement NIBP STAT quick key STAT button

NIBP Measure quick key  → STAT

Stop the current NIBP 
measurements

NIBP Start/Stop quick key Stop NIBP button
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14.8 Changing NIBP Settings

14.8.1 Setting the NIBP Alarm Properties
To set the NIBP alarm properties, follow this procedure: 

1. Select the NIBP numeric area to enter the NIBP dialog.

2. Select the Alarm tab.

3. Enter the password if required. For more information, refer to 33.14.3 Selecting Password for User 
Authentication.

4. Set the alarm properties as desired.

14.8.2 Setting the Initial Cuff Inflation Pressure
To set initial cuff inflation pressure, follow this procedure:

1. Select the NIBP numeric area to enter the NIBP dialog.

2. Select Initial Pressure, and then select the appropriate setting.

NOTE

•  For known hypertensive patients, you need to set initial cuff pressure to a higher value to reduce the 
measurement time.

14.8.3 Setting the NIBP Interval
For auto NIBP measurement, you need to set the interval between two NIBP measurements. To set the NIBP 
interval, follow this procedure:

1. Select the NIBP numeric area to enter the NIBP dialog.

2. Set Interval. Selecting Manual switches to manual mode.

NOTE

• NIBP Measure dialog gives quick access to starting and setting the interval. Selecting an option from 
the NIBP Measure dialog will change the NIBP interval to that selection and start the NIBP 
measurement.

14.8.4 Selecting NIBP Start Mode
Start mode defines how future NIBP  measurements are initiated with automatic measurement mode. To set the 
start mode, follow this procedure:

1. Select the NIBP numeric area to enter the NIBP dialog.

2. Select Start Mode. 

◆ Clock: after the first measurement, the monitor automatically synchronizes NIBP automatic 
measurements with the real time clock. For example, if Interval is set to 20 min, and NIBP auto 
measurement is started at 14:03, the next measurement will be taken at 14:20, and then at 14:40, 
15:00, and so on.

End auto NIBP series or NIBP 
Sequence

NIBP Stop All quick key NIBP Stop All button

Stop STAT measurement and end 
series

NIBP Start/Stop quick key Stop NIBP or NIBP Stop All button

NIBP STAT quick key 

Task By Quick Key From NIBP dialog
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◆ Interval: after the first measurement, the monitor automatically repeats measurements at set interval. 
For example, if Interval is set to 20 min, and NIBP auto measurement is started at 14:03, the next 
measurement will be taken at 14:23, and then at 14:43, 15:03, and so on.

14.8.5 Enabling the NIBP End Tone
The monitor can issue a reminder tone at the completion of NIBP measurement. The NIBP End Tone is off by 
default. To switch on the NIBP end tone, follow this procedure:

1. Select the NIBP numeric area to enter the NIBP dialog.

2. Switch on NIBP End Tone. 

14.8.6 Setting NIBP Sequence
NIBP sequence measurement can have up to five phases: A, B, C, D, and E. The duration and interval of each phase 
can be set individually. 

To set NIBP sequence, follow this procedure: 

1. Select the NIBP numeric area to enter the NIBP dialog.

2. Select the Sequence tab.

3. Set Duration and Interval of each phase. 

14.8.7 Setting the NIBP Display Format
To set the NIBP display format, follow this procedure:

1. Select the NIBP numeric area to enter the NIBP menu.

2. Select the Setup tab.

3. Set Display Format.

14.8.8 Setting the NIBP Alarm Limits Display Switch
To set whether to display the alarm limits of diastolic NIBP and mean NIBP, follow this procedure:

1. Select the NIBP numeric area to enter the NIBP menu.

2. Select the Setup tab.

3. Switch on or off Display Alarm Limits.

14.8.9 Showing/Hiding PR
You can set whether to display the PR value in the NIBP parameter area. To do so, follow this procedure:

1. Select the NIBP numeric area to enter the NIBP menu..

2. Select the Setup tab.

3. Switch on or off Display PR.

14.8.10 Correcting the NIBP Measurements
The middle of the cuff should be at the level of right atrium. If the limb is not at the heart level, the measurement 
should be corrected as follows:

■ Add 0.75 mmHg (0.10 kPa) to the displayed value for each centimetre higher.

■ Deduct 0.75 mmHg (0.10 kPa) to the displayed value for each centimeter lower.

14.9 Assisting Venous Puncture
You can use the NIBP cuff to cause sub-diastolic pressure to block the venous blood vessel and therefore help 
venous puncture. To assist venous puncture, follow this procedure:

1. Select the Venipuncture quick key or select the NIBP numeric area → Setup tab.
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2. Set Venipuncture Pressure.

3. Select Venipuncture at the bottom of the dialog.

4. Puncture vein and draw blood sample.

5. Select the NIBP Start/Stop quick key to deflate the cuff. If the cuff is not manually deflated, the cuff 
automatically deflates after a fixed period of time (170 seconds for adult and pediatric patient, 85 seconds 
for neonatal patient). 

During venous puncture, pay attention to the cuff pressure and the remaining time displayed in the NIBP 
numerics area. 

14.10 NIBP Troubleshooting
This section lists the problems that might occur. If you encounter the problems when using the equipment or 
accessories, check the table below before requesting for services. If the problem persists, contact your service 
personnel.

NOTE

• For the physiological and technical alarm messages, see Appendix D Alarm Messages.

Problem Solution

Cannot see NIBP numeric area on the main 
screen

1. Check that the NIBP is set to display in the Screen Setup → Tile Layout 
page. For more information, see.3.9.2 Displaying Parameter Numerics and 
Waveforms

2. Check that if the NIBP parameter switch is enabled. If not, enable the NIBP 
measurement. For more information, see 3.9.1 Switching On or Off a 
Parameter.
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15 Monitoring Invasive Blood Pressure (IBP)

15.1 IBP Introduction
You can measure invasive blood pressure (IBP) using the MPM, or the IBP module. This patient monitor can 
monitor up to 8 invasive blood pressures and displays the systolic, diastolic and mean pressures and a waveform 
for each pressure.

IBP monitoring is intended for adult, pediatric, and neonatal patients. PAWP monitoring is only intended for 
adult and pediatric patients. 

15.2 IBP Safety Information

WARNING

• Use only pressure transducers specified in this manual. Never reuse disposable pressure 
transducers. See chapter 25 Accessories for specified pressure transducers.

• Make sure that the applied parts never contact other conductive parts.

• To reduce the hazard of burns during high-frequency surgical procedures, ensure that the monitor’s 
cables and transducers never come into contact with the high-frequency surgical units.

• When using accessories, their operating temperature should be taken into consideration. For more 
information, see instructions for use of accessories.

• All invasive procedures involve risks to the patient. Use aseptic technique. Follow catheter 
manufacturer's instructions. 

• Mechanical shock to the invasive blood pressure transducer may cause severe shifts in zero balance 
and calibration, and cause erroneous readings. 

• The neutral electrode of the electro-surgery unit (ESU) shall properly contact the patient. Otherwise, 
burns may result.

CAUTION

• Measuring IBP on patients connected to an Intra Aortic Balloon Pump (IABP) machine may result in 
the IBP measurement, including PR, to be inaccurate or fail.

(1) Zero IBP hard key (2) IBP cable connector (3) IBP dialog hard key

T1

T2

ECG NIBP

IBP2

SpO2

MP1Platinum

(2) (2)

(2)

(1) (1)(3)
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15.3 Preparing for IBP Monitoring

15.3.1 IBP Equipment to Patient Connection

15.3.2 Measuring an Invasive Blood Pressure
To monitor IBP, follow this procedure:

1. Connect one end of the IBP cable to the IBP cable connector, and the other end to the IBP transducer.

2. Flush the IBP transducer system to exhaust all air from the tubing according to the manufacturer’s 
instructions. Ensure that the system is free of air bubbles.

3. Connect the IBP transducer to the patient, making sure that the transducer is at the same horizontal level as 
the heart.

4. Select the proper pressure label for currently measured pressure. For more information, see 
15.6.2 Changing the Pressure Label.

5. Zero the IBP transducer. For more information, see.15.3.3 Zeroing the IBP transducer. After a successful 
zeroing, turn off the three-way valve to the air and turn on the three-way valve to the patient.

CAUTION

• Make sure that all the transducers are zeroed correctly before making IBP measurements.

• Make sure that all air bubbles have been flushed from the IBP transducer system before making IBP 
measurements. 

• If measuring intracranial pressure (ICP) with a sitting patient, level the transducer with the top of the 
patient’s ear. Incorrect leveling may give incorrect values (not applicable if measuring ICP with the 
Codman ICP transducer).

(1) Pressure bag (2) IBP connector

(3) IBP cable (4) IBP transducer

(5) Three-way valve

(1)

(2)

(3)

(4)

(5)

(5)
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15.3.3 Zeroing the IBP transducer
To avoid inaccurate pressure readings, the monitor requires a valid zero. Zero the transducer in accordance with 
your hospital policy. The IBP transducer should be zeroed in the following conditions:

■ The IBP transducer, adapter cable or module is reconnected.

■ The monitor restarts.

■ The readings are in doubt.

■ The monitor displays the prompt message Zero Required.

To zero the transducer, follow this procedure:

1. Connect the IBP transducer, the IBP adapter cable and the module.

2. Turn off the three-way valve (the one near the transducer) to the patient, in order to vent the transducer to 
the atmospheric pressure.

3. Zero the transducer by one of the following methods:

◆ Press the Zero hard key on the module. In the Zero IBP dialog, select to zero an IBP, or select to zero 
all IBP.

◆ Select the numeric area (such as the Art numeric area), and then select Zero button.

◆ Select the Zero IBP quick key. In the Zero IBP dialog, select to zero an IBP, or select to zero all IBP.

4. After the zero calibration is completed, close the three-way valve to the air and open the three-way valve to 
the patient.

Zero calibration may fail in case of pressure fluctuation or pressure exceeding the calibration range. If zero 
calibration fails, follow this procedure:

1. Check that the three-way valve (the one near the transducer) is open to the air. 

2. Perform zero calibration again. Do not sway the IBP transducer and tubing during zero calibration.

15.4 Measuring ICP Using the Codman ICP Transducer

15.4.1 Zeroing the Codman ICP transducer
The Codman ICP transducer (Model: 82-6653) must be zeroed before use. To zero the ICP transducer, follow this 
procedure:

1. Before unpacking the ICP transducer, check that the monitor supports the Codman ICP transducer. 

a Select the Main Menu quick key → from the Parameters column select Setup → select ICP (If the 
ICP button is not in the Parameter Setup dialog, select any IBP button to enter corresponding IBP 
dialog, and then change the IBP label to ICP) → select the Zero tab.

b Check that the following icon is displayed in the Zero page. The monitor supports the Codman ICP 
transducer if the following icon is displayed in the Zero page. 

2. Connect the ICP transducer, the ICP adapter cable and the module.

3. Follow the manufacturer’s instructions to prepare the ICP transducer.

4. Zero the ICP transducer: when the message Zero Reference is displayed in the ICP numeric area, select the 
ICP waveform area or numeric area to enter the ICP dialog → select the Zero tab → select the Zero button.

5. Record the zero reference value on the blank area of the ICP transducer for reference.

If the ICP transducer zero calibration failed or the zero reference value is in doubt, perform the zero calibration 
again.
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15.4.2 Measuring ICP
To perform the ICP measurement, follow this procedure:

1. Zero the Codman ICP transducer. For more information, see section 15.4.1 Zeroing the Codman ICP 
transducer.

2. Disconnect the ICP transducer and ICP adapter cable. Follow the manufacturer’s instructions to apply the 
ICP transducer to the patient.

3. Reconnect the ICP transducer and ICP adapter cable. 

4. Check that the zero reference value displayed on the monitor is consistent with that recorded on the ICP 
transducer. 

◆ Consistent: select Accept.

◆ Inconsistent: input the zero reference value recorded on the ICP transducer, and select Accept.

If the patient being monitored for ICP must be transported, check that the target monitor supports the Codman 
ICP transducer. For more information, see 15.4.1 Zeroing the Codman ICP transducer. If the target monitor does 
not support the Codman ICP transducer, do not use it for ICP monitoring.

If the target monitor supports the Codman ICP transducer, follow this procedure to transport the patient:

1. Disconnect the ICP adapter cable from the measurement module, or remove the module from the monitor.

2. Connect the ICP adapter cable, measurement module, and the transport monitor, or insert the 
measurement module into the transport monitor.

3. Check that the zero reference value displayed on the monitor is consistent with that recorded on the ICP 
transducer. 

◆ Consistent: select Accept.

◆ Inconsistent: input the zero reference value recorded on the ICP transducer, and select Accept.

CAUTION

• If monitors of different brands are used to zero the Codman ICP transducer, the zero reference 
values can be different. Use a Mindray monitor to Zero the Codman ICP transducer if you will take 
ICP measurement using a Mindray monitor. Otherwise the ICP measurement could be inaccurate.

15.5 IBP Display
The IBP measurement is displayed on the monitor as a waveform and numeric pressures. For arterial pressure, 
the IBP numeric area displays systolic pressure, diastolic pressure and mean pressure. For venous pressure, the 
IBP numeric area displays only the mean pressure. The figure below shows the waveform and numerics for the 
Art pressure. 

For some pressures, the parameter window may show the mean pressure only. For different pressures, their 
defaults unit may be different. If the Art and ICP pressures are measured simultaneously, the ICP parameter area 
will display numeric CPP, which is obtained by subtracting ICP from the Art mean.

(1) Pressure label (2) Waveform

(3) Pressure Unit (4) Systolic pressure

(5) Diastolic pressure (6) Mean pressure

(7) PPV measurement

(7)                      (6)

  (1)                          (2)                                                                                                            (3)               (4)              (5)     
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15.5.1 Overlapping IBP Waveforms
The IBP waveforms can be displayed together. To combine IBP waveforms, follow this procedure:

1. Access Tile Layout by either of the following ways:

◆ Select the Screen Setup quick key → select the Tile Layout tab.

◆ Select Main Menu quick key → from the Display column select Tile Layout.

2. Select the waveform area where you want to display the overlapped IBP waveforms, and then select the IBP 
waves to be overlapped on the left side of the same line.

3. Repeat step 2 in another waveform area if needed.

4. Select  to save the setting and exit the screen. The main screen will display the overlapped IBP waves.

Selecting the overlapped IBP waveforms on the main screen opens the Overlapping Waveform Setup dialog, 
where you can make the following settings:

■ Scale

◆ Set Left Scale for the arterial pressure.

◆ Set Right Scale for the venous pressure.

◆ Set CVP Scale individually if the CVP waveform is combined and CVP unit is different from IBP unit.

◆ Set ICP Scale individually if the ICP waveform is combined and ICP unit is different from IBP unit.

◆ Set PA Scale individually if the PA waveform is combined.

■ Switch on or off Gridlines to show or hide gridlines in the overlapped waveform area.

■ Set Speed for the overlapped waveforms.

NOTE

• The unit of CVP scale is consistent with the CVP parameter unit.

15.6 Changing IBP Settings

15.6.1 Changing the IBP Alarm Settings
To change the IBP alarm settings, follow this procedure:

1. Select the IBP numeric area or waveform area to enter the corresponding pressure dialog.

2. Select the Alarm tab.

3. Enter the password if required. For more information, refer to 33.14.3 Selecting Password for User 
Authentication.

4. Set the alarm properties of pressure.

15.6.2 Changing the Pressure Label
The pressure label is a unique identifier for each type of pressure. Therefore, it is recommended to select the 
proper pressure label for the source of the pressure being monitored. 
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To select the pressure label, follow this procedure:

1. Select the IBP numeric area or waveform area to enter the corresponding pressure dialog.

2. Select the Setup tab.

3. Set IBP1 Label or IBP2 Label.

NOTE
• The same label cannot be selected for different pressures. When two pressures are detected having 

the same label, the monitor automatically changes one pressure label to a currently unused one.

15.6.3 Setting the Pressure Type for Display
For the non-specific pressure (P1, P2, P3 or P4), the displayed pressure type is configurable. To set the displayed 
pressure type, follow this procedure:

1. Select the numeric area or waveform area of the non-specific pressure to enter the corresponding pressure 
dialog.

2. Select the Setup tab.

3. Set Measure:

◆ If this non-specific pressure is arterial pressure, set the Measure to All. In this case, its corresponding 
numeric area displays systolic pressure, diastolic pressure and mean pressure.

◆ If this non-specific pressure is venous pressure, set the Measure to Mean Only. In this case, its 
corresponding numeric area displays only the mean pressure.

15.6.4 Changing the Sensitivity
The IBP value displayed on the monitor screen is the average of data collected within a specific time. The shorter 
the averaging time is, the quicker the monitor responds to changes in the patient’s blood pressure, and the 
higher the sensitivity. Contrarily, the longer the averaging time is, the slower the monitor responds to changes in 
the patient’s blood pressure, the lower the sensitivity, but the measurement accuracy will be improved. For 
critically ill patients, selecting higher sensitivity will help with understanding the patient’s state. 

To set the sensitivity, follow this procedure:

1. Select the IBP numeric area or waveform area to enter the corresponding pressure dialog.

2. Select the Setup tab.

3. Set Sensitivity.

15.6.5 Setting the IBP Waveform
To set the IBP waveform, follow this procedure:

1. Select the IBP numeric area or waveform area to enter the corresponding pressure dialog.

2. Select the Setup tab.

3. Set the following properties of the IBP waveform:

Label Description Label Description

Art Arterial blood pressure PA Pulmonary artery pressure

Ao Aortic pressure UAP Umbilical arterial pressure

BAP Brachial arterial pressure FAP Femoral arterial pressure 

CVP Central venous pressure LAP Left atrial pressure

RAP Right atrial pressure ICP Intracranial pressure

UVP Umbilical venous pressure LV Left ventricular pressure

P1 to P4 Non-specific pressure label
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◆ Speed

◆ Scale: if Auto is selected, the size of the pressure’s waveform will be adjusted automatically.

15.6.6 Setting the Display Format of Artery Pressure
To set the display format of the artery pressure, follow this procedure:

1. Select the numeric area or waveform area of any arterial pressure to enter the corresponding menu.

2. Select the Setup tab.

3. Set Display Format.

15.6.7 Showing/Hiding the Alarm Limits of Artery Pressure
To set whether to display the alarm limits of the arterial pressure, follow this procedure:

1. Select the numeric area or waveform area of any arterial pressure to enter the corresponding menu.

2. Select the Setup tab.

3. Switch on or off Display Alarm Limits.

15.6.8 Setting the Use PA-D as PAWP Switch
The PA-D value can be configured to replace the PAWP value for hemodynamic calculation. To do so, follow this 
procedure:

1. Select the PA numeric area or waveform area to enter the PA dialog.

2. Select the Setup tab.

3. Switch on or off Use PA-D as PAWP.

For more information on hemodynamic calculation, see 28.4 Hemodynamic Calculations.

15.6.9 Enabling PPV Measurement
PPV indicates pulse pressure variation. When measuring the arterial pressure (except PA), the PPV measurement 
is available. To enable the PPV measurement, follow this procedure:

1. Select the IBP numeric area or waveform area to enter the corresponding pressure dialog.

2. Select the PPV Setup tab.

3. Switch on PPV Measure.

You can select PPV source after enabling the PPV measurement. 

WARNING

• This monitor can calculate PPV from beat-to-beat values of any arterial pulsatile pressure. The 
circumstances under which the calculation of a PPV value is clinically meaningful, appropriate and 
reliable must be determined by a physician.

• The clinical value of the derived PPV information must be determined by a physician. According to 
recent scientific literature, the clinical relevance of PPV information is restricted to sedated patients 
receiving controlled mechanical ventilation and mainly free from cardiac arrhythmia.

• PPV calculation may lead to inaccurate values in the following situations:

◆ at respiration rates below 8 rpm

◆ during ventilation with tidal volumes lower than 8 ml/kg

◆ for patients with acute right ventricular dysfunction (cor pulmonale).

• The PPV measurement has been validated only for adult patients.
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15.7 PAWP
Pulmonary Artery Wedge Pressure (PAWP) values, used to assess cardiac function, are affected by fluid status, 
myocardial contractility, and valve and pulmonary circulation integrity.

Obtain the measurement by introducing a balloon-tipped pulmonary artery flotation catheter into the 
pulmonary artery. When the catheter is in one of the smaller pulmonary arteries, the inflated balloon occludes 
the artery allowing the monitor to record changes in the intrathoracic pressures that occur throughout the 
respiration cycle.

The pulmonary wedge pressure is the left ventricular end diastolic pressure when the airway pressure and valve 
function are normal. The most accurate PAWP values are obtained at the end of the respiration cycle when the 
intrathoracic pressure is fairly constant and the artifact caused by respiration is minimal.

WARNING

• PAWP monitoring is not intended for neonatal patients.

15.7.1 PAWP Equipment to Patient Connection

15.7.2 Preparing to Measure PAWP
To prepare to monitor PAWP, follow this procedure:

(1) IBP connector (2) Flush bag

(3) IBP transducer (4) Three-way valve

(5) PA distal port (6) Balloon inflation syringe

(7) Thermodilution catheter (8) Balloon

  (1)
(2)

(3)

(4)

(5)

(6)

(7)

(8)
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1. Connect one end of the IBP cable to the IBP cable connector, and the other end to the IBP transducer. For 
more information, see 15.3.2 Measuring an Invasive Blood Pressure.

2. Follow the manufacturer’s instructions to connect the PA port of the thermodilution catheter and the 
patient end of the IBP transducer.

3. Zero the IBP transducer. For more information, see 15.3.3 Zeroing the IBP transducer.

4. Set the IBP label to PA since the PAWP is measured on PA. For more information, see 15.6.2 Changing the 
Pressure Label. 

15.7.3 Measuring PAWP
To measure the PAWP, follow this procedure:

1. Select the PA numeric area or waveform area to enter the PA dialog, and then select PAWP. 

2. Wedge the flotation catheter into the pulmonary artery by observing the PA waveform changes on the 
screen, referring to the following figure. 

3. Select Start.

4. Inflate the balloon and pay attention to PA waveform changes on the screen when the prompt message 
Ready For Balloon Deflation appears.
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5. Deflate the balloon when the prompt message Ready For Balloon Deflation appears. If the PA waveform 
is stable, but the monitor is still not showing the prompt message Ready For Balloon Deflation, select 
Freeze to freeze the waveform, and deflate the balloon.

6. Select Accept to save the PAWP value.

7. If you need to start a new measurement, repeat step 3 to step 6.

If the measurement fails or you need to adjust the PAWP value, you can use the following buttons to adjust the 
PAWP waveform and measurement. 

■ Select the up or down arrow button to adjust the PAWP value.

■ Select the left or right arrow button to view the frozen waveforms of 40 seconds.

■ Select Accept to save the PAWP value.

WARNING

• Prolonged inflation can cause pulmonary hemorrhage, infarction or both. Inflate the balloon for the 
minimum time necessary to get an accurate measurement.

• If the PAWP is greater than the PA (systolic), deflate the balloon and report the incident in 
accordance with hospital policy. Because the pulmonary artery could be accidentally ruptured, and 
the PAWP value derived will not reflect the patient’s hemodynamic state, but will merely reflect the 
pressure in the catheter or balloon.

• If the flotation/thermodilution catheter drifts into the wedge position without inflation of the 
balloon, the PA waveform assumes a wedged appearance. Take appropriate action, in accordance 
with standard procedures, to correct the situation.

NOTE
• The PA alarm is turned off automatically when the monitor enters the PAWP screen.

15.7.4 Setting the Waveforms of the PAWP Screen
On the PAWP screen, select Setup to enter the PAWP Setup dialog. In the PAWP Setup dialog, you can make 
the following settings:

■ Select Reference Waveform 1 to set an ECG lead wave as the first reference wave.

■ Select Reference Waveform 2 to set a respiration wave as the second reference wave.

■ Select Speed to set a sweep speed for the displayed waveforms on the PAWP screen.

■ Select Scale to set the  size of the PA waveform on the PAWP screen.

15.7.5 Performing Hemodynamic Calculation
On the PAWP screen, select Hemo Calcs to enter the Calculations dialog. For more information, see 
28.4 Hemodynamic Calculations.

15.8 Connecting a Camino Device
The IBP module can interface with the Camino multi-parameter monitor (Model: MPM-1) to measure intracranial 
pressure (ICP). 

To connect the Camino, follow this procedure: 

1. Plug the IBP module into the module rack.

2. Connect the Camino ICP cable to the IBP module.’

3. Connect the Camino ICP cable to the ICP adapter.

4. Connect the ICP connector to the ICP adapter. 

5. Connect the Camino cable to the Camino monitor. 
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WARNING

• Refer to the Camino Operator’s Manual to adjust settings and connect the monitor with the patient.

• ICP alarm settings on the Mindray patient monitor are independent of the Camino monitor alarm 
settings, and thus may be different. Please pay special attention to the alarms on the Camino 
monitor.

15.9 IBP Troubleshooting
This section lists the problems that might occur. If you encounter the problems when using the equipment or 
accessories, check the table below before requesting service. If the problem persists, contact your service 
personnel.

NOTE

• For the physiological and technical alarm messages, see Appendix D Alarm Messages.

(1) IBP module (2) Camino ICP cable

(3) ICP adapter (4) ICP connector

(5) Camino cable (6) Camino monitor

(1) (2) (3) (4) (5)
(6)

Problem Solution

Cannot see IBP numeric area or waveform 
area on the main screen

1. Check that the IBP is set to display in the Screen Setup dialog. For more 
information, see.3.9.2 Displaying Parameter Numerics and Waveforms.
2. Check that if the IBP parameter switch is enabled. If not, enable the IBP 
measurement. For more information, see 3.9.1 Switching On or Off a 
Parameter.
3. Check the connection of IBP cable, IBP transducer and monitor.
4. Check that the three-way valve is turned to the correct position.
5. Check that the IBP transducer has been zeroed. For more information, see 
15.3.3 Zeroing the IBP transducer.

Cannot see systolic pressure and diastolic 
pressure for P1/P2/P3/P4

Set Measure to All in the P1/P2/P3/P4 setup page. For more information, see 
15.6.3 Setting the Pressure Type for Display.

IBP readings seem unstable 1. Make sure there are no air bubbles in the transducer systems.
2. Check that the transducer is properly fixed.
3. Zero the transducer again.
4. Replace the transducer.
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Zeroing of IBP channel(s) fails. 1. Ensure that the channels are open to air.
2. Perform zero calibration again. Do not sway the IBP transducer and 

tubing during zero calibration. For more information, see 15.3.3 Zeroing 
the IBP transducer.

3. If zero calibration still fails, replace the transducer.

Problem Solution
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16 Monitoring Cardiac Output (C.O.)

16.1 C.O. Introduction
The cardiac output (C.O.) measurement invasively measures cardiac output and other hemodynamic parameters 
using the right heart (atria) thermodilution method. A cold solution of known volume and temperature is 
injected into the right atrium through the proximal port of a pulmonary artery (PA) catheter. The cold solution 
mixes with the blood in the right ventricle and the change in blood temperature is measured with a thermistor 
at the distal end of the catheter in the pulmonary artery. The temperature change is displayed as a curve on the 
C.O. split screen, and the monitor calculates the C.O. value from this curve. The C.O. value is inversely 
proportional to the area under the curve. As cardiac output varies continuously, a series of measurements must 
be carried out to achieve a reliable C.O. average value. Always use the average of multiple thermodilution 
measurements for therapy decisions. The monitor is capable of storing 6 measurements.

C.O. monitoring is intended for adult patients only.

16.2 C.O. Safety Information

WARNING

• The C.O. measurement results may be erroneous during electrosurgery.

• All invasive procedures involve risks to the patient. Use aseptic technique and follow catheter 
manufacturer's instructions.

• Use only accessories specified in this manual. Make sure that the accessories never come into 
contact with conductive parts.

• C.O. monitoring is not intended for pediatric and neonatal patients.

(1) C.O. dialog hard key (2) C.O. measure dialog hard key (3) C.O. cable connector

(1) (2)

(3)
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16.3 C.O. Measurement Limitations
The following factors may influence the accuracy of C.O. measurement:

■ temperature of injectate solution

■ volume of injectate solution

■ baseline of patient’s blood temperature

■ patient’s inspiratory/expiratory cycle

■ placement of catheter with relation to proximity of lung field

■ the catheter itself

■ patient’s heart rate and hemodynamic status

■ any solution infused with intravenous injection during the C.O. measurement

To obtain accurate C.O. measurements, follow these recommendations:

■ Temperature of injectate solution must be at least 10 ºC cooler than that of the patient’s blood.

■ Inject solution at end of expiration.

■ Inject solution rapidly and smoothly.

■ Finish injection within four to five seconds.

16.4 C.O. Display
The C.O. display shows only C.O., C.I. (cardiac index), and TB (blood temperature) in the C.O. numeric area.

NOTE
• The C.O. value is invalid if it is displayed in outline font.

(1) C.O. label (2) Primary parameter unit

(3) Labels and values for primary parameters (4) Labels and values for secondary parameters

(1)

(2)

(3) (4)
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16.5 C.O. Equipment to Patient Connection

16.6 Performing C.O. Measurement

16.6.1 Preparing for C.O. Measurement
1. Connect the C.O. cable to the C.O. module and thermistor connector, making sure the C.O. numeric area is 

displayed on the monitor’s main screen.

2. Follow the hospital’s policy and procedures to prepare the patient for the C.O. measurement.

3. Follow the manufacturer’s instructions to set up the catheter and other accessories.

4. Check that all the accessories are properly connected. 

• For an in-line probe setup, make sure the in-line sensor is securely connected to the tubing. For the 
bath probe setup, make sure the bath probe is correctly sensing the injectate temperature.

16.6.2 Setting C.O. Measurement
Before performing the C.O. measurement, follow this procedure:

1. Select the C.O. numeric area to enter the C.O. Measure dialog.

2. Select the Setup.

3. Perform the following check or setup:

◆ Check if the height and weight are appropriate for your patient. Change if necessary. The patient's 
height and weight values are required for determining cardiac index (C.I.).

◆ Check that the correct computation constant is entered. The computation constant has a close 
relationship with the entered injectate volume, injectate probe type (in-line probe or bath probe) and 
temperature. See the Instructions for Use of the pulmonary artery catheter to determine correctness. 
To change the computation constant, select Comp Const and then input the correct value. When a 

(1) C.O. module (2) 12-pin C.O. cable (Model: CO7702) (3) TI cable connector

(4) In-line probe (5) Injectate solution (6) Injectate syringe

(7) Three-way valve (8) Proximal injectate port (9) Balloon inflation valve

(10) Thermistor connector (11) PA distal port (12) Thermodilution catheter

(13) Thermistor
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new catheter is used, the computation constant should be adjusted in accordance with the 
manufacturer’s instructions for use.

◆ Switch on or off Auto TI. If Auto TI is switched on, the system automatically detects the injectate 
temperature, and TI setting is disabled. If Auto TI is switched off, you need to input the injectate 
temperature at TI.

◆ Switch on or off Auto Start. If Auto Start is switched on, the monitor automatically takes the C.O. 
measurement after establishing a baseline of blood temperature. If Auto Start is switched off, you 
need to click the Start button in the C.O. Measure dialog for a new measurement.

16.6.3 Performing C.O. Measurement
To perform the C.O. measurement, follow this procedure:

1. Select the C.O. numeric area to enter the C.O. Measure dialog.

2. Proceed as follows to perform the C.O. measure:

◆ If Auto Start is switched off, select the Start button, and then inject the solution quickly when you 
see the message Please Wait. As shown in the figure above, during the measurement, the currently 
measured thermodilution curve is displayed. At the end of the measurement, the thermodilution 
curve is transferred to one of the 6 measurement areas and the monitor prompts you to wait for a 
certain period of time before starting a new measurement.

◆ If Auto Start is switched on, inject the solution quickly when you see the message Ready For New 
Set Of Measurement. The monitor consecutively takes C.O. measurements automatically without the 
need for pressing the Start button between two measurements. A new thermodilution measurement 
is possible as soon as the message Inject Now! is displayed on the screen. The monitor automatically 
detects further thermodilution measurements.

3. Acquire the average value of C.O. and C.I. A maximum of 6 measurements can be stored. If you perform 
more than six measurements without rejecting any, the oldest will automatically be deleted when a 
seventh curve is stored. Select from the 6 measurement curves and the system will automatically calculate 
and display the averaged C.O. and C.I. values. Then select the Accept Average button to accept and store 
the averaged values.

When injecting, the stopcock to the thermodilution catheter is open and the stopcock to the injectate solution is 
closed. After completing the measurement, turn off the stopcock to the thermodilution catheter and turn on the 
stopcock to the injectate solution, and then draw the injectate solution into the injectate syringe.

The button area also provides you with the following functions: 

(1) Average values (2) Historical measurement dialogs

(3) Current measurement values (4) Current C.O. curve

(5) Prompt message area (6) Buttons

(1)

(2)

(3)

(6)

(4)
(5)
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■ Select Stop to stop the current measurement. Select Setup to enter the C.O. dialog.

■ Select Hemo Calcs to enter the Calculations dialog.

NOTE

• Starting a measurement without blood temperature being stable may cause measurement failure.

• The TB alarms are inactivated during a C.O. measurement, and will be reactivated automatically 
after the completion of C.O. measurement.

• Please see the Instructions for Use of thermodilution catheter to determine the Comp Const and the 
volume of injectate solution.

16.7 Changing C.O. Settings

16.7.1 Setting C.O. Alarm Properties
To set the C.O. alarm properties, follow this procedure:

1. Select the C.O. numeric area to enter the C.O. Measure dialog.

2. Select Setup to enter the C.O. dialog.

3. Select the Alarm tab.

4. Enter the password if required. For more information, refer to 33.14.3Selecting Password for User 
Authentication.

5. Set the alarm properties as desired.

16.8 C.O. Troubleshooting
This section lists the problems that might occur. If you encounter the problems when using the equipment or 
accessories, the table below may help with troubleshooting before requesting a service personnel visit. If the 
problem persists, contact your service personnel.

NOTE

• For the physiological and technical alarm messages, see Appendix DAlarm Messages.

Problem Solution

Do not see C.O. numeric area on the main 
screen

1. Check that the C.O. is set to display in the Screen Setup dialog. For 
more information, see 3.9.2Displaying Parameter Numerics and 
Waveforms.
2. Check that if the C.O. parameter switch is enabled. If not, enable the 
C.O. measurement. For more information, see 3.9.1Switching On or Off a 
Parameter.
3.Check that the patient type is adult.
4. Check the connection of C.O. cable, thermodilution catheter and TI 
sensor.

C.O. value is inaccurate 1. Check that the thermodilution catheter is positioned properly.
2. Check that the computational constant is proper for current injectate 
temperature, injectate volume and injectate probe type.
3. Inject solution rapidly and smoothly.
4. Finish injection within four to five seconds.
5. Inject more volume, or inject colder solution.
6. Check that the height and weight of patient is properly configured.
7. If Auto TI is switched off, check that the entered temperature is 
correct.
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C.O. measurement fails 1. Inject more volume, or inject colder solution. Make sure that the 
injectate temperature is at least 10°C colder than the patient blood 
temperature.
2. Finish injection within four to five seconds.
3. Check the connection of C.O. cable, thermodilution catheter and TI 
sensor.

Problem Solution
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17 Monitoring Central Venous Oxygen Saturation 

(ScvO2)

17.1 ScvO2 Introduction

Central venous oxygen saturation (ScvO2) is measured across spectrophotometry. Spectrophotometry involves 
the use of light emitting diodes (LED) that produce light of various wavelengths in red and infrared spectra. The 
light is transmitted to the blood through a fiberoptic in the probe, reflected off the red blood cells and 
transmitted back through a separate fiberoptic to an optical module. The central venous oxygen saturation is 
calculated through the analysis of the reflected spectra.

ScvO2 monitoring is intended for adult and pediatric patients.

17.2 ScvO2 Safety Information

WARNING

• ScvO2 monitoring is not intended for neonatal patients. 

17.3 ScvO2 Display

(1) Calibration hard key (2) CeVOX cable connector

(1)

(2)

(1) ScvO2 value (2) SQI bar graph

(2)

(1)
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17.4 Accessing the On-screen ScvO2 Guide

The monitor provides the on-screen ScvO2 guide to help you understand ScvO2 monitoring principles, 
functions, and operating procedure. To access the on-screen ScvO2 guide, follow this procedure:

1. Select the ScvO2 numeric area to enter the ScvO2 dialog.

2. Select the Introduction tab.

3. Select the desired tab of Summary, Target Patients, Points To Note,  or Operation Guides.

17.5 ScvO2 Equipment to Patient Connection

17.6 Measuring ScvO2 

To perform the ScvO2 measurements, follow this procedure:

1. Apply the central venous catheter. 

2. Place one end of the fiberoptic probe into the central venous catheter through the distal lumina, and 
connect the other end to the CeVOX optical module. 

3. Plug the CeVOX cable into the ScvO2 module.

4. If you see the message Calibration Required, calibrate the ScvO2 before performing the measurements. 
For more information, see 17.7 ScvO2 Calibration.

5. Check the reading in the ScvO2 numeric area.

WARNING

• To avoid application failure, ensure that the proper fiberoptic probe is selected. 

• The monitor may only be regarded as a device providing early warning. If there is an indication of a 
trend towards de-oxygenation of the patient, blood samples must be taken and tested on a 
laboratory oximeter in order to arrive at a decision concerning the condition of the patient.

• Incorrect placement of the fiberoptic probe can lead to vessel perforation. Therefore, check the 
correct position of the probe as indicated in the probe’s instructions for use.

(1) ScvO2 module (2) CeVOX optical module

(3) CeVOX fiberoptic probe (4) Central venous catheter
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17.7 ScvO2 Calibration

Regular in vivo calibration is required using blood gas analysis of a central venous blood sample to ensure 
accurate measurement of continuous ScvO2. For optimal accuracy, it is recommended that an in vivo calibration 
be performed at least every 24 hours or if hemoglobin is changing (for more details, check the notes below). 

To perform calibration, follow this procedure:

1. Check the central venous catheter and CeVOX probe for proper placement.

2. Check the quality of the signal. The Signal Quality Indicator (SQI) is used for assessing the quality of 
fiberoptical signals during probe placement, calibration and measurement. The signal quality is indicated 
by bars of different height levels. Generally, the higher the level, the better the signal. 

3. Withdraw a sufficient amount of central venous blood from the side port of the CeVOX probe to avoid 
intermixture of infusion/injection with the withdrawn blood.

4. Slowly withdraw 2ml blood from the side port of the CeVOX probe. Do not pull too strongly in order to 
avoid a hemolysis.

5. Immediately confirm by selecting Sample Drawn in the Calibration page of the ScvO2 dialog.

6. If necessary put blood sample on ice and perform an analysis by a blood gas analysis device or a laboratory 
oximeter.

7. Input lab values for Hb, Hct, and ScvO2 and select Calibrate to confirm.

NOTE

• The SQI signal can be affected by the presence of electrosurgical units. Keep electrocautery 
equipment and cables away from the monitor and use separate power socket if possible.

• To achieve optimal accuracy, it is recommended that the entered hemoglobin and hematocrit values 
are updated when there is a change of 6% or more in hematocrit, or of 1.8 g/dl (1.1 mmol/l) or more 
in hemoglobin. A change in hemoglobin may also affect SQI. 

• Dye (e.g. Indocyanine Green) or other substances, containing dyes which usually modify the light 
absorption capacities, can lead to faulty measurement values of the oxygen saturation.

17.8 Accessing the HemoSight Dialog
To accessing the HemoSight dialog, follow this procedure:

1. Select the ScvO2 numeric area to enter the ScvO2 dialog.

2. Select the HemoSight button. For information on HemoSight, see 27.8 HemoSightTM.

17.9 Changing ScvO2 Settings

17.9.1 Changing ScvO2 Alarm Settings

To change the ScvO2 alarm settings, follow this procedure:

1. Select the ScvO2 numeric area to enter the ScvO2 dialog.

2. Select the Alarm tab.

3. Enter the password if required. For more information, refer to 33.14.3 Selecting Password for User 
Authentication.

4. Set the alarm properties as desired.

17.9.2 Setting Hb or Hct
To set the Hb or Hct, follow this procedure:

1. Select the ScvO2 numeric area to enter the ScvO2 dialog.

2. Select the Calibration tab.

3. Set Hb or Hct.
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17.9.3 Inputting the SaO2 Value

The monitor computes the DO2 and VO2 using the SaO2 value. To input the SaO2 value, follow this procedure:

1. Select the ScvO2 numeric area to enter the ScvO2 dialog.

2. Select the Setup tab.

3. Input the SaO2 value.
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18 Monitoring CCO/SvO2

18.1 CCO/SvO2 Introduction
The Edwards Lifesciences Vigilance II monitor, Vigileo monitor, EV1000 monitor, and HemoSphere monitor, 
measure continuous cardiac output (CCO), mixed venous oxygen saturation (SvO2), central venous oxygen 
saturation (ScvO2) etc. They also calculate hemodynamic and oxygenation parameters. The N Series monitors 
can be connected to the Vigilance II/Vigileo/EV1000/HemoSphere monitors and can display, store, and review 
the measured and calculated parameter values from these monitors. The N Series monitors can also give alarms 
of these measured parameters; however, you must set alarm on/off, alarm limits, alarm priority, and alarm record 
separately on the N Series monitors. The alarm is On by default.

The CCO/SvO2 module is only intended for adult and pediatric patients.

 

(1) CCO/SvO2 dialog hard key

(2) Calibration key (for Vigilance II and Vigileo monitor)

(3) Module status indicator (4) CCO/SvO2 cable connector

(1) (2)

(4)

(3)
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18.2 CCO/SvO2 Safety Information

WARNING

• Because the alarm limits of the relevant measured parameters can be set on the N Series monitors, 
the alarms of these parameters may be different from those on the Vigilance II/Vigileo/EV1000/
HemoSphere monitors. Please pay special attention to the alarms on the Vigilance II/Vigileo/
EV1000/HemoSphere monitors.

• The CCO/SvO2 monitoring is not intended for neonatal patients.

CAUTION

• Observe the operator’s manuals of Vigilance II/Vigileo/EV1000/HemoSphere monitor to configure 
settings and to connect the monitor to the patient.

• The N Series monitors give disconnection alarms when being disconnected from the Vigilance II/
Vigileo/EV1000/HemoSphere monitors. These alarms may be delayed.

NOTE

• The Vigilance II monitor, Vigileo monitor, EV1000 monitor, and HemoSphere monitor are 
manufactured and trademarked by Edwards Lifesciences, and they provide the technology for 
measuring and calculating the relevant parameters. Mindray only provides a connection and 
interface to display the parameters from the  Vigilance II/Vigileo/EV1000/HemoSphere monitor on 
the N Series monitors. If you have any doubts about the operation and maintenance of the Vigilance 
II/Vigileo/EV1000/HemoSphere monitors, read the operator’s manuals of the corresponding 
monitor, or contact Edwards Lifesciences (www.edwards.com) directly.

18.3 Connecting the Device
The CCO/SvO2 cable is used to connect this monitor to the Vigilance II/Vigileo/EV1000/HemoSphere monitor.

18.3.1 CCO/SvO2 Cable
The following figure shows the CCO/SvO2 cable.

18.3.2 Connecting to the Vigilance II Monitor
The following figure shows the rear housing connectors of the Vigilance II monitor.
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To connect the Vigilance II monitor, follow this procedure:

1. Insert the end of the CCO/SvO2 cable marked CN1 to the Mindray CCO/SvO2 module.

2. Insert the ECG signal end of the CCO/SvO2 cable into the ECG signal input port marked  on the rear 
housing of the Vigilance II monitor.

3. Insert the MAP signal end of the CCO/SvO2 cable into the analog signal input port 1 marked , the CVP 
signal end into port 2 marked , and SpO2 signal end into port 3 marked  respectively on the rear 
housing of the Vigilance II monitor.

4. Insert UART end of the CCO/SvO2 cable into either of the serial ports (marked  or ) on the rear 
housing of the Vigilance II monitor.

5. Enter the Serial Port Setup menu of the Vigilance II monitor, and make the following settings:

◆ Device: IFMout

◆ Baud Rate: 19200

◆ Parity: None

◆ Stop Bits: 1

◆ Data Bits: 8

◆ Flow Control: 2 seconds

6. Enter the Analog Input Setup menu of the Vigilance II monitor, and set port 1, port 2 and port 3 as follows:

For more information, see the Vigilance II operator’s manual for the operation of the monitor.

(1) Serial ports (2) ECG signal input port (3) Analog signal input ports

Setting Port 1 Port 2 Port 3

Parameter MAP CVP SaO2

Voltage Range 0-5 V 0-5 V 0-10 V

Full Scale Range 500 mmHg (66.7 kPa) 100 mmHg (13.3 kPa) 100%

Simulated High Value 500 mmHg (66.7 kPa) 100 mmHg (13.3 kPa) 100%

Simulated Low Value 0 mmHg (0.0 kPa) 0 mmHg (0.0 kPa) 0%

(1)                                                            (2)                       (3)
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WARNING

• Calibrate the Vigilance II monitor before monitoring. For more information, see the Vigilance II 
operator’s manual for the calibration instructions. 

18.3.3 Connecting to the Vigileo Monitor

The following figure shows the rear housing connectors of the Vigileo monitor.
 

To connect the Vigileo monitor, follow this procedure:

1. Insert the end of the CCO/SvO2 cable marked CN1 to the Mindray CCO/SvO2 module.

2. Insert the CVP signal end of the CCO/SvO2 cable into the analog signal input port(2) on the rear housing of 
the Vigileo monitor.

3. Insert UART end of the CCO/SvO2 cable into the serial port on the rear housing(4) of the Vigileo monitor.

4. Enter the Serial Port Setup menu of the Vigileo monitor, and make the following settings:

◆ Device: IFMout

◆ Baud Rate: 19200

◆ Parity: None

◆ Stop Bits: 1

◆ Data Bits: 8

◆ Flow Control: 2 seconds

5. Enter the Analog Input Port Setup menu of the Vigileo monitor, and set the CVP as follows:

◆ Parameter: CVP

◆ Voltage Range: 0-5 v

◆ Full Scale Range: 100 mmHg (13.3 kPa)

◆ Simulated High Value:100 mmHg (13.3 kPa)

◆ Simulated Low Value: 0 mmHg (0.0 kPa) 

For more information, see the Vigileo operator’s manual for the operation of the monitor.

WARNING

• Calibrate the Vigileo monitor before monitoring. See the Vigileo operator’s manual for the 
calibration instructions. 

(1) Patient Optical Module (OM) (2) Analog Input

(3) Analog Input (4) Serial Port

(1)

(2)

(4)

(3)
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18.3.4 Connecting the EV1000 Monitor
The following figure shows the rear housing of the EV1000 monitor.

To connect the EV1000 monitor, follow this procedure:

1. Insert the end of the CCO/SvO2 cable marked CN1 to the Mindray CCO/SvO2 module.

2. Insert UART into the serial port(1) on the rear housing of the EV1000 monitor.

3. Enter the Serial Port Setup menu of the EV1000 monitor, and make the following settings:

◆ Device: IFMout

◆ Baud Rate: 19200

◆ Parity: None

◆ Stop Bits: 1

◆ Data Bits: 8

◆ Flow Control: 2 seconds

For more information, see the EV1000 operator’s manual for the operation of the monitor.

WARNING

• Calibrate the EV1000 monitor before monitoring. Refer to the EV1000 Operator’s Manual for the 
calibration instructions. 

18.3.5 Connecting the HemoSphere Monitor
The following figure shows the rear housing of the HemoSphere monitor.

(1) serial port

LAN1 LAN2
-          +

DC24V

(1)

(1) COM1 Serial Port (2) Analog Input

(3) Analog Input (4) ECG Input

(1)

(2)

(3)

(4)
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To connect the HemoSphere monitor, follow this procedure:

1. Connect CN1 with the CCO/SvO2 cable connector of the CCO/SvO2 module.

2. Insert the UART signal end of the CCO/SvO2 cable into the COM1 serial port on the rear housing of the 
HemoSphere monitor.

3. Insert the CVP and MAP signal ends of the CCO/SvO2 cable into the Analog Inputs on the rear housing of 
the HemoSphere monitor.

4. Insert ECG signal end of the CCO/SvO2 cable into the ECG Input on the rear housing of the HemoSphere 
monitor.

5. Enter the Serial Port Setup menu of the HemoSphere monitor, and make the following settings:

◆ Device: IFMout

◆ Baud Rate: 19200

◆ Parity: None

◆ Stop Bits: 1

◆ Data Bits: 8

◆ Flow Control: 2 seconds

6. Enter the Analog Input Setup menu of the HemoSphere monitor, and set as follows:

For more information, see the HemoSphere operator’s manual for the operation of the monitor.

WARNING

• Calibrate the HemoSphere monitor before monitoring. Refer to the HemoSphere Operator’s Manual 
for the calibration instructions. 

18.4 Accessing the HemoSight dialog
To access the HemoSight dialog, follow this procedure:

1. Select the CCO numeric area to enter the CCO dialog.

2. Select the HemoSight button. For more information, see 27.8 HemoSightTM.

18.5 Changing CCO Settings

18.5.1 Changing the CCO Alarm Settings
To change the CCO alarm settings, follow this procedure:

1. Select the CCO numeric area to enter the CCO dialog.

2. Select the Alarm tab.

3. Set the alarm properties of CCO and CCI.

18.5.2 Setting Parameters for Display
To set the parameters for display, follow this procedure:

Parameter MAP CVP

Voltage Range 0-5 v 0-5 v

Full Scale Range 500 mmHg (66.7 kPa) 100 mmHg (13.3 kPa)

Simulated High Value 500 mmHg (66.7 kPa) 100 mmHg (13.3 kPa)

Simulated Low Value 0 mmHg (0.0 kPa) 0 mmHg (0.0 kPa)
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1. Select the CCO numeric area to enter the CCO dialog.

2. Select the Select Parameter tab.

3. Select the primary and secondary parameters for display.

18.5.3 Setting the CCO Analog Output Signal
To set the CCO output signal, follow this procedure:

1. Select the CCO numeric area to enter the CCO dialog.

2. Select the Signal Output Setup tab.

3. Set the output signal as follows:

◆ This monitor can output the analog signals of ECG waveform, MAP value, SpO2 value and CVP value to 
the Vigilance II monitor. If a signal has several sources, you can select a source.

◆ This monitor can output the CVP analog signal to the Vigileo monitor. If the CVP signal has several 
sources, you can select a source.

◆ This monitor can output ECG waveform, MAP value, and CVP value to the HemoSphere monitor. If a 
signal has several sources, you can select a source.

◆ Select Simulated High Value to output the simulated high value calibration signals to Vigilance II, 
Vigileo, or HemoSphere monitor. To stop outputting the simulated high value signal, select Stop Cal 
Signal Output where the Simulated High Value button was previously.

◆ Select Simulated Low Value to output the simulated low value calibration signals to Vigilance II, 
Vigileo, or EV1000 monitor. To stop outputting the simulated low value signal, select Stop Cal Signal 
Output where the Simulated Low Value button was previously.

The following table shows values and voltages of the high and low value calibration signals.

CAUTION

• The calibration voltage of Vigilance II, Vigileo, EV1000, and HemoSphere monitor should be the 
same as the output voltage of this monitor. Otherwise, some parameter values may be incorrectly 
calculated.

NOTE

• See the operator’s manuals of Vigilance II, Vigileo, EV1000, and HemoSphere monitors for the 
calibration instructions.

18.6 Changing SvO2/ScvO2 Settings

18.6.1 Changing the SvO2/ScvO2 Alarm Settings

To change the SvO2/ScvO2 alarm settings, follow this procedure:

Parameters Parameter Values Output Voltage

High Value Calibration Signals

MAP 500 mmHg 5V

SpO2 100% 10V

CVP 100 mmHg 5V

Low Value Calibration Signals

MAP 0 mmHg 0V

SpO2 0% 0V

CVP 0 mmHg 0V
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1. Select the SvO2/ScvO2 numeric area to enter the SvO2 or ScvO2 dialog.

2. Select the Alarm tab.

3. Set the alarm properties of SvO2/ScvO2.

18.6.2 Setting the SvO2/ScvO2 Analog Output Signal

This monitor can output the analog signals to the Vigilance II/Vigileo/EV1000/HemoSphere monitor. To set the 
SvO2/ScvO2 analog output signal, follow this procedure:

1. Select the SvO2 numeric area to enter the SvO2 dialog; or select the ScvO2 numeric area to enter the 
ScvO2 dialog.

2. Select the Signal Output Setup tab.

3. Set the output signal as follows:

◆ This monitor can output the analog signals of ECG waveform, MAP value, SpO2 value and CVP value to 
the Vigilance II monitor. If a signal has several sources, you can select a source.

◆ This monitor can output the CVP analog signal to the Vigileo monitor. If the CVP signal has several 
sources, you can select a source.

◆ This monitor can output ECG waveform, MAP value, and CVP value to the HemoSphere monitor. If a 
signal has several sources, you can select a source.

◆ Select Simulated High Value to output the simulated high value calibration signals to Vigilance II, 
Vigileo, or HemoSphere monitor. To stop output the simulated high value signal, select Simulated 
High Value again.

◆ Select Simulated Low Value to output the simulated low value calibration signals to Vigilance II, 
Vigileo, or HemoSphere monitor. To stop output the simulated low value signal, select Simulated 
Low Value again.

The following table shows values and voltages of the high and low value calibration signals.
 

CAUTION

• The calibration voltage of Vigilance II, Vigileo, EV1000, and HemoSphere monitor should be the 
same as the output voltage of this monitor. Otherwise, some parameter values may be incorrectly 
calculated.

NOTE

• See the operator’s manuals of Vigilance II, Vigileo, EV1000, and HemoSphere monitors for the 
calibration instructions.

Parameters Parameter Values Output Voltage

High Value Calibration Signals

MAP 500 mmHg 5V

SpO2 100% 10V

CVP 100 mmHg 5V

Low Value Calibration Signals

MAP 0 mmHg 0V

SpO2 0% 0V

CVP 0 mmHg 0V
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18.7 CCO/SvO2 Troubleshooting
This section lists the problems that might occur. If you encounter the problems when using the equipment or 
accessories, check the table below before requesting for services. If the problem persists, contact your service 
personnel.

NOTE

• For the physiological and technical alarm messages, see Appendix D Alarm Messages.

Problem Solution

The numeric area does not display CCO values 
when the Vigilance II, Vigileo, EV1000, or 
HemoSphere monitor is connected.

1. Check that the CCO is set to display in the Screen Setup → Tile 
Layout page. For more information, see 3.9.2 Displaying Parameter 
Numerics and Waveforms.
2. Check that if the CCO parameter switch is enabled. If not, enable the 
CCO measurement. For more information, see 3.9.1 Switching On or Off a 
Parameter.
3.Check that the Vigilance II, Vigileo, EV1000, or HemoSphere monitor is 
set properly as described in 18.3 Connecting the Device.
4. Check the connection of CCO/SvO2 cable. For more information, see 
18.3 Connecting the Device.

Do not see ScvO2 or SvO2 numeric area on the 
main screen

1. Check that the ScvO2 or SvO2 is set to display in the Screen Setup → 
Tile Layout page. For more information, see 3.9.2 Displaying Parameter 
Numerics and Waveforms.
2. Check that if the ScvO2 /SvO2 parameter switch is enabled. If not, 
enable the ScvO2 /SvO2 measurement. For more information, see 
3.9.1 Switching On or Off a Parameter.
3.Check that the Vigilance II, Vigileo, EV1000, or HemoSphere monitor is 
set properly as described in 18.3 Connecting the Device.
4. Check the connection of CCO/SvO2 cable. For more information, see 
18.3 Connecting the Device.
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19 Monitoring Carbon Dioxide (CO2)

19.1 CO2 Introduction

CO2 monitoring is a continuous, non-invasive technique for determining the concentration of CO2 in the 
patient’s airway by measuring the absorption of infrared (IR) light of specific wavelengths. CO2 has its own 
absorption characteristic and the amount of light passing the gas probe depends on the concentration of the 
measured CO2. When a specific band of IR light passes through respiratory gas samples, some of IR light will be 
absorbed by the CO2 molecules. The amount of IR light transmitted after it has been passed through the 
respiratory gas sample is measured with a photodetector. From the amount of IR light measured, the 
concentration of CO2 is calculated.

CO2 measurement is used to monitor the patient’s respiratory status. The sidestream/Microstream CO2 
measurement takes a sample of the respiratory gas with a constant sample flow from the patient's airway and 
analyzes it with a remote CO2 sensor built into the Sidestream or Microstream CO2 module. 

The sidestream CO2 module can be configured with a paramagnetic oxygen sensor to measure O2. The 
paramagnetic oxygen sensor measures oxygen based on its paramagnetic properties. 

The sidestream and microstream CO2 measurement can be used, with specified accessories, with intubated and 
non-intubated adult, pediatric, and neonatal patients. With intubated patients, a sample of the respiratory gas is 
drawn from the patient's breathing circuit through an airway adapter and a gas sampling line. With non-
intubated patients, the gas sample is drawn through a nasal cannula.

Both sidestream and microstream CO2 modules have the function of automatic barometric pressure 
compensation (the system automatically measures the barometric pressure to which the patient monitor is 
exposed). 

CO2 monitoring is intended for adult, pediatric and neonatal patients.

19.2 Identifying CO2 Modules

The following figures show the controls and connectors of different CO2 module.

To measure CO2 using the AG module, see 20 Monitoring Anesthetic Gas (AG).

(1) CO2 dialog hard key (2) CO2 Measure/standby hard key

(3) CO2 watertrap seat (4) Gas outlet

(5) Sample line connector 

(1)

(5)

(4)

(2)(1) (2)

(4)

(3)

Sidestream CO2 module Microstream CO2 module
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19.3 CO2 Safety Information

WARNING

• Route all tubing away from the patient’s throat to avoid strangulation.

CAUTION

• Remove the airway sample line from the patient’s airway while nebulized medications are being 
delivered. Measuring CO2 during nebulization may lead to inaccurate CO2 readings.

• EtCO2 values measured from the CO2 module may differ from those from the blood gas analysis.

• Avoid mechanical shock to the sidestream CO2 module.

• Shaking the CO2 module during O2 measurement may lead to a distorted O2 waveform or 
inaccurate O2 measurement

NOTE
• The CO2 module automatically suppresses physiological alarms until breathing waves have been 

detected. Ensure that the patient is properly connected when using the CO2 module.

19.4 CO2 Measurement Limitations

The following factors may influence the measurement accuracy:

■ Leaks or internal venting of sampled gas

■ Mechanical shock

■ Cyclic pressure up to 10 kPa (100 cmH2O)

■ Other sources of interference, if any

For more information, refer to A.13.12 CO2 Specifications.

CAUTION

• Measurement accuracy of the sidestream CO2 module may be affected by the breath rate and 
inspiration/expiration (I/E) ratio.

• Measurement accuracy of the microstream CO2 module may be affected by the breath rate.

19.5 CO2 Display

The CO2 numeric and waveform areas provide FiCO2 measurement, EtCO2 measurement, awRR measurement, 
and a CO2 waveform.

If the sidestream CO2 module is configured with the oxygen sensor, O2 waveform and parameters can be 
displayed in an O2 numeric and waveform area as follows:

(1) CO2 waveform (2) Fraction of inspired CO2 (FiCO2)

(3) End tidal CO2 value (EtCO2) (4) Airway respiration rate (awRR)

(1) (2) (3) (4)
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19.6 Measuring CO2 Using the Sidestream/Microstream CO2 Module

19.6.1 Preparing to Measure CO2 Using the Sidestream CO2 Module

To prepare the CO2 measurement, follow this procedure:

1. Select the appropriate gas sample line and watertrap according to the patient category.

2. Connect the watertrap to the CO2 module, and connect the gas sample line to the watertrap.

3. Connect the other end of the gas sample line to the patient.

◆ For intubated patients requiring an airway adapter, install the airway adapter between the patient 
circuit and the ventilator Y-piece.

◆ For non-intubated patients, place the nasal cannula onto the patient.

(1) O2 waveform (2) FiO2 measurement (3) EtO2 measurement

(3)

(2)

(1)

(1) Watertrap receptacle (2) DRYLINE II watertrap

(3) Gas sample line

(1) Sample line (2) Connection to the ventilator

(3) Airway adapter (4) Connection to the patient

(1)

(2)
(3)

(1)

(2)

(3)

(4)
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4. Connect the gas outlet to the scavenging system using an exhaust tube.

After the CO2 module is connected, it enters measure mode by default and the monitor displays CO2 Starting. 
CO2 can be measured after the start-up sequence is complete.

WARNING

• Do not use the adult or pediatric watertrap with a neonate patient. Otherwise, patient injury could 
result.

• Connect the gas outlet to the scavenging system when measuring CO2 using the sidestream CO2 
module.

CAUTION

• Leakage in the breathing or sampling system may cause the displayed EtCO2 values to be 
significantly low. Always make sure that all components are securely connected.

• Inspect the airway adapter for a tight connection and proper operation before attaching it to the 
patient.

• Squeezing or bending the sample line during sidestream or microstream CO2 measurement may 
cause inaccurate CO2 readings or no reading.

• To avoid blocking the airway, empty the DRYLINE II watertrap container whenever half full. 
Replacing the DRYLINE II watertrap once a month is recommended. Dispose of accumulated fluids in 
accordance with hospital policy or your local regulations. 

• The DRYLINE II watertrap has a filter preventing bacterium, water and secretions from entering the 
module. Extended use could destroy the filter in watertrap and fail to stop the bacterium, water and 
secretions entering the module, result in damaging the gas module and having infection risk.

NOTE
• To extend the lifetime of the watertrap and module, disconnect the watertrap from the module and 

set the operating mode to Standby mode when CO2 monitoring is not required.

• The sample rates are different when different types of watertraps are used.

• The emptying interval of the DRYLINE II adult/pediatric watertrap is 26 hours @ 120 ml/min, sample 
gas of 37 °C, room temperature of 23 °C, and 100% RH.

• The emptying interval of the DRYLINE II neonatal watertrap is 35 hours @ 90 ml/min, sample gas of 
37 °C, room temperature of 23 °C, and 100% RH.

19.6.2 Preparing to Measure CO2 Using the Microstream CO2 Module

To prepare the CO2 module for measurement, follow this procedure:

1. Connect one end of the sample line to the microstream CO2 module.
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2. Connect the other end of the sample line to the patient.

◆ For intubated patient requiring an airway adapter, install the airway adapter between the patient 
circuit and the ventilator Y-piece.

◆ For non-intubated patient, place the nasal cannula onto the patient.

◆ For patient prone to mouth breathing, place the oral-nasal cannula onto the patient.

3. Connect the gas outlet to the a scavenging system using an exhaust tube.

After the CO2 module is connected, it enters measure mode by default and the monitor displays CO2 Sensor 
Warmup. CO2 can be measured after the start-up sequence is complete.

WARNING

• Connect the gas outlet to the scavenging system when measuring CO2 using the microstream CO2 
module.

NOTE

• Disconnect the sample line from the module when CO2 monitoring is not required.

19.6.3 Zeroing the Sidestream/Microstream CO2 Module

The sidestream and microstream CO2 modules perform a zero calibration automatically when needed. Once the 
zero calibration is started, the CO2 module stops measuring and “Zeroing” is displayed in the CO2 numeric area.

After the zero calibration is completed, the CO2 module reacquires the CO2 readings. During the reacquisition 
period, “Zero Recovering” is displayed in the CO2 numeric area. Valid data will reappear 30 seconds after the 
zero calibration is started. You can hide the display of the “Zero Recovering” message, but values displayed 
during the reacquisition period may not be accurate. See 33.5.6 Hiding the Invalid Display after Zeroing the CO2 

Module for more information.

The automatic zero calibration will not start under the following conditions:

■ Physiological alarms related to CO2 or AG are active.

■ An apnea alarm is active.

■ No breath has been detected for over 30 seconds.

You can also perform the zero calibration manually. For more information, see 33.5.5 Manually Zeroing the CO2 

Module.

(1) Sample line connector (2) Sample line

(2)

(1)
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19.7 Changing Settings for All CO2 Modules

19.7.1 Changing CO2 Alarm Settings

To change the CO2 alarm settings, follow this procedure:

1. Select the CO2 numeric area or waveform area to enter the CO2 dialog.

2. Select the Alarm tab.

3. Enter the password if required. For more information, refer to 33.14.3 Selecting Password for User 
Authentication.

4. Set alarm properties as desired.

19.7.2 Setting the CO2 Waveform

To set the CO2 waveform, follow this procedure:

1. Select the CO2 numeric area or waveform area to enter the CO2 dialog.

2. Select the Setup tab.

3. Set Waveform Type, Speed, Scale, or CO2 Scale of the CO2 waveform.

19.7.3 Setting the RR Source
To set the respiration rate (RR) source, follow this procedure:

1. Select the CO2 numeric area or waveform area to enter the CO2 dialog.

2. Select the Setup tab.

3. Set RR Source.

When you select Auto, the system automatically selects the RR source according to the priority. The priority of 
RR source is first CO2, and then RM and ECG. When the current RR source does not have valid measurement, the 
system automatically switches the RR Source to Auto. 

19.7.4 Entering the Standby Mode
Set the CO2 module to one of the following modes according to the module status:

■ Select Measure mode when using the CO2 module for monitoring.

■ Select Standby mode to prolong the CO2 module service life when not using the CO2 module.

The default operating mode is Measure. When not using the CO2 module, proceed as follows to enter the 
Standby mode:

1. Select the CO2 numeric area or waveform area to enter the CO2 dialog.

2. Select the Setup tab.

3. Set Operating Mode to Standby.

19.7.5 Entering the Intubation Mode
When performing intubation during general anesthesia, enter the intubation mode to reduce unnecessary 
alarms. To enter the intubation mode, follow this procedure:

1. Select the CO2 numeric area or waveform area to enter the CO2 dialog.

2. Select Intubation Mode.

To exit the intubation mode, choose either of the following ways: 

■ From the bottom of the CO2 dialog, select Exit Intubation Mode. 

■ Select the Main Menu quick key →from the Alarm column select Exit Intubation Mode.

For the details of the intubation mode, see 8.13 Intubation Mode.
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NOTE

• When the configured intubation period is over, the monitor automatically exits the intubation mode 
and gives two alert sounds.

19.7.6 Setting the Auto Standby

The monitor enters standby mode automatically if no breath is detected after the configured period of time. To 
set the auto standby, follow this procedure:

1. Select the CO2 numeric area or waveform area to enter the CO2 dialog.

2. Select the Setup tab.

3. Set Auto Standby.

19.7.7 Setting Humidity Compensation
Sidestream and microstream CO2 modules are configured to compensate CO2 readings for either Body 
Temperature and Pressure, Saturated Gas (BTPS), to account for humidity in the patient’s breath, or Ambient 
Temperature and Pressure, Dry Gas (ATPD).

■ ATPD:  PCO2(mmHg)=CO2(vol%) x Pamb/100

■ BTPS (sidestream):  PCO2(mmHg)=CO2(vol%) x (Pamb- 47)/100

■ BTPS (microstream):  PCO2(mmHg)=CO2(vol%) x (1- 0.03)x Pamb/100

Where, PCO2(mmHg)= partial pressure, vol%=CO2 concentration, Pamb=ambient pressure, and unit is mmHg.

For the sidestream and microstream CO2 module, set the humidity compensation on or off according to the 
actual condition. 

To set the humidity compensation, follow this procedure:

1. Select the CO2 numeric area or waveform area to enter the CO2 dialog.

2. Select the Setup tab.

3. Set BTPS Compensation. 

◆ Switch on for BTPS.

◆ Switch off for ATPD.

19.8 Changing O2 Settings (For Sidestream CO2 Module Integrating O2)

19.8.1 Changing O2 Alarm Settings

To change the O2 alarm settings, follow this procedure:

1. Select the CO2 numeric area or waveform area to enter the CO2 dialog.

2. Select the Alarm tab.

3. Enter the password if required. For more information, refer to 33.14.3 Selecting Password for User 
Authentication.

4. Set alarm properties as desired.

19.8.2 Setting the O2 Waveform

To set the O2 waveform, follow this procedure:

1. Select the CO2 numeric area or waveform area to enter the CO2 dialog.

2. Select the Setup tab.

3. Set Speed and O2 Scale of the O2 waveform.
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19.9 Setting the Gas Compensation
The presence of interfering gas affects the CO2 measurement. To get the best possible measurement result, it is 
recommended to set the gas compensation. The configured concentration of the interfering gas should be in 
accordance with its actual proportion. 

For the microstream CO2 module, gas compensations are not required.

CAUTION

• Make sure to use the appropriate compensations. Inappropriate compensations may cause 
inaccurate measurement values and result in misdiagnosis.

For the sidestream CO2 module, follow this procedure to set the gas compensation:

1. Select the CO2 numeric area or waveform area to enter the CO2 dialog.

2. Select the Setup tab.

3. Set the compensation according to the actual condition.

19.10 Choosing a Time Interval for Peak-Picking
For microstream CO2 modules, select a time interval for picking the highest CO2 as the EtCO2 and the lowest as 
the FiCO2.

To set the time interval, follow this procedure:

1. Select the CO2 numeric area or waveform area to enter the CO2 dialog.

2. Select the Setup tab.

3. Set Maximum Hold.

4. Toggle between Single Breath, 10 s and 20 s.

◆ Single Breath: EtCO2 and FiCO2 are calculated for every breath.

◆ 10 s and 20 s: EtCO2 and FiCO2 are calculated using 10 or 20 seconds of data.

19.11 Performing the Leakage Test
When measuring CO2 using the sidestream CO2 module, the leakage test is required every time before the CO2 
measurement. To perform the CO2 leakage test, follow this procedure: 

1. Connect the measuring accessories as per section 19.6.1 Preparing to Measure CO2 Using the Sidestream CO2 

Module. 

2. Wait until the startup finishes. Completely block the gas inlet on the sidestream CO2 module. The alarm 
message “CO2 Airway Occluded” will appear on the screen. 

3. Continue to block the gas inlet for another one minute.

4. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

5. Select the Module tab → CO2 tab.

6. Check that the current flow rate is less than 10ml/min, and the alarm message “CO2 Airway Occluded” 
does not disappear. 

This indicates that the module does not leak. If the alarm message disappears, or the flow rate is equal to 
10ml/min or greater, it indicates that the module leaks. Perform the leakage test again. If the problem 
remains, contact your service personnel for help.

19.12 CO2 Calibration

For sidestream and microstream CO2 modules, a calibration is needed every year or when the measured values 
have a great deviation. 

To calibrate the CO2 module, contact your service personnel.
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CAUTION

• Connect the gas outlet to the scavenging system when calibrating the CO2 module.

19.13 Test Method Used to Determine the Respiration Rate Measuring 
Range
To determine the RR measurement range, follow this procedure:

1. Connect the 5% CO2 + N2 (BAL) gas cylinder, reduction valve, rhythm generator and gas sampling path of a 
monitor.

2. Respectively set the rhythm generator to generate a respiration rate of 0 rpm, 6 rpm, 20 rpm, 60 rpm, 
120rpm, and 150 rpm.

3. Verify that it meets the specifications.

NOTE

• The rhythm generator mentioned above is a sensor/sampling site in Figure 201.101 – Test apparatus 
for the TOTAL SYSTEM RESPONE TIME of an RGM of ISO 80601-2-55.

19.14 CO2 Troubleshooting

This section lists the problems that might occur. If you encounter the problems when using the equipment or 
accessories, check the table below before requesting service. If the problem persists, contact your service 
personnel.

NOTE

• For the physiological and technical alarm messages, see Appendix D Alarm Messages.

19.14.1 Troubleshooting the Sidestream/Microstream CO2 Module

19.15 Oridion Information

Oridion Patents

This posting serves as notice under 35 U.S.C.§287(a) for Covidien patents: http://www.covidien.com/patents.

No Implied License

Possession or purchase of this device does not convey any express or implied license to use the device with 
unauthorized CO2 sampling consumables which would, alone, or in combination with this device, fall within the 
scope of one or more of the patents relating to this device and/or CO2 sampling consumable.

Problem Solution

EtCO2 measurements too low 1. Check the patient status.
2. Check the sample line and connectors for leakage.
3. Ventilate the room if the environmental CO2 concentration is too 
high.
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20 Monitoring Anesthetic Gas (AG)

20.1 AG Introduction
The anesthetic gas (AG) module measures the patient’s anesthetic and respiratory gases by connecting to the 
airway of intubated patients or collecting the gases with specified accessories. It also incorporates the features 
of the O2 module and BIS module.

The AG module determines the concentration of certain gases using the infrared (IR) light absorption 
measurement. The gases that can be measured by the AG module absorbing IR light. Each gas has its own 
absorption characteristic. The gas is transported into a sample cell, and an optical IR filter selects a specific band 
of IR light to pass through the gas. For multiple gas measurements, there are multiple IR filters. The higher the 
concentration of gas in a given volume, the more IR light is absorbed. This means that higher concentration of IR 
absorbing gas causes a lower transmission of IR light. The amount of IR light transmitted after it has been passed 
through an IR absorbing gas is measured. From the amount of IR light measured, the concentration of gas 
present can be calculated. 

Oxygen does not absorb IR light as other breathing gases and is therefore measured relying on its paramagnetic 
properties. Inside the O2 sensor are two nitrogen-filled glass spheres mounted on a strong rare metal taut-band 
suspension. This assembly is suspended in a symmetrical non-uniform magnetic field. In the presence of 
paramagnetic oxygen, the glass spheres are pushed further away from the strongest part of the magnetic field. 
The strength of the torque acting on the suspension is proportional to the oxygen concentration. From the 
strength of the torque, the concentration of oxygen is calculated.

AG monitoring is intended for adult, pediatric and neonatal patients.

NOTE

• The AG module is configured with automatic barometric pressure compensation function.

(1) AG dialog hard key (2) Gas outlet

(3) AG Measure/standby hard key (4) Watertrap seat

(5) BIS cable connector

(1) (3)

(4)

(2)

(5)
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20.2 AG Safety Information

WARNING

• To avoid explosion hazard, do not use flammable anesthetic agent such as ether and cyclopropane 
for this equipment.

• The presence of other substances in the patient’s breathing circuit, such as ethanol, acetone, 
methanol, isopropanol, freon, asthma medication carrier gases, and other infrared absorbing gases, 
can influence the anesthesia agent identification and lead to incorrect measurements and 
identification. 

• Using high-frequency electrosurgical units may increase the risk of skin burn. In this case, do not use 
antistatic or conductive respiratory tubing.

• Route all tubing away from the patient’s throat to avoid strangulation. 

CAUTION

• Perform the measurement in a well-ventilated environment.

• EtCO2 values measured from the AG module may differ from that of from the blood gas analysis.

NOTE
• The AG module automatically suppresses physiological alarms until breathing waves have been 

detected. Make sure that a patient is properly connected when monitoring with the AG module 

20.3 AG Measurement Limitations
The following factors may influence the measurement accuracy:

■ Leaks or internal venting of sampled gas

■ Mechanical shock

■ Cyclic pressure up to 10 kPa (100 cmH2O)

■ Other sources of interference, if any
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20.4 AG Display

The AG module can send waves and numerics for all measured anesthetic gases for display on the monitor, 
including:

■ CO2, O2, N2O and AA waves

■ awRR: airway respiratory rate

■ MAC: minimum alveolar concentration

■ End tidal (Et) and fraction of inspired (Fi) numerics for CO2, O2, N2O and AA

AA represents one of the following agents: Des (desflurane), Iso (isoflurane), Enf (enflurane), Sev (sevoflurane), or 
Hal (halothane).

If only one anesthetic agent is used, the AA waveform area displays the waveform of this anesthetic agent. If 
several anesthetic agents are used, the AA waveform area displays the waveform of the primary anesthetic 
agent. 

20.5 AG Equipment to Patient Connection
 

( )

(4)

(5)
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20.6 Preparing for AG Monitoring
To prepare to monitor AG, follow this procedure:

1. Select the appropriate gas sample line and watertrap according to the patient category.

2. Connect the watertrap to the AG module, and connect the gas sample line to the watertrap.

3. Connect the other end of the gas sample line to the patient via the airway adapter.

4. Connect the gas outlet to a scavenging system or the patient respiration circuit using an exhaust tube.

5. Check that the connections are tight. 

After the AG module is connected to the SMR, the AG module enters the measurement mode by default and the 
monitor prompts AG Starting. AG measurement is available after the start-up is completed.

WARNING

•  When using the AG module, connect the gas outlet to the scavenging system or the patient 
respiration circuit when in use with the Mindray A7 anesthesia machine.

•  If the sampled gas is returned to the breathing system, there may be a risk of patient cross-
infection. 

• If the sampled gas is returned to the breathing system, install a breathing system filter compliant 
with the ISO 23328-1 and ISO 23328-2 standards on the patient end.

• Make sure that the connections are tight. Any leak in the system can result in erroneous readings 
due to ambient air mixing with patient gases.

• Always inspect the airway adapter for a tight connection and proper operation before attaching it to 
the patient.

• Squeezing or bending the gas sample line during AG measurement may cause erroneous readings 
or no readings. 

CAUTION

• Position the airway adapter so that the part connecting to the gas sample line is pointing upwards. 
This prevents condensed water from passing into the gas sample line and causing an occlusion. 

• The watertrap collects water drops condensed in the sample line and therefore prevents them from 
entering the module. To avoid blocking the airway, empty the watertrap container whenever half 
full. 

• The watertrap has a filter preventing bacterium, water and secretions from entering the module. 
After long-term use, dust or other substances may compromise the performance of the filter or even 
block the airway. In this case, replace the watertrap. Replacing the watertrap once a month is 
recommended.

NOTE

• Do not apply adult watertrap to the neonatal patient. Otherwise, patient injury could result.

• To extend the lifetime of the watertrap and module, disconnect the watertrap from the module and 
set the operating mode to Standby when AG monitoring is not required.

20.7 Zeroing the AG Module
The AG module performs a zero calibration automatically when needed. Once the zero calibration is started, the 
AG module stops measuring and “Zeroing” is displayed in the AG numeric area.

(1) AG module (2) Gas outlet

(3) Watertrap (4) Gas sample line

(5) Airway adapter (connected to patient) (6) Y-piece (connected to the anesthesia machine)
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After the zero calibration is completed, the AG module reacquires the AG readings. During the reacquisition 
period, “Zero Recovering” is displayed in the AG numeric area. Valid data will reappear 30 seconds after the zero 
calibration is started. You can hide the display of the “Zero Recovering” message, but values displayed during 
the reacquisition period may not be accurate. See 33.5.8 Hiding the Invalid Display after Zeroing the AG Module for 
more information.

The automatic zero calibration will not start under the following conditions:

■ Physiological alarms related to CO2 or AG are active.

■ An apnea alarm is active.

■ No breath has been detected for over 30 seconds.

You can also perform the zero calibration manually. For more information, see 33.5.7 Manually Zeroing the AG 
Module.

20.8 MAC Values
Minimum alveolar concentration (MAC) is the minimum concentration of the agent in the alveoli. It is a basic 
index to indicate the depth of anesthesia. The standard ISO 80601-2-55 defines MAC as this: alveolar 
concentration of an inhaled anesthetic agent that, in the absence of other anesthetic agents and at equilibrium, 
prevents 50% of patients from moving in response to a standard surgical stimulus.

MAC values are listed below:

* indicates 1 MAC nitrous oxide can only be reached in hyperbaric chamber.

NOTE

• The types of gases used for calculating the MAC value can be selected. For more information, see 
33.5.5 Manually Zeroing the CO2 Module.

• The MAC values shown in the table above are those published by the U.S. Food and Drug 
Administration for a healthy 40-year-old adult male patient.

• In actual applications, the MAC value may be affected by age, weight and other factors.

The formula to calculate the MAC value is as follows:

Where N is the number of all agents (including N2O) that the AG module can measure, EtAgenti is the 
concentration of each agent, and AgentVolagei is the concentration of each agent at 1 MAC with age correction.

The formula for calculating age correction of 1 MAC is:

 

For example, the Des concentration at 1 MAC of a 60-year old patient is.

The AG module measures 4% of Des, 0.5% of Hal and 50% of N2O in the patient’s end-tidal gas:

NOTE

• The formula above is only suitable for patients who are older than one year. If the patient is less than 
one year, the system uses one year old to do age correction.

Agent Des Iso Enf Sev Hal N2O

1 MAC 6% 1.15% 1.7% 2.1% 0.77% 105%*

MAC EtAgent
AgentVolagei
-------------------------------------

i 0=

N 1–

=

MACage MAC40 10
0.00269 age 40–( )×–( )×=

6% 10
0.00269 60 40–( )×–( )× 6% 0.88×=

MAC
4.0%

6% 0.88×
------------------------ 0.5%

0.77% 0.88×
--------------------------------- 50%

105% 0.88×
------------------------------+ + 2.04= =
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20.9 Changing AG Settings

20.9.1 Changing AG Alarm Settings
To change the AG alarm settings, follow this procedure:

1. Select the AG numeric area or waveform area to enter the Gas dialog.

2. Select the desired gas tab.

3. Select the Alarm tab.

4. Enter the password if required. For more information, refer to 33.14.3 Selecting Password for User 
Authentication.

5. Set alarm properties as desired.

20.9.2 Setting the O2 Compensation

If the AG module does not incorporate the O2 module, you need to set the amount of O2 in the ventilation gas 
mixture. To set the O2 compensation, follow this procedure:

1. Select the AG numeric area or waveform area to enter the Gas dialog.

2. Select the Setup tab.

3. Set O2 Compensation:

◆ Select Off when the amount of O2 is less than 30%.

◆ Select the other options in accordance with the O2 concentration in the gas mixture.

The O2 Compensation setting is available only when the AG module does not incorporate the O2 module. If the 
AG module incorporates the O2 module, the system directly uses the O2 concentration detected by the O2 
module to make compensation. 

20.9.3 Entering the Standby Mode
Set the AG module to one of the following modes according to the module status:

■ Select Measure mode when using the AG module for monitoring.

■ Select Standby mode when not using the AG module. 

The default operating mode is Measure. If not using the AG module, follow this procedure to enter the Standby 
mode:

1. Select the AG numeric area or waveform area to enter the Gas dialog.

2. Select the desired gas tab.

3. Select the Setup tab.

4. Set Operating Mode to Standby.

20.9.4 Setting Auto Standby
The monitor enters the standby mode automatically after the configured period of time if no breath is detected 
since the last detected breath. To set the auto standby, follow this procedure:

1. Select the AG numeric area or waveform area to enter the Gas dialog.

2. Select the desired gas tab.

3. Select the Setup tab.

4. Set Auto Standby.
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20.9.5 Setting the Gas Waveform
To set the gas waveform, follow this procedure:

1. Select the AG numeric area or waveform area to enter the Gas dialog.

2. Select the desired gas tab.

3. Select the Setup tab.

4. Set the speed and scale of gas waveforms. For CO2, set Waveform Type.

20.9.6 Setting the RR Source
To set the RR (respiration rate) source, follow this procedure:

1. Select the AG numeric area or waveform area to enter the Gas dialog.

2. Select the desired gas tab.

3. Select the Setup tab.

4. Set RR Source.

When the current RR source does not have valid measurement, the system will automatically switch RR Source to 
Auto.

20.9.7 Entering the Intubation Mode
When performing intubation during general anesthesia, enter the intubation mode to reduce unnecessary 
alarms. To enter the intubation mode, follow this procedure:

1. Select the AG numeric area or waveform area to enter the Gas dialog.

2. Select Intubation Mode from the bottom of the dialog.

For the details of the intubation mode, see 8.13 Intubation Mode.

20.9.8 Enabling or Disabling MAC Display

Set whether MAC value is displayed in the AG numeric area by following this procedure:

1. Select the AG numeric area or waveform area to enter the Gas dialog.

2. Select the desired anesthetic agent tab.

3. Switch on or off MAC.

20.10 Changing the Anesthetic Agent
When the anesthetic agent used on the patient is changed, the AG module detects the mixed anesthetic gas 
during the transition of two anesthetic agents. The time required for completing the replacement of anesthetic 
agent depends on anesthesia type (low flow or high flow) and the characteristics of anesthetic agents 
(pharmacokinetics). During the transition of two anesthetic agents, the monitor gives no prompt messages and 
the MAC value displayed may be inaccurate.

The AG module can identify two anesthetic agents automatically. When the proportion of primary and secondary 
anesthetic agents in the mixture changes, the AG module can distinguish between them according to their 
contributions to the MAC value. Then primary and secondary anesthetic agents will be exchanged for display.
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20.11 Performing AG Leakage Test 
The AG leakage test is required every time before the AG measurement. To perform the AG leakage test, follow 
this procedure: 

1. Plug the AG module into the module rack. 

2. Wait for about one minute until the AG module warms up. Completely block the gas inlet of the AG module. 
Then the alarm message “AG Airway Occluded” will appear on the screen. 

3. Block the gas inlet for another one minute.

4. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

5. Select the Module tab → AG tab.

6. Check that the current flow rate is less than 10 ml/min, and the alarm message “AG Airway Occluded” does 
not disappear. 

This indicates that the module does not leak. If the alarm message disappears, or the flow rate is equal to 
10ml/min or greater, it indicates that the module leaks. Perform the leakage test again. If the problem 
remains, contact your service personnel for help.

20.12 Calibrating the AG Module
Calibrate the AG module every year or when the measured value is outside the specification. To calibrate the AG 
module, contact the service personnel.

CAUTION

• Connect the gas outlet to the scavenging system when calibrating the AG module.

20.13 AG Troubleshooting
If the AG airway is occluded, the message AG Airway Occluded appears. In this case, check for the follows until 
the message disappears:

1. Check the airway adapter for occlusion and replace if necessary.

2. Check the sample line for occlusion or kinking and replace if necessary.

3. Check the watertrap for water or occlusion. Empty the watertrap, or replace the watertrap if necessary.

4. Check the gas outlet and the exhaust tube for any occlusion.

If the message does not disappear, it is probably the module fault. Contact the service personnel in this case.

NOTE

• For the physiological and technical alarm messages, see Appendix D Alarm Messages.
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21 Monitoring Respiratory Mechanics (RM)

21.1 RM Introduction
The RM monitoring enables clinicians to understand the ventilator/anesthesia machine operation and patient 
respiratory status. In respiratory mechanics (RM) monitoring, the airway pressures are measured between the 
patient circuit and intubation tube using a flow sensor inserted between the Y-piece of the patient circuit and 
the patient connection. The pressure is transferred to the monitor through the tube and measured by a pressure 
transducer in the RM module. The pressure difference together with the gas concentration information is used 
to calculate flow. The volume information is obtained by integrating the flow signal. From these three 
parameters, other parameters such as RR, I:E, Compl, etc. are derived.

RM monitoring is intended for adult and pediatric patients.

 

21.2 RM Safety Information

WARNING

• RM monitoring is not intended for neonatal patients.

• RM monitoring is for mechanically ventilated patients only.

• The RM module is not intended to be used with high frequency ventilators. 

21.3 RM Parameters
RM monitoring displays the following waveforms and loops:

■ Flow waveform

■ Paw waveform

■ Vol waveform

■ FV (flow-volume) loop

■ PV (paw-volume) loop

(1) RM menu hard key (2) Enter/Exit the respiratory Loops

(3) Module status indicator (4) Flow sensor connector

(1) (2)

(4)

(3)
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■ PF (paw-flow) loop

RM monitoring provides values for 18 parameters. The 18 parameters can be classified into 4 categories:

21.4 RM Display
You can select the parameter for display in the Select Parameter page of the RM menu. For more information, 
see 21.8.8 Setting Parameters for Display.

Parameter Label Description Unit

Paw parameters

PIP peak inspiratory pressure cmH2O

Pplat pressure cmH2O

PEEP positive end expiratory pressure cmH2O

Pmean mean pressure cmH2O

Flow parameters

PIF peak inspiratory flow L/min

PEF peak expiratory flow L/min

Vol parameters

TVi inspiratory tidal volume ml

TVe expiratory tidal volume ml

MVi inspiratory minute volume L/min

MVe expiratory minute volume L/min

Other parameters

RR respiratory rate rpm

I : E ratio of the inspiratory and expiratory time /

Compl compliance ml/cmH2O

FEV1.0 first second forced expiratory volume ratio %

RSBI rapid shallow breathing index rpm/L

WOB work of breathing J/L

NIF negative inspiratory force cmH2O

RAW airway resistance cmH2O/L/s

(1) Flow waveform (2) Paw waveform

(3) Volume waveform (4) Flow numeric area

(1)

(2)

(4)

(6)
(3)

(5)
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21.5 RM Equipment to Patient Connection

21.6 Preparing for RM Monitoring
To prepare to monitor RM, follow this procedure:

1. Select an appropriate flow sensor in accordance with the patient category.

2. Connect the thin tubes of the flow sensor to the flow sensor connector of the RM module.

3. Connect the end of the flow sensor marked   to the patient tracheal tube.

4. Connect the other end of the flow sensor to the Y-tube of a ventilator or anesthesia machine.

5. Check that the connections are tight.

CAUTION

• Be sure to set the barometric pressure properly before using the RM module. Improper settings will 
result in erroneous RM reading.

• A system leak may significantly affect readings of flow, volume, pressure and other respiratory 
mechanics parameters.

• Match the airway adapter you select to the appropriate patient category. Improper sensor selection 
may produce excessive ventilation resistance or introduce excessive airway dead space.

• To prevent stress on the endotracheal tube, support the sensor and airway adapter.

• Position sensor tubing carefully to avoid entanglement or potential strangulation.

NOTE
• To avoid the effect of excessive moisture in the measurement circuit, insert the flow sensor in the 

breathing circuit with the tubes upright, and make sure that the flow sensor is always positioned a 
few degrees off the horizontal level towards the ventilator side. 

• Do not place the flow sensor between the endotracheal tube and an elbow as this may allow patient 
secretions to block the flow sensor window.

• Measurement values provided by a ventilator or an anesthesia machine may differ significantly from 
the values provided by the RM module due to different locations of the flow sensor.

• For best measurement performance, a heat moisture exchanger (HME) should always be put 
between the tracheal tube and the flow sensor. Periodically check the flow sensor and tubing for 
excessive moisture or secretion build-up and purge if necessary.

(5) Paw numeric area (6) Vol numeric area

(1) Connects to the patient (2) Flow sensor (3) Connect to the RM module

(3)

     (1) (2)
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• During RM monitoring, the RM module automatically performs zero calibration periodically or when 
the temperature changes. Zero calibration affects RM waveforms.

• Keep the respiration loop away from condensing equipment.

21.7 Respiratory Loops
Respiratory loops reflect patient lungs function and ventilation condition, such as the lung’s compliance, over-
inflation, breathing system leakage and airway blockage.

The monitor provides three types of respiratory loops: PV (pressure-volume) loop, FV (flow-volume) loop, and PF 
(flow-pressure) loop. The three types of loops come from pressure, flow, and volume waveforms data.

To view the respiration loops, choose any of the following ways:

■ Select the Loops quick key.

■ Select the Screen Setup quick key → the Select Quick Keys tab.

■ Select the Main Menu quick key → from the Display column select Choose Screen→ select Respiration 
Loops.

(1) Respiratory loop (2) Reference loop

(3) RM parameters (4) Button area

(3) (2)

(1)

(4)

(3)
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21.7.1 Changing the Loop Type
The monitor displays only one type of respiratory loops at the same time. To change the type of the respiratory 
loops, follow this procedure:

1. Select the numeric area or waveform area of Paw, Flow or Vol to enter the RM menu.

2. Select Loops from the bottom of the menu to enter the Loops window.

3. Select the desired loop type at the lower left corner of the window.

21.7.2 Saving the Loop as Reference
You can save the real time loops as reference loops. To save the loops, follow this procedure:

1. Select the numeric area or waveform area of Paw, Flow or Vol to enter the RM menu.

2. Select Loops from the bottom of the menu to enter the Loops window.

3. Select Set Reference. 

The reference loops and the time at which the reference loops are saved display in the Loops window 
simultaneously. Up to four groups of loops can be saved as reference loops. If the fifth group of loops needs to be 
saved as reference, the monitor will prompt that an older group of reference loops should be replaced by the fifth 
group.

21.7.3 Displaying the Reference Loop
The reference loop and real time loop can overlap and be displayed in the same area of the Loops window. In this 
case, the reference loop is drawn in white. To display the reference loop, follow this procedure:

1. Select the numeric area or waveform area of Paw, Flow or Vol to enter the RM menu.

2. Select Loops from the bottom of the menu to enter the Loops window.

3. Select the reference loop to be displayed.

4. Select  Display Reference.

To hide the reference loop, select Hide Reference button in the Loops window.

21.7.4 Adjusting the Loop Scale
The scales of the loops are the same as the scale of the corresponding waveforms. For more information, see 
21.8.5 Changing the Wave Scale.

21.7.5 Selecting the Parameters for Display
The parameters displayed in the Loops window are the same as those displayed in the Paw, Flow and Vol numeric 
areas. For more information, see21.8.8 Setting Parameters for Display.

21.8 Changing RM Settings

21.8.1 Changing RM Alarm Settings
To change the RM alarm settings, follow this procedure:

1. Select the numeric area or waveform area of Paw, Flow or Vol to enter the RM menu.

2. Select the Alarm tab.

3. Set the alarm properties of PEEP, PIP and MVe:

21.8.2 Setting the Apnea Alarm Delay
The monitor will alarm if the patient has stopped breathing for longer than the previously set apnea time. To 
change the delay time of the apnea alarm, follow this procedure:

1. Select the numeric area or waveform area of Paw, Flow or Vol to enter the RM menu.
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2. Select the Alarm tab.

3. Enter the password if required.

4. Set Apnea Delay.

WARNING

• The respiration monitoring does not recognize the cause of apneas. It only indicates an alarm if no 
breath is detected when a preadjusted time has elapsed since the last detected breath. Therefore, it 
cannot be used for diagnostic purposes.

21.8.3 Setting RR Source
To set the RR (respiration rate) source, follow this procedure:

1. Select the numeric area or waveform area of Paw, Flow or Vol to enter the RM menu.

2. Select the Setup tab.

3. Set RR Source.

When the current RR source does not have valid measurement, the system will automatically switch RR Source to 
Auto.

21.8.4 Changing the Wave Sweep Speed
To set the sweep speed of Paw, Flow, and Vol waveforms, follow this procedure:

1. Select the numeric area or waveform area of Paw, Flow or Vol to enter the RM menu.

2. Select the Setup tab.

3. Set Speed.

21.8.5 Changing the Wave Scale
To set the scale of Paw, Flow, and Vol waveforms, follow this procedure:

1. Select the numeric area or waveform area of Paw, Flow or Vol to enter the RM menu.

2. Select the Setup tab.

3. Set Paw Scale, Flow Scale, or Vol Scale

21.8.6 Setting the Ambient Temperature
To set the ambient temperature, follow this procedure:

1. Select the numeric area or waveform area of Paw, Flow or Vol to enter the RM menu.

2. Select the Setup tab.

3. Set Atmosphere Temp.

21.8.7 Setting the Ambient Humidity
To set the ambient humidity, follow this procedure:

1. Select the numeric area or waveform area of Paw, Flow or Vol to enter the RM menu.

2. Select the Setup tab.

3. Set Relative Humidity.

21.8.8 Setting Parameters for Display
Each numeric areas of Paw, Flow or Vol can display up to  6 parameters. To set the parameters for display, follow 
this procedure:
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1. Select the numeric area or waveform area of Paw, Flow or Vol to enter the RM menu.

2. Select the Select Parameter tab.

3. Select the parameters for display on pages of Paw, Flow and Vol.

21.8.9 Entering the Intubation Mode
When performing intubation during general anesthesia, you can enter the intubation mode in order to reduce 
unnecessary alarms. To enter the intubation mode, follow this procedure:

1. Select the numeric area or waveform area of Paw, Flow or Vol to enter the RM menu.

2. Select Intubation Mode from the bottom of the menu.

For more information of the intubation mode, see 8.13 Intubation Mode.

21.9 VCO2 and Metabolic Monitoring

When the RM module is used together with the sidestream CO2 module or AG module configured with the 
paramagnetic oxygen sensor, the following parameters can be monitored:

■ Volume CO2 parameters (VCO2, MVCO2) 

■ Oxygen consumption parameters (VO2, MVO2)

■ Respiratory Quotien (RQ) and Energy Expenditure (EE) 

Monitoring above parameters is intended for adult and pediatric patients.

21.9.1 VCO2 and Metabolic Parameters

The following table lists VCO2 and metabolic parameters.

21.9.2 Safety Information When RM Module in Use with CO2 or AG Module

WARNING

• Measurement using RM module and CO2 or AG Module is for intubated patients only.

CAUTION

• When using the RM module together with the CO2 or AG Module, the gas sampling positions should 
be between the patient and the Y-piece, adjacent to the Y-piece end. The two sampling positions 
should be close to each other. Otherwise, measurement error can result.

• Strong scavenging suction may change the operating pressure of the modules and cause inaccurate 
readings or excessive sample gas flow.

• When monitoring with the RM module and the CO2 or AG Module, keep the patient still. Do not 
disturb the patient or adjust the ventilation device. 

Parameter label Description Unit

VCO2  CO2 Production for one breath ml

MVCO2 CO2 Minute Production ml/min

VO2 O2 Consumption for one breath ml

MVO2 O2 Minute Consumption ml/min

EE Energy Expenditure kCal/day

RQ Respiratory Quotient /
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• RQ has no reference significance if beyond the range of 0.6 and 1.3. Verify that the 
measurement is correct and the patient is stable. 

21.9.3 Measurement Limitations When RM Module in Use with CO2 or AG Module

When the RM module is used together with the CO2 module or AG module, measurements have reference 
significance only when the patient is in stable ventilation status. Stable ventilation status refers to the following 
situations:

■ Patient is at rest for at least 30 minutes.

■ Mechanical ventilation parameters (RR, TV, and etc) remain unchanged.

■ No operations that may affect the patient’s gas exchange or metabolism.

The measurement may be inaccurate in the following situations:

■ The airway of sampling lines are abnormal or sampling lines leak or are blocked.

■ Unsteady FiO2 values

■ Other circumstance causing wrong CO2, O2, and Flow measurements

Measurement cannot be taken in the following situations due to inadequate time for accurate sampling:

■ High frequency ventilation (HFV) or bi-level positive airway pressure (BiPAP) 

■ Respiration rate is above 35 rpm.

21.9.4 Equipment to Patient Connection When RM Module in Use with CO2 or AG 
Module

When the RM module is used together with the sidestream CO2 module or AG module, equipment to patient 
connection is as follows: 

21.9.5 Displaying the VCO2 and EE Numerics Areas
When the RM module is used together with the sidestream CO2 module or AG module configured with the 
paramagnetic oxygen sensor, parameter display is as follows:

■  In the VCO2 parameter area, VCO2, MVCO2, VO2, MVO2 are displayed.

■ In EE parameter area, RQ and EE are displayed.

(1) Connects to the patient (2) RM flow sensor (3) Connects to the RM module

(4) Airway adapter (5) Connects to the sidestream CO2 module or AG module

(6)Y-piece (connects to the ventilator or anesthesia machine)

(1)

(2)

(3)

(5)

(4)

(6)
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21.9.6 Preparing for VCO2 and Metabolic Monitoring
For more information, see 19.6.1 Preparing to Measure CO2 Using the Sidestream CO2 Module, 20.6 Preparing for AG 
Monitoring, and 21.6 Preparing for RM Monitoring.

NOTE

• When the RM module is used together with the sidestream CO2 module or AG module configured 
with the paramagnetic oxygen sensor, the CO2 and Flow waveforms need to be synchronized to get 
valid measurements. This process is automatic, but takes approximately two minutes to complete.

21.10 RM Troubleshooting
This section lists the problems that might occur. If you encounter the problems when using the equipment or 
accessories, check the table below before requesting for services. If the problem persists, contact your service 
personnel.

NOTE
• For the physiological and technical alarm messages, see D Alarm Messages.

Problem Solution

Do not see RM numeric area or waveform area 
on the main screen

1. Check that the Paw, Flow or Vol is set to be displayed in the Screen 
Setup menu. For more information, see 3.9.2 Displaying Parameter 
Numerics and Waveforms.
2. Check that if the RM parameter switch is enabled. If not, enable the RM 
measurement. For more information, see 3.9.1 Switching On or Off a 
Parameter.
3. Check the connection of flow sensor.

Erroneous values 1. Check that the tube connectors and their connections are tight and not 
leaking.
2. Check that the sensor type is appropriate.
3. Disconnect the flow sensor, and remove the water or secretions from 
the flow sensor.

Values seem unstable

Strong vibrations in the loop 1. Check the patient status.

2. Check the breathing system for water or secretions.

The respiratory loops are not whole. (gap 
between the starting and ending points may 
indicate a leak)

Check the breathing system for leakage.
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22 Monitoring Electroencephalogram (EEG)

22.1 EEG Introduction
The Electroencephalograph (EEG) module monitors the patient's cerebral function by measuring the electrical 
activity of the brain.

The EEG module can continuously monitor EEG signal from up to four channels. It can also display Density 
Spectral Arrays (DSA) and Compressed Spectral Arrays (CSA). 

EEG monitoring is intended for adult, pediatric, and neonatal patients. 

22.2 EEG Safety Information

WARNING
:

• The conductive parts of electrodes and connectors should not contact other conductive parts, 
including electrically grounded parts.

• To reduce the hazard of burns in the high-frequency surgical neutral electrode connection, the EEG 
sensor should not be located between the surgical site and the electrosurgical unit return electrode.

• The EEG electrode must not be located between defibrillator pads when a defibrillator is used on a 
patient under monitoring.

• To ensure proper defibrillator protection, use only recommended cables and leadwires.

• EEG is a complex monitoring technology intended for use only as an adjunct to clinical judgment 
and training. 

CAUTION

• Only use parts and accessories specified in this manual. Follow the instructions for use and adhere to 
all warnings and cautions.

• Implanted devices (for example cardiac pacemakers), other patient connected equipment, and other 
equipment near the patient (for example high-frequency surgical units) can cause interference on 
the waveform, numerics, and the CSA presentation.

(1) EEG dialog hard key (2) Sensor check hard key

(3) Module status indicator (4) EEG cable connector

(1) (2)

(4)

(3)
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• External radiating devices may disturb the measurement. It is recommended to avoid the use of 
electrical radiating equipment in close proximity to the monitor. 

• Interference from ECG can be eliminated by adjusting the filter settings. 

NOTE

• The EEG accessories are purchased from EB Neuro S.p.A. Please contact EB Neuro or visit its website 
(www.ebneuro.com) for more information.

• In the event of electrode connection issues, the monitor provides an error indication only when it 
performs an auto sensor check according to the time interval that is set by the user. It is 
recommended to start a manual sensor check if an abnormal waveform or high noise is observed.

22.3 EEG Parameters
EEG monitoring provides ten parameters: SEF, MF, PPF, TP, SR, EMG, Delta, Theta, Alpha, and Beta. The numerics 
area of each EEG channel can display up to six parameters. 

22.4 EEG Display

Label Description

SEF
(Spectrum Edge Frequency)

The frequency at which 95% of the total power lies below it and 5% 
lies above it. Its range is from 0.5 to 30.0 Hz. 

MF
(Median Frequency)

The frequency at which 50% of the total power lies below it and 50% 
lies above it. Its range is from 0.5 to 30.0Hz.

PPF
(Peak Power Frequency)

The PPF is the frequency with the highest measured amplitude range 
from 0.5 to 30 Hz.

TP 
(Total Power)

TP numeric is a measure of the absolute total power in the frequency 
band from 0.5 to 30.0 Hz. The useful range is from 40 to 100 dB, 
where 0 dB = 0.0001uV2..

SR
(Suppression Ratio)

SR numeric is the percentage of time in the past 60 seconds in which 
the EEG signal is considered suppressed. 

EMG
(Electromyography)

EMG bar graph reflects the electrical power of muscle activity and 
high frequency artifacts. Low EMG indicates that EMG activity is low. 

Delta%, Theta%, Alpha%, Beta% 
(Frequency band ratio)

EEG is traditionally divided into four frequency bands: delta, theta, 
alpha and beta. Frequency band ratio is the percentage of total 
power falling in corresponding band. For example, Delta % = Power 
in delta band/Total power.
Alpha waves: 8 to 13 Hz
Beta waves: 13 to 30 Hz
Theta waves: 4 to 8 Hz
Delta waves: 0.5 to 4 Hz

(1)    (2) (3) (4)

(5)

(1) Lead label

(2) EEG waveform scale. For more information, see 22.8.1 Changing the EEG Scale.
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22.5 Accessing the On-screen EEG Guide
The monitor provides the on-screen EEG guide to help you understand EEG monitoring functions and operating 
procedure.

To access the on-screen EEG guide, follow this procedure:

1. Select the EEG numerics area or waveform area to enter the EEG dialog.

2. Select the Introduction tab.

3. Select a tab as required.

◆ Select the Summary tab to view the EEG monitoring principles, intended use, and work modes. 

◆ Select the Target Patients tab to view the applicable patients for EEG monitoring.

◆ Select the Operation Guides tab to view the EEG monitoring procedure.

◆ Select the CSA and DSA tab to understand the CSA and DSA expand views.

22.6 Prepare for EEG Monitoring
To monitor EEG, follow this procedure:

1. Connect EEG module, patient cable and lead wires. For more information, see 22.6.1 EEG Equipment to 
Patient Connection.

2. Select Montage. You can select a predefined montage and you can also customize a montage. See 
22.6.2.3 Customizing an Electrode Montage.

3. Mark the electrode sites on the patient’s head according to the montage you have chosen.

4. Prepare the skin of the electrode application sites.

5. Apply the electrodes. For more information, see 22.6.3 Attaching EEG Electrodes.

6. Perform sensor check and observe the results. 

22.6.1 EEG Equipment to Patient Connection
The following picture illustrates the connection between the EEG module and accessories.

(3) EEG waveform
You can configure the displayed EEG waveforms. A maximum of four EEG waveforms can be displayed.

(4) EEG parameters
You can configure the displayed EEG parameters. A maximum of six EEG parameters can be displayed. For more 
information, see 22.8.5 Changing Displayed EEG Parameters. 

(5) EMG indicator

◆ Empty: EMG < 30 dB. EEG monitoring conditions are optimal.

◆ 1 to 4 bars: EMG 30 to 55 dB. EEG monitoring conditions are acceptable.

◆ 5 bars: EMG > 55 dB. EEG monitoring conditions are unacceptable.

(2)

(3)

(1)
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22.6.2 Choosing an EEG Electrode Montage
To choose a montage, follow this procedure:

1. Select the EEG numerics area or waveform area to enter the EEG dialog.

2. Select the Montage Setup tab.

3. Select Montage.

For each montage, the Montage Setup dialog shows the lead connection and electrode locations of each 
channel.

There are four predefined montages available. The following table shows electrode locations of each predefined 
montage.

You can modify the predefined montage and rename it as customized montage. For more information, see 
22.6.2.3 Customizing an Electrode Montage.

22.6.2.1 EEG Electrode Locations

The following pictures shows the electrode locations. The electrode locations are labeled according to the 
international 10-20 electrode placement system. The numbers and letters refer to electrode locations:

(1) EEG module (2) EEG patient cable (3) Lead wires

Electrode Montage 1 Montage 2 Montage 3 Montage 4

EEG1 (A)

Positive (+) Fp1 F3 F3 Fp1

Negtive (-) T3 C3 Cz Cz

Label Fp1-T3 F3-C3 F3-Cz Fp1-Cz

EEG2 (B)

Positive (+) Fp2 C3 F4 Fp2

Negtive (-) T4 P3 Cz Cz

Label Fp2-T4 C3-P3 F4-Cz Fp2-Cz

EEG3 (C)

Positive (+) C3 F4 P3 O1

Negtive (-) O1 C4 Cz Cz

Label C3-O1 F4-C4 P3-Cz O1-Cz

EEG4 (D)

Positive (+) C4 C4 P4 O2

Negtive (-) O2 P4 Cz Cz

Label C4-O2 C4-P4 P4-Cz O2-Cz
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■ Odd numbered electrodes: placed on the left

■ Even numbered electrodes: placed on the right

■ Letters: F = frontal, T = temporal, C = central, P = parietal, O = occipital, Z = midline electrodes

22.6.2.2 Bipolar Mode and Referential Mode

Measurement can be referential or bipolar. 

■ In bipolar mode, each channel (EEG1, EEG2, EEG3 and EE4) uses two electrodes, a positive and a negative, 
to measure the potential difference between each pair. 

■ In referential mode, all channels use the same referential electrode (negative), and only use one electrode 
(positive) to measure the potential difference.

Montage 1 and Montage 2 are bipolar, while Montage 3 and Montage 4 are referential.

22.6.2.3 Customizing an Electrode Montage

To modify a predefined montage and save it as customized montage, follow this procedure:

1. Select the EEG numerics area or waveform area to enter the EEG dialog.

2. Select the Montage Setup tab.

3. Select a montage (for example Montage 1).

4. Modify the electrode locations and montage type: select an electrode from the channel area on the left, 
and then select the electrode position from the electrode map on the right. Repeat this operation until you 
have defined all the electrodes as desired.

5. Select Save As and input a new name for this montage, and then select OK to confirm the changes. 

You can have up to three customized montages. Selecting Delete can delete a customized montage.

22.6.3 Attaching EEG Electrodes

WARNING

• Use only one type of electrode in the whole montage. Using different types of electrodes in the same 
montage may result in inaccurate readings. 

NOTE

• Make sure that you have attached the ground electrode.

• The neutral electrode is usually more prone to artifact.
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• For best results, use Ag/AgCl electrodes for the EEG measurement. 

22.6.3.1 Attaching Cup Electrodes 
1. Mark the spots on the patient’s head according to the montage you have chosen.

2. Comb or cut the hair away from the spots and rub the skin with the abrasive paste to remove oil and 
grease.

3. Apply the conductive paste on the inside of each electrode and then press the electrodes on the spots.

NOTE

• Preferably use cup electrodes if montage includes placements within hair area.

22.6.3.2 Attaching Needle Electrodes
1. Clean the skin with alcohol.

2. Insert the needle into the subcutaneous area.

3. Secure the needles to prevent excess movement or detachment. You may also use a small amount of paste 
to attach the cable to the patient's hair. This prevents the cables from pulling the needles out of the skin.

WARNING

• Check that the package of needle electrodes is intact before use. Do not use the electrodes if the 
package is damaged.

• Do not open the electrode package until immediately before use. 

• Needle electrodes are disposable. Do not reuse needle electrodes.

• Replace any needle electrodes that are found to be bent. Using needles that have been previously 
bent may cause damage to the attachment site or inaccurate measurement.

22.7 Performing EEG Sensor Check
The monitor has an EEG sensor check function. The Sensor Check dialog displays the status of each electrode 
and the result of sensor check. 

22.7.1 Setting the Interval of Auto Sensor Check
The sensor check is automatically initiated in the following situations:

■ The EEG module is connected.

■ The patient cable is connected.

■ The Electrode montage is changed.

■ The Sensor Check dialog is entered.

You can set the interval of performing the auto sensor check. To do so, follow this procedure:

1. Select the EEG numerics area or waveform area to enter the EEG dialog.

2. Select the Sensor Check tab.

3. Select an appropriate setting from Interval list. Selecting Off disables auto sensor check.

22.7.2 Displaying/Hiding Impedance Value
You can display the impedance value on the electrode map of Sensor Check dialog by clicking Display Imped 
Values (KΩ) key, or hide the value by clicking Hide Imped Values (KΩ) key.
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22.7.3 Manually Starting a Sensor Check 
To manually start sensor check, choose either of the following way: 

■ Press the sensor check    hard key on the EEG module.

■ Select Start Sensor Check from the Sensor Check dialog.

At the completion of sensor check, the electrode status is shown. For more information, see22.7.4 EEG Electrode 
Status.

22.7.4 EEG Electrode Status
EEG electrode status is color coded. The following table lists all electrode status options and actions to be taken. 

For each EEG channel, to get reliable results all electrodes for this channel should be in Pass status (green).

22.7.5 Stopping Sensor Check 
Sensor check automatically stops if all the electrodes pass the impedance check. You can also manually stop the 
sensor check. 

To stop sensor check, choose either of the following ways:

■ Press the sensor check  hard key on the EEG module.

■ Select Stop Sensor Check from the Sensor Check dialog.

22.8 Changing EEG Settings

22.8.1 Changing the EEG Scale
To set EEG waveform scale, follow this procedure:

1. Select the EEG numerics area or waveform area to enter the EEG dialog.

Color Status Description Action

Red Off Electrode falls off and has no skin contact. Reconnect electrodes:
In the Bipolar mode, reconnect the 
electrode indicated as red, and PGND 
electrode.
In the Referential mode, reconnect the 
electrode indicated as red, NE and PGND 
electrodes.

Grey Noise The EEG signal is too noisy. Impedance 
cannot be measured.

Check the sensor-to-skin contact. If 
necessary, reconnect the electrodes.

Yellow High The impedance is above the need. Check the sensor-to-skin contact. If 
necessary, reconnect the electrodes.

Green Pass The impedance is within the need. No action is necessary.
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2. Select the Setup tab.

3. Select an appropriate setting from the Scale list.

22.8.2 Changing the EEG Sweep Speed
To set EEG sweep speed, follow this procedure:

1. Select the EEG numerics area or waveform area to enter the EEG dialog.

2. Select the Setup tab.

3. Select an appropriate setting from the Speed list. 

22.8.3 Changing the High/Low Filter
The low and high filters can screen out undesirable interference which may come from respiration, movement, 
etc. The current EEG high and low filter settings are shown at the top of DSA and CSA view.

To change the filter settings, follow this procedure:

1. Select the EEG numerics area or waveform area to enter the EEG dialog.

2. Select an appropriate setting from the Low Freq Cut-off and High Freq Cut-off list.

22.8.4 Switching Off the Notch Filter
The notch filter can screen out 50Hz/60Hz power line noise. The notch filter is enabled by default. To disable the 
notch filter, follow this procedure:

1. Select the EEG numerics area or waveform area to enter the EEG dialog.

2. Select the Setup tab.

3. Set Notch Filter to Off . 

22.8.5 Changing Displayed EEG Parameters
You can choose the displayed parameters. To do so, follow this procedure:

1. Select the EEG numerics area or waveform area to enter the EEG dialog.

2. Select the Select Parameter tab.

3. Select the parameters you want to display.

You can select at most six parameters. The selected parameters are applied to all EEG channels. 

22.9 Displaying the EEG Expand View
To display the EEG expand view, follow this procedure:

1. Select the EEG numerics area or waveform area to enter the EEG dialog.

2. From the bottom of the EEG dialog, select EEG Expand.

3. Select the desired tab to enter corresponding view:

◆ Select the EEG tab, and then select EEG Channels, Scale, and Speed to view corresponding EEG 
waveforms.

◆  Select the Parameters tab to view parameter values of each EEG channel.

◆ Select the Trends tab, and then select EEG Channels, Parameters, and Trend Length to view the 
trends of corresponding EEG channels and parameters.

◆ Select the CSA tab to enter the CSA view. For more information, see 22.9.1 CSA View.

◆ Select the DSA tab to enter the DSA view. For more information, see 22.9.2 DSA View.
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22.9.1 CSA View
The continuous EEG signal is sampled periodically and this value is stored in a frame. Each frame is processed 
using Fast Fourier Transformation (FFT) to provide a frequency spectrum displayed as a compressed spectral 
array (CSA).

The CSA View provides an overview of the patient's EEG values over time. 

To display the CSA View, follow this procedure:

1. Select the EEG numerics area or waveform area to enter the EEG dialog.

2. From the bottom of the EEG dialog, select EEG Expand.

3. Select the CSA tab.

The CSA View provides up to CSA of four EEG channels. It provides the following information:

From the CSA view you can select the following items:

■ EEG Channels

■ Parameters

■ Trend Length 

To change Power Scale and CSA Clipping setting, select CSA Setup.

■ Changing Power Scale can adjust the amplitude of spectral lines. The wider the power scale range, the 
greater amplitude of the spectral lines is. 

■ If CSA Clipping is switched on, the latest spectral line displays in a normal shape, in which area other go-
through spectral lines will be cut out. If the CSA Clipping is switched off, all the spectral lines display 
normally.  

22.9.2 DSA View
The Density Spectral Array (DSA) is to show changes in the power spectrum distribution over time. 

Displayed item Description

Status bar The first line displays the current montage, filter setting, notch frequency, SEF percentage (95%), 
and trendline labels and color codes.
The second line displays the EEC channel labels and lead labels.

Frequency scale It is the horizontal axis. The scale range depends on the filter settings (Low Freq Cut-off and 
High Freq Cut-off settings. The maximum displayed frequency is 30 Hz, so if you set High Freq 
Cut-off to 50 or 70, the upper scale remains 30.

Spectral lines The energy at each frequency is computed and displayed as a spectral line.

Trendlines EEG values are sampled at configured time intervals and displayed as color-coded trendlines. 
Trendlines are available for up to three frequency numerics (SEF, MF, and PPF). SEF trendline is 
white, MF trendline is purple, and PPF trendline is green.

“?” mark Appears when artifact is detected, electrodes are off or disconnected, or montage is changed.
BeneVision N22/N19/N17/N15/N12 Patient Monitor Operator’s Manual 22 - 9



To display the DSA View, follow this procedure:

1. Select the EEG numerics area or waveform area to enter the EEG dialog.

2. From the bottom of the EEG dialog, select EEG Expand.

3. Select the DSA tab.

The DSA View displays DSA for up to four EEG channels. It provides the following information:

From the DSA view you can select the following items:

■ EEG Channels

■ Parameters

■ Trend Length

■ Power Scale 

Displayed item Description

Color bar It is located at the right of the DSA view. The color bar color codes the power.  
You can change the setting of Power Scale to adjust the color of 
corresponding power.

Status bar Displays the current montage, filter setting, notch frequency, SEF percentage 
(95%), and trendline labels and color codes.

Frequency scale It is the vertical axis. The scale range depends on the filter settings (Low Freq 
Cut-off and High Freq Cut-off setting. The maximum displayed frequency is 
30 Hz, so if you set High Freq Cut-off to 50 or 70, the upper scale remains 30. 

Trendlines EEG values are sampled at configured time intervals and displayed as color-
coded trendlines. Trendlines are available for up to three frequency numerics 
(SEF, MF, and PPF). SEF trendline is white, MF trendline is purple, and PPF 
trendline is green.

“?” mark Appears when high electrode impedance or artifact is detected, electrodes 
are off or disconnected is changed.
22 - 10  BeneVision N22/N19/N17/N15/N12 Patient Monitor Operator’s Manual



22.10 EEG Troubleshooting
This section lists the problems that might occur. If you encounter the problems when using the equipment or 
accessories, check the table below before requesting for services. If the problem persists after corrective actions 
have been taken, contact the service personnel. 

NOTE

• For a comprehensive list of physiological and technical alarm messages, see D Alarm Messages.

Problem Solution

EEG signal is noisy 1. Check that the electrodes are properly connected and not dried out.
2. Check that the electrodes properly contact with skin.
3. Perform electrode impedance check.
4. Calm the patient since frontal muscle activity can cause artifact.
5. Remove sources of external electrical noise (for example, the lamps) 
from the vicinity of the patient’s head.
6. ECG monitoring may cause artifact; change electrode positioning.

EEG cable and electrodes properly connected, 
but no EEG waveforms.

1. The number of channels in the montage is smaller than the number 
of channels connected to the patient. Check the number of channels.
2. Select the Screen Setup quick key → Parameters On/Off. Make sure 
that EEG parameter is turned on. 

The EEG numerics area displays ”- -”. The patient has high muscle activity in the head area, or noise from 
some interfering equipment is coupling to electrode cables. Relax the 
patient and remove the source of noise.

EEG waveform baseline fluctuates. 1. Sweating may cause variations in the electrode impedance. Check the 
patient.
2. If the fluctuation is disturbing, prepare the skin and replace the 
electrodes.

The electrode impedances show “- -” and there 
is a message prompting to check the ground 
electrode?

The ground electrode is poorly connected to the patient. Check the 
electrode and cable. If the impedance of the electrode is too high, the 
measurement fails even if the electrode is properly attached. Use better 
electrodes or prepare the skin better.
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23 Monitoring Bispectral Index (BIS)

23.1 BIS Introduction
Bispectral Index (BIS) monitoring helps to monitor the level of consciousness of a patient under general 
anesthesia or sedation in OR and ICU. It is designed to monitor the hypnotic state of the brain based on 
acquisition and processing of EEG signals. Use of BIS monitoring to help guide anesthetic administration may be 
associated with the reduction of the incidence of awareness with recall during general anesthesia or sedation. 

There are two BIS solutions available for use with the BIS module: the BISx or the BISx4. The BISx is for single side 
BIS monitoring, and the BISx4 is for both single side and bilateral BIS monitoring. The BISx4 provides bilateral BIS 
monitoring only when the BIS Bilateral Sensor is connected. 

BIS monitoring is intended for adult and pediatric patients.

(1) BIS dialog hard key (2) Sensor check hard key

(3) Module status indicator (4) BIS cable connector

(5) BIS module (6) BISx or BISx4

(7) Patient cable (8) BIS sensor

(6)

(5)

(7)

(8)

(2)

(3)

(4)

(1)
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23.2 BIS Safety Information

WARNING

• BIS monitoring is not intended for neonatal patients.

• The BIS technology used with this monitor is purchased from Covidien. It is important to recognize 
this index is derived using solely that company's proprietary technology. Therefore, it is 
recommended that clinicians have reviewed applicable information on its utility and/or risks in 
published articles and literature/web site information from Covidien, or contact Covidien at 
www.covidien.com for clinical-based BIS questions. Failure to do so could potentially result in the 
incorrect administration of anesthetic agents and/or other potential complications of anesthesia or 
sedation. It is recommend that clinicians also review the following practice advisory (that includes a 
section on BIS monitoring): The American Society of Anesthesiologists, Practice Advisory for 
Intraoperative Awareness and Brain Function Monitoring (Anesthesiology 2006;104:847-64). 
Clinicians are also recommended to maintain current knowledge of FDA or other federal-based 
regulatory, practice or research information on BIS and related topics. 

• The conductive parts of sensors and connectors should not come into contact with other conductive 
parts, including earth conductors. 

• To reduce the hazard of burns in the high-frequency surgical neutral electrode connection, the BIS 
sensor should not be located between the surgical site and the electrosurgical unit return electrode. 

• To reduce the hazard of burns during use of brain-stimulating devices (e.g. transcranial electrical 
motor evoked potential), place stimulating electrodes as far as possible from the BIS sensor and 
make certain that sensor is placed according to package instructions. 

• The BIS sensor must not be located between defibrillator pads when a defibrillator is used on a 
patient connected to the monitor.

• The clinical utility, risk/benefit and application of the BIS component have not undergone full 
evaluation in the pediatric population. 

• Due to limited clinical experience for patients with neurological disorders, patients taking 
psychoactive medication, and children under one year old, BIS values from these patients should be 
interpreted cautiously. 

• The BIS monitoring is a complex technology, intended for use only as an adjunct to clinical 
judgment and training. Clinical judgment should always be used when interpreting BIS in 
conjunction with other available clinical signs. Reliance on BIS alone for intraoperative anesthetic 
management is not recommended. 

• Misinterpretation of BIS can result in incorrect administration of anesthetic agents and/or other 
potential complications of anesthesia or sedation. 

• BIS values should be interpreted cautiously with certain anesthetic combinations, such as those 
relying primarily on either ketamine or nitrous oxide/narcotics to produce unconsciousness. 

CAUTION

• Ensure that the BISx or BISx4 does not come into prolonged contact with the patient's skin, as it may 
generate heat and cause discomfort.

• Do not use the BIS sensor if the sensor gel is dry. To avoid dryout, do not open the pack until you are 
ready to use the sensor. 

• When using electro-convulsive therapy (ECT) equipment during BIS monitoring, place ECT 
electrodes as far as possible from the BIS sensor to minimize the effect of interference. Certain ECT 
equipment may interfere with the proper function of the BIS monitoring system. Check for 
compatibility of equipment during patient setup.

• The BIS measurement based on measuring the EEG signal is inherently very sensitive. Do not use 
electrical radiating equipment close to the BISx or BISx4.

• Artifact may lead to inappropriate BIS values. Potential artifact may be caused by unusual or 
excessive electrical interference or high EMG activity like shivering, muscle activity or rigidity, 
sustained eye movements, head and body motion. Also, improper sensor placement and poor skin 
contact (high impedance) may cause artifact and interfere with the measurement.

• External radiating devices may disturb the measurement.

• Poor signal quality may lead to inappropriate BIS values.
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23.3 BIS Parameters
Single side BIS monitoring provides the following parameters:

Bilateral BIS monitoring simultaneously monitors both cerebral hemispheres.  When bilateral BIS is monitored, 
an "L" or "R" will be added to each of the numeric identifiers except ASYM. In addition to the above parameters, it 
also provides the following parameters:

Parameter Description

BIS
(Bispectral Index)

The BIS numeric reflects the patient’s level of consciousness. It ranges from 100 for wide 
awake to 0 in the absence of brain activity. 
100: the patient is wide awake.
70: the patient is underdosed but still unlikely to become aware. 
60: the patient is under general anesthesia and loses consciousness. 
40: the patient is overdosed and in deep hypnosis. 
0: the EEG is a flat line. The patient has no electrical brain activity. 

SQI
(Signal Quality Index)

The SQI numeric reflects signal quality and provides information about the reliability of 
the BIS, SEF, TP, and SR numerics during the last minute. The greater the SQI value, the 
better signal quality.

EMG
(Electromyography)

EMG bar graph reflects the electrical power of muscle activity and high frequency 
artifacts. Low EMG indicates that EMG activity is low. BIS monitoring conditions are 
optimal when the bar is empty. 

SR
(Suppression Ratio)

SR numeric is the percentage of time over the last 63-second period during which the 
EEG is considered to be in a suppressed state. 

SEF
(Spectral Edge Frequency)

The SEF is a frequency below which 95% of the total power is measured. 

TP 
(Total Power)

TP numeric is a measure of the absolute total power in the frequency ranging from 0.5 to 
30.0 Hz. The useful range is from 40 to 100 db. 

BC
(Burst Count)

A burst means a period (at least 0.5 second) of EEG activity followed and preceded by 
inactivity. The BC numeric helps you quantify suppression by measuring the number of 
EEG bursts per minute. For single side BIS monitoring, this parameter is intended for the 
BIS module with the Extend sensor only. BC numeric is valid only when SQI≥15% and 
SR≥5%.

Parameter Description

sBIS
(BIS Variability Index)

sBIS numeric represents the standard deviation of the BIS variable over the last three 
minutes. 

sEMG
(EMG Variability Index)

sEMG numeric represents the standard deviation of the EMG value over the last three 
minutes. 

ASYM
(Asymmetry)

ASYM is a processed variable indicating the percentage of EEG power presented in the 
left or right hemisphere with respect to total (left and right) EEG power. 
Designation ‘L’ of the asymmetry data indicates asymmetry to the left side. 
Designation ‘R’ of the asymmetry data indicates asymmetry to the right side. 
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23.4 BIS Display

23.5 Accessing the On-screen BIS Guide
The monitor provides the on-screen BIS guide to help you understand BIS monitoring functions and operating 
procedure.

To access the on-screen BIS guide, follow this procedure:

1. Select the BIS numerics area or waveform area to enter the BIS dialog.

2. Select the Introduction tab.

3. Select a tab as required.

◆ Select the Summary tab to view the BIS monitoring principles. 

◆ Select the Target Patients tab to view the applicable patients for BIS monitoring.

◆ Select the Operation Guides tab to view the BIS monitoring procedure.

(3)

(4)

(5)

(1) (2)

(1) BIS waveform 
The display of BIS waveform area depends on the setting of Display from the BIS dialog. For more information, see 
23.7.3 Setting the Display of BIS Waveform Area.

(2) BIS value

(3) SQI indicator

◆ Empty: SQI < 15%, unable to calculate BIS and secondary parameter values. BIS and secondary parameter 
values are displayed as “---”.

◆ 1 to 2 bars: SQI 15% - 49%, parameter values are unreliable.

◆ 3 to 5 bars: SQI 50% - 100%, parameter values are reliable.

(4) EMG indicator

◆ Empty: EMG < 30 dB. BIS monitoring conditions are optimal.

◆ 1 to 4 bars: EMG 30 - 55 dB. BIS monitoring conditions are acceptable.

◆ 5 bars: EMG > 55 dB. BIS monitoring conditions are unacceptable. 

(5) Secondary parameters
The displayed secondary parameters are configurable. For more information, see 23.7.5 Setting the Displayed BIS 
Parameters.
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23.6 Preparing for BIS Monitoring

To perform BIS monitoring, follow this procedure:

1. Connect the BISx or BISx4 to the BIS module. 

2. Use the attachment clip to secure the BISx or BISx4 to a convenient location near the patient’s head. 

3. Connect the patient cable to the BISx or BISx4. 

4. Attach the BIS sensor to the patient following the instructions supplied with the sensor. 

5. Insert the BIS sensor into the patient cable connector until it is fully engaged. 

6. Observe the results of the automatic sensor check in the numeric area. 

Sensor Check is initiated automatically when the BIS sensor and the patient cable are connected to the BISx or 
BISx4. The measurement starts automatically after the sensor has passed the check. 

WARNING

• To minimize the risk of patient strangulation, the patient cable must be carefully placed and 
secured.

CAUTION

• Make sure the patient’s skin is dry. A wet sensor or a salt bridge could result in erroneous BIS and 
impedance values. 

• Do not use if sensor gel is dry. To avoid dry out, do not open pack until ready for use. 

• Due to intimate skin contact, reuse may pose risk of infection. If skin rash or other unusual 
symptoms develop, stop using and remove. 

(1) BIS module (2) BISx or BISx4

(3) Patient cable (4) BIS sensor

(2)

(1)
(3)

(4)
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23.7 Changing BIS Settings

23.7.1 Setting BIS Alarm Properties
To set the BIS alarm properties, follow this procedure: 

1. Select the BIS numeric area or waveform area to enter the BIS dialog. 

2. In the BIS dialog, select the Alarm tab.

3. Enter the password if required. For more information, refer to 33.14.3 Selecting Password for User Authentica-
tion.

4. Set alarm properties as desired.

23.7.2 Choosing the BIS Smoothing Rate
The smoothing rate defines how the monitor averages the BIS value. With the smoothing rate becoming smaller, 
the monitor provides increased response to changes in the patient’s state. Contrarily, the monitor provides a 
smoother BIS trend with decreased variability and sensitivity to artifacts.   

To change the smoothing rate, follow this procedure:

1. Select the BIS numeric area or waveform area to enter the BIS dialog. 

2. In the BIS dialog, select the Setup tab.

3. Set Smoothing Rate to 10 sec, 15 sec, or 30 sec. 

23.7.3 Setting the Display of BIS Waveform Area
To set the display of BIS waveform, follow this procedure:

1. Select the BIS numeric area or waveform area to enter the BIS dialog. 

2. In the BIS dialog, select the Setup tab.

3. Set Display. 

◆ If you set Display to EEG waveforms, set Scale and Speed for EEG waveforms.

◆ If you set Display to BIS parameter trends, set Trend Length. 

23.7.4 Switching the Filter On or Off
The filter can remove undesired interference from the raw EEG wave display. It is switched on by default.

To enable/disable the filter, follow this procedure:

1. Select the BIS numeric area or waveform area to enter the BIS dialog. 

2. In the BIS dialog, select the Setup tab.

3. Switch on/off Filter.

23.7.5 Setting the Displayed BIS Parameters
Besides the BIS value, you can also display up to four secondary parameters in the BIS numeric area. To select the 
displayed parameters, follow this procedure: 

1. Select the BIS numeric area or waveform area to enter the BIS dialog. 

2. In the BIS dialog, select the Select Parameter tab. 

3. From the BIS Tile area, select a secondary parameter block, and then select a secondary parameter from 
the Parameters area.
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23.8 Sensor Check

23.8.1 Automatic Sensor Check
Once the BIS sensor is connected, an automatic sensor check starts to check the sensor type, status, and   
impedance of all the electrodes, including the signal electrodes, the reference electrode and the ground 
electrode. During the sensor check, the message “Sensor Check In Progress” displays in the information area. If 
this message continuously displays, enter the Sensor Check dialog and check if the impedance of each 
electrode is acceptable.

After the initial sensor check, the monitor performs automatic checks during BIS monitoring. Automatic sensor 
checks includes the following items:

■ The combined impedance of the signal electrodes plus the reference electrode. This is done automatically 
and continuously and does not affect the EEG waveform. As long as the impedances are within the valid 
range, there is no prompt message of this check or its results.

■ The impedance of the ground electrode. This is done every ten minutes and takes approximately four 
seconds. It causes artifact in the EEG waveform, and the message BIS: Checking Ground is displayed on 
the monitor during the check. If the ground electrode does not pass this check, re-apply the electrode. 
Then another check will automatically initiate. 

The monitor continually checks impedance levels during a procedure by generating a 128 Hz test signal. 
Occasionally this signal may interfere with other equipment. If this becomes a problem, you may need to disable 
the auto checking. Impedance levels will still be tested at startup, but once they pass, they will not be tested 
again until a new case is begun. 

NOTE

• Automatic sensor check may need to be disabled if the 1nA 128 Hz impedance check signal 
interferes with other equipment.

23.8.2 Disabling automatic sensor check
To disable automatic sensor check, follow this procedure:

1. Select the BIS numeric area or waveform area to enter the BIS dialog. 

2. Select the Setup tab.

3. Switch off Auto Check.

CAUTION

• Switching the auto impedance check off will disable automatic prompt to the user of impedance 
value changes, which may lead to incorrect BIS values. Therefore, this should only be done if the 
check interferes with or disturbs other measurements.

23.8.3 Manual Sensor Check
To manually start a sensor check, use either of the following methods:

■ Press the sensor check hard key  on the BIS module. 

■ Select the Sensor Check tab from the BIS dialog.

The monitor enters the Sensor Check dialog after you start the sensor check. The Sensor Check dialog displays 
the following items: 

■ Sensor Type

■ The status of each electrode  

■ Expiration time or usable cycles

NOTE

• For different types of sensors the Sensor Check dialog may be different.
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23.8.4 BIS Sensor Status
The color of each electrode indicates its status:

Although BIS may still be measured when the electrode status is Noise or High, for best performance, all 
electrodes should be in the Pass status. 

The sensor check may fail for the following reasons:

■ Impedance too high

■ Incorrect sensor application

■ Poor sensor connection

■ Defective patient interface cable or sensor

To correct the situation:

■ Recheck the sensor

■ Reapply the sensor according to instructions

■ Check sensor connection

■ Replace patient interface cable or sensor

23.9 Monitoring Bilateral BIS
By using BISx4 and the Bilateral sensor you can perform bilateral BIS monitoring. You can display the BIS expand 
view during bilateral BIS monitoring. 

From the BIS expand view you can monitor 4-channel EEG and the density spectral array (DSA) which shows the 
degree of asymmetry in EEG power between the left and right hemispheres. The BIS expand view also provides 
BIS trend.

23.9.1 Entering the BIS Expand View
 To enter the BIS expanded view, follow this procedure:

1. Select the BIS numeric area or waveform area to enter the BIS dialog. 

2. Select BIS Expand at the bottom left corner to enter the BIS Expand View. 

23.9.2 Selecting BIS Expand View Display
To configure what is displayed in the BIS Expand View screen, follow this procedure:

1. Select the BIS numeric area or waveform area to enter the BIS dialog. 

2. Select BIS Expand at the bottom left corner to enter the BIS Expand View. 

3. Select the EEG, BIS Trend or DSA tab.

23.9.2.1 Displaying the EEG waveforms

The EEG tab of the BIS Expand view shows the selected EEG waveforms. You can configure the EEG waveforms:

■ Select EEG Waveforms to set which EEG waveforms you want to display.

Color Status Description Action

Red Lead off Electrode has fallen off and has no 
skin contact.

Press the sensor more firmly to skin to ensure 
good sensor-to-skin contact. If necessary, 
remove the sensor, and then clean and dry the 
skin. Reapply the senor or replace the sensor.

Grey Noise The EEG signal is too noisy. Impedance 
cannot be measured.

Press the sensor more firmly to skin to ensure 
good sensor-to-skin contact.

Yellow High The impedance is above the limit. Press the sensor more firmly to skin to ensure 
good sensor-to-skin contact.

Green Pass The impedance is within valid range. No action necessary.
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■ Select Scale to set EEG waveform scale.

■ Select Speed to set EEG waveform speed.

23.9.2.2 Displaying the BIS Trend

The BIS Trend tab of the BIS Expand view shows the trend of selected parameters. You can configure the BIS 
trend:

■ Select Parameter 1 and Parameter 2 to set the parameters whose trend you want to display.

■ Set Trend Length.

23.9.2.3 Displaying BIS DSA

The Density Spectral Array (DSA) shows changes in the power spectrum distribution over a certain period of 
time. 

DSA view shows the following information:

■ y-axis: time scale

■ x-axis: signal frequency scale from 0 to 30 Hz

■ Color bar: shows range of power. Red indicates maximum power and blue indicates minimum power.

■ Spectral edge frequency (SEF) trend: It is the white Spectral Edge line superimposed on the graph where 
95% of the total power lies on one side of the line (toward the inside of the graph) and 5% lies on the other. 

■ The current SEF value: displays above the graph.

■ ASYM graph: displays in the center of the DSA view. It shows the degree of asymmetry in EEG power 
between the left and right hemispheres. The ASYM scale begins at 20% at the center line and runs left or 
right to 100%. Asymmetry data less than 20% are not displayed on the graph, but are available in the 
tabular trends.
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23.10 BIS Troubleshooting
This section lists the problems that might occur. If you encounter the problems when using the equipment or 
accessories, check the table below before requesting for services. If the problem persists after corrective actions 
have been taken, contact the service personnel.

NOTE

• For a comprehensive list of physiological and technical alarm messages, see D Alarm Messages.

23.11 Covidien Information
Covidien Patents

This posting serves as notice under 35 U.S.C.§287(a) for Covidien patents: http://www.covidien.com/patents.

No Implied License

Possession or purchase of this device does not convey any express or implied license to use the device with 
unauthorized replacement parts or consumables which would, alone, or in combination with this device, fall 
within the scope of one or more of the patents relating to this device.

Problem Solution

Measurement does not start 1. Check the sensor attachment to the patient and the sensor placement. Check 
the sensor contact with skin.
2. Check the sensor type.
3. Check all connections and the patient cable.
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24 Monitoring Neuromuscular Transmission (NMT)

24.1 NMT Introduction
The neuromuscular transmission (NMT) module evaluates muscle relaxation of patients under neuromuscular 
block by measuring the strength of muscle reaction after electrically stimulating the dedicated motor nerve. 
Two electrodes are placed on the patient’s skin over dedicated nerve. A controllable current source delivers 
stimulation pulses to the two electrodes, and the acceleration of muscle contractions is measured with a 3-axis 
accelerometer.

NMT monitoring is intended for adult and pediatric patients.

24.2 NMT Safety Information

WARNING

• The NMT measurement is not intended for neonatal patients.

• The NMT stimulation should not be applied across or through the head, directly on the eyes, 
covering the mouth, on the front of the neck, especially the carotid sinus, or from electrodes placed 
on the chest and the upper back or cross over the heart.

• Application of electrodes near the thorax may increase the risk of cardiac fibrillation.

• Never apply electrodes to patients in areas where inflammation or injury is evident.

• When you are connecting the electrodes or the patient cable, make sure that the connectors do not 
touch any electrically conductive material including earth conductors. 

• Patients with nerve damage or other neuromuscular problems may not respond properly to 
stimulation. The NMT measurement may show unusual patterns when monitoring muscle paralysis 
in these patients. 

• NMT stimulation current pulses may interfere with other sensitive equipment, for example, 
implanted cardiac pacemakers. Do not use the NMT measurement on patients with implanted 
electronic devices unless so directed by a medical specialist.

• Simultaneous use of the NMT with high frequency electrosurgical equipment (ESU) may result in 
burns at the stimulation site and can also adversely affect measurement accuracy. Make sure the 
ESU return electrode is properly applied to the patient. 

• Do not use the NMT in close proximity to shortwave or microtherapy devices, there is a risk of 
adversely affecting the NMT measurement.

(1) Calibration hard key (2) Start/stop key

(3) Module status indicator (4) NMT patient cable connector

(1) (2)

(3)

(4)
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• Never touch the electrodes unless the stimulation has been stopped.

• Check each time before use that the material insulating the NMT sensor and the stimulation cable is 
intact and does not show signs of wear and tear. 

CAUTION
 

• NMT monitoring is intended as an adjunct in patient assessment and must be used in conjunction 
with observation of clinical signs and symptoms.

• NMT stimulation can be painful to a non-sedated patient. It is recommended not to stimulate before 
the patient is adequately sedated.

• Use only electrodes suitable for nerve stimulation deemed appropriate by the attending physician. 

• Pay special attention to current densities exceeding 2 mA r.m.s/cm2 for any electrodes.

24.3 Stimulation Modes
The NMT module provides the following stimulation modes. Some stimulation modes require a minimum 
neurophysiological recovery time and during this recovery phase no new stimulation can be started. So you 
cannot start a measurement or calibration.

24.3.1 Train-Of-Four (TOF)
TOF mode is recommended for most cases. 

In TOF mode, four stimulation pulses are generated at 0.5 second intervals. Each stimulation of the train causes 
the muscle to contract. The fade in the individual response to each single stimulation provides a basis for 
evaluation. The response is measured after each stimulus and the ratio of the fourth to the first response of the 
TOF sequence is calculated resulting in TOF-Ratio (TOF%). 

When relaxation deepens, the TOF% declines until the fourth response disappears and no TOF% is calculated. 
Low response to the first stimulus (T1) also results in TOF% unavailable. When no TOF% is available, the degree 
of neuromuscular block is estimated from the number of responses or TOF counts. The fewer the response count 
is detected, the deeper is the relaxation.

If NMT calibration establishes the reference response amplitude, response to T1 as percentage of the reference 
value is calculated resulting in T1%. 

In TOF mode, the minimum neurophysiological recovery time is 10 seconds. If NMT measurement or calibration 
is initiated during this period, it will be automatically delayed. 

24.3.2 Single Twitch (ST)
In single twitch (ST) stimulation, the module delivers a single electrical pulse and measures the strength of the 
resulting twitch, the module then calculates the ratio of measured response to the reference twitch resulting in 
ST-Ratio. 

ST mode is practical when using depolarizing relaxants since TOF% does not give any additional information 
about the patient status. Additionally, when the change of patient’s relaxation level is considered, ST stimulation 
at a frequency of 1 Hz can indicate the relaxation change in a more real-time way. 

24.3.3 Post-Tetanic Count (PTC)
When neuromuscular block deepens, different parameters are needed to measure the response. At first, when 
the response to the fourth TOF stimulation pulse disappears or the first twitch is very weak, the TOF% is not 
available and only the number of detected counts can be observed. When stimulation pulses no longer give any 
stimulation response, you do not get the TOF count either. To monitor the relaxation level, you can start tetanic 
stimulation and estimate the relaxation level from the Post Tetanic Count (PTC).

PTC stimulation mode starts with a sequence of four current pulses delivered at 2 Hz. If a muscle response is 
detected, the PTC sequence is stopped and the TOF result is reported. If there is no muscle response, the 
sequence continues with a five seconds long tetanic stimulation delivered at 50 Hz, followed by a pause of 3 
seconds, followed by 20 single current pulses delivered at 1 Hz. The number of detected responses is counted 
and expressed as PTC. The fewer responses are detected, the deeper the relaxation is.
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After tetanic stimulation, NMT measurements and calibration are disabled for 20 seconds and PTC is disabled for 
2 minutes. 

24.3.4 Double Burst Stimulation (DBS)
Double Burst Stimulation (DBS) enables better visual observing of the fading in the responses. DBS consists of 
two separate bursts at an interval of 750 ms, where each burst consists of certain pulses directly after each other 
at a frequency of 50 Hz. The response ratio of the second to the first burst is calculated resulting in DBS-Ratio, 
while the number of responses is detected and expressed as DBS Count.

The module supports DBS3.2 and DBS3.3.

■ For DBS3.2 mode, the first burst consists of 3 consecutive pulses, and the second burst consists of 2 
consecutive pulses. 

■ For DBS3.3 mode, both bursts consist of 3 consecutive pulses.

In DBS mode, the minimum neurophysiological recovery time is 15 seconds. If NMT measurement or calibration 
is initiated during this period, it will be automatically delayed. 

24.4 NMT Parameters
The following table lists the NMT parameters in different stimulation modes.

24.5 NMT Display

Stimulation Mode Parameter Label Unit Number of Bars

TOF TOF-ratio % 4

TOF-count / 4

T1% / /

ST ST-ratio % 1

ST-count / 1

PTC PTC / /

DBS DBS ratio % 2

DBS count / 2

(8)

(6)

(5)(4)(3)

(2)

(10) (9)

(1)

(7)

(1) Parameter unit

(2) Parameter value

(3) Parameter label

(4) Stimulation current 
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NOTE

• The NMT parameter values become outline font 15 minutes after the NMT measurement is taken. 

• The PTC value is shown on the display for 20 seconds after which the NMT module returns to the 
preset stimulation mode.

24.6 Accessing the On-screen NMT Guide
The monitor provides the on-screen NMT guide to help you understand NMT monitoring functions and 
operating procedure.

To access the on-screen NMT guide, follow this procedure:

1. Select the NMT numerics area or waveform area to enter the NMT menu.

2. Select the Introduction tab.

3. Select a tab as required.

◆ Select the Summary tab to view the NMT monitoring principles. 

◆ Select the Target Patients tab to view the applicable patients for NMT monitoring.

◆ Select the Points To Note tab to view the precautions before NMT monitoring.

◆ Select the Operation Guides tab to view the NMT monitoring procedure.

24.7 Preparing for NMT Monitoring

24.7.1 NMT Equipment to Patient Connection
The following picture shows NMT cable and patient connection.

(5) T1%: responses to the first stimulus as percentage of the reference amplitude in TOF mode. This value is not shown if 
calibration fails.

(6) Bar graph: indicates the amplitude of response to the stimulation. The maximum height of the bar graph displayed is 
120%. Bar graph is not shown if calibration is not completed successfully.

(7) Scale: indicates the amplitude of response to stimulation. 

(8) Measurement interval: Manual is displayed if Interval is set to Manual.

(9) Measurement countdown: time to the next measurement. The measurement countdown is not shown if Interval is set 
to Manual.

(10) The last measurement time. 

(1) NMT module (2) NMT patient cable

(3) NMT stimulation cable (4) NMT sensor cable

(5) Proximal electrode (red) (6) Distal electrode (black)

(7) NMT sensor

(3)

(5)

(6)

(1)
(2) (4)

(7)
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24.7.2 Preparing the Skin
Good electrode-to-skin contact is important for good signal quality. Before applying the electrodes, clean the 
application site of oil and dirt and avoid placing the electrodes over excessive body hair or lesions. Insufficient 
cleaning of the skin can cause high skin impedance which could cause the stimulation to stop.

To properly prepare the skin, follow this procedure:

1. Select sites with intact skin, without lesion of any kind.

2. Shave hair from skin at chosen sites. 

3. Gently rub skin surface at sites to remove dead skin cells. 

4. Thoroughly cleanse the site with a mild soap and water solution. 

5. Dry the skin completely before applying the electrodes. 

24.7.3 Placing the Electrodes and Sensor
Stimulation of the ulnar nerve in the wrist and acceleration measurements at the adductor pollicis are preferred 
for routine monitoring. When monitoring neuromuscular transmission, round surface electrodes with snap 
connection are a must. Small (pediatric or neonatal) electrodes are advisable to obtain a sufficient current 
density. In order to ensure a steady signal quality, be sure only to use CE marked electrodes.

Ensure that the thumb can move freely before applying NMT electrodes and sensor. Follow this procedure to 
place the electrodes and sensor:

1. Place the distal electrode near the wrist.

2. Place the proximal electrode 2 to 3 cm proximal of the distal electrode.

3. Attach the red clamp to the proximal electrode.

4. Attach the black clamp to the distal electrode.

5. Affix the sensor with its large flat side against the palmar side of the thumb with a piece of tape. The cable 
should be attached in such a way that it does not 'pull' at the sensor and that movement of the thumb is 
not obstructed. 

CAUTION

• When placing the electrodes, make sure that they do not touch each other.

• If the electrodes are placed incorrectly, wrong nerves are stimulated and this causes wrong muscle 
response.

• When multiple nerves are stimulated, the measured response may be affected by activity of other 
muscles.

• If the stimulation electrodes are placed very close to the palm of the hand, the muscles are 
stimulated directly by the stimulation pulses.

• If the current is too strong, it may stimulate the muscles too much.

• Moving or touching the patient during measurement may cause incorrect results.

• Make sure that the NMT cables does not contact external pacemaker or catheter wires.

• To avoid unintentional electrical shocks always make sure that the NMT stimulation has been 
stopped before touching the electrodes.

• Take care to handle the NMT sensor, avoiding forcefully striking the sensor.

• After repositioning the patient, check the NMT sensor application site and ensure that the sensor is 
still properly applied and the thumb can move freely.
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CAUTION

• Correct positioning of the electrodes is important. Small displacements may result in considerable 
changes in stimulation current requirements. Furthermore, the electrodes must be positioned in 
such a way to avoid direct stimulation of the muscle. 

• The electrodes should be applied properly to the patient skin. It has been found that slight pressure 
on the electrodes may improve the stimulation considerably. Therefore, taping the electrodes to the 
skin may be advisable.

• The more distal the sensor is placed on the thumb, the stronger the acceleration signal. This effect 
can be used to adjust the signal strength.

• During NMT measurement, the arm applied with NMT electrodes and sensor should be kept 
immobile during the whole procedure.

24.8 Calibrating the NMT Measurement
The size of the sensor signal varies from patient to patient. NMT calibration determines supramaximal 
stimulation current and the reference response amplitude. The reference response amplitude is the twitch at the 
supramaximal stimulation current when the patient is not paralyzed. The calibration must be done prior to 
administration of a muscle relaxant drug.

CAUTION

• Start calibration before the administration of a muscle relaxant drug (but after the induction of 
sleep in general anesthesia) to prevent voluntary muscle contraction and tension from interfering 
with the reference search.

24.8.1 Setting the Calibration Current
If you set Stimulation Current to Supra (60 mA), the module automatically searches for supramaximal current 
to determine the reference response amplitude. If you select a value between 0 and 60 mA, the reference 
response amplitude is determined using the selected stimulation current. For adults, the supramaximal current 
is usually between 35 and 55 mA. For more information, see 24.11.2 Changing the Stimulation Current.

24.8.2 Starting NMT Calibration
To Start NMT calibration, follow this procedure:

1. Select the NMT numeric area to enter the NMT menu.

2. Select the Setup tab.

3. Verify that the settings of Stimulation Current and Pulse Width.

4. Press the calibration hard key on the NMT module or select Calibrate at the bottom of the NMT menu to 
start calibration.

If calibration  succeeds, the message Calibration Completed displays on the NMT menu. If calibration failed, the 
NMT module automatically uses the default value as the reference amplitude.

NOTE

• It is recommended that the patient be anesthetized before setting up the calibration twitch as nerve 
stimulation can be painful.

• Changing the stimulation current or pulse width after calibration invalidates the stored reference 
data, and therefore recalibration is required.
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24.9 Starting NMT Measurements
At the completion of NMT calibration, the monitor automatically starts a TOF mode measurement.

You can also choose either of the following ways to start NMT measurements:

■ Press the Start/stop key on the NMT module.

■ From the Measure tab of the NMT menu, select a measurement mode, set Interval, and select Start (XX) 
to start NMT measurement at corresponding mode. 

NOTE

• Stop NMT measurements if you need to change the NMT settings.

• Take care when removing the sensor from the patient. Do not pull on the cable.

24.10 Stopping NMT Measurements
Choose either of the following ways to stop an on-going NMT measurement. 

■ Press the Start/stop key on the NMT module. 

■ Select Stop All at the bottom of the NMT menu. 

24.11 Changing NMT Measurement Settings

24.11.1 Selecting the NMT Measurement Mode
To select the NMT measurement mode, follow this procedure:

1. Select the NMT numeric area to enter the NMT menu.

2. Select the Measure tab.

3. Select the desired stimulation mode.

4. If you select TOF Mode, ST Mode, or DBS mode, select Interval to set the time interval between two 
measurements.

24.11.2 Changing the Stimulation Current
Before calibration and NMT measurement, confirm that the desired stimulus current is selected. To set the 
simulation current, follow this procedure:

1. Select the NMT numeric area to enter the NMT menu.

2. Select the Setup tab.

3. Set Stimulation Current.

◆ When Stimulation Current is set to Supra, the module automatically searches for supramaximal 
current to determine the reference response amplitude. For adults, the supramaximal current is 
usually between 35 and 55 mA. Smaller currents may be desirable for children.

◆ If Stimulation Current is set to a value between 0 and 60 mA, the reference response amplitude is 
determined using the selected stimulation current.

NOTE

• Stimulation current is adjusted in increments of 5 mA.

24.11.3 Changing the Pulse Width
You can increase the pulse width to increase the effect of the stimulation to help finding the supramaximal 
current. To set the pulse width, follow this procedure:
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1. Select the NMT numeric area to enter the NMT menu.

2. Select the Setup tab.

3. Set Pulse Width.

24.11.4 Enabling Block Recovery Notification
A message “NMT Block Recovery” is displayed in the technical alarm information area to notify you when the set 
block recover limit is reached. This indicates that the patient is responding more clearly to the stimuli and the 
neuromuscular block is decreasing. This notification can be used, for example, to help maintain a certain 
relaxation level. 

To enable the block recovery notation and set the limit for activating the note, follow this procedure:

1. Select the NMT numeric area to enter the NMT menu.

2. Select the Setup tab.

3. Set Block Recovery. If Block Recovery is set to Off, the monitor will not give a note.

24.11.5 Adjusting NMT Stimulation Beep Volume
The monitor gives a beep at the selected volume at each stimulation pulse if the setting is not zero. To adjust the 
volume of NMT stimulation beep, follow this procedure:

1. Select the NMT numeric area to enter the NMT menu.

2. Select the Setup tab.

3. Set Stimulation Beep Volume.

24.12 Recalling Calibration Information
In the situation that the NMT module is power down, or you want move the NMT module to another monitor 
along with the patient and you want to continue with the already determined calibration information, including 
stimulation current, pulse width, and reference response amplitude, you can use the recall function. 

To recall the calibration information, follow this procedure:

1. Select the NMT numeric area to enter the NMT menu.

2. Select the Recall Reference tab.

3. Select Recall Reference.

24.13 NMT Troubleshooting
This section lists the problems that might occur. If you encounter the problems when using the equipment or 
accessories, check the table below before requesting for services. If the problem persists, contact the service 
personnel.

NOTE

• For a comprehensive list of physiological and technical alarm messages, see D Alarm Messages.

Problem Solution

NMT calibration and measurement fails. 1. Check that the electrodes are properly applied. 
2. Replacing the electrodes.

NMT measurement is disturbed. 1. Do not touch the arm where electrodes are applied. 
2. Check that the electrodes and NMT sensor are properly applied.

Supramaximal current cannot be found. Check that the electrodes are properly applied. Also, supramaximal 
current may not be found if the patient is already relaxed.
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25 Monitoring Regional Oxygen Saturation (rSO2)

25.1 rSO2 Introduction

The rSO2 (Regional Oxygen Saturation) monitoring provides noninvasive and continuous information of 
changes in regional oxygen saturation of blood. The measurement takes place in real time, providing an 
immediate indication of a change in the critical balance of regional oxygen delivery and oxygen consumption.

The harmless, near-infrared wavelengths generated by the INVOS System’s light-emitting diodes pass through 
scalp and bone tissue beneath the sensor. Once in vivo they are either absorbed or scattered back up to the 
sensor’s shallow and deep detectors. Red-colored hemoglobin molecules within red blood cells have the highest 
light absorption of the wavelengths used, and the exact shade of red of each hemoglobin molecule indicates the 
amount of oxygen it is carrying. The type and quantity of absorption data returned to the detectors reflects de-
oxyhemoglobin and total hemoglobin, from which a regional oxygen saturation (% rSO2) value unique to the 
specific area under the sensor is calculated. 

(1) Light source (2) Shallow detector (3) Deep detector 

(4) rSO2 dialog hard key (5) Set the baseline for all rSO2 channels

(6) Module status indicator (7) rSO2 cable connector

(1)

(2)

(1)
(2)
(3) ((3)

(4) (5)

(6)

(7)
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25.2 rSO2 Safety Information

CAUTION

• rSO2 monitoring is intended for use in individuals greater than 2.5 kg at risk for reduced-flow or no-
flow ischemic states. 

• Do not use the rSO2 value as the sole basis for making decisions regarding diagnosis or therapy 
because the rSO2 values represent a small volume of tissue beneath the sensor and may not reflect 
oxygenation disturbances that occur elsewhere. 

• Use only recommended or provided accessories. Using any other sensor will compromise accuracy.

• Use of an electrosurgical instrument in the vicinity of the monitor may interfere with the signal and 
result in inaccurate rSO2 measurement.

NOTE
• Environments with excessive ambient light such as bright sunlight or strong operating room 

lighting may require loosely covering the area of the sensor with an opaque drape.

25.3 rSO2 Measurement Limitations

If present, the following may cause inaccurate readings:

■ Cardiogreen, indigo carmine or other intravascular dyes

■ Carboxyhemoglobin or other dyshemoglobins

■ Hemoglobinopathies

■ Conjugated hyperbilirubinemia (direct)

■ Myoglobin (Mb) in muscle tissues

25.4 rSO2 Display

rSO2-1 and rSO2-2 are from the first inserted rSO2 module. rSO2-1' and rSO2-2' are from the second inserted rSO2 
module. Each rSO2 numeric area displays one rSO2 channel, which is shown as below:

(7)

(6)                                 (5)

(1)

(2)                                              (3)

(4)

(8)

(9)

(1) rSO2 label (2) Channel indicator

(3) Baseline (BL) (4) Signal Strength Indicator (SSI)
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25.5 Accessing the On-screen rSO2 Guide

The monitor provides the on-screen rSO2 guide to help you understand rSO2 monitoring principles, functions, 
and operating procedure. To access the on-screen rSO2 guide, follow this procedure:

1. Select the rSO2 numeric area to enter the rSO2 dialog.

2. Select the Introduction tab.

3. Select the desired tab of Summary Target Patients, Points To Note, or Operation Guides.

25.6 Preparing for rSO2 Monitoring 
1. Select the site for sensor placement. For more information, see 25.6.1 rSO2 Sensor Site Selection.

2. Prepare the patient skin. For more information, see 25.6.2 Preparing the Skin.

3. Apply the rSO2 sensor. For more information, see 25.6.3 Applying the rSO2 Sensor.

4. Connect the rSO2 parts. For more information, see 25.6.4 Connecting the rSO2 Parts.

25.6.1 rSO2 Sensor Site Selection

The rSO2 sensor can be placed on the proper cerebral or somatic site. 

■ Cerebral site selection: select sensor site on the right and/or left side of forehead. Placement of the sensor 
in other cerebral locations, or over hair, may cause inaccurate readings.

■ Somatic site selection: select sensor site over tissue area of interest (site selection will determine which 
body region is monitored) 

CAUTION

• For cerebral site selection, do not place the sensor over nevi, sinus cavities, the superior sagittal 
sinus, subdural or epidural hematomas, injured skin or other anomalies such as arteriovenous 
malformations, as this may cause readings that are not reflective of brain tissue or no readings at all.

• For somatic site selection, avoid placing the sensor over thick fatty deposits, hair or bony 
protuberances. Do not place the sensor over nevi, hematomas or broken skin, as this may cause 
readings that are not reflective of somatic tissue or no readings at all.

NOTE

• For the somatic site selection, see the instruction for use of corresponding sensor for detailed 
information.

25.6.2 Preparing the Skin
To achieve the optimal measurement result, the sensor application site should be clean and dry. To properly 
prepare the skin, follow this procedure:

1. Shave hair from skin at chosen sites. 

2. Gently rub skin surface at sites to remove dead skin cells.

3. Thoroughly cleanse the site with a mild soap and water solution. 

4. Dry the skin completely before applying the sensors. 

(5) Change percentage of the rSO2 realtime value and baseline (If the rSO2 value is greater than or equal to the 
baseline, the arrowhead is upward; If the rSO2 value is smaller than the baseline, the arrowhead is downward)

(6) Realtime rSO2 value (7) Upper and lower rSO2 alarm limits

(8)rSO2 rolling average of latest 60 minutes (9) Area Under the Curve (AUC)
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25.6.3 Applying the rSO2 Sensor

Follow this procedure to apply the rSO2 sensor to patient:

1. Remove the protective backing label from the adhesive side of the sensor and apply the sensor to the skin.

2. Continue applying the sensor by smoothing it to the skin from the center outward. Ensure edges of the 
sensor are sealed to prevent light from entering.

CAUTION

• The sensor is designed for single use only and can not be reused. Reuse may cause inaccurate 
readings, erratic readings, or no readings at all. Also, reuse may cause an increased risk of cross-
contamination among patients. 

• The sensor is designed for external use only as described in the instructions. Do not use the sensor 
internally for any reason.

• Do not place the sensor on regions with severe tissue edema to reduce the possibility of skin lesions.

• Do not autoclave or gas sterilize the sensor.

NOTE

• Use care when placing orremoving sensor. Do not place on broken or undeveloped skin.

• For extended monitoring, it is recommended to use a new sensor every 24 hours or if adhesive is 
inadequate to seal the sensor to the skin.

• To avoid pressure sores do not apply external pressure (e.g. headbands, wraps, or tape) to sensor.

25.6.4 Connecting the rSO2 Parts
1. Connect Preamplifier(s) to the rSO2 module. Align red dot on the silvery connector of the Preamplifier with 

red dot on rSO2 cable connector.

2. Connect the following devices as per patient category:

◆ For neonatal patients, connect the neonatal sensor directly to the Preamplifier.

◆ For pediatric or adult patients, a reusable sensor cable is needed for the connection of the 
Preamplifier and the sensor. Use color-coding when connecting the Preamplifier and the reusable 
sensor cable.

NOTE
• Different sensors (adult, pediatric and infant/neonatal) cannot be used simultaneously on the same 

monitor. Cerebral sensors can be used with somatic sensors on the same monitor.

(1) rSO2 module (2) Preamplifier (3) Reusable sensor cable

(3)
(2)

(1)
25 - 4  BeneVision N22/N19/N17/N15/N12 Patient Monitor Operator’s Manual



25.7 Changing rSO2 Settings

25.7.1 Changing rSO2 Alarm Settings

To change the rSO2 alarm settings, follow this procedure:

1. Select the rSO2 numeric area to enter the rSO2 dialog.

2. Select the Alarm tab.

3. Enter the password if required. For more information, refer to 33.14.3 Selecting Password for User 
Authentication.

4. Set alarm properties as desired.

25.7.2 Setting the rSO2 Auto Low Limit Switch

To set the rSO2 auto low alarm limit, follow this procedure:

1. Select the rSO2 numeric area to enter the rSO2 dialog.

2. Select the Alarm tab.

3. Set Auto Low Limit switch.

◆ If Auto Low Limit is switched on, rSO2-1 Variance and  rSO2-2 Variance are activated to allow you 
to set the percentage of rSO2 low limits below the baseline. Then the monitor calculates the rSO2 low 
limits automatically based on the setting.

◆ If Auto Low Limit is switched off, the rSO2 low limits should be set manually.

25.7.3 Setting the rSO2 Label

To set the rSO2 label, follow this procedure:

1. Select the rSO2 numeric area to enter the rSO2 dialog.

2. Select the Setup tab.

3. Set rSO2-1 Label and rSO2-2 Label.

25.7.4 Setting the AUC Mode
To set the AUC mode, follow this procedure:

1. Select the rSO2 numeric area to enter the rSO2 dialog.

2. Select the Setup tab.

3. Set AUC Mode.

◆ Select Fixed to activate the item Fixed Threshold. In this case, AUC is calculated according to the 
configured fixed threshold.

◆ Select Below Base Percentage to activate the item Percentage Below Baseline. In this case, AUC is 
calculated according to the configured percentage below baseline.

25.7.5 Setting the Baseline
To set the rSO2 baseline for the respective channel, follow this procedure:

1. Select the rSO2 numeric area to enter the rSO2 dialog.

2. Select the Baseline tab.

3. Select Set Baseline. The monitor automatically sets the current rSO2 value as the baseline.

You can also set the baselines for all rSO2 channels by the following two methods:

■ Select Set Baselines in the lower left corner of the rSO2 dialog.

■ Press the hard key at the upper right of the rSO2 module.
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Then the monitor set the baselines for all rSO2 channels according to their respective current rSO2 values.

NOTE

• Set the rSO2 value measured when patient is sober and eupraxic as baseline. The baseline will be set 
automatically if it is not set within 5 to 6 minutes and current rSO2 value is effective.

25.7.6 Selecting rSO2 Parameters for Display

In the rSO2 numeric area, rSO2 and SSI are permanently displayed parameters, and other parameters are 
selectable. To select the parameters for display, follow this procedure:

1. Select the rSO2 numeric area to enter the rSO2 dialog.

2. Select the Select Parameter tab.

3. Select the parameters for display.

25.8 Covidien Information
Covidien Patents

This posting serves as notice under 35 U.S.C.§287(a) for Covidien patents: http://www.covidien.com/patents.

No Implied License

Possession or purchase of this device does not convey any express or implied license to use the device with 
unauthorized replacement parts or consumables which would, alone, or in combination with this device, fall 
within the scope of one or more of the patents relating to this device.
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26 Review

26.1 Review Overview
Trends are patient data collected over time and displayed in graphic, tabular, or other forms to give you a picture 
of how the patient's condition is developing. The Review dialog also enables access to review the events, 12-
lead ECG analysis results and waveforms, full disclosure waveforms, and so on.

26.2 Review Dialog
The Review dialog contains tabs to display trend data in tabular, graphic, or other forms. 

26.2.1 Accessing the Review Dialog
Choose one of the following methods to enter the review dialog:

■ Select the Review quick key.

■ Select the Main Menu quick key → from the Review column select the desired option. 

26.2.2 Example Review Dialog
The review pages have a common structure. The graphic trends review page is taken as an example: 

(5)

(7)

(6)

(1)
(2)

(3)

(4) (8)

(9)

(1) Event type indicator: different color blocks match different types of events:
■ Red: high priority alarm event

■ Yellow: medium priority alarm event

■ Cyan: low priority alarm event

■ Green: manual event

■ White: operation-related event

(2) Current screen time line: indicates the time length of the current screen. 

(3) Waveform area: displays trend curves. The color of trend curves is consistent with the color of parameter labels.
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26.2.3 Symbols on Review Pages
The following table lists the symbols on review pages.

26.2.4 Common Operations 
This section describes common operations for all review pages.

26.2.4.1 Browsing Trend Data

Browse trend data in one of the following ways:

■ Move the cursor.

■ Move the slider .

■ Slide your finger on the screen.

26.2.4.2 Viewing Events

You can view the following types of events:

■ Manually triggered events

■ Parameter-related operation events and alarm-related events, such as starting NIBP measurement

■ Operation events not related to parameters, such as system time change

View events in either of the following ways:

(4) Time line: indicates the entire time length.
■ : indicates the time length of trend data.  can be moved within this time length.

■ : indicates the time length of no trend data.  cannot be moved within this time length.

■ Different color blocks along the time line indicate events of different types. See the color definition for the 
event type indicator.

(5) Event area: displays the event of the cursor time. Selecting the event accesses the event list. If there is no event at 
the cursor time, the cursor time is displayed.

(6) Cursor: this is adjusted by touching different locations. Adjusting this changes the data displayed in the Event 
area and Numeric area.

(7) Numeric area: displays numeric values at the cursor indicated time. The background color of numeric values 
matches the alarm priority.

(8) Slider: indicates the position of current screen time in the entire time length. Dragging this button left or right 
enables you to locate the trend data at a specific time and also refreshes trend data in current screen 
accordingly.

(9) Button area.

Symbol Description

Slider: indicates the position of current screen time in the entire time length. Dragging 
the slider left or right enables you to locate the trend data at a specific time and also 
refreshes data in current screen accordingly.

 or  Goes to the previous or next event.

 Event list: displays events in a chronological order. The most recent event is displayed 
at the top. The number of asterisk symbols before an event indicates alarm priority.

 or Selecting this symbol displays two review pages simultaneously.

Record button: select it to output patient information and data through the recorder.

 Print button: select it to output patient information and data through the printer.

+ Indicates that the followed parameter is from an external device connected to the 
monitor via the BeneLink module.
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■ Select  and select the desired event.

■ Select  or  to jump to the previous event or next event. 

Events are displayed in a chronological order. The most recent event is displayed at the top. The number of 
asterisk symbols before an event indicates alarm priority as follows: 

■ ***: high priority alarm

■ **: medium priority alarm

■ *: low priority alarm

26.2.4.3 Displaying Two Review Pages Simultaneously

For N22/N19, you can display two review pages simultaneously.  To do so, follow this procedure:

1. Enter the desired review page by one of the following methods:

◆ Select the Review quick key → select the desired tab.

◆ Select the Main Menu quick key →  from the Review column select the desired item. 

2. Select  (for landscape display) or  (for portrait display) to open a duplicate view that can be 
navigated independently.

26.2.5 Tabular Trends Review Page
The tabular trends review page displays trend data in a tabular form. 

26.2.5.1 Entering the Tabular Trends Review Page

 Choose one of the following methods to enter the tabular trends review page:

■ Select the Review quick key → select the Tabular Trends tab.

■ Select the Main Menu quick key → from the Review column select Tabular Trends. 

26.2.5.2 Changing the Tabular Trend Group

To change the tabular trend group, follow this procedure:

1. Enter the tabular trends review page.

2. Set Trend Group.

26.2.5.3 Editing the Tabular Trend Group

The setting of the Trend Group defines the contents of displayed trends. It is possible to edit any trend group 
except for the All and Standard trend groups. To do so, follow this procedure:

1. Enter the tabular trends review page:

2. Select Group Setup → select the desired tab.

◆ Rename the trend group (optional): select the  symbol at the upper left corner and input the 
desired name.

◆ Add parameters: select desired parameters from the Choices column, and then select Add. Selecting 
Add All adds all parameters (up to the maximum of 83).

◆ Delete parameters: select desired parameters from the Selected column, and then select Delete. 
Selecting Delete All deletes all parameters except for HR.

◆ Move the position of parameters displayed on the trend page: select desired parameters from the 
Selected column, and then select Move up, Move Down, Move to Top, or Move to Bottom.

◆ Display two parameters side by side: select two parameters from the Selected column, and then 
select Overlap. Then, the symbol  appears at the right of the overlapped parameters. The 
overlapped parameters will be displayed side by side in one numerics area and waveform area.

◆ Unoverlap two parameters: select the overlapped parameters from the Selected column, and then 
select Unoverlap.

Selecting Default will restore the trend group settings to factory defaults. 
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NOTE

• Trend groups labeled All or Standard cannot be edited.

• The HR parameter and waveform are always displayed in the first row on the trend page. It cannot be 
deleted or moved.

26.2.5.4 Changing the Resolution of Tabular Trend Data

The interval of tabular trends defines the interval of displaying trend data. A short interval is especially suited for 
neonatal applications, where the clinical situation may change very quickly. In adult monitoring, where the 
patient's status typically changes more gradually, a longer interval may be more informative.

To change the interval of trend data, follow this procedure:

1. Enter the tabular trends review page.

2. Select Interval.

◆ 5 sec or 30 sec: select to view up to 4 hours of tabular trends at an interval of 5 seconds or 30 seconds.

◆ 1 min, 5 min, 10 min, 15 min, 30 min, 1 hr, 2 hrs, or 3 hrs: select to view up to 120 hours of tabular 
trends at selected interval.

◆ Select parameters, such as NIBP, or GCS, to view the tabular trends when these parameter 
measurements are acquired.

NOTE

• Changing between intervals does not typically change the position of the slider or cursor except to 
round it to the nearest interval, however changing intervals to be 30 seconds or less will move any 
cursor position more than 4 hours ago to the oldest data less than 4 hours ago.

26.2.5.5  Printing a Tabular Trends Report

To print a tabular trends report, follow this procedure:

1. Enter the tabular trends review page.

2. Select  to enter the Print Setup dialog.

3. Set the tabular trends report as described in 30.6.3 Configuring Tabular Trends Reports.

4. Select Print or Print (All).

◆ Print: the trend data before the above set Time, for the above set Period, and at the above set 
Interval will be printed.

◆ Print (All): all the stored trend data will be printed at the review interval.

26.2.5.6 Recording Tabular Trends

To print tabular trends with the recorder, follow this procedure:

1. Enter the tabular trends review page.

2. Select  to enter the Record Setup dialog.

3. Respectively set Start Time and End Time of the tabular trends data.

4. Select Record or Record (All).

◆ Record: the trend data between the Start Time and End Time will be recorded.

◆ Record (All): all the stored trend data at the review interval will be recorded.

26.2.6 Graphics Trends Review Page
The graphic trends review page displays trend data in a visual format.

26.2.6.1 Entering the Graphic Trends Review Page

Choose one of the following methods to enter the graphic trends review page:
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■ Select the Review quick key → select the Graphic Trends tab.

■ Select the Main Menu quick key → from the Review column select Graphic Trends. 

26.2.6.2 Changing the Graphic Trend Group

To change the graphic trend group, follow this procedure:

1. Enter the graphic trends review page.

2. Set Trend Group.

26.2.6.3 Editing the Graphic Trend Group
1. Enter the graphic trends review page.

2. Select Group Setup.

For more information, see 26.2.5.3 Editing the Tabular Trend Group for detail on how to edit the group.

26.2.6.4 Changing the Resolution of Trend Data

To change the length of trend data displayed on the current screen, follow this procedure:

1. Enter the graphic trends review page.

2. Select Zoom.

◆ 8 min: the screen displays eight minutes of trend data. You can view the most recent one hour of 
data.

◆ 30 min, 1 hr, 2 hrs, 4 hrs: the screen displays 30 minutes, one hour, two hours, or four hours of trend 
data. You can view the most recent four hours of data.

◆ 8 hrs, 12 hrs, 24 hrs, 48 hrs: the screen displays 8 hours, 12 hours, 24 hours, or 48 hours of trend data. 
You can view the most recent 120 hours of data.

26.2.6.5 Changing the Number of Waveforms

To change the number of waveforms displayed on the trend review page, follow this procedure:

1. Enter the graphic trends review page.

2. Select Trends. 

26.2.6.6 Printing a Graphic Trends Report

To print a graphic trends report, follow this procedure:

1. Enter the graphic trends review page.

2. Select  to enter the Print Setup dialog.

3. Set the graphic trends report as described in 30.6.4 Configuring Graphic Trends Reports.

4. Select Print to print the graphic trend data before the above set Time and for the above set Period.

26.2.7 Events Review Page
The monitor stores events in real time, including technical alarm events, physiological alarm events, manual 
events, and operational events. When an event occurs, all the measurement numerics and three event-related 
waveforms 16 seconds before and after the event are stored. 

NOTE

• Alarms are saved as events and will be maintained if the equipment is powered down. The time of 
equipment power down is not recorded as an event and cannot be reviewed.

• Earlier events will be overwritten by later ones if the storage capacity is reached.

• A total loss of power does not affect the events already stored.
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26.2.7.1 Entering the Events Review Page

Choose one of the following methods to enter the events review page:

■ Select the Review quick key → select the Events tab.

■ Select the Main Menu quick key → from the Review column select Events. 

The Event page displays the event list.  Events are displayed in descending chronological order, with the most 
recent displayed at the top. The number of asterisk symbols before an event indicate alarm priority as described 
in 8.3.3 Alarm Indicators.

Different color blocks are displayed on the left of each event to indicate different event types.

■ Red: high priority alarm event

■ Yellow: medium priority alarm event

■ Cyan: low priority alarm event

■ Green: manual event

■ White: operation-related event

The number of currently selected events and the total number of events are displayed at the top right corner of 
the event list. For example, 2/4 indicates that the selected event is the second event in the filtered events and the 
total number of filtered events is 4. Total indicates the total number of events. For example: Total: 28 means that 
there are a total of 28 events.

26.2.7.2 Configuring the Filter 

You can filter events to facilitate event review. To configure the filter, follow this procedure:

1. Enter the Events page.

2. Select Filter. From the drop-down list, select the desired filter item.

You can create up to two sets of custom filter. To do so, follow this procedure:

1. From the Filter drop-down list, select Custom 1 or Custom 2 to enter the Filter Setup menu.

2. Select the Name field to edit the name of the custom filter criterion.

3. Select the desired items.

If you want to review events which happened around certain time, select the  button → set the time → 
select Ok. The cursor then jumps to the event happened closest to the time entered.

26.2.7.3 Editing Events

To edit events, follow this procedure:

1. Enter the Events page and tick off the desired events.

2. Select  to edit the selected events.

◆ Lock: manually lock the event. Locked events cannot be deleted.

◆ Note: enter comments for the event.

◆ Rename: allow renaming an event name. Only manual events and arrhythmia events can be renamed 
if enabled by the hospital’s settings.

26.2.7.4 Viewing Event Details

To view waveforms and parameter values at the event time, follow this procedure:

1. Enter the Events page.

2. Select Detail.

To display beat labels on the first ECG waveform, switch on Beat Anno. The white beat labels indicate heart 
beats classification and may explain suspected, missed, or false arrhythmia calls. Heart beats are classified as 
follows:

■ N = Normal

■ V = Ventricular ectopic
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■ S = Supraventricular premature

■ P = Paced

■ L = Learning

■ ? = Insufficient information to classify beat

■ I = Inoperative (for example, Lead Off ) 

■ M = Missed beat

If you switch on Beat Anno on the Events page, beat labels will also be displayed on the Full Disclosure page, 
and vise versa. Beat labels can be printed out.

26.2.7.5 Printing Event Reports

To print event reports via a printer, follow this procedure:

1. Enter the events review page.

2. Select  to enter the Print Setup dialog.

3. Select the desired options.

◆ Print All Event List: print the entire event list.

◆ Print List of Selected Events: print the list of selected events.

◆ Print Detail of Selected Events: print the details of selected events.

◆ Print Displayed Event Detail: print the waveforms and parameters of the currently displayed event. 

4. Select Print.

26.2.7.6 Recording Event Details

To print events details via a recorder, follow this procedure:

1. Enter the events review page.

2. Select the Detail button.

3. Select  to print the details of the event.

NOTE

• When a parameter label is prefixed with the plus sign (+) on a printout, it indicates that the data is 
from an external device.

26.2.8 Full Disclosure Review Page
You can review up to 48 hours of waveform data on the full disclosure review page. You can view both the 
compressed waveforms and numeric values.

26.2.8.1 Entering the Full Disclosure Review Page

Choose one of the following methods to enter the full disclosure review page:

■ Select the Review quick key → select the Full Disclosure tab.

■ Select the Main Menu quick key → from the Review column select Full Disclosure. 

26.2.8.2 Selecting Waveforms

You can select the waveforms to be displayed and stored. Up to 48 hours of waveforms for all parameters can be 
stored. When closing the Select Waveform dialog, a prompt will inform you of the duration of waveforms that 
can be saved if the amount is less than 48 hours. To save and display the desired waveforms, follow this 
procedure:

1. Enter the full disclosure review page.

2. Select Setup to enter the Select Waveform page.
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3. Select the Storage tab and set the desired waveforms to be stored in the monitor. Select the Display 
(Maximum: 3) tab and set the desired waveforms to be displayed on the Full Disclosure page.

NOTE

• Storing more waveforms may shorten the storage time to less than 48 hours. Please adjust the 
waveforms stored with this consideration.

• Parameter labels from external devices are prefixed with the plus sign (+).

In case of alarms, the background of the compressed waveform is highlighted with a colored block during the 
alarm time:

■ Red: high alarm priority

■ Yellow: medium alarm priority

■ Cyan: low alarm priority

26.2.8.3 Setting the Scale and Duration

To set the length and size of displayed compressed waveforms, follow this procedure:

1. Enter the full disclosure review page.

2. Set the waveforms scale in either of the following ways:

◆ Select the Scale button. If you do not see Scale, select the  button to show it.

◆ Select the waveform label. 

3. Select Duration to set the length of displayed waveforms.

4. Select the parameter label beside the waveforms to set scale for each parameter.

26.2.8.4 Viewing Details of Compressed Waveforms

To view the full waveforms and numeric values, follow this procedure:

1. Enter the full disclosure review page.

2. Select Detail.

You can perform the following operations on the this page:

■ Switch on Beat Anno. For more information, see 26.2.7.4 Viewing Event Details.

■ Select Speed, ECG Gain, or Save As Event. If you do not see an option, then select the  button to 
show it.

■ Select Overview to switch to the compressed waveform view.

26.2.8.5 Printing the Full Disclosure Waveform Report

To print a compressed waveform report, follow this procedure:

1. Enter the full disclosure review page.

2. Select  to enter the Print Setup dialog.

3. Select waveform type you want to print:

◆ Print Waveform Overview: compressed waveform of selected period will be printed. This option is 
only available when printing from the Overview or compressed waveform view.

◆ Print Displayed Waveform Detail: parameter values and all stored waveforms around the cursor 
time will be printed. This option is only available when printing from the Detail view.

4. Select Print.

NOTE

• When a parameter label is prefixed with the plus sign (+) on a printout, it indicates that the data is 
from an external device.
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26.2.8.6 Recording the Details of the Compressed Waveform

To record a Full Disclosure Detail Record Report, follow this procedure:

1. Enter the Full Disclosure page.

2. Select Detail.

3. Select .

NOTE

• When a parameter label is prefixed with the plus sign (+) on a printout, it indicates that the data is 
from an external device.

26.2.9 Arrhy Statistics Review Page
The Arrhy Statistics review page shows arrhythmia events happened over the lastest 24 hours. This page is only 
available with the ECG 24h Summary option.

To enter the Arrhy Statistics review page, choose one of the following methods:

■ Select the Review quick key → select the  Arrhy Statistics tab.

■ Select the Main Menu quick key → from the Review column select  Arrhy Statistics. 

Selecting each type of arrhythmia statistics bar shows compressed waveforms, the time and duration of each 
arrhythmia event. Selecting the compression waveform shows the event details.

26.2.10 OxyCRG Review Page
You can review up to 48 hours worth of 4 minute trend curves on the OxyCRG review page. The OxyCRG review 
functionality is available for neonatal monitoring only.

NOTE

• OxyCRG Review Page is available only when Patient Category is set to Neo.

26.2.10.1 Entering the OxyCRG Review Page

Choose one of the following methods to enter the OxyCRG review page:

■ From the OxyCRG screen, select the ABD events list area.

■ Select the Review quick key → select the OxyCRG tab.

■ Select the Main Menu quick key → from the Review column select OxyCRG. 

26.2.10.2 The Display of the OxyCRG Review Page

The following figure shows the OxyCRG screen:
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26.2.10.3 Changing the Resolution of Trend Curves

To set the resolution of trend curves, follow this procedure:

1. Enter the OxyCRG review page.

2. Set Zoom.

NOTE

•  If the Zoom is set for a large duration (for example, 8 hrs), the screen may show "No Patient Data" for 
the first several minutes of data collection (for example, 6 minutes), but data will be shown after 
enough data has been collected.

26.2.10.4 Printing an OxyCRG Review Report

To print an OxyCRG review report, follow this procedure:

1. Enter the OxyCRG review page.

2. Select  to enter the Print Setup dialog.

3. Select Print. The report duration corresponds to the duration of data shown on the screen.

26.2.11 12-Lead ECG Review Page
When 12-lead ECG analysis is performed, you can review the most recent 20 events of 12-lead analysis. For more 
information, see 10 Resting 12-Lead ECG Analysis.

26.2.11.1 Entering the 12-Lead Review Page

Choose one of the following methods to enter the 12-lead ECG review page:

■ Upon completion of 12-lead ECG analysis, select Review from the 12-Lead Interpretation page. For more 
information, see 10 Resting 12-Lead ECG Analysis.

■ Select the Review quick key → select 12-Lead ECG.

■ Select the Main Menu quick key → from the Review column select 12-Lead ECG.

(3)

(4)

(2)(2)

(1)

(1) Event title area: displays information of the selected event, such as the event type and time.

(2) Event detail area: displays 4 minutes of parameter trends and compressed waveform, and parameter 
values of the selected event.

(3) Event summary area: displays ABD events within the Zoom period. The selected event is enclosed in 
a white frame.

(4) Event statistics area: displays the total number of ABD events and the numbers of each event within 
the Zoom period.
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26.2.11.2 Switching to Median Complex (for Glasgow Algorithm Only)

The median complex template displays 12-lead ECG waveforms on one page in 4 columns, with 3 lines in each 
column, and one rhythm lead waveform at the bottom. Additionally, a short vertical bar appears above each 
waveform, marking the start and end positions of the P-wave and the QRS-wave and the end position of T-wave. 

To view Median Complex, follow this procedure:

1. Enter the 12-lead review page.

2. Select Median Complex.

Selecting Waveform can return to the 12-lead ECG waveform page.

26.2.11.3 Setting 12-Lead ECG Waveforms

To set the 12-lead ECG waveforms on the review page, follow this procedure:

1. Enter the 12-lead review page.

2. Set Speed, Gain, and Layout.

26.2.11.4 Printing the 12-Lead ECG Report

To print the 12-Lead ECG report, follow this procedure:

1. Enter the 12-lead review page.

2. Select .

3. Configure the 12-lead ECG report.

4. Select Print.

26.2.11.5 Recording the 12-Lead ECG Report

To print the 12-Lead ECG report via the recorder, follow this procedure:

1. Enter the 12-lead review page.

2. Select .

26.2.12 ST Review Page
When ST analysis is enabled, the monitor saves ST segments and values at an interval of one minute. You can 
review the latest 120 hours of ST data.

26.2.12.1 Entering the ST Review Page

Choose either of the following methods to enter the ST review page:

■ Select the Review quick key → select the ST tab.

■ Select the Main Menu quick key → from the Review column select ST.

26.2.12.2 Setting the ST Reference 

You can set the currently displayed ST as reference. To do so, follow this procedure:

1. Enter the ST review page.

2. Select Set Reference. 

NOTE

• The ST baseline is used as ST reference by default.

26.2.12.3 Displaying/Hiding the ST Reference 

To display or hide ST reference, follow this procedure:
BeneVision N22/N19/N17/N15/N12 Patient Monitor Operator’s Manual 26 - 11



1. Enter the ST review page.

2. Select Display Reference or Hide Reference. 

26.2.12.4 Displaying/Hiding Markers

To display or hide markers, follow this procedure:

1. Enter the ST review page.

2. Select Display Marker or Hide Marker.

26.2.12.5 Printing ST Data

To print ST data, follow this procedure:

1. Enter the ST review page.

2. Select .

26.3 Reviewing Discharged Patients
For discharged patients, you can review the trend data in the review page. You can also review the events and 
12-lead ECG analysis results.

26.3.1 Checking the Data of a Discharged Patient
1. Access the Discharged Patients dialog box by either of the following ways:

◆ Select the Discharged Patients quick key.

◆ Select the Main Menu quick key → from the Patient Management column select Discharged 
Patients.

2. From the patient list select the desired patient.

3. Select Detail.

26.3.2 Checking the Information of a Discharged Patient 
1. Access the data of the discharged patient as described in 26.3.1 Checking the Data of a Discharged Patient.

2. Select the  icon to enter the Patient Management dialog box.

3. Select Ok to exit the Patient Management dialog box.
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27 Clinical Assistive Applications (CAA)

The Clinical Assistive Applications (CAA) function integrates some commonly used clinical guidelines and tools 
into the monitor. It puts the currently monitoring parameter measurements together and provides 
comprehensive analysis results. 

CAA can improve the clinician’s working efficiency. However, it is not directly used for diagnosis and cannot not 
replace the clinician’s judgement.

27.1 Checking Software Licenses
Licenses are required to run the following CAA functions in the monitor:

■ BoA Dashboard

■ HemoSight

■ Early Warning Score (EWS)

■ SepsisSight

■ CPR Record

■ ECG 24h Summary

To check the licenses, select the Main Menu quick key → select License → Local.

To install the licenses, follow this procedure:

1. For N17/N15/N12, connect the USB drive with the licenses in to the monitor’s USB connector. For N22/N19. 
connect the USB drive to the monitor’s MSB connector.

2. Select the Main Menu quick key →select License → select External.

3. Select Install.

27.2 BoA DashboardTM

The Balance of Anesthesia (BoA) Dashboard helps the clinicians to monitor the patient’s status during anesthetic 
induction, maintenance, and postoperative recovery. 

NOTE

• BoA Dashboard is only available when Department is set to OR.

27.2.1 Accessing BoA DashboardTM

Access BoA Dashboard in any of the following ways: 

■ Select the BoA Dashboard quick key.

■ Select the Screen Setup quick key → Select the Choose Screen tab → select BoA Dashboard.

■ Select the Main Menu quick key → from the CAA column select BoA Dashboard.

BoA Dashboard has three pages:

■ Induction

■ Maintenance

■ Recovery

27.2.2 Induction
Select the Induction tab to enter the Induction page. You can check parameter minitrends and apnea time from 
the Induction page.
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Select Induction to start apnea detection, mark the induction event, and start an NIBP STAT measurement. The 
systolic pressure value will be saved as the reference.

The following figure shows the Induction page. Your display may be configured to look slightly different.

 (1) Cursor: indicates the current apnea time.

(2) Apnea indicator: provides apnea time scale.

(3) Timer: displays the time elapsed since the timer was started.

(4) Minitrends area: provides parameter minitrends. You can select the parameters you want to view. 
For more information, see 27.2.5.1 Selecting Parameters for Viewing Trends.

(1)
(2)

(4)

(3)
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27.2.3 Maintenance
You can check the patient’s parameter trends, anesthesia status, and triple low status.

Select Anesthesia Status or Triple Low to choose the indicator.

The anesthesia status indicator presents the patient’s status in terms of pain, consciousness, and neuromuscular 
blockage. 

The triple low indicator presents BIS, MAC and mean pressure. Postoperative mortality and hospital stay are 
increased in patients having low MAC and low blood pressure. With low BIS value, the postoperative mortality 
and hospital stay are further increased. (Sessler et al: Hospital Stay and Mortality Are Increased in Patients Having 
a “Triple Low” of Low bood Pressure, Low Bispectral Index, and Low Minimum Alveolar Concentration of Volatile 
Anesthesia.Anesthesiology 2012; 116: 1195–203)

The following figures show the anesthesia status indicator and triple low indicator:

■ The three arms of the anesthesia status indicator respectively indicate pain (Analgesia), consciousness 
(Sedation), and neuromuscular blockage (Paralysis). You can select parameters for the anesthesia status 
indicator. For more information, see 27.2.5.2 Selecting Parameters for Anesthesia Status Indicator.

■ The three arms of the triple low indicator respectively indicate BIS, MAC, and mean blood pressure.

■ The length of the filling indicates parameter value. 

■ The color of the arms indicates parameter status: green indicates that parameter value is within normal 
range. Red indicates that parameter value is beyond normal range. Gray indicates that parameter value is 
unavailable or invalid.

■ The black lines on the parameter arms indicate the normal range of corresponding parameters.

 (1) Total triple low duration: if BIS, MAC, and Art-M values are lower than the threshold, the patient is in triple low 
status. For information on setting the triple low threshold, see 27.2.5.5 Setting Thresholds for Triple Low Parameters.

(1)
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27.2.4 Recovery
You can view parameter trends from the Recovery page.

Select Aldrete Score to show the latest score and scoring time. To understand the current patient status, select a 
score for each item and then select Confirm to get a new score. 

WARNING

•  The Aldrete score and recommendation is for reference only. Clinicians must make the decision of 
discharging the patient from recovery according to the patient’s actual condition.

27.2.5 Setting the BoA Dashboard
From the BoA Dashboard, you can set the parameters, anesthesia status indicator, and triple low indicator.

27.2.5.1 Selecting Parameters for Viewing Trends

You can view the trends of up to 6 parameters from the Maintenance page and Recovery page.

To select the parameters you want to view, use either of the following ways:

■ Select .

◆ Select the Maintenance tab or Recovery tab to set the parameters you want to view.

◆  Selecting Defaults resumes the default setting.

■ Select a parameter on the trend view, and set which parameter you want to display in this position.

27.2.5.2 Selecting Parameters for Anesthesia Status Indicator

In the anesthesia maintenance stage, you can evaluate the patient’s pain status by heart rate and/or blood 
pressure values. You can evaluate the patient’s consciousness status by BIS or MAC value. The neuromuscular 
blockage status is evaluated by NMT.

To select parameters for the anesthesia status indicator, follow this procedure:

1. Select .

2. Select the Maintenance tab.

3. From the Parameters area, set Analgesia and Sedation.

27.2.5.3 Setting References for Heart Rate and Systolic Blood Pressure

The current heart rate and systolic blood pressure references are displayed as white lines in minitrends area. To 
set the references, follow this procedure:

1. Select Set Reference.

2. Select Ok to set the current HR and BP-S measurements as the reference. You can also input HR and BP-S 
values and then select Ok.

You can also follow this procedure to set HR and BP-S reference:

1. Select .

2. Select the Maintenance tab.

3. From the Reference area, set HR and BP-S.

27.2.5.4 Setting Thresholds for Anesthesia Status Parameters

To set low limits for anesthesia status parameters, follow this procedure:

1. Select .

2. Select the Maintenance tab.

3. From the Threshold area, set threshold for each parameter. 
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27.2.5.5 Setting Thresholds for Triple Low Parameters

To set low limits for triple low parameters, follow this procedure:

1. Select .

2. Select the Maintenance tab → Triple Low tab. 

3. Set low limits for BIS, MAC, and MAP. 

The ranges of the thresholds for triple low parameters are as follows:

27.3 Early Warning Score (EWS)
The Early Warning Scores (EWS) can help you recognize the early sign of deterioration in patients based on vital 
signs and clinical observations. It is based on the “Royal College of Physicians (2015) National Early Warning 
Score (NEWS2): Standardizing the assessment of acute illness severity in the NHS, Report of a Working Party. RCP, 
London. Depending on the score calculated, appropriate recommendations are displayed. 

The monitor supports the following scores: 

■ MEWS (Modified Early Warning Score)

■ NEWS (National Early Warning Score)

■ NEWS2 (National Early Warning Score 2)

■ Custom Score

There are two types of scoring tools:

Total score: A subscore is given for each parameter based on the measured or entered value. When all the 
required parameters are entered or measured, the subscores are added together to calculate the total early 
warning score. Each subscore has a color coding to indicate associated level of risk. When the total score is 
outside of the thresholds, actions are recommended. MEWS, NEWS and NEWS2 can give total scores.

■ IPS (individual parameter score): A color-coded score is given for each parameter based on the measured or 
entered value. Each parameter has upper and lower thresholds. When an individual parameter measured 
or entered is outside of the thresholds, actions are recommended.

Custom Score  is based on user-defined parameters. It can be a total score or an IPS, depending on the 
configuation.

MEWS, NEWS and NEWS2 are intended for adult patients only. The patient category applied to the Custom Score 
is defined by the Mindray Clinical Score Configuration Tool. For more information, see Mindray Clinical Scoring 
Config Tool Instruction for Use (P/N: 046-012986-00).

WARNING

• EWS is not intended for pediatric and neonatal patients.

• The default settings for IPS and Custom Scoring are based on the scoring system used by MEWS and 
NEWS, which have only been clinical validated in the adult population. If you choose to use this 
feature for pediatric patients, you may need to customize the scoring system to reflect any relevant 
differences between adult and pediatric patients.

• The EWS scores and recommended actions are for reference only and cannot be directly used for 
diagnostic interpretation. 

• EWS cannot be used as an prognosis index. It is not a clinical judgement tool. Clinicians must use 
their clinical judgement in conjunction with the EWS tool at all times. 

Parameter Range Default setting

BIS 0 - 100 46

MAC 0 - 3.0 0.6

MAP Adult: 20 -230 mmHg
Pediatric: 20 - 165 mmHg
Neonate: 20 - 110 mmHg

87 mmHg
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• MEWS and NEWS are intended for adult patients only. NEWS is not applicable to pregnant woman 
and COPD (Chronic Obstructive Pulmonary Disease) patients. 

NOTE

• The EWS scores does not trigger any alarms and cannot used for continuous monitoring.

27.3.1 Displaying the EWS Numerics Area
To display the EWS numerics area, follow this procedure:

1. Access Tile Layout in either of the following ways:

◆ Select the Screen Setup quick key → select the Tile Layout tab.

◆  Select the Main Menu quick key → from the Display column select Tile Layout.

2. Select the parameter area where you want to display the EWS score, and then from the popup list select 
EWS.

27.3.2 Accessing the EWS Screen
Access the EWS window in any of the following ways: 

■ Select the EWS parameter area

■ Select the EWS quick key.

■ Select the Screen Setup quick key → select the Choose Screen tab → select EWS.

■ Select the Main Menu quick key → from the CAA column select EWS.

When the EWS screen is hidden as , you can also choose one of the following methods to quickly enter the 
EWS screen.

■ Swipe left or right across the touchscreen with two fingers until you switch to the EWS screen.

■ Swipe right across the touchscreen with a single finger, 

 (1) EWS protocol label

(2) Scoring countdown: time to the next scoring.

(3) Scoring interval

(4) The scoring time

(5) Single parameter whose score reaches 3

(6) Risk level indicator. The level of risk increases from top down. For IPS, this indicator does not display. The current 
level is enclosed by a white square frame.

(7) History total score. The rightmost one is the latest history score.

(8) Total score. The color of the circle indicates the level of risk. For IPS, no score is displayed. Only level of risk is shown: 
white means normal and red indicates alert.

(1)

(8)

(7)

(3)

(5)

(6)

(4)

(2)
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■ Select the  button, 

Take NEWS2 as an example, the EWS screen is shown as follows. Your screen may be slightly different due to the 
configuration. 

27.3.3 Performing EWS Scoring
To perform scoring, follow this procedure:

(1) Total score. The color of the circle indicates the level of risk. For IPS, no numeric score is displayed. Only level of risk 
is shown: white means normal and red indicates alert by default.

(2) Risk level indicator. The level of risk increases from top down. The current level is enclosed by a white frame. For 
IPS, this indicator does not display.

(3) Parameter area: display the subscore and parameter value of each parameter. The keyboard symbol indicates that 
the parameter value is manually entered.

(4) History total scores area: selecting this area or swiping up with one finger can review the trends of total score and 
each subscore

(5) Selecting this button expands the History Total Scores area where your can review the trends of the total score and 
each subscore.

(6) Selecting this button or swiping right across the screen with one finger displays the trends of total score and 
parameter values for scoring.

(7) Clinician ID (displays only when the Clinician ID is enabled): allows inputing the Clinician ID to associate with the 
EWS score. For more information, see 33.4.1 Enabling Inputing the Clinician ID.

(8) Select this button to see the clinical response to the current score

(9) Scoring interval

(10) EWS protocol label

(11) Scoring countdown: time to the next scoring.

(12) The scoring time

(1)

(2)

(3)

(4)

(8)

(7)

(12)   (11)  (10)    (9)      

(6)

(5)
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1. Select Reset to clear the previous score and update values of currently monitored parameters and relevant 
subscores.   

2. For NEWS2, set the SpO2 Scale.

◆ Scale 1: for patient without hypercapnic respiratory failure.

◆ Scale 2: for patients with a prescribed oxygen saturation requirement of 88–92% (for example, in 
patients with hypercapnic respiratory failure).

3. Measure or manually enter other required parameters and observations. 

4.  If the clinician ID is enabled, input the clinician information by selecting , and then 
manually entering the information, or by scanning the clinician’s barcode.

5. Select Calculate to get the total score.

6. If Score Confirmation is enabled, select Confirm to save current scoring, or select Cancel to give up 
current scoring. Refer to section 27.3.4.2 Setting the Scoring Confirmation Switch for more information.

CAUTION

• The decision to use Scale 2 of the SpO2 Scale should be made by a competent clinical decision maker 
and should be recorded in the patient’s clinical notes.

NOTE

• Before calculating the score, select Reset to clear the previous score.

• The keyboard symbol at the right of the parameter value indicates that the value is manually 
entered.

• You can get the score only when all required parameters have been measured or entered.

• When a patient is discharged, or the monitor is turned off, the clinician ID is cleared

27.3.4 Changing EWS Settings

27.3.4.1 Changing the Scoring Protocol

The monitor is configured with a default scoring protocol. To change the scoring protocol, follow this procedure:

1. From the EWS page select Setup.

2. Set Score.

27.3.4.2 Setting the Scoring Confirmation Switch

To select if confirmation is required before saving score, follow this procedure:

1. From the EWS page select Setup.

2. Set Score Confirmation switch.

◆ Off: the monitor automatically saves the scoring result after the scoring is completed.

◆ On: you need to confirm that whether the scoring result is saved or not after the scoring is completed.

27.3.4.3 Setting the Manual Data Timeout

The manually input parameter data can be configured to become invalid after a preset time. To set the timeout 
period for the input data, follow this procedure:

1. From the EWS screen select Setup.

2. From the Manual Data Timeout area, select a desired parameter and set its timeout period.

NOTE

• If the data is expired and not updated, the monitor displays the corresponding parameter score in 
outline font, and gives a timeout alarm. 
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27.3.4.4 Setting Auto Scoring

The monitor automatically starts scoring at the preset interval. To set auto scoring, follow this procedure:

1. From the EWS page select Setup.

2.  Set Auto Scoring:

◆ Interval: the monitor automatically starts scoring at the preset interval.

◆ NIBP: the monitor automatically starts scoring at the completion of each NIBP measurement.

◆ Alarm: the monitor automatically starts scoring when an alarm occurs to the parameter for scoring.

◆ If no option is selected, the monitor does not initiate auto scoring.

27.3.4.5 Setting Auto Scoring Interval
1. From the EWS page select Setup.

2. Set Interval:

◆ By Score: the monitor automatically starts scoring as per the interval selected for corresponding total 
score.

◆ 5 min - 24 h: If Auto Scoring is set to Interval, the monitor automatically starts scoring as per the 
selected interval. If Auto Scoring is not set to Interval, the countdown timer of manual scoring is 
selected.

27.3.5 Viewing Historical Scores
From the EWS screen, you can view the total score or subscores of the past 24 hours. To do so, choose either of 
the following ways:

■ Select the history total score area.

■ From the history total score area, swipe up with a finger.

To return to the EWS screen, select  from the top of the historical score screen. Refer to 27.3.2 Accessing the 
EWS Screen for the position of the history total score area.

27.3.6 Viewing Parameter Trends
From the EWS screen, you can view the 24-hour graphic trends of each parameter used for scoring. To do so, 
choose either of the following ways:

■ Select the  button.

■ Swipe right across the EWS screen with a finger.

From the screen of parameter trends, selecting the  button or swiping left across the screen with a finger can 
return to the EWS screen. 

Refer to 27.3.2 Accessing the EWS Screen for the position of the  button.

27.4 Glasgow Coma Scale (GCS)
The Glasgow Coma Scale (GCS) function is based on Teasdale’s Assessment of Coma and Impaired Consciousness-A 
Practical Scale (Lancet, 1974). Three aspects of behavior are independently measured: eye opening, verbal 
response, and motor response. The scores are added together to indicate that patient’s level of consciousness. 

GCS is intended for adults and pediatric patients.

CAUTION

• GCS is intended as an adjunct in patient assessment and must be used in conjunction with 
observation of clinical signs and symptoms.

• GCS is not applied to patients that are sedated, muscularly relaxed, with artificial airway, drunk, 
hypothermia or in status epilepsies.

• Please refer to hospital policy regarding acceptable use of GCS.
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• When applied to children younger than five years old or to the elderly, the GCS score may not reflect 
actual function.

27.4.1 Displaying the GCS Parameter Area
To display the GCS parameter area, follow this procedure:

1. Access Tile Layout in either of the following ways:

◆ Select the Screen Setup quick key → select the Tile Layout tab.

◆  Select the Main Menu quick key → from the Display column select Tile Layout.

2. Select the parameter area where you want to display the GCS score, and then from the popup list select 
GCS.

The following figure shows the GCS parameter area. The display may be configured to look slightly different.

27.4.2 Accessing the GCS Dialog
Enter the GCS dialog in any of the following ways: 

■ Select the GCS parameter area.

■ Select the GCS quick key.

■ Select the Main Menu quick key → from the CAA column select GCS.

 (1) GCS label

(2) Total score and level of consciousness. The color of the circle indicates the level of risk. 

(3) Scoring time

(4) Scoring countdown: time to the next scoring

(5) Scoring interval

(6) Subscores

◆ E: eye opening

◆ V: verbal response

◆ M: motor response

(4)

(5)

(2)

(3)

(6)

(1)
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                                                      (1) Subscore                                     (2) Total score 

27.4.3 Performing GCS Scoring
To perform scoring, follow this procedure:

1. From the Eye Opening area, Verbal Response area, and Motor Response area, respectively select an item 
that represents the patient’s status.    

2. Select Ok to accept the total score. 

The following table lists the default score range and color of relevant consciousness level.

NOTE
• The GCS score range is adjustable. Refer to 33.4.4 Setting GCS Threshold for Each Consciousness Level 

for the method of changing the high limit and low limit of each consciousness level.

27.4.4 Setting GCS Scoring Interval
From the GCS dialog, select Interval to set GCS scoring interval. When the scoring interval is reached and you do 
not perform another scoring, the score will be invalidated and displayed as outline fonts. 

27.4.5 Reviewing GCS Trend Data
From the GCS dialog, select Review to enter the Review dialog and view the GCS trend data from the Tabular 
Trends.

27.5 SepsisSightTM  
The SepsisSightTM function is based on Third International Consensus Definitions for Sepsis and Septic Shock 

(Sepsis-3) and Surviving Sepsis Campaign: International Guidelines for Management of Sepsis and Septic Shock: 
2016 (SSC Guideline 2016). It assists you in recognizing the early signs and symptoms of sepsis by comparing the 
state of the patient to the defined criteria and then guides you through the recommended treatment protocol.

(1)                                                               

(2)                                                               

Level Range Color

Mild damage 13-15 White

Moderate damage 9 - 12 Yellow

Severe damage 3 - 8 Red
BeneVision N22/N19/N17/N15/N12 Patient Monitor Operator’s Manual 27 - 11



CAUTION

• SepsisSight is not a diagnostic or therapeutic tool and is not intended to replace the competent 
judgment of a clinician.

• SepsisSight should not be used with intravenous immunoglobulins in adult patients with severe 
sepsis or septic shock.

• SepsisSight should not be used with intravenous selenium for the treatment of severe sepsis.

• SepsisSight should not be used with sodium bicarbonate therapy for the purpose of improving 
hemodynamics or reducing vasopressor requirements in patients with hypoperfusion-induced 
lactic acidemia with pH ≥7.15.

NOTE

• SepsisSight is intended to perform routine screening of potentially infected seriously ill patients for 
severe sepsis to allow earlier implementation of therapy.

• SepsisSight is intended to be followed by application of hospital–based performance improvement 
efforts in severe sepsis.

• The Surviving Sepsis Campaign recommends to discuss goals of care and prognosis with patients 
and families.

• The Surviving Sepsis Campaign recommends to incorporate goals of care into treatment and end-of-
life care planning, utilizing palliative care principles where appropriate.

• The SepsisSight goals of care are intended to be applied in a time defined by the SSC guidelines.

• Due to space limitations on the screen, the recommendations cannot always be reproduced in the 
full detail available in the printed and on-line guidelines. 

• SepsisSight is intended for patients suffering from sepsis or suspicion of sepsis.

27.5.1 Accessing the SepsisSight Dialog
Enter the SepsisSight dialog in any of the following ways: 

■ Select the SepsisSight quick key.

■ Select the Main Menu quick key → from the CAA column select SepsisSight.

27.5.2 Screening
As per Sepsis-3, SepsisSight supports quick Sepsis-Related Organ Failure Assessment (qSOFA, or quick SOFA) and 
Sepsis-Related Organ Failure Assessment (SOFA).

27.5.2.1 Performing qSOFA

qSOFA evaluates the patient’s respiration rate, systolic blood pressure and altered mental status. 

RR and BP-S being monitored are automatically obtained. You can also manually enter these values by 
selecting the  symbol. Select whether the patient’s mental status is altered. Then qSOFA score is calculated.

If the qSOFA score is greater than or equal to 2, or sepsis is suspected, select SOFA>> to perform SOFA.

To clear the score, select Reset.

NOTE
• The keyboard symbol  indicates that the parameter value is manually entered.

• The question mark (?) in the score circle indicates that more parameter values are required before a 
score can be calculated.

27.5.2.2 Performing SOFA

SOFA score is used to identify organ function or the rate of sepsis-related organ failure.
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To perform SOFA, enter the value or select a range for each item, SOFA score will be automatically calculated.

To clear the score, select Reset.

If Sepsis criteria is met, make a comprehensive judgement on the clinical features.

27.5.2.3 Changing Screening Settings

From the Screening page select Setup. You can change the following settings:

■ In the Screening area, set RR (rpm) high limit and BP-S (mmHg) low limit for qSOFA scoring.

■ In the Unit area, set the unit of Bilirubin and Creatinine.

27.5.3 Recommendations
As per the SSC Guidelines 2016, SepsisSight provides graded recommendations. Pages Part I and Part II in the 
SepsisSight screen list these recommendations.

27.5.3.1 Viewing Detailed Recommendations

Select the  icon at the right side of each item to view detailed recommendations of SSC Guideline 
2016. The star symbol ★ indicates the grade of recommendation:

■ ★★: strong recommendation

■ ★: weak recommendation

■ No ★ symbol: ungraded strong recommendation

27.5.3.2 Marking Implemented Items

Check off implemented items. Then the time and date are automatically recorded and displayed.

■ You can select the  symbol to change the date and time.

■ Select Reset to clear the current results.

27.5.4 Reviewing SepsisSight Trend Data
Select the Graphic Trends tab to view the trend of parameters of resuscitation. 

When a recommended treatment is checked off on the Part I page and Part II page, relevant event is marked in 
the tabular trend. Vertical lines of different colors indicate the event type:

■ White: inspection performed

■ Blue: medication

■ Green: goal achieved

■ Purple: other treatment

27.6 Resus Mode
You can put the monitor into the Resus mode when rescuing a patient. The Resus mode has the following 
features:

■ Displaying resuscitation-related parameter values and waveforms.

■ Recording drugs and treatments through the CPR Record.

The Resus mode is intended for adult, pediatric, and neonatal patients.

WARNING

• In the Resus mode, all physiological alarms and some of technical alarms are disabled.

• Exit the Resus mode as soon as the resuscitation ends to resume normal patient monitoring.
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27.6.1 Entering the Resus Mode
To enter the Resus mode, choose either of the following ways:

■ Select the Resus Mode quick key → select OK.

■ Select the Main Menu quick key → from the Alarm column select Resus Mode → select OK.

27.6.2 CPR Record
The CPR Record helps you record the process of patient resuscitation. You can record the following items 
through the CPR Record:

■ The time resuscitation starts and ends. 

■ Drug names and doses.

■ Resuscitation treatments.

NOTE

• A license is required for the CPR Record function.

27.6.2.1 Accessing the CPR Record

The CPR Record automatically displays when you enter the Resus mode. If the CPR Record is closed, choose 
either of the following ways to open it:

■ Select the Main Menu quick key → from the CAA column select CPR Record.

■ Select the  button at the left of the screen and swipe right.

The following figure shows the CPR Record. Your display may be configured to look slightly different.

(1) Press this key to output the resuscitation report through the recorder.

(2) Press this key to output the resuscitation report through the printer.

(6)

(3)

(5)

(3)

(4)

(1)

(7)

(2)
(8)

(9)
(10)
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27.6.2.2 Customizing Drugs

You can customize drugs frequently used for resuscitation. To do so, follow this procedure:

1. From the CPR Record screen, select the  button to enter the Setup menu.

2. Define the name, unit, dose, and color of each drug as needed.

The CPR Record can list up to six frequently used drugs. The first two drugs  directly shown on the CPR Record 
screen are the most frequently used. The other four drugs are displayed by selecting Other Drugs.

27.6.2.3 Customizing Treatment

Besides Start Compression, Tracheal Intubation, Establish IV Access, Defibrillation, Mechanical 
Ventilation, Place Urinary Catheter, you can customize defibrillation energy and two additional treatments. To 
do so, follow this procedure:

1. From the CPR Record screen, select the  button to enter the Setup menu.

2. Select the Customized Treatment tab to define the defibrillation energy and the names of two additional 
treatments.

27.6.2.4 Recording the Resuscitation Result

After the resuscitation is completed, select End Resus to record the resuscitation end time and result.

27.6.2.5 Outputting the Current Resuscitation Report

The resuscitation report automatically saves. You can output the resuscitation report through the recorder or 
printer. See  The following figure shows the CPR Record. Your display may be configured to look slightly different. for 
details.

You can also export the resuscitation report using a USB drive. To do so, follow this procedure:

1. For N17/N15/N12/N12C, connect the USB drive in to the monitor’s USB connector. For N22/N19, connect 
the USB drive to the monitor’s MSB connector.

2. From the top of the CPR Record screen, select the  button to enter the Print Setup menu.

3. Select Print Preview → Export to USB.

27.6.2.6 Closing the CPR Record

The CPR Record automatically closes when you exit the Resus mode. You can select the  button at the right of 
the CPR Record screen and swipe left to close the CPR Record.

(3) Press this key to record the resuscitation start time/end time and result. The monitor 
automatically records the resuscitation start time when you enters the Resus mode.

(4) Event area: lists drugs and treatments. Select any event to add an event, edit or delete this event. 
The resuscitation record saves automatically.

(5) Drug color mark: is used to distinguish the type of drugs.

(6) Press this key to select other doses. If adrenalin is used, you can define the injection interval. If the 
injection time is approaching, the time to the last injection will be highlighted in red, reminding 
that injection is required.

(7) Drug record area: quickly records the names and doses of drugs used for patient resuscitation. 
Select Other Drugs to record other drugs or temporary drugs not included. You can edit these 
drugs later.

(8) Press this key to enter the Setup menu. You can customize drugs and treatments.

(9) Treatment record area: quickly records the treatments. Select Other Treatments to record other 
treatments. If an undefined treatment is selected, you can edit it later.

(10) Press this key to select other defibrillation energy and the type of defibrallation waveform.
BeneVision N22/N19/N17/N15/N12 Patient Monitor Operator’s Manual 27 - 15



27.6.3  Exiting the Resus Mode
To exit the Resus mode, choose either of the following ways:

■ Select the Exit Resus Mode quick key.

■ Select the Main Menu quick key → from the Alarm column select Exit Resus Mode.

Exit the Resus mode as soon as resuscitation ends to return to normal patient monitoring.

27.6.4 Reviewing the Resuscitation Events
You can review the details of resuscitation events after exiting the Resus mode. To do so, follow this procedure:

1. Enter the Events page by choosing either of the following ways:

◆ Select the Review quick key → select the Event tab.

◆ Select the Main Menu quick key → from the Review column select the Event tab.

2. From the events list select the desired resuscitation event, and then select Detail.

27.6.4.1 Editing an Resuscitation Event

You can edit the history resuscitation event and result. To do so, follow this procedure.

1. Enter the Events page.

2. From the events list select the desired resuscitation event, and then select Detail.

3. Select any event to add an event, edit or delete this event.

27.6.4.2 Outputting History Resuscitation Record

You can print or export the history resuscitation record through event review. To do so, follow this procedure:

1. Enter the Events page.

2. From the events list select the desired resuscitation event, and then select Detail.

3. Select the  button to enter the Print Setup menu.

4. Print or export the resuscitation report:

◆ Select Print Preview → Print to print this report.

◆ Select Print Preview → Export to USB to export this report.

27.7 ECG 24h Summary 
The ECG 24h Summary provides ECG statistics of the current patient over the latest 24 hours. You can view the 
following information through the ECG 24h Summary:

■ Heart rate statistics

■ Arrhythmia event statistics

■ QT/QTc measurement statistics

■ Maximum and minimum ST statistics of each lead

■ Pacer statistics

■ Typical ECG strips

NOTE

• The ECG 24h Summary is intended for the current patient. It is not intended for discharged patients.

• Pacer statistics is intended for paced patients.

• Patient data is saved, collected and displayed together in the ECG 24h Summary. Data displayed in 
the ECG 24h Summary is not recalculated. 

• If BeneView T1 is used to monitor a patient, when BeneView T1 is connected with the host monitor, 
data sent to the host monitor is not included in the ECG 24h Summary.
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• A license is required for the ECG 24h Summary function.

27.7.1 Viewing the ECG 24h Summary
To view the ECG 24h Summary, choose either of the following ways:

■ Select the ECG 24h Sum quick key.

■ Select the Main Menu quick key → from the CAA column select ECG 24h Summary.

27.7.2 Selecting Typical ECG Strips
The Typical Strips area displays ECG strips of the following situations:

■ Maximum heart rate

■ Minimum heart rate

■ Four arrhythmia events

You can select a typical ECG strip of each situation. For example, to select the typical ECG strip of asystole, follow 
this procedure:

1. Select the currently displayed asystole strip.

2. From the popup strips, select the desired strip as the typical strip of asystole.

27.7.3 Reviewing ECG Summary
From the ECG 24h Summary dialog, you can review corresponding trends and events.

■ Select the Heart Rate area to review HR graphic trends.

■ Select the Max ST/Min ST area to review the current ST reference and ST graphic trends.

■ Select the Pace area to review historic pace events.

■ Select the QT area to review QT/QTc graphic trends.

■ Select the Arrhythmia area to review arrhythmia statistics. For more information, refer to 26.2.9 Arrhy 
Statistics Review Page.

■ Select Full Disclosure to review ECG full disclosure waveforms. For more information, refer to 26.2.8 Full 
Disclosure Review Page.

27.8 HemoSightTM

This monitor provides the HemoSightTM function. You can easily view and review hemodynamic parameters 
through the HemoSight dialog. 

The HemoSight dialog is available when you are using the following modules:

■ C.O. module

■ ScvO2 module

■ CCO/SvO2 module (measured from the Vigilance II, Vigileo, HemoSphere, and EV1000 monitor)

 For detailed information on monitoring and setting hemodynamic-related parameters, see 16 Monitoring 
Cardiac Output (C.O.), 17 Monitoring Central Venous Oxygen Saturation (ScvO2), and 18 Monitoring CCO/
SvO2. This chapter only introduces functions operated through the HemoSight dialog.

27.8.1 Accessing the HemoSight Dialog
Access the HemoSight dialog by either of the following ways:

■ Select the HemoSight quick key.

■  Select the CCO numeric area, ScvO2 numeric area, or SvO2 numeric area → from the bottom of the dialog 
select HemoSight.

■ Select the Main Menu quick key → from the CAA column select HemoSight.
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27.8.2 Viewing Hemodynamic Parameters
To view hemodynamic parameters, select the desired tab on the Diagnosis page of the HemoSight dialog:

◆ Select All to view all hemodynamic parameters. For more information, see 32.2.1 Hemodynamic 
Parameters.

◆ Select Physiology Graphics to view dynamic graphics for parameters’ changes. For more 
information, see 27.8.3 Physiology Graphics.

◆ Select Physiology Relationship to view the realtime relationship of parameters. For more 
information, see 27.8.4 Physiology Relationship.

The symbols beside the hemodynamic parameters have the following meanings:

■ *: indicates an intermittent parameter.

■ **: indicates an oxygenation parameter.

■ *Measure Time: refers to the measurement time of the intermittent parameter.

■ ↑ or ↓: indicates that a parameter value exceeds its upper or lower limit. For setting the upper and lower 
limits of the hemodynamic parameters, see section 27.8.8 Setting Hemodynamic Parameter Ranges.

27.8.2.1 Hemodynamic Parameters from ScvO2 module

The following table lists the hemodynamic parameters from the ScvO2 module.

27.8.2.2 Hemodynamic Parameters from CCO/SvO2 module

The following table lists the hemodynamic parameters from the Vigilance II, Vigileo, HemoSphere, and EV1000 
monitors. 

Abbreviation Full Spelling Unit

Oxygenation 
Parameters

ScvO2 Central Venous Oxygen Saturation %

Hb Hemoglobin g/L, g/dl, mmol/L

Hct Haematocrit %

DO2 Oxygen Delivery ml/min

DO2I Oxygen Delivery Index ml/min/m2

VO2 Oxygen Consumption ml/min

VO2I Oxygen Consumption Index ml/min/m2

SaO2 Arterial Oxygen Saturation %

Abbreviation Full Spelling Unit Applicable Device

Output CCO Continuous Cardiac Output L/min All

CCI Continuous Cardiac Index L/min/m2 All

C.O. Cardiac Output L/min Vigilance II

CI Cardiac Index L/min/m2 Vigilance II

SV Stroke Volume ml All

SVI Stroke Volume Index ml/m2 All

HR Heart Rate bpm Vigilance II, 
HemoSphere

PR Pulse Rate bpm EV1000, 
HemoSphere

Contractility ESV End Systolic Volume ml Vigilance II

ESVI End Systolic Volume Index ml/m2 Vigilance II
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RVEF Right Ventricular Ejection 
Fraction

% Vigilance II, 
HemoSphere

GEF Global Ejection Fraction % EV1000

CFI Cardiac Function Index l/min EV1000

Preload 
Volume

CVP Central Venous Pressure cmH2O, kPa, or mmHg All

EDV End Diastolic Volume ml Vigilance II, 
HemoSphere

EDVI End Diastolic Volume Index ml/m2 Vigilance II, 
HemoSphere

SVV Stroke Volume Variation % Vigileo, EV1000, 
HemoSphere

GEDV Global End Diastolic Volume ml EV1000

GEDI Global End Diastolic Volume 
Index

ml/m2 EV1000

ITBV Intrathoracic Blood Volume ml EV1000

ITBI Intrathoracic Blood Volume 
Index

ml/m2 EV1000

PPV Pulse Pressure Variation % HemoSphere

Afterload MAP Mean Arterial Pressure mmHg or kPa Vigilance II

SVR Systemic Vascular Resistance DS/cm5 or kPa-s/l All

SVRI Systemic Vascular Resistance 
Index

DS•m2/cm5 or kPa-s-m2/l All

eArt-S Systolic Arterial Pressure from 
the EV1000 monitor

mmHg or kPa EV1000, 
HemoSphere

eArt-M Mean Arterial Pressure from 
the EV1000 monitor

mmHg or kPa EV1000, 
HemoSphere

eArt-D Diastolic Arterial Pressure 
from the EV1000 monitor

mmHg or kPa EV1000, 
HemoSphere

Oxygenation 
Parameters

SaO2 Arterial Oxygen Saturation % Vigilance II

ScvO2 Central Venous Oxygen 
Saturation

% All

SvO2 Mixed Venous Oxygen 
Saturation

% All

DO2 Oxygen Delivery ml/min Vigilance II, EV1000, 
HemoSphere

DO2I Oxygen Delivery Index ml/min/m2 EV1000, 
HemoSphere

VO2 Oxygen Consumption ml/min Vigilance II, EV1000, 
HemoSphere

VO2I Oxygen Consumption Index ml/min/m2 EV1000, 
HemoSphere

VO2E Estimated Oxygen 
Consumption 

ml/min EV1000, EV1000, 
HemoSphere

Abbreviation Full Spelling Unit Applicable Device
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27.8.3 Physiology Graphics
The lungs, heart and circulatory system vary according to the patient’s condition at the time of the 
thermodilution measurement. The Physiology Graphics displays monitored parameters using animation, 
which gives a visual representation of the interaction between the heart, lungs, blood, and vascular system. The 
continuous parameter values are displayed in realtime. When the intermittent data is available, the animation 
changes to reflect this change. The heart rate showed by the animation is also a visual reflection of the patient’s 
heart rate.

VO2IE Estimated Oxygen 
Consumption Index

ml/min/m2 EV1000, 
HemoSphere

O2EI Oxygen Extraction Index % Vigilance II

Hb Hemoglobin g/L, g/dl, or mmol/L EV1000, 
HemoSphere

SpO2 Arterial Oxygen Saturation 
from Pulse Oximetry

% EV1000, 
HemoSphere

Organ 
Function

EVLW Extravascular Lung Water ml EV1000

ELWI Extravascular Lung Water 
Index

ml/kg EV1000

PVPI Pulmonary Vascular 
Permeability Index

no unit EV1000

TB Blood Temperature ºC or °F EV1000, 
HemoSphere

Abbreviation Full Spelling Unit Applicable Device

(1) When ScvO2 or SvO2 is available, the color varies according to the value, so a change in color indicates a change of 
ScvO2 or SvO2 value.

(2) When CVP and SVRI are available, the change in blood vessel diameter indicates the change of SVRI values. For more 
information, see 27.8.3.1 Systemic Vascular Resistance Status. 

(3) When SpO2 is available, the color varies according to the SpO2 value, so a change in color indicates a change of 
SpO2 value.
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27.8.3.1 Systemic Vascular Resistance Status

Systemic vascular resistance status is indicated by SVRI. The following pictures show the systemic vascular 
resistance status. 

27.8.3.2 Lung Water Status

Lung water status is indicated by ELWI. The following picture shows the lung water status, which is indicated by 
the liquid level of lung. The dotted line marks the high limit of ELWI. The ELWI is considered too high if the liquid 
level exceeds the dotted line. When ELWI is not available, the lung is displayed in gray color.

27.8.3.3 End Diastolic Volume Status

End diastolic volume status is indicated by EDVI (from the CCO/SvO2 module). The following pictures show different end 
diastolic volume statuses. The dotted line marks the normal end diastolic volume status. When EDVI or GEDI is not available, 
the heart in the diastole is displayed in gray color.

(4) When EDVI or GEDI is available, the size change in the diastole indicates the change of end diastolic volume index. 
For more information, see 27.8.3.3 End Diastolic Volume Status.

(5) When ELWI is available, the change in liquid level of lung indicates the change of ELWI values. For more information, 
see 27.8.3.2 Lung Water Status.

(6) When RVEF or GEF is available, the size change in the systole indicates the change of ejection fraction. For more 
information, see 27.8.3.4 Ejection Fraction Status.

Normal resistance High resistance Low resistance

High end diastolic volume Normal end diastolic volume Low end diastolic volume 
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27.8.3.4 Ejection Fraction Status

Ejection fraction status is indicated by RVEF (from the CCO/SvO2 module). The following pictures show different ejection 
fraction statuses. The dotted line marks the normal ejection fraction status. When RVEF or GEF is not available, the heart in the 
systole is displayed in gray color.

27.8.4 Physiology Relationship
The Physiology Relationship screen depicts the balance between oxygen delivery (DO2) and estimated oxygen 
consumption (VO2). It automatically updates as parameter values change so the displayed values are always 
current. The connecting lines highlight the relationship of the parameters to each other.

In the Physiology Relationship screen, the connecting lines have the following meanings:

■ Solid line: indicates that connected parameters have a direct relationship.

■ Dotted line: indicates that connected parameters have an indirect relationship.

■ Red frame: the parameter value is out of its normal range.

■ Green frame: the parameter value is within its normal range.

■ Gray frame: the parameter value is not available.

In the Physiology Relationship screen, each parameter frame displays the following contents:

■ Parameter name

■ Parameter value (”--” if parameter value is not available)

■ * (if the parameter is intermittent)

■ ** (if the parameter value is input manually)

■ ↑ or ↓ (if the parameter value exceeds its upper or lower limit, as defined in the Setup dialog. See section 
27.8.8 Setting Hemodynamic Parameter Ranges )

NOTE
• When measuring the hemodynamic parameters with different modules or devices, parameters 

displayed in the Physiology Relationship screen are different.

Low ejection fraction Normal ejection fraction High ejection fraction 
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27.8.5 Hemodynamic Test
The Test page in the HemoSight window provides the trends before and after a hemodynamic test. To access 
the Test page, follow this procedure:

1. Select the numeric area of CCO, ScvO2, or SvO2.

2. Select HemoSight.

3. Select the Test tab.

27.8.5.1 Renaming a Test

The passive leg raising (PLR) test and rapid fluid loading (RFL) test are default tests, and their names cannot be 
changed. To rename a custom defined test, follow this procedure:

1. Access the HemoSight dialog. For more information, refer to 27.8.1 Accessing the HemoSight Dialog.

2. Select the Test tab.

3. Select Custom1, Custom 2, Custom 3 or Custom 4.

4. Select the  symbol at the upper left corner of the current dialog.

5. Input the test name in the input field.

27.8.5.2 Setting Test Time Duration

To set test time duration, follow this procedure:

1. Access the HemoSight dialog. For more information, refer to 27.8.1 Accessing the HemoSight Dialog.

2. Select the Test tab.

3. Set Test Duration.

27.8.5.3 Selecting Parameters for Testing

To set test parameters, follow this procedure:

1. Access the HemoSight dialog. For more information, refer to 27.8.1 Accessing the HemoSight Dialog.

2. Select the Test tab.

3. Select Setup.

4. From desired parameter page, select parameters for testing.

27.8.5.4 Performing a Hemodynamic Test

To measure and record a hemodynamic test, follow this procedure, along with hospital guidelines for the test to 
be administered:

1. Access the HemoSight dialog. For more information, refer to 27.8.1 Accessing the HemoSight Dialog.

2. Select the Test tab.

3. Select Setup to select the involved parameters. 

4. Select Test Duration to set test duration.

5. Prepare the patient and select the Start button to begin recording the measurements.

6. Wait until the test finishes automatically, or select the Stop button to end the test.

7. View the parameter trends. After the test, the Test page displays the current parameter value, reference 
parameter value, and Delta value (the variation of current value and reference value). For more information, 
see 26 Review.

NOTE

• Hemodynamic tests can also run in background. If the Test page is closed during a test or the 
HemoSight dialog is closed, then the monitor gives a prompt tone and pops up the Test page after 
the test ends.
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27.8.6 Following Up the Patient Hemodynamic Status
You can view the cardiac function curve, lung water curve and SVV/PPV slope indicator in the Follow-up page. 
To view these curves or indicator, follow this procedure:

1. Access the HemoSight dialog. For more information, refer to 27.8.1 Accessing the HemoSight Dialog.

2. Select the Follow-up tab.

3. View the following curves or indicator:

◆ Cardiac function curve

◆ SVV/PPV slope indicator

◆ Lung water curve

27.8.6.1 Cardiac Function Curve and Lung Water Curve

Cardiac function curve and the lung water curve are used to assess the fluid responsiveness.

For more information on the setup of X-axis or Y-axis parameter, see27.8.6.2 Setting the Cardiac Function Curve 
and Lung Water Curve.

27.8.6.2 Setting the Cardiac Function Curve and Lung Water Curve

To set the cardiac function curve and lung water curve, follow this procedure:

1. Access the HemoSight dialog. For more information, refer to 27.8.1 Accessing the HemoSight Dialog.

2. Select the Follow-up tab.

3. Make the following settings:

◆ Interval: set the time interval between coordinate points on the X-axis and Y-axis of the cardiac 
function curve and lung water curve. This setting is effective only when continuous parameters are 
selected at both the X-axis and Y-axis. When ELWI is unavailable and all the other parameters selected 
are continuous parameters, coordinate points will not be drawn on the lung water curve, but will be 
drawn on the cardiac function curve at the configured interval.

◆ Output: set the Y-axis parameter for cardiac function curve.

◆ Preload Volume: set the X-axis parameter for both cardiac function curve and lung water curve.

NOTE

• If intermittent parameters are selected at either the X-axis or Y-axis, coordinate points will be drawn 
for all the intermittent parameters. In this case, coordinates drawn for continuous parameters and 
intermittent parameters are consistent. 

(1) Cardiac function curve (2) Lung water curve

(1)

(2)
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27.8.6.3 SVV/PPV Slope Indicator

The SVV/PPV slope indicator is a visual representation of the cardiac function curve used when assessing the 
stroke volume variation value or pulse pressure variation. The curved line indicates the SVV/PPV slope. 

The dot moves up and down the curved line according to the SVV or PPV value. The color of the dot changes 
based upon set target ranges.

■ SVV/PPV≤10%: the dot is green, and may predict that the patient is fluid unresponsive.

■  SVV/PPV>10%: the dot is red, and may predict that the patient is fluid responsive.

CAUTION

• PPV and SVV are only applicable in patients on controlled mechanical ventilation and sinus rhythm.

27.8.6.4 Setting the SVV/PPV Slope Indicator

To set the SVV or PPV slope, follow this procedure:

1. Access the HemoSight dialog. For more information, refer to 27.8.1 Accessing the HemoSight Dialog.

2. Select the Follow-up tab.

3. Select SVV or PPV to set which Curve is the indicator. You can also set it to Off to hide the indicator.

27.8.7 Evaluating the Hemodynamic Parameters
You can review the hemodynamic parameter trends on the Evaluation page. The changes of hemodynamic 
parameters are shown by the trends or Spidervision diagram. The trends and Spidervision diagram display both 
current values and reference values of parameters, which let you conveniently see the hemodynamic status at 
different timepoints.

To enter the Evaluation page, follow this procedure:

1. Access the HemoSight dialog. For more information, refer to 27.8.1 Accessing the HemoSight Dialog.

2. Select the Evaluation tab.

27.8.7.1 Viewing the Spidervision Diagram

The Spidervision diagram shows hemodynamic parameters in dynamic conjunction. To enter the Spidervision 
diagram, follow this procedure:

1. Access the HemoSight dialog. For more information, refer to 27.8.1 Accessing the HemoSight Dialog.

2. Select the Evaluation tab.
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Each leg of the graph is divided into 3 segments indicating different value ranges for the respective parameters. 
The middle segment indicates the normal range for the respective parameter. The outer segment will be 
highlighted when corresponding parameter value exceeds the upper limit. The inner segment will be 
highlighted when its corresponding parameter value exceeds the lower limit. 

■ The links between legs of the graph are displayed in green when all displayed parameters are within the 
normal range. 

■ The links between legs of the graph and the corresponding spider segment are displayed in yellow when 
one of the displayed parameters is outside the normal range. 

■ The links between legs of the graph and the corresponding spider segments are displayed in red when two 
or more displayed parameters are outside the normal range.

27.8.7.2 Viewing Trends

To view the trends of hemodynamic parameters, follow this procedure:

1. Access the HemoSight dialog. For more information, refer to 27.8.1 Accessing the HemoSight Dialog.

2. Select the Evaluation tab.

3. Select the Trends tab.

For more information on trends review, see 26.2.2 Example Review Dialog.

27.8.7.3 Viewing Hemodynamic Parameters

You can view the hemodynamic parameters on the Evaluation page. The timeline below the Spidervision 
diagram indicates the entire time length. The timeline below the Trends page indicates the time length of 
current window (for more information, see 27.8.7.4 Changing the Time Length of Trends). Different color markers 
on the timeline indicate different types of events:

■ Red: high priority physiological alarm event

■ Yellow: medium priority physiological alarm event

■ Cyan: low priority physiological alarm event

■ Green: manual event

■ White: operation-related event, such as accepting the C.O. average

To locate a hemodynamic event, choose any of the following methods:

■ Move the slider  to the target position.

■ Use the following buttons:

◆ Select  or  beside  to go to the previous or next hemodynamic event. 

(1) Current value (2) Reference value (3) Outer segment

(4) Middle segment (5) Inner segment (6) Link between legs of the graoh

(1)
(2)

(3) (4) (5)         (6)
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◆ Select  to view the event list and select the desired hemodynamic event.

◆ Select  or  beside  to go to the previous or next C.O. average acceptance event.

◆ Select  to enter the list of C.O. average acceptance events, and select the desired C.O. average 
acceptance event.

◆ Select  or  to move the white vertical line to the left or right. Alternately, the cursor will move to 
any location you touch on the graph.

NOTE

• If a physiological alarm event or manual event occurs simultaneously with a C.O. average acceptance 
event, this event will be displayed in preference to a C.O. average acceptance event. 

27.8.7.4 Changing the Time Length of Trends

To change the time length of trends, follow this procedure:

1. Access the HemoSight dialog. For more information, refer to 27.8.1 Accessing the HemoSight Dialog.

2. Select the Evaluation tab.

3. Select Trends Tab.

4. Select Zoom and set the time length of trends.

27.8.7.5 Selecting the Spidervision Pattern

The pattern defines the hemodynamic parameters and their numbers displayed in the Spidervision diagram 
and Trends page. To select the pattern, follow this procedure:

1. Access the HemoSight dialog. For more information, refer to 27.8.1 Accessing the HemoSight Dialog.

2. Select the Evaluation tab.

3. Select the Spidervision tab or Trends tab.

4. Click the Pattern button and select a Spidervision pattern.

For more information, see 27.8.10 Setting the Pattern for detailed information of creating or updating a pattern.

27.8.7.6 Saving Reference Values

To save the hemodynamic parameter values of any moment as reference values, follow this procedure:

1. Access the HemoSight dialog. For more information, refer to 27.8.1 Accessing the HemoSight Dialog.

2. Select the Evaluation tab.

3. Select the Spidervision tab or Trends tab.

4. Move the timeline below the trends or Spidervision graph to select a desired time, or refer to  
27.8.7.3 Viewing Hemodynamic Parameters to select an event.

5. Select Set Reference to save the parameter values at the selection time as reference values.

27.8.8 Setting Hemodynamic Parameter Ranges
To set the ranges of hemodynamic parameters, follow this procedure:

1. Access the HemoSight dialog. For more information, refer to 27.8.1 Accessing the HemoSight Dialog.

2. Select the Setup button.

3. Select the Range tab.

4. Set the normal ranges of the hemodynamic parameters.

27.8.9 Restoring Default HemoSight Range Values
To restore the default values, follow this procedure:

1. Access the HemoSight dialog. For more information, refer to 27.8.1 Accessing the HemoSight Dialog.

2. Select the Setup button.
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3. Select the Defaults button.

NOTE

• Selecting Defaults restores all the parameter ranges to default values.

27.8.10 Setting the Pattern
To set the pattern, follow this procedure:

1. Access the HemoSight dialog. For more information, refer to 27.8.1 Accessing the HemoSight Dialog.

2. Select the Setup button.

3. Select the Spidervision tab.

4. Make the following settings:

◆ Select the number of parameters (three to seven).

◆ Select the parameters to be displayed in Spidervision. The same parameters will show in the Trends as 
they are listed in Spidervision clockwise, starting at the top.

◆ Select Save, Save As or Delete to save, create or delete a pattern.

NOTE
• You cannot delete the default pattern or the pattern that is in use.
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28 Calculation

28.1 Calculation Overview
The monitor provides calculation functions. The calculated values, which are not directly measured, are 
computed based on the values you provide. The calculation function is independent of other monitoring 
functions and can therefore be used for patients being monitored by other monitors. Any operation in a 
calculation dialog does not affect the patient monitored by the current monitor. 

You can perform the following calculations:

■ Drug calculations

■ Hemodynamic calculations

■ Oxygenation calculations

■ Ventilation calculations

■ Renal calculations

28.2 Calculation Safety Information

WARNING

• Decisions on the choice and dosage of drugs administered to patients must always be made by the 
physician in charge. The drug calculations are based on the values input; it does not check the 
plausibility of the calculation performed. 

• Check that the entered values are correct and the calculated values are appropriate. Mindray 
assumes no responsibility for any consequences caused by wrong entries and improper operations.

28.3 Drug Calculations

28.3.1 Performing Drug Calculations
To perform drug calculations, follow this procedure:

1. Access the drug calculator by either of the following ways:

◆ Select the Calculations quick key → select the Drug tab.

◆  Select the Main Menu quick key → from the Calculations column select Drug.

2. Set Drug Name and Patient Category. If the dose of drug is weight dependent, you must input the 
patient’s weight. The dose calculation program has a library of commonly used drugs, while Drug A 
through Drug E are user defined.

3. Enter the known values, for example Drug Amount and Solution Volume.

4. Select Calculate. The calculated values are indicated by red arrows. 

NOTE

• If available, the patient category and weight from the Patient Demographics dialog are 
automatically entered when you first access drug calculation. You can change the patient category 
and weight. This will not change the patient category and weight stored in the patient demographic 
information.
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28.3.2 Checking the Titration Table
The titration table shows information on the currently used drugs. Use the titration table to see what dose of a 
drug your patient will receive at different infusion rates. To access the titration table, follow this procedure:

1. Access drug calculator by either of the following ways:

◆ Select the Calculations quick key.

◆  Select the Main Menu quick key → from the Calculations column select Drug.

2. Select the Titration Table tab.

3. Select Dose Type to set the type of dose unit in the titration table.

4. Select Interval to set the interval between two adjacent titration table items. 

You can select how to display the titration table:

■ Dose: the titration table is listed in the sequence of increased drug dose.

■ Infusion Rate: the titration table is listed in the sequence of increased infusion rate. By default the 
resolution of the infusion rate is one (1). By selecting Exact Rate the resolution of the infusion rate can 
reach 0.01 so that you can display the infusion rate more accurately. 

28.3.3 Drug Calculation Formula

28.3.4 Titration Table Calculation Formula

Description Unit Formula

Dose Dose/hr 
Dose/min

Dose = Infusion Rate × Concentration

Dose (weight based) Dose/kg/hr 

Dose/kg/min

Dose (weight based) = Infusion Rate × 
Concentration/Weight

Drug Amount g series: mcg, mg, g
unit series: Unit, KU, MU 
mEq series: mEq

Drug Amount =Dose × Duration

Drug Amount (weight based) g series: mcg, mg, g
unit series: Unit, KU, MU 
mEq series: mEq

Drug Amount (weight based) = Dose × Duration × 
Weight

Duration hr Duration = Amount/Dose

Duration (weight based) hr Duration (weight based) = Amount/(Dose × Weight)

Concentration mcg/ml, mg/ml, g/ml, Unit/ml, 
KU/ml, MU/ml, mEq/ml

Concentration = Drug Amount/Solution Volume

Solution volume ml Volume = Infusion Rate × Duration

Infusion rate ml/hr Infusion Rate = Dose/Concentration

Infusion rate (weight based) g•ml/hr Infusion Rate = Dose × Weight/Concentration

Description Unit Formula

Infusion Rate ml/hr Infusion Rate = Dose/Concentration

Infusion Rate (weight based) ml/hr Infusion Rate = Weight × Dose/Concentration

Dose Dose/hr 
Dose/min

Dose = Infusion Rate × Concentration

Dose (weight based) Dose/kg/hr 
Dose/kg/min

Dose (weight based) = Infusion Rate × 
Concentration/Weight
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28.4 Hemodynamic Calculations
The monitor provides the hemodynamic calculation function and can save the results of up to 10 calculations, 
which are displayed in groups.

28.4.1 Performing Hemodynamic Calculations
To perform hemodynamic calculation, follow this procedure:

1. Access hemodynamic calculation by either of the following ways:

◆ Select the Calculations quick key → Hemodynamics tab.

◆  Select the Main Menu quick key → from the Calculations column select Hemodynamics.

2. Enter the known values. For a patient who is being monitored, the currently measured values are 
automatically entered. 

3. Select Calculate. 

A calculated value greater than the normal upper limit is indicated by an up arrow “↑”. A calculated value 
lower than the normal lower limit is indicated by a down arrow “↓”.

You can select Range to show the normal range of each parameter.

28.4.2 Input Parameters for Hemodynamic Calculations

NOTE

• If you enable Use PA-D as PAWP, PA-D value will be used to replace PAWP value for hemodynamic 
calculation. For more information, refer to 15.6.8 Setting the Use PA-D as PAWP Switch.

28.4.3 Calculated Parameters and Formulas for Hemodynamic Calculations 

Input Parameter Label Unit

cardiac output C.O. L/min

heart rate HR bpm

pulmonary artery wedge pressure PAWP mmHg

mean arterial pressure MAP mmHg

pulmonary artery mean pressure PA-M mmHg

central venous pressure CVP mmHg

end-diastolic volume EDV ml

height Height cm

weight Weight kg

Calculated Parameters Label Unit Formula

cardiac index C.I. L/min/m2 C.I. (L/min/m2) = C.O. (L/min)/BSA (m2)

body surface area BSA m2 BSA (m2) = Wt0.425 (kg) × Ht 0.725 (cm) × 
0.007184

stroke volume SV ml SV (ml) = 1000× C.O. (L/min)/HR (bpm)

stroke index SVI ml/m2 SVI (ml/m2) = SV (ml)/BSA (m2)

systemic vascular 
resistance

SVR DS/cm5 SVR (DS/cm5) = 79.96 × [APMAP (mmHg) - 
CVP (mmHg)]/C.O. (L/min)
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28.5 Oxygenation Calculations
The monitor provides the oxygenation calculation function and can save the results of up to 10 calculations, 
which are displayed in groups.

28.5.1 Performing Oxygenation Calculations
To perform oxygenation calculations, follow this procedure:

1. Access oxygenation calculation by either of the following ways:

◆ Select the Calculations quick key → Oxygenation tab.

◆  Select the Main Menu quick key → from the Calculations column select Oxygenation.

2. Enter the known values. For a patient who is being monitored, the currently measured values are 
automatically entered. 

3. Select Calculate. 

A calculated value greater than the normal upper limit is indicated by an up arrow “↑”. A calculated value 
lower than the normal lower limit is indicated by a down arrow “↓”.

In the Oxygenation page, you can also perform the following operations:

■ Select OxyCont Unit, Hb Unit, and Pressure Unit. Then corresponding parameter values will be 
automatically converted and updated accordingly.

■ Select Range to show the normal range of each parameter.

systemic vascular 
resistance index

SVRI DS•m2/cm5 SVRI (DS•m2/cm5) = SVR (DS/cm5) × BSA (m2)

pulmonary vascular 
resistance

PVR DS/cm5 PVR (DS/cm5) = 79.96 × [PAMAP (mmHg) - 
PAWP (mmHg)]/C.O. (L/min)

pulmonary vascular 
resistance index

PVRI DS•m2/cm5 PVRI (DS•m2/cm5) = PVR (DS/cm5) × BSA (m2)

left cardiac work LCW kg•m LCW (kg•m) = 0.0136 × APMAP (mmHg) × C.O. 
(L/min)

left cardiac work index LCWI kg•m/m2 LCWI (kg•m/m2) = LCW (kg•m)/BSA (m2)

left ventricular stroke 
work

LVSW g•m LVSW (g•m) = 0.0136 × APMAP (mmHg) × SV 
(ml)

left ventricular stroke 
work index

LVSWI g•m/m2 LVSWI (g•m/m2) = LVSW (g.m)/BSA (m2)

right cardiac work RCW kg•m R CW (kg•m) = 0.0136 × PAMAP (mmHg) × C.O. 
(L/min)

right cardiac work index RCWI kg•m/m2 R CWI (kg•m/m2) = RCW (kg.m)/BSA (m2)

right ventricular stroke 
work

RVSW g•m R VSW (g•m) = 0.0136 × PAMAP (mmHg) × SV 
(ml)

right ventricular stroke 
work index

RVSWI g•m/m2 R VSWI (g•m/m2) = RVSW (g•m)/BSA (m2)

ejection fraction EF % EF (%) = 100 × SV (ml)/EDV (ml)

end-diastolic volume 
index

EDVI ml/m2 EDVI (ml/m2) = EDV (ml)/BSA (m2)

end-systolic volume ESV ml ESV (ml) = EDV (ml) –SV (ml)

end-systolic volume index ESVI ml/m2 ESVI (ml/m2) = ESV (ml)/BSA (m2)

Calculated Parameters Label Unit Formula
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28.5.2 Input Parameters for Oxygenation Calculations

28.5.3 Calculated Parameters and Formulas for Oxygenation Calculations

Input Parameter Label Unit

cardiac output C.O. L/min

percentage fraction of inspired oxygen FiO2 %

partial pressure of oxygen in the arteries PaO2 mmHg, kPa

partial pressure of carbon dioxide in the arteries PaCO2 mmHg, kPa

arterial oxygen saturation SaO2 %

partial pressure of oxygen in venous blood PvO2 mmHg, kPa

venous oxygen saturation SvO2 %

hemoglobin Hb g/L, g/dl, mmol/L

respiratory quotient RQ None

atmospheric pressure ATMP mmHg, kPa

height Height cm, inch

weight Weight kg, lb

Calculated Parameters Label Unit Formula

body surface area BSA m2 BSA (m2) = Wt0.425 (kg) × Ht 0.725 (cm) × 
0.007184

oxygen consumption VO2 ml/min VO2 (ml/min) = C(a-v)O2 (ml/L)× C.O. (L/min))

arterial oxygen content CaO2 ml/L, ml/dL CaO2 (ml/L) = 10× (0.0134 × Hb (g/dl) × SaO2 
(%)) +0.031× PaO2 (mmHg)

venous oxygen content CvO2 ml/L, ml/dL CvO2 (ml/L) = 10× (0.0134 × Hb (g/dl) × SvO2 
(%)) +0.031 × PvO2 (mmHg)

arteriovenous oxygen 
content difference

C(a-v)O2 ml/L, ml/dl C(a-v)O2 (ml/L) = CaO2 (ml/L) - CvO2 (ml/L)

oxygen extraction ratio O2ER % O2ER (%) = 100×C(a-v)O2 (ml/L)/CaO2 (ml/L)

oxygen transport DO2 ml/min DO2(ml/min) = C.O. (L/min) × CaO2(ml/L)

partial pressure of oxygen 
in the alveoli

PAO2 mmHg, kPa PAO2 (mmHg) = [ATMP (mmHg) - 47 mmHg] × 
FiO2 (%)/100 - PaCO2 (mmHg) × [FiO2 (%)/100  
+ (1 - FiO2 (%)/100)/RQ]

alveolar-arterial oxygen 
difference

AaDO2 mmHg, kPa AaDO2 (mmHg) = PAO2 (mmHg) - PaO2 
(mmHg)

capillary oxygen content CcO2 ml/L, ml/dl CcO2 (ml/L) = Hb (g/L) × 1.34 + 0.031 × PAO2 
(mmHg)

venous admixture QS/QT % QS/QT (%) = 100× [1.34 × Hb (g/L) × (1 - SaO2 
(%)/100)  +  0.031 × (PAO2 (mmHg) - PaO2 
(mmHg))]/[1.34 × Hb (g/L) ×  (1 - SvO2 (%)/
100) + 0.031× (PAO2 (mmHg) -  PvO2 
(mmHg))]

oxygen transport index DO2I ml/min/m2 DO2I (ml/min/m2) = CaO2 (ml/L) × (C.O. (L/
min)/BSA (m2)) 

oxygen consumption VO2I ml/min/m2 VO2I (ml/min/m2) = C (a-v) O2 (ml/L) ×(C.O. (L/
min)/BSA (m2))
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28.6 Ventilation Calculations
The monitor provides the ventilation calculation function and can save the results of up to 10 calculations, which 
are displayed in groups.

28.6.1 Performing Ventilation Calculations
To perform ventilation calculations, follow this procedure:

1. Access ventilation calculation by either of the following ways:

◆ Select the Calculations quick key → Ventilation tab.

◆  Select the Main Menu quick key → from the Calculations column select Ventilation.

2. Enter the known values. For a patient who is being monitored, the currently measured values are 
automatically taken. If the anesthesia machine or ventilator is connected, measured values for ventilation 
calculation are also automatically entered.

3. Select Calculate. 

A calculated value greater than the normal upper limit is indicated by an up arrow “↑”. A calculated value lower 
than the normal lower limit is indicated by a down arrow “↓”.

On the Ventilation page, you can also perform the following operations:

■ Select Pressure Unit. Then corresponding parameter values will be automatically converted and updated 
accordingly.

■ Select Range to show the normal range of each parameter.

28.6.2 Input Parameters for Ventilation Calculations

28.6.3 Calculated Parameters and Formulas for Ventilation Calculations

Input Parameter Label Unit

percentage fraction of inspired oxygen FiO2 %

respiration rate RR rpm

partial pressure of mixed expiratory CO2 PeCO2 mmHg, kPa

partial pressure of carbon dioxide in the arteries PaCO2 mmHg, kPa

partial pressure of oxygen in the arteries PaO2 mmHg, kPa

tidal volume TV ml

respiratory quotient RQ None

atmospheric pressure ATMP mmHg, kPa

Calculated Parameters Label Unit Formula

partial pressure of oxygen 
in the alveoli

PAO2 mmHg, kPa PAO2 (mmHg) = [ATMP (mmHg) - 47 mmHg] × 
FiO2 (%)/100 - PaCO2 (mmHg) × [FiO2(%)/100  
+ (1 - FiO2 (%)/100)/RQ]

alveolar-arterial oxygen 
difference

AaDO2 mmHg, kPa AaDO2 (mmHg) = PAO2 (mmHg) - PaO2 
(mmHg)

oxygenation ratio Pa/FiO2 mmHg, kPa Pa/FiO2(mmHg) = 100 × PaO2 (mmHg)/FiO2 
(%)

arterial to alveolar oxygen 
ratio

a/AO2
% a/AO2 (%) = 100 × PaO2 (mmHg)/PAO2 

(mmHg)

minute volume MV L/min MV (L/min) = [TV (ml) × RR (rpm)]/1000
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28.7 Renal Calculations
The monitor provides the renal calculation function and can save the results of up to 10 calculations, which are 
displayed in groups.

28.7.1 Performing Renal Calculations
To perform renal calculations, follow this procedure:

1. Access renal calculation by either of the following ways:

◆ Select the Calculations quick key → select the Renal tab.

◆ Select the Main Menu quick key → from the Calculations column select Renal.

2. Enter the known values. 

3. Select Calculate. 

A calculated value greater than the normal upper limit is indicated by an up arrow “↑”. A calculated value lower 
than the normal lower limit is indicated by a down arrow “↓”.

You can select Range to show the normal range of each parameter.

28.7.2 Calculated Parameters and Formulas for Renal Calculations 

volume of physiological 
dead space

Vd ml Vd (ml) = TV (ml) × [1 - PeCO
2

 (mmHg)/PaCO
2

 (mmHg)]

physiologic dead space in 
percent of tidal volume

Vd/Vt % Vd/Vt (%) = 100 × Vd (ml)/TV (ml)

alveolar volume VA L/min VA (L/min) =[TV (ml) - Vd (ml)] × RR (rpm)/
1000

Calculated Parameters Label Unit Formula

Input Parameter Label Unit

urine potassium URK mmol/L

urinary sodium URNa mmol/L

urine Urine ml/24 hrs

plasm osmolality Posm mOsm/kgH2O

urine osmolality Uosm mOsm/kgH2O

serum sodium SerNa mmol/L

creatinine Cr μmol/L

urine creatinine UCr μmol/L

blood urea nitrogen BUN mmol/L

height Height cm

weight Weight kg
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28.7.3 Calculated Parameters and Formulas for Renal Calculations

*: BUN/Cr is a ratio under the unit of mol.

Calculated Parameters Label Unit Formula

urine sodium excretion URNaEx mmol/24 hrs URNaEx (mmol/24 hrs) = Urine (ml/24 hrs) × 
URNa (mmol/L)/1000

urine potassium excretion URKEx mmol/24 hrs URKEx (mmol/24 hrs) = Urine (ml/24 hrs) × 
URK (mmol/L)/1000

sodium potassium ratio Na/K % Na/K (%) = 100 × URNa (mmol/L)/URK (mmol/
L)

clearance of sodium CNa ml/24 hrs CNa (ml/24 hrs) = URNa (mmol/L) × Urine (ml/
24 hrs)/SerNa (mmol/L)

creatinine clearance rate Clcr ml/min Clcr (ml/min) = Ucr (μmol/L) × Urine (ml/24 
hrs)/[Cr (μmol/L) × (BSA (m2)/1.73) × 1440]

fractional excretion of 
sodium

FENa % FENa (%) = 100 × URNa (mmol/L) × Cr (μmol/
L)/[SerNa (mmol/L) × Ucr (μmol/L)]

osmolar clearance Cosm ml/min Cosm (ml/min) = Uosm (mOsm/kgH2O) × 
Urine (ml/24 hrs)/(Posm (mOsm/kgH2O) × 
1440)

free water clearance CH2O ml/hr CH2O (ml/hr) = Urine (ml/24 hrs) × [1 - Uosm 
(mOsm/kgH2O)/Posm (mOsm/kgH2O)]/24

urine to plasma 
osmolality ratio

U/P osm None U/P osm = Uosm (mOsm/kgH2O)/Posm 
(mOsm/kgH2O)

blood urea nitrogen 
creatinine ratio

BUN/Cr* Mmol/L BUN/Cr = 1000 × BUN (mmol/L)/Cr (μmol/L)

urine-serum creatinine 
ratio

U/Cr None U/Cr (mmol/L) = Ucr (μmol/L)/Cr (μmol/L)
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29 Recording

29.1 Recorder
The thermal recorder records patient information, measurement data, and up to three waveforms.

N17/N15/N12 can be configured with a built-in recorder. If the built-in recorder is not configured, the monitor 
can be configured to use an external recorder module.

 N22 and N19 do not have a built-in recorder. To perform recording, insert the recorder module into the SMR.

29.2 Starting Recordings
Recordings can be started manually or automatically.

29.2.1 Manually Starting Recordings
To manually start a recording, you can either:

■ Press the  hardkey on the front of the recorder to start a Realtime Segment Waveform Recording.

■ Select  on the current dialog to start a recording corresponding to that dialog or page.

29.2.2 Automatic Recordings
In the following conditions, you can set the recorder to automatically start recording:

■ At a preset interval. For more information, see 29.5 Setting up the Recorder.

■ When a parameter alarm is triggered. For more information, see 33.3.10.3 Enabling Automatic Recordings on 
an Alarm.

(1) (2)

(5)

(4)

(3)

(1) Start/Stop key: press to start a recording or stop the current recording.

(2) Module status indicator

◆ On: when the recorder is powered and ready for use.

◆ Off: when the monitor is switched off.

◆ Flashes: if an error has occurred with the recorder.

(3) Paper outlet

(4) Recorder door

(5) Latch: pull it away from the recorder to open the recorder door.
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29.3 Stopping Recordings
Recordings can be stopped manually or automatically.

29.3.1 Stopping Recordings Manually
To manually stop a recording, press the  hardkey while the recorder is creating a strip or select Clear All 
Record Tasks in the Record Setup menu. 

29.3.2 Stopping Recordings Automatically
Recordings stop automatically in the following conditions:

■ The recording is completed.

■ The recorder runs out of paper.

■ The recorder has an alarm condition.

■ The recorder module is removed from the monitor.

■ The monitor is turned off.

29.4 Recording Related Flags
You can find the following flags on the recording reports:

■ For automatically stopped recordings, there are two columns of asterisks “*” at the end of the report.

■ For manually or abnormally stopped recordings, there is one column of asterisks “*” at the end of the 
report.

■ If the parameter data is from external devices connected to the monitor via the BeneLink module, the 
parameter label is prefixed with the plus sign “+”.

29.5 Setting up the Recorder
To configure the recorder for waveforms and printing intervals, follow this procedure:

1. Select the Main Menu quick key → from the Report column select Record Setup.

2. In the Record Setup dialog, select the desired waveform for Waveform 1, Waveform 2 and Waveform 3 in 
turn. The recorder can record up to 3 waveforms at a time.

3. Switch on or off IBP Overlap to enable or disable IBP recordings in the overlapping format.

◆ When the IBP Overlap is enabled: If two or more waveforms in the selected waveforms for recording 
are IBP waveforms, the IBP waveforms will be recorded in the overlapping format.

◆ When the IBP Overlap is disabled: IBP waveforms will be recorded without overlap.

4. Select Recording Duration to set the duration of real-time recording. 

5. Select Interval to set the time interval for automatic recording.

6. Select Recorder Paper Speed to set the speed for recording waveforms.

29.6 Clearing Recording Tasks
To clear recording tasks, follow this procedure:

1. Select the Main Menu quick key → from the Report column select Record Setup.

2. In the Record Setup dialog, select Clear All Record Tasks. This clears all queued recording tasks and stops 
the current recording.
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29.7 Loading Paper
To load paper, follow this procedure:

1. Use the latch at the upper right of the recorder door to pull the door open.

2. Insert a new roll into the compartment as shown below. Feed the paper through and pull some paper out 
from the top of the roller.

3. Close the recorder door.

CAUTION

• Use only specified thermal paper. Otherwise, it may cause damage to the recorder’s printhead, the 
recorder may be unable to print, or poor print quality may result.

• Never pull the recorder paper with force when a recording is in process. Otherwise, it may cause 
damage to the recorder.

• Do not leave the recorder door open unless you are reloading paper or cleaning a paper jam.

29.8 Removing Paper Jam
If the recorder works incorrectly or produces unusual sounds, check if there is a paper jam. If a paper jam is 
detected, follow this procedure to remove it:

1. Open the recorder door.

2. Take out the paper and tear off the draped part.

3. Reload the paper and close the recorder door.

29.9 List of Recording Reports
The recorder can output the following reports:

■ Realtime reports

◆ Realtime Segment Waveform Record

◆ Realtime Continuous Waveform Record

◆ Auto Realtime Record

◆ ST Record

◆ QT Record

◆ 12-Lead Interpretation Record

◆ Record on Alarm Report

◆ 12-Lead Waveform Record

■ History reports

◆ Event Detail

◆ Full Disclosure Detail Record

◆ 12 Lead Review Record

◆ ST Review Record
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◆ Tabular Trend Report

◆ Graphic Trend Report
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30 Printing

30.1 Supported Printer
The monitor can output patient reports via a connected network printer. The monitor supports the following 
printers:

■ HP LaserJet Pro M202dw

■ HP LaserJet Pro 400 M401n

■ HP LaserJet P4015n

■ HP LaserJet 600 M602

■ HP LaserJet Enterprise M605

■ HP LaserJet Enterprise M608n 

NOTE

• For more details about the printer, refer to the document accompanying the printer. With product 
upgrades, the monitor may support additional printers without prior notice. If you have any doubts 
about the compatibility of the printer used with this monitor, contact Mindray.

30.2 End Case Reports

30.2.1 Printing the End Case Report
To print the end case report, choose one of the following ways:

■ Select Print from the End Case Report menu.

■ Select Print End Case Report when you discharge a patient.

■ Select the End Case Report quick key.

30.2.2 Setting a Report as An End Case Report
The following reports can be set as end case reports:

■ Tabular Trends Report

■ Graphic Trends Report

■ Event Report

■ 12-lead Interpretation

■ Alarm Limits Report

■ Realtime Report

■ ECG Report

To set a report as an end case report, follow this procedure:

1. Select the Main Menu quick key → from the Report column select End Case Report.

2. From the Select Reports page, select the desired report tab, for example ECG Report.

30.2.3 Configuring the End Case Reports

To configure the end case reports, follow this procedure:

1. Select the Main Menu quick key → from the Report column select End Case Report.
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2. From the Report Setup page, set the following end case reports:

◆ Select the Tabular Trends Report, Graphic Trends Report, Realtime Report, and ECG Report tab, 
and set these end case report by referring to section 30.6 Configuring Reports.

◆ Select the Event Report tab, and select the event that needs to be printed.

◆ Select the 12-Lead Interpretation tab, and set the switch of Median Complex, Measurements, 
Interpretation, or Interpretation Summary. For other settings, refer to section 30.6.1 Configuring 
ECG Reports.

30.2.4 Setting the End Case Report Period
To set the end case report print period, follow this procedure:

1. Select the Main Menu quick key → from the Report column select End Case Report.

2. From the Select Reports page, set the Period.

NOTE

• End case report print period is calculated from the patient discharged time to the configured period.

• Period setting is applicable to all of the end case reports.

30.3 Manually Starting a Printing Task
This section describes different methods for manually printing a report.

30.3.1 Printing from the Screen 
The  button will be shown at the top of dialogs that have associated reports. If the button is gray, then there 
is not enough information to begin the report, or the printer has not been set up.

When the icon is white, pressing it opens a Print Setup dialog or starts printing a report. If the Print Setup 
dialog is entered, configure the report and press Print to start printing.

30.3.2 Printing Realtime Reports
Select the Print quick key to print a realtime report. You can also print a realtime report from the Report Setup 
dialog. For more information, see 30.3.3 Printing Most Common Reports.

30.3.3 Printing Most Common Reports
The following most common reports can be printed:

■ ECG Report 

■ Realtime Report

■ Tabular Trends Report

■ Graphic Trend Report.

To print these reports, follow this procedure:

1. Select the Main Menu quick key → from the Report column select Report Setup. 

2. Select the desired report tab.

3. Check the settings.

4. Select Print.

30.4 Automatically Printing Reports
When a parameter alarm switch is set to on and an alarm is triggered for this parameter, you can set the monitor 
to automatically print a Print on Alarm Report.

To do so, follow this procedure:
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1. Access alarm related tabs such as the Alarm tab for a parameter in one of the following ways:

◆ Select the Alarm Setup quick key at the bottom of the screen.

◆ Select the parameter or waveform area of the desired parameter → select the Alarm tab.

◆ Select the Parameters Setup quick key at the bottom of the screen → select the desired parameter 
→ select the Alarm tab.

◆ Select the Main Menu quick key → from the Parameters column select Setup→ select the desired 
parameter → select the Alarm tab.

2. Switch on Alarm Outputs for desired parameters. 

30.5 Stopping a Printing Task
To stop a printing task, follow this procedure:

1. Select the Main Menu quick key →from the Report column select Print Queue.

2. Select desired printing tasks and then select Delete. Alternately, select Delete All to stop all the printing 
tasks.

30.6 Configuring Reports
This section focuses on how to configure ECG reports, realtime reports, tabular trends reports, and graphic 
trends reports.

30.6.1 Configuring ECG Reports
 To configure ECG reports, follow this procedure:

1. Select the Main Menu quick key → from the Report column select Report Setup.

2. Select the ECG Report tab.

3. Set the desired options. The following table explains some of the less familiar options.

Menu item Function Description

Speed Set the print speed of 
ECG waveforms

25 mm/sec: prints 25 mm of ECG waveform per second.
50 mm/sec: prints 50 mm of ECG waveform per second.

Auto Interval Defines the spacing 
between the ECG 
waveforms on a 
printout

On: automatically adjusts the space between waveforms to 
avoid overlapping.
Off: each waveform area has the same size on a printout.

Note: Auto Interval is only enabled when 12×1 is selected for 12-Lead Format.

12-Lead Format Select the format of 12-
lead ECG waveforms 
on a printout.

12×1: displays 12-lead ECG waveforms on one page in one 
column.
6×2: displays 12-lead ECG waveforms on one page in two 
columns, with 6 lines in each column.
6×2+1: displays 12-lead ECG waveforms on one page in two 
columns, with 6 lines in each column, and one rhythm lead 
waveform at the bottom.
3×4+1: displays 12-lead ECG waveforms on one page in 4 
columns, with 3 lines in each column, and one rhythm lead 
waveform at the bottom.
3×4+3: displays 12-lead ECG waveforms on one page in 4 
columns, with 3 lines in each column, and three rhythm lead 
waveforms at the bottom.

Rhythm Lead 1
Rhythm Lead 2
Rhythm Lead 3

Select the lead that will 
be used as Rhythm 
Lead 1, 2, or 3.

I, II, III, aVR, aVL, aVF, V1, V2, V3, V4, V5, V6

Note: Rhythm Lead setting is only enabled when 6×2+1, 3×4+1, or 3×4+3 is selected for 
12-Lead Format.
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NOTE

• When ECG Lead Set is set to 3-Lead, the ECG report cannot be printed.

30.6.2 Configuring Realtime Reports
To configure tabular realtime reports, follow this procedure:

1. Select the Main Menu quick key → from the Report column select Report Setup.

1. Select the Realtime Report tab.

2. Set the desired options. The following table explains some of the options.

30.6.3 Configuring Tabular Trends Reports
To configure tabular trends reports, follow this procedure:

1. Select the Main Menu quick key → from the Report column select Report Setup.

2. Select the Tabular Trends Report tab.

3. Set the desired options. 

The following table explains some of the options.

Format Sequence Select the recording 
method of ECG report 
generated by auto 
measurement

Sequential: 12-lead ECG data are recorded sequentially and 
displayed in 3 lines and 4 columns with 2.5 seconds of ECG data 
for each column.
Simultaneous: Record simultaneous 12-lead ECG data.

Menu item Function Description

Menu item Function Description

Select Waveform Select the desired 
waveform to print

Current Waveforms: prints the realtime report for the currently 
displayed waveforms and all the currently measured parameter 
values.
Selected Waveforms: prints the realtime report for the waveforms 
configured in the Select Waveform dialog, accessed by clicking the 
Select Waveform button.

Menu Item Function Description

Time Select the time before which a tabular 
trends report will be printed

/

Period Select the period during which a 
tabular trends report will be printed.

Auto: one page of a tabular trends before the current time 
will be printed at the selected Interval.
All: all stored tabular trends will be printed at the selected 
Interval.
30 min to 96 hrs: 30 min to 96 hrs of tabular trends before 
the selected Time will be printed at the selected Interval.

Interval Select the resolution of the tabular 
trends printed on a report.

NIBP, EWS, GCS,  C.O.: at an interval of acquiring the values 
of selected parameter.
Auto: using the Interval setting of the Tabular Trends 
review page.
5 sec to 3 hrs: the tabular trends will be printed at the 
interval of 5 sec to 3 hrs.
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30.6.4 Configuring Graphic Trends Reports
To set graphic trends reports, follow this procedure:

1. Select the Main Menu quick key →from the Report column select Report Setup. 

2. Select the Graphic Trends Report tab. 

3. Set the desired options.

30.7 Viewing Printer Status
You can view the status of the most recent ten printing tasks in the Print Queue dialog. To view the status of 
printing tasks, follow this procedure:

1. Select the Main Menu quick key → from the Report column select Print Queue.

2. View the status of printing tasks in the Print Queue dialog. 

Each printing task includes the following information:

■ Print time

■ Report title

■ Printer name (when using the printer server) or IP address (when using the network printer)

■ Printing status, for example, printing, failed, retrying, and waiting.

30.8 Printer Out of Paper
When the printer runs out of paper, the print request will remain incomplete. If there are too many print jobs that 
remain incomplete, then a printer error may occur. To resolve the error, install paper. Some print requests may be 
lost if the incomplete tasks overflow the printer buffer. Missing or lost reports must be recreated and printed.

To reduce risks of printer errors, maintain enough paper in the printer.

30.9 List of Reports
The monitor can output the following reports to the printer:

■ Realtime reports

◆ Realtime Report

◆ Freeze Report

◆ ECG Report (5-lead, 6-lead, 12-lead)

◆ 12-Lead Interpretation Report (realtime)

Report Format Select the printing principle. Parameter Oriented: print one page span of report with 
parameters listed by row and time listed by column when 
Interval is set to Auto.
Time Oriented: print one page span of report with time 
listed by row and parameter listed by column when Interval 
is set to Auto.
Note that Interval on Auto only limits the number of rows or 
columns for Time. The report may have multiple pages to 
accommodate the number of parameters. To limit the 
parameters, change the Trend Group.

Menu Item Function Description

Menu Item Function Description

Period Select the period during which a 
graphic trends report will be printed.

Auto: one page of a graphic trends before the current 
time will be printed.
All: all stored graphic rends will be printed..
30 min to 96 hrs: 30 min to 96 hrs of graphic trends 
before the selected Time will be printed.
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◆ Print on Alarm Report

◆ Alarm Limits Report

◆ Titration Table Report

◆ Hemodynamic Calculation Report

◆ Oxygenation Calculation Report

◆ Ventilation Calculation Report

◆ Renal Calculation Report

◆ EEG Report

◆ CSA Report (EEG expand View - CSA)

◆ EEG Report (EEG expand View - EEG)

◆ Hemodynamic Report (hemodynamic parameters)

◆ Hemodynamic Report (hemodynamic graphics)

◆ ST Report (Realtime)

◆ QT Report (Realtime)

◆ OxyCRG Report

◆ C.O. Measure Report

◆ PAWP Report

◆ ECG 24h Summary & Typical Strips

◆ Device Integration - Loops Report (BeneLink)

■ History reports

◆ Tabular Trends Report

◆ Graphic Trends Report

◆ Event List Report

◆ Event Detail Report

◆ Full Disclosure Overview Report

◆ Full Disclosure Detail Report

◆ 12-Lead Review Interpretation Report (review)

◆ ST Report (review)

◆ OxyCRG review Report (review)

■ End Case Report

◆ End Case Report - Realtime Report

◆ End Case Report -ECG Report

◆ End Case Report - Tabular Trends Report

◆ End Case Report - Graphic Trends Report
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31 Using the On-Screen Timers

The monitor has a Timer function to notify you when a preset time period is expired or how much time has 
elapsed. You can simultaneously display up to four timers. 

31.1 Displaying Timers
To display a timer, follow this procedure:

1. Access Tile Layout in either of the following ways:

◆ Select the Screen Setup quick key → select the Tile Layout tab.

◆ Select the Main Menu quick key → from the Display column select Tile Layout.

2. Click the numeric tile area where the timer is to be displayed, and then select a timer from the popup list.

31.2 Controlling the Timer
The timer provides the following controls, depending on the state and settings of the timer:

■ Start: starts the timer. 

■ Pause: pauses the timer.

■ Resume: resumes the timer.

■ Reset: clears the timer.

31.3 Setting the Timer
You can set each timer independently. To set the timer, follow this procedure:

1. Select the timer area to enter the Timer Setup dialog.

2. Set Timer Type:

◆ Normal: The timer has a single and defined run time, and stops with a notification beep when the run 
time is reached.

◆ Advanced: The timer has a single and defined run time. When the run time is reached, the timer 
makes a notification beep and continuously displays the time beyond the end of run time.

◆ Cycled: The timer has a single and defined run time. When the run time is reached, the timer makes a 
notification beep and restarts automatically. The number of elapsed cycles is also displayed on the 
left of the Timer tile. 

◆ Unlimited: The timer displays the time elapsed since the timer was started.

◆ Clock: The timer displays the system time.

3. Set Direction.

◆ Up: the timer counts up, from zero to Run Time.

◆ Down: the timer counts down, from Run Time to zero.

4. Set Run Time.

5. Set Reminder Volume. 

A progress bar is shown with the run time. When the remaining time is 10 seconds, the monitor issues a 
reminder tone and the timer flashes in red, prompting you that the run time is about to expire. 

NOTE
• You cannot change timer settings, other than Reminder Volume when a timer is running.

• You can set Direct, Run Time, and Reminder Volume only for normal, advanced, and cycled timers.
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32 Managing Configurations

32.1 Configuration Introduction
When performing continuous monitoring on a patient, the clinical professional often needs to adjust the 
monitor’s settings according to the patient’s condition. The collection of all these settings is called a 
configuration. The system configuration items can be classified as: parameter configuration items, conventional 
configuration items, and user maintenance items. Allowing you to configure the monitor more efficiently, the 
monitor provides different sets of configurations to accommodate the varying patient categories and 
departments. You can change some settings from a certain set of configuration and then save the changed 
configuration as a user configuration.

The default configurations provided for your monitor are department-oriented. You can choose either from:

■ General

■ OR

■ ICU

■ Neonatology

■ CCU

Each department has three different sets of configurations tailored for adult, pediatric and neonatal patients 
respectively.

WARNING

• The configuration management function is password protected. The configuration management 
tasks must be performed by clinical professionals.

32.2 Changing the Department
If the current department configuration is not the one you want to view, you can change the department by 
following this procedure:

1. Select the Main Menu quick key → from the Configuration column select Manage → input the required 
password → select .

2. Select Change Department.

3. Select a department.

4. Select Ok.

CAUTION

• Changing the department will delete all current user configurations.

32.3 Setting Default Patient Category
To set the default patient category when admitting a new patient, follow this procedure:

1. Select the Main Menu quick key → from the Configuration column select Manage → input the required 
password → select .

2. Set Default Patient Category.

32.4 Setting Default Configuration
The monitor will load the pre-set default configuration in the following cases:
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■ A patient is admitted.

■ A patient is discharged.

■ Patient category is changed.

To set the default configuration, follow this procedure:

1. Select the Main Menu quick key → from the Configuration column select Manage → input the required 
password → Select .

2. Select Select Default Config.

3. Select Load the Latest Config or Load Specified Config.

◆ When you select Load Specified Config, the restored configuration is subject to the patient category 
(adult, pediatric or neonate). This configuration can be either factory configuration or a saved user 
configuration. As an example, select Default Adult Config and then select Factory Default or user 
configuration(s).

◆ When you select Load the Latest Config, the latest configuration is loaded when the monitor is 
started or a patient is admitted. 

32.5 Saving Current Settings
Current settings can be saved as a user configuration. Up to 25 user configurations can be saved.

To save current settings, follow this procedure:

1. Select the Main Menu quick key → from the Configuration column select Manage → input the required 
password → Select .

2. Select Save Current Settings.

3. Input the configuration name.

4. Select Ok to save current settings as a user configuration.

32.6 Deleting a Configuration
To delete a configuration, follow this procedure:

1. Select the Main Menu quick key → from the Configuration column select Manage → input the required 
password → Select .

2. Select Delete Configuration. 

3. Select the configuration you want to delete:

◆ In the Delete Configuration dialog, selecting Local tab shows the existing user configurations on the 
monitor. 

◆ In the Delete Configuration dialog, selecting USB Drive tab shows the existing user configurations 
on the USB drive.

4. Select Delete.

5. Select Ok.

32.7 Transferring a Configuration
When installing several monitors with identical user configurations, it is not necessary to set each unit 
separately. Use a USB drive to transfer the configuration from monitor to monitor.

32.7.1 Exporting a Configuration
To export the current monitor’s configuration, follow this procedure:

1. Connect the USB drive to the monitor’s USB port.

2. Select the Main Menu quick key → from the Configuration column select Manage → input the required 
password → Select .

3. Select Export Configuration.
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4. Select the configurations and User Maintenance Settings to export.

5. Select Export. 

32.7.2 Importing a Configuration
To import the configuration from the USB drive to the monitor, follow this procedure:

1. Connect the USB drive to the monitor’s USB port.

2. Select the Main Menu quick key → from the Configuration column select Manage → input the required 
password → Select .

3. Select Import Configuration.

4. Select the configurations and User Maintenance Settings to import. 

5. Select Import. 

32.7.3 Loading a Configuration
You may make changes to some settings during operation. However, these changes or the pre-selected 
configuration may not be appropriate for the newly admitted patient. Therefore, the monitor allows you to load 
a desired configuration to ensure that all the settings are appropriate for your patient.

To load a configuration, follow this procedure:

1. Select the Main Menu quick key → from the Configuration column select Load.

2. Select the desired configuration.

◆ Select the configuration on this monitor in the Local page.

◆ Select the configuration on the USB drive in the USB Drive page.

3. Select Load.

NOTE

• The monitor may configure some settings by default when you load a configuration of different 
software version with the current configuration.

32.8 Printing Configurations
To print both factory configurations and user configurations, follow this procedure:

1. Select the Main Menu quick key →from the Configuration column select Manage → input the required 
password → select .

2. Select Print Configuration.

3. Select desired configurations.

4. Select Print.

32.9 Modifying Configuration Password
To modify the configuration password, follow this procedure:

1. Select the Main Menu quick key → from the Configuration column select Manage → input the required 
password → Select .

2. Select Modify Password.

3. Respectively input the old password and new password.

4. Select OK.
BeneVision N22/N19/N17/N15/N12 Patient Monitor Operator’s Manual 32 - 3



This page intentionally left blank.
32 - 4  BeneVision N22/N19/N17/N15/N12 Patient Monitor Operator’s Manual



33 Password-protected User Settings

This chapter describes the password-protected functions accessed in the Maintenance dialog.

33.1 Setting the Device Location

33.1.1 Setting Monitor Information
To set monitor information, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Device Location tab.

3. Input monitor name, facility name and department name.

33.1.2 Setting Monitor Location
If your monitor is installed at a fixed position, or you do not need clinicians to change the room number and bed 
number, you can set Monitor Location to Fixed. To set the monitor location, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Device Location tab.

3. Set Location.

◆ Fixed: the Patient Management dialog displays Bed No. and Room No., but you cannot change 
them.

◆ Unfixed: you can change Bed No. and Room No. from the Patient Management dialog.

4. Input the room number and bed number. 

NOTE

• If Location is set to Unfixed, Bed No. and Room No. are cleared from the Device Location tab each 
time you discharge a patient. 

33.1.3 Enabling the Auto Obtain Bed Number Function
If the monitor is connected to the wired network, the monitor can automatically set the patient’s bed number 
according to the bed number information bonded to the bedside network connector.

 To enable this function, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Device Location tab.

3. Select Unfixed.

4. Switch on Auto Obtain Bed No..

NOTE

• The Auto Obtain Bed Number function is available only when the switch connected to the monitor 
supports the LLDP or CDP protocol, and the corresponding protocol is enabled.
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33.2 Changing Patient Management Settings

33.2.1 Selecting Displayed Patient Information
You can define which items can be displayed and edited from the Patient Management tab. To do so, follow 
this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Patient Management tab.

3. Select the fields you want to display in the Patient Management dialog.

4. If necessary, select the customized fields and input names for these fields.

NOTE

• If the monitor is connected with the CMS, the patient information items and customized fields are 
loaded from the CMS.

33.2.2 Setting the Length of Data Transferred by N1 or T1 
When using N1 or T1 to transfer the patient data, you can set the data transfer length. To do so, follow this 
procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Patient Management tab → select the Transfer tab.

3. Set Transfer Data Length.

33.2.3 Setting the Strategy of Transferring Patient Information
When N1, T1or MPM is connected to the monitor, N1, T1 or MPM automatically uploads the data to the monitor 
if the patient demographic information in the monitor are consistent with those of in N1, T1 or MPM. However, 
the monitor needs a data transfer strategy if the patient demographic information in the monitor are not 
consistent with those of in the N1/T1/MPM. To set the data transfer strategy, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Patient Management tab → select the Transfer tab.

3. Select Data Transfer Strategy.

◆ Always Ask: always prompts a dialog box to ask for strategy.

◆ Continue Patient in Module: continue to use the patient data in N1/T1/MPM. The monitor 
discharges the patient, and automatically admits a new patient and copies all data from N1/T1/MPM.

◆ Continue Patient in Monitor: continue to use the patient information in the monitor. The monitor 
deletes all patient information in the N1/T1/MPM and copies the parameter settings in the monitor to 
the N1/T1/MPM.

33.2.4 Transferring the N1 or T1 Settings
When transferring the N1 or T1 data, the settings can also be transferred. To transfer settings, follow this 
procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Patient Management tab → select the Transfer tab.

3. Set Apply Module Settings to On.
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33.2.5 Auto Discharging a Patient after Monitor Power Off
You can let the monitor automatically discharge after the monitor has been switched off for a period of time.

To set the time period of discharging a patient, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Patient Management tab→ select the Discharge tab.

3. Select a time for Auto Discharge When Power Off. The monitor will automatically discharge the patient 
when it is turned off for the designated period of time. The default is Never. That is to say the monitor will 
not automatically discharge a patient, regardless of how long the monitor has been switched off.

33.2.6 Clearing All Patient Data

You can delete all patient information and data in the monitor. To do so, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Patient Management tab→ select the Discharge tab.

3. Select Clear All Patient Data. 

4. Select OK. Select OK again for confirmation until a message indicating you that all data is cleared.

CAUTION
 

• Clearing patient data will discharge the current patient. Make sure there is no patient is being 
monitored before you clear all data.

33.2.7 Selecting Query Criteria for Searching Patients in ADT Server
You can define which criteria can be used to search patients in the ADT server. To do so, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Patient Management tab → ADT Query tab.

3. Select the query criteria as desired.

33.2.8 Setting Patient Location Options for the Discharge Screen
To set options for patient location, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Patient Management tab → select the Location tab.

3. Input or edit patient location options.

33.2.9 Hiding Patient Name
To hide patient name on specific screens, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Patient Management tab → select the Display tab.

3. Set the following switches as desired:

◆ Switch off Primary Screen Display Full Name: does not display patient name in the patient 
information area on the primary display.

◆ Switch off Secondary Screen Display Full Name: does not display patient name in the patient 
information area on the secondary display, if configured.
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◆ Switch off Remote View Display Full Name: does not display patient name in the patient 
information area on the remote monitors when this monitor is viewed by other monitors.

◆ Switch off Remote View Bedlist Display Full Name: does not display patient name in bed list on the 
remote monitors when this monitor is viewed by other monitors.

33.2.10 Select Whether a Prompt is Required When Auto Deleting Discharged Patients
The monitor automatically delete earlier discharged patients when the memory is limited. You can select 
whether an alarm is issued when discharged patients are automatically deleted and the monitor memory is very 
low.

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Set the Review tab → Discharged Patients tab.

3. Configure the alarms as needed:

◆ Prompt on patient auto deleted: an alarm is issued when the monitor automatically deletes earlier 
discharged patients.

◆ Alarm on storage is nearly full: selects whether an alarm is issued when the monitor memory is very 
low and the priority of this alarm.

33.3 Changing the Alarm Settings

33.3.1 Setting Alarm Tone Properties

33.3.1.1 Setting the Minimum Alarm Volume

To set the minimum alarm volume, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select . 

2. Select the Alarm tab → Audio tab.

3. Set Minimum Alarm Volume. 

33.3.1.2 Setting the Audible Alarm Tone Pattern

You can distinguishes the heart beat tone, pulse tone, and keystroke tone by frequency. You can choose any of 
the three tone patterns: ISO, Mode 1, and Mode 2. For more information, see 8.3.3 Alarm Indicators. 

To set the alarm tone pattern, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Audio tab.

3. Set Alarm Sound to ISO, Mode 1or Mode 2.

33.3.1.3 Setting the Interval between Alarm Sounds

If you choose the ISO pattern, you can change the interval between alarm tones. To change the interval between 
alarm tones, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Audio tab.

3. Set High Alarm Interval, Med Alarm Interval, and Low Alarm Interval.
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33.3.1.4 Setting Alarm Volume Escalation

The monitor provides the function of automatically escalating the alarm tone volume. When this function is 
enabled, if an alarm is not reset within the designated delay time after the alarm occurs, the volume of the alarm 
tone increases automatically. 

To set the alarm volume escalation, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Audio tab.

3. Set Auto Increase Volume.

◆ 2 Steps: if an alarm is not reset within the designated delay time after the alarm occurs, the alarm 
volume automatically increases by two levels.

◆ 1 Step: if an alarm is not reset within the designated delay time after the alarm occurs, the alarm 
volume automatically increases by one level.

◆ Off: if an alarm is not reset within the designated delay time after the alarm occurs, the volume of the 
alarm tone does not change.

4. Select Increase Volume Delay to set the delay time of alarm volume escalation.

NOTE

• The alarm volume escalation function is not applied to the latched alarms.

33.3.2 Setting Alarm Pausing and Resetting Properties

33.3.3 Defining the Pause Function
You can either pause alarms or pause alarm tones. This depends on the pause setting. To set the pause function, 
follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Pause/Reset tab.

3. Set Pause to Alarm Pause or Audio Pause. 

33.3.3.1 Setting the Alarm Pause Time/Alarm Tone Pause Time

The alarm pause time or alarm tone pause time can be set to 1 min, 2 min, 3 min, or Permanent. The default 
audio pause time is two minutes. 

To set the alarm tone pause time, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Pause/Reset tab.

3. Set Pause Time. 

33.3.3.2 Setting the Priority of Audio Paused Alarms

To select alarm of what priority can be paused or alarm sound of what priority can be paused, follow this 
procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Pause/Reset tab.

3. Set Pause Priority.

◆ All: pressing the Alarm Pause quick key pauses all alarms.
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◆ Med & Low: pressing the Alarm Pause quick key pauses alarms of medium and low priority. The high 
priority alarms will not be paused.

◆ Disable: the Alarm Pause quick key is disabled.

33.3.3.3 Disabling the Options of Prolonging Alarm Pause Time/Alarm Tone Pause Time 

To disable specific options for the clinician when prolonging alarm pause time or the alarm tone pause time, 
follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Pause/Reset tab.

3. Switch off Pause 5 min, Pause 10 min, or Pause 15 min.

33.3.3.4 Setting Alarm Light Status on Alarm Reset 

When the alarm system is reset, the monitor presents the alarm light by default , but you can switch off the alarm 
light. To change the alarm light setting, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Pause/Reset tab.

3. Set Alarm Light.

◆ On When Reset: when the alarm system is reset, the alarm tones of the current alarms are switched 
off, but the alarm lamp remains flashing. 

◆ Off When Reset: when the alarm system is reset, both the alarm tone and alarm lamp of the current 
alarms are switched off. 

33.3.3.5 Setting the Reminder Tones

When the alarm volume is set to zero, or the alarm is reset or switched off, the monitor issues a periodical 
reminder tone. The reminder tone is enabled by default.

To set the reminder tone, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Pause/Reset tab.

3. Set Alarm Reset Reminder and Alarm Off Reminder.

◆ On: the monitor issues reminder tones at a designated interval.

◆ Re-alarm: if the alarm condition persists the alarms marked with “√” will be re-generated after the 
designated reminder tone interval.

◆ Off: the monitor does not issue reminder tones at a designated interval. The alarms marked with “√” 
will be silenced.

4. Set Reminder Interval to 10 min, 5 min, 3 min, 2 min, or 1 min.

33.3.4 Latching Physiological Alarms
To latch physiological alarms, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Latching tab.

3. Select how you want to latch the alarms.

Alarm latching rules are as follows:

■ You can separately latch visible alarm signals and audible alarm signals.
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■ Latching audible alarm signals simultaneously latches the corresponding visible signals.

■ Selecting alarms of lower priority simultaneously latches higher priority alarms. 

■ Switching V-Tach Latching Lock off allows you to switch on or off V-Tach Latching.

■ When V-Tach Latching Lock is switched on, V-Tach latching follows the setting of Lethal alarm latching 
and you cannot control V-Tach Latching.

33.3.5 Changing Remote Alarm Settings

33.3.5.1 Resetting Alarms for Remote Devices

You can reset the alarms occurring on the remote devices that are viewed on the Remote View screen of the 
monitor. To enable this function, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Alarm tab → Remote View tab.

3. Switch on Reset Remote Bed Alarms. Then the Alarm Reset button appears on the bottom left of the 
Remote View screen.

To reset any remote device alarms, the clinician may now select the Alarm Reset button at the bottom of the 
Remote View screen.

NOTE

• You can reset remote device alarms only if the Alarm Reset By Other Bed switch is on at the remote 
devices and alarms are occurring on the remote device.

33.3.5.2 Authorizing the Alarm Reset to Other Devices

Alarms on your monitor can be reset by remote devices if you enable this function. To do so, follow this 
procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Alarm tab → Remote View tab.

3. Switch on Alarm Reset By Other Bed. 

33.3.5.3 Selecting the Alarm Reminder for Remote Devices

You can configure what alarm indicators are necessary for the remote devices. To do so, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Alarm tab → Remote View tab.

3. Select Alarm Reminder:

◆ Visible + Audible: the monitor provides visual alarm indication, and continuous audible alarm 
indication if the alarm persists at the remote device.

◆ Visible + Single Tone: the monitor provides visual alarm indication, and a single tone when the alarm 
occurs at the remote device.

◆ Visible Only: the monitor only provides visual alarm indication.

33.3.5.4 Presenting Alarm Sound for Remote Devices as per Alarm Priority 

You can configure what priority of remote device alarms are presented for audible notification. To do so, follow 
this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Alarm tab → Remote View tab.
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3. Select Alarm Priority:

◆ All: the monitor sounds if an alarm occurs.

◆ High & Med: the monitor sounds if a high or medium priority alarm occurs.

◆ High Only: the monitor sounds only if a high priority alarm occurs.

33.3.5.5 Setting the Tone Pattern for Alarms from Remote Devices

The monitor provides the same alarm tone pattern for the remote device alarms as those for your monitor 
alarms. For more information on alarm tone pattern, see 8.3.3 Alarm Indicators.

To set the alarm tone pattern for the remote device alarms, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Alarm tab → select the Remote View tab.

3. Set Alarm Sound to ISO, Mode 1 or Mode 2.

33.3.5.6 Switching Off the Remote Device Disconnection Alarm

The monitor can provide an alarm if remote devices, for example, a bedside monitor or a telemetry, are 
disconnected. By default, the function is enabled. To disable the alarm, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Alarm tab → Remote View tab.

Switch off Remote Disconnected Alarm. 

33.3.6 Setting Nurse Call Properties

33.3.6.1 Selecting Alarms to be Sent to the Nurse Call System

To set the type and priority of alarms that are sent to the nurse call system, follow this procedure: 

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Nurse Call tab.

3. Select Signal Type

◆ Pulse: the nurse call signal is a pulse signal and each pulse lasts one second. When multiple alarms 
simultaneously occur, only one pulse signal is outputted. If an alarm occurs but the previous one is 
not cleared, a new pulse signal will also be outputted. 

◆ Continuous: the nurse call signal lasts until the alarm ends. That is to say the duration of a nurse call 
signal is equal to that of the alarm condition.

4. Select Contact Type to set the work mode of the nurse call relay.

5. Select Alarm Priority to set the priority of alarms sent to the nurse call system. 

6. Select Alarm Type to set the type of alarms sent to the nurse call system.

33.3.6.2 Disabling the Receiving Call Help Function

If a monitor in the same department calls for help, you can receive the calling signal. This function is enabled by 
default. To disable this function, follow this procedure:

1. Select the Main Menu quick key →from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Nurse Call tab.

3. Switch off Receive Call Help.
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33.3.6.3 Enabling Presenting the Nurse Call from the Telemetry

If the telemetry is connected, the monitor can pops up the nurse call dialog if nurse call is initiated from the 
telemetry. To enabling this function, follow this procedure:

1. Select the Main Menu quick key →from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Nurse Call tab.

3. Switch on Telemetry Nurse Call.

33.3.7 Changing Alarm Priority Settings

33.3.7.1 Setting the Priority of the ECG Lead Off Alarm

To set the priority of the ECG lead off alarm, follow this procedure: 

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Alarm tab→ select the Other tab.

3. Set the priority of ECG Lead Off. 

33.3.7.2 Setting the Priority of the SpO2 Sensor Off Alarm

To set the priority of the SpO2 sensor off alarm, follow this procedure: 

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Alarm tab→ select the Other tab.

3. Set the priority of SpO2 Sensor Off. 

33.3.7.3 Setting the Priority of the IBP No Sensor Alarm

To set the priority of the IBP no sensor alarm, follow this procedure: 

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Alarm tab→ select the Other tab.

3. Set the priority of IBP No Sensor. 

33.3.7.4 Setting the Switch of the CMS and eGateway Disconnection Alarm

You can choose whether to issue an alarm when the monitor is not connected or disconnected from the CMS/
eGateway. To do so, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Other tab.

3. In the Other block, switch on or off CMS/eGW Disconnected Alarm. If CMS/eGW Disconnected Alarm is 
switched off, the “Offline” alarm is not presented when the monitor is not connected or disconnected from 
the CMS/eGateway.

33.3.7.5 Setting the Priority of the CMS and eGateway Disconnection Alarm

To set the priority of the CMS and eGateway disconnection alarm, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Other tab.
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3. Set CMS/eGW Disconnected.

33.3.7.6 Setting the Switch of the SpO2 Desat Alarm Off

You can choose whether switching off the SpO2 Desat alarm is permissible or not. To do so, follow this 
procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → select the Other tab.

3. Set SpO2 Desat Alarm Off.

◆ Disable: the SpO2 Desat alarm is always on. You cannot switch it off.

◆ Enable: you can switch off the SpO2 Desat alarm. For more information, see 12.6.1 Changing the SpO2 

Alarm Settings.

WARNING

• If a clinician switches off the SpO2 Desat alarm, the monitor will not alarm when the patient’s SpO2 is 
extremely low. This may result in a hazard to the patient. 

33.3.7.7 Setting the Switch of the Apnea Alarm Off

You can choose whether switching off the apnea alarm is permissible or not. To do so, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → select the Other tab.

3. Set Apnea Alarm Off.

◆ Disable: the apnea alarm is always on. The clinician cannot switch it off.

◆ Enable: the clinician can switch off the apnea alarm. For more information, see 11.5.1 Setting the Resp 
Alarm Properties.

WARNING

• If a clinician switches off the apnea alarm, the monitor will not issue the apnea alarm when that 
situation occurs. This may result in a hazard to the patient. Keep the patient under close 
surveillance. 

33.3.8 Changing Alarm Delay Settings

33.3.8.1 Setting the Alarm Delay Time

 For continuously measured parameters, you can set the alarm delay time. If the alarm condition is resolved 
within the delay time, the monitor does not present the alarm. 

To set the alarm delay time, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Other tab.

3. Set Alarm Delay.

◆ Off: an alarm is presented as soon as the alarm condition occurs.

◆ 1 sec ~ 8sec: for continuously measured parameters, an alarm is not presented if the alarm condition 
is resolved within the designated delay time.
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The setting of Alarm Delay is not applied to the apnea alarms and the ST alarms. You can set Apnea Delay and 
ST Alarm Delay separately. 

WARNING

• The alarm delay time can be set to a maximum of 8 seconds. Changing this setting to an 
inappropriate level could result in a hazard to the patient.

33.3.8.2 Setting the ST Alarm Delay Time
1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Other tab.

3. Set ST Alarm Delay.

33.3.9 Adjusting the Alarm Light Brightness
To adjust the alarm light brightness, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Other tab.

3. From the Alarm Light Brightness area, set Primary Screen (note that you may have to scroll up the dialog 
to see this option). If you set alarm light brightness to Auto, the monitor automatically adjusts the alarm 
light brightness according to the ambient light. The stronger the ambient light is, the brighter the alarm 
light is. 

For N22/N19, if you are using a secondary display, set the Secondary Screen too.

33.3.10 Changing Other Alarm Settings

33.3.10.1 Setting the Lethal Arrhythmia Alarms Switch

To allow a clinician to disable the lethal arrhythmia alarms, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Alarm tab→ select the Other tab.

3. From the Other block, set Lethal Arrh Alarms Off as follows.

◆ Lethal Arrh Alarms Off is set to Disable by default. In this case, a clinician cannot switch off lethal 
arrhythmia alarms. 

◆ If you set Lethal Arrh Alarms Off to enable, a clinician can switch off lethal arrhythmia alarms from 
the ECG dialog. For more information, see 9.6.4.1 Changing Arrhythmia Alarm Settings.

WARNING

• If any of lethal arrhythmia alarms are switched off, the ECG waveform area displays a message to 
indicate that corresponding alarms are off. 

• If a clinician switches off all arrhythmia alarms, the monitor will not present arrhythmia alarms. 
Always keep the patient under close surveillance.

33.3.10.2 Setting the Intubation Time

The default intubation time is 2 minutes. To change the intubation time, following this procedure: 
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1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Alarm tab → Other tab.

3. Set the Intubation Mode Period.

33.3.10.3 Enabling Automatic Recordings on an Alarm

Print on Alarm is set to Printer by default. To enable automatic recording via recorder when a parameter alarm 
is triggered, set Print on Alarm to Recorder. To do so, follow this procedure: 

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Alarm tab → select Other.

3. Set Print on Alarm to Recorder.

33.3.10.4 Setting Arrhythmia Alarm Timeout Period

The arrhythmia algorithm can disable alarm light and alarm tone for designated period of time when certain 
arrhythmia alarms are detected. 

To set the arrhythmia alarm timeout period, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Alarm tab→ select the Other tab.

3. From the Other block, set Arrhy Shield Time.

NOTE

• For the following alarms, alarm light and alarm tone cannot be disabled: HR high, HR low, 
Tachycardia, Bradycardia, Afib End, Irr Rhythm End.

• The arrhythmia alarm timeout period is only applied to the medium priority chains and atrial 
fibrillation chain. For the alarms in the high priority chain, alarm tone and alarm light are presented 
as soon as the alarm condition is detected. Refer to 9.6.5.1 Arrhythmia Alarm Chains for more 
information on the arrhythmia alarm chain.

• Alarm indication rules for alarms in the atrial fibrillation chain are the same with those for the 
medium priority chains. 

33.4 Changing CAA Settings

33.4.1 Enabling Inputing the Clinician ID
To display the clinician ID on the EWS screen, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the CAA tab → select the EWS tab.

3. Switch on Clinician ID.

4. Select Clinician ID Timeout to set how long the clinician ID will remain valid.

NOTE
• The EWS tab is only available if a license for EWS is installed in the monitor.

33.4.2 Selecting the Default Scoring Tool
To set the default scoring tool for different patient category, follow this procedure:
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1.  Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the CAA tab → select EWS tab.

3. From the Select Default Score area, set Default Adult Score, Default Ped Score, and Default Neo Score.

33.4.3 Managing the Scoring Tools
To manage the scoring tool, follow this procedure:

1.  Select the Main Menu quick key →from the System column select Maintenance → input the required 
password → select .

2. Select the CAA tab → select EWS tab.

3. Select the Manage Score button.

◆ Delete local scoring tools: from the Local page, delete any unnecessary scoring tools.

◆ Import the desired scoring tools to the monitor: from the USB drive page, select the scoring tools on 
the USB drive, and then select Import.

NOTE

• The monitor provides MEWS and NEWS by default. You cannot delete them.

33.4.4 Setting GCS Threshold for Each Consciousness Level
You can configure the threshold and color of each consciousness level. To do so, follow this procedure:

1.  Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the CAA tab → select the GCS tab.

3. Set high limit, low limit for each level.

33.5 Changing Module Settings

33.5.1 Selecting the ECG Standard
Select the ECG standard according to the leadwires you are using. To select the ECG standard, follow this 
procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Module tab → ECG tab.

3. Set ECG Standard to AHA or IEC.

33.5.2 Changing the QTc Formula
The monitor uses the Hodges correction formula by default to correct the QT interval for heart rate. To select the 
QTc formula, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Module tab → ECG tab.

3. Set QTc Formula.

◆ Hodges: 

◆ Bazett: 

◆ Fridericia: 
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◆ Framingham: 

33.5.3 Setting the 12-Lead Order Switch
To set whether to send the order number of 12-lead interpretation report to the hospital information system 
while saving the report, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Module tab.

3. Select the ECG tab.

4. Set 12-Lead Order.

33.5.4 Calibrating ECG
The ECG signal may be inaccurate due to hardware or software problems. As a result, the ECG waveform 
amplitude becomes greater or smaller. In that case, you need to calibrate the ECG module. To do so, follow this 
procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Module tab → ECG tab.

3. From the bottom left corner of the dialog select Calibrate.

33.5.5 Manually Zeroing the CO2 Module

To zero the CO2 module, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Module tab → CO2 tab.

3. From the bottom left corner of the dialog select Zero.

33.5.6 Hiding the Invalid Display after Zeroing the CO2 Module

After the zero calibration is completed, the CO2 module reacquires the CO2 readings. During the reacquisition 
period, “Zero Recovering” is displayed in the CO2 numeric area. Valid data will reappear 30 seconds after the 
zero calibration is started. 

To hide the display of the “Zero Recovering” message, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Module tab → CO2 tab.

3. Switch off Zero Recovery for 30s. 

Selecting Defaults from the bottom of the dialog can restore this setting to the factory default.

33.5.7 Manually Zeroing the AG Module
To zero the AG module, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Module tab → AG tab.

3. From the bottom left corner of the dialog select Zero.

QTc QT 154 1
60

HeartRate
-----------------------------– 

 ×+=
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33.5.8 Hiding the Invalid Display after Zeroing the AG Module
After the zero calibration is completed, the AG module reacquires the AG readings. During the reacquisition 
period, “Zero Recovering” is displayed in the AG numeric area. Valid data will reappear 30 seconds after the zero 
calibration is started. 

To hide the display of the “Zero Recovering” message, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Module tab → AG tab.

3. Switch off Zero Recovery for 30s. 

Selecting Defaults from the bottom of the dialog can restore this setting to the factory default.

33.5.9 Selecting the Gas Type for Measurement
You can select what gases detected by the monitor are used for measurements. To do so, follow this procedure:

1. Ensure that the AG module is inserted in the monitor.

2. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

3. Select the Module tab → AG tab.

4. Set Types of Gas Measurement. Any gas that is not selected, will not be displayed or used for calculating 
the MAC value. When the concentration of any unselected gas is equal to or greater than 1%, you will be 
prompted to select the gas and enable the measurement (Set XX measurement to On).

Selecting Defaults from the bottom of the dialog can restore this setting to the factory default.

33.5.10 Setting Parameter Measurement Timeout
NIBP measurements become outline fonts after a preset time. This feature prevents older values being 
misinterpreted as current measurements. To adjust the timeout period for PAWP, C.O., and NIBP, follow this 
procedure: 

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select . 

2. Select the Module tab → select the Other tab.

3. Set the timeout period for PAWP, C.O., and NIBP.

33.5.11 Setting Flow Rate (For Sidestream CO2 Module Without O2)

When you are using the sidestream CO2 module without the O2 monitoring function to monitor a neonatal 
patient, you can select flow rate. To do so, follow this procedure:

1. Ensure that the sidestream module without O2 is inserted in the monitor.

2. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

3. Select the Module tab → Other tab.

4. Set CO2 Flow Rate For Neo.

33.6 Hiding Undesired Review Tabs
If you do not need to review some items, you can hide them. To do so, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Review tab.

3. From the Tabs page, Event page or Arrh Mark page deselect those that do not need to be available to 
clinicians during review.
BeneVision N22/N19/N17/N15/N12 Patient Monitor Operator’s Manual 33 - 15



33.7 Setting the Printer

33.7.1 Setting the Printer Properties
To set a network printer, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Print tab.

3. In the Printer tab, select Connection Type to choose whether you want to output patient reports via the 
print server or a network printer.

4. If you set Connection Type to Print Server, perform the following settings:

◆ Print Server Address: select  to input the print server name or IP address.

◆ Port: selects  to input the print server port. If the CMS is used as the print server, set Port to 6603.

◆ Set the report type in the Report Type area. For more information, see section 33.7.2 Setting the 
Report Type. 

5. If you set Connection Type to Printer, perform the following settings:

◆ Select Printer IP Address. Select  to input the IP address of the desired network printer.

◆ Select Paper Size.

◆ Select Resolution.

After finishing configurations, you can select the Print Test Page button to verify that the printer works properly.

33.7.2 Setting the Report Type
If the Connection Type is set to Print Server, you need to set the report type:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Print tab.

3. Set Connection Type to Print Server.

4. Select the report you intend to set, for example, General Report.

5. Set the Print Action:

◆ Paper: outputs paper report.

◆ PDF: outputs the electronic report in PDF format.

◆ Paper And PDF: outputs both the paper report and the PDF report.

6. For paper report, respectively select Printer and Printer Resolution to set the default printer and the 
resolution for the default printer.

7. For PDF report, select the PDF Resolution to set the resolution.

NOTE

• General reports refer to the reports other than the end case report and realtime alarm report.

33.7.3 Setting the Report Layout

 To set the patient information you want to display on general reports, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Print tab. 

3. Select the Report Layout tab.

4. Select the desired items under Report Name. N/A indicates that this item is not displayed on a report.
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33.7.4 Setting Patient Information on 12-lead ECG Reports
To set the patient information you want to display on 12-lead ECG reports, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Print tab.

3. select the ECG Report tab.

4. On the right of the ECG Report page, select the desired patient information items. Patient ID, Patient 
Name, Age, and Gender are displayed on an ECG report by default.

NOTE

• You can only set the patient information to display on the ECG report from the ECG Report page. 
Patient information configured in the Report Layout page is not applied to ECG reports.

33.7.5 Configuring the Name of PDF Files
If you use the print server to output patient reports, you can use the PDF printer to output PDF format reports. To 
configure the name of PDF files, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Print tab → PDF File Name tab. 

3. Select the desired items and their sequence under PDF File Name. N/A refers to no information.

33.7.6 Showing the Second Mark
To set whether you want to show second marks on the report output by the printer, follow this procedure.

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Print tab → Other tab.

3. Enable or disable Second Mark (Printer).

33.7.7 Setting the Arrhythmia Information to Output by the Recorder
To set whether you want to include arrhythmia thresholds and QRS thresholds in the report output by the 
recorder, follow this procedure.

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Print tab → Other tab.

3. Enable or disable Arrhy Settings (Recorder).

33.7.8 Setting Parameter Unit
To set parameter unit, follow this procedure: 

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Set the Unit tab.

3. Set unit for each parameter.
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33.8 Setting the Time

33.8.1 Setting the Time Synchronization
If the NTP Time Synchronization function is enabled, the monitor can automatically synchronize its time with a 
time server on which NTP (Network Time Protocol) is implemented. If there are many monitors connected within 
one network, you can enable the time synchronization to synchronize the time, and make it unnecessary to 
manually set the time for individual monitors.

33.8.1.1 Enabling NTP Time Synchronization

To enable the NTP Time Synchronization function, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select . 

2. Select the Time tab → Time Synchronization tab.

3. Switch on Start NTP Time Sync.

33.8.1.2 Setting the Time Server Address

To set the DNS name of the time server address, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select . 

2. Select the Time tab → Time Synchronization tab.

3. Input the name or IP address of the time server.

After configuring the NTP time server, select Network Test to verify that the NTP server is properly connected.

33.8.1.3 Setting the Time Synchronization Interval

To set the time synchronization interval, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select . 

2. Select the Time tab → Time Synchronization tab.

3. Set Interval.

33.8.1.4 Defining the Hours of Nighttime

To define the nighttime, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select . 

2. Select the Time tab → Time Synchronization tab.

3. Select From and To to define the beginning and end of Nighttime.

33.8.2 Enabling Auto Daylight Savings Time
By default, daylight savings time is disabled. If this function is needed, you need to manually enable the daylight 
savings time. To auto start the daylight savings time, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Time tab → Daylight Savings Time tab..

3. Switch on Auto Daylight Savings Time.

4. Adjust daylight savings time settings as necessary.
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NOTE

• If you enable Auto Daylight Savings Time you cannot manually switch it on or off from the System 
Time dialog. For more information, see 3.8.2 Setting the Date and Time.

33.9 Viewing Version Information
To view the system software version, module hardware and software version, and firmware version , follow this 
procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Version tab.

You can also view the system software version by selecting the Main Menu quick key → from the System 
column select Version.

33.10 Checking Battery Information
To check the battery information, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Battery Information tab.

33.11 Changing Secondary Display Settings (for N22/N19)
You can separately set the orientation, brightness, alarm indications, and the display contents of the secondary 
display. 

NOTE

• If you change the Maintenance dialog settings for the secondary display, you need to restart the 
monitor for the changes to take effect. 

• If you plug in a secondary display when the monitor is on, you need to restart the monitor before 
you use the secondary display.

33.11.1 Configuring Secondary Display Screen Contents (for N22/N19/N17)

The contents of the secondary display is configurable. To do so, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Display tab.

3. Set Screen Contents.

◆ Mirrored: The contents of the secondary display is exactly the same with the primary display. The 
orientation of the secondary display is also the same with the primary display. It is not available for 
the N17 monitor.

◆ Independent: You can separately configure the contents and layout of the primary display and 
secondary display. The independent secondary display cannot share the mouse and keyboard with 
the primary display. For N22/N19, separate mouse and keyboard connected to the MSB connectors of 
the secondary display is required.

◆ Extended: You can separately configure the contents and layout of the primary display and 
secondary display. The extended secondary display shares the mouse and keyboard with the primary 
display. You cannot use separate mouse and keyboard to operate the extend secondary display. 

4. If the Screen Contents is set to Extended, set Secondary Screen Location.
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33.11.2 Enabling Secondary Display Alarm Indications (for N22/N19)
The secondary display can provide visual and audible indications. This function is disabled by default. To enable 
the secondary display to present alarm light and alarm sound, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Display tab.

3. Switch on Alarm Sound/Light.

33.12 Changing Scanner Settings 
For the 2D barcode reader, you can change the scanner settings.

33.12.1 Establish the Relationship between Patient Demographics and 2D Barcode 
Fields (for the Mindray Custom 2D Barcode Reader)
To configure 2D barcode reader, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Scanner tab → 2D Barcode tab.

3. Establish the relationship between the monitor data and hospital’s barcode data for selectable patient 
demographics. For example, the monitor has an option of Ped for patient category. In your hospital 
barcode, the text may read as Pediatric. So input Pediatric for the field Ped to establish their relationship. 

33.12.2 Setting the Barcode Reader Information 
To set the barcode reader information, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Scanner tab → Scanner Info. tab.

3. Set Scanner Type:

◆ 1D Scanner: select this option when using a 1D scanner or a 2D scanner other than the Mindray 
custom 2D scanner.

◆ 2D Scanner: select this option when using the Mindray custom scanner.

NOTE

• When you set Scanner Type to 2D Scanner, default settings are applied to Data Encoding Type and 
Data Parse Mode. You do not need to change these setting.

33.12.3 Identifying the Barcode Reader (for the non-Mindray Custom 2D Barcode 
Reader)
When you are using barcode readers other than the JADAK Flexpoint HS-1R or HS-1M, you should select the 
barcode reader from the USB device list, so that the monitor can identify the barcode reader. To do so, follow this 
procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Scanner tab → Identify Scanner tab.

3. From the USB device list, select the barcode reader you are using.
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33.12.4 Selecting Patient Information Read by the Barcode Reader (for the Mindray 
Custom 2D Barcode Reader)
To select desired patient information that will be read by the barcode reader, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Scanner tab → Field tab.

3. Select the patient information. The selected information can be read by the barcode reader.

NOTE

• The patient information read by the barcode reader is dependent on the patient information 
encoded in the hospital's barcodes.

33.13 Configuring the Network
You can connect the monitor to the central monitoring system (CMS), eGateway, and other monitors through 
wired LAN or wireless LAN.

33.13.1 Network Safety Information

CAUTION

• Wireless network designing, deploying, debugging, and maintenance should be executed by 
Mindray service personnel or authorized technicians.

• Always set the wireless network according to local wireless regulations.

• Keep network authentication information, for example passwords, safe, to protect the network from 
being accessed by unauthorized users.

• Do not connect non-medical devices to the monitor network.

• If wireless network signal is poor, there may be a risk of CMS-destined data loss.

• RF interference may result in wireless network disconnection. 

• Disconnecting from the network may result in CMS-destined data loss and function failure. Check 
the patient in case of network disconnection and solve the network problem as soon as possible.

• Ensure that the monitor IP address setting is correct. Changing the network settings may result in 
network disconnection. Contact your service personnel if there are any problems with the IP 
address.

33.13.2 Selecting a Network Type
To select network type, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Type tab.

3. Set Monitor to Auto, LAN1 IP, or WLAN according to your network type. The default is Auto, which means 
the monitor will automatically use LAN1 IP when detected and the available WLAN when LAN1 IP is not 
detected..

33.13.3 Setting the Wired Network
To set the wired network, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab→LAN1 IP tab.

3. Select how to get the IP address.

◆ Obtain IP Address Automatically: the monitor automatically gets the IP address.
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◆ Use the following Address: you need to input the IP address, Subnet mask, and Gateway.

4. Select how to get the DNS address:

◆ Obtain DNS Address Automatically: the monitor automatically gets the DNS address.

◆ Use the following DNS Address: you need to input the IP address of Preferred DNS server and 
Alternate DNS server.

33.13.4 Setting the Wireless Network
 To add and set the wireless network, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab → WLAN tab.

3. Select Add WLAN. In the popup dialog, input network name, SSID, and password. Set Security.

4. Select the WLAN IP tab and select how to get the IP address and DNS address.

◆ Obtain IP Address Automatically: the monitor automatically gets the IP address.

◆ Use the Following Address: you need to input the IP address, Subnet Mask, and Gateway.

◆ Obtain DNS Address Automatically: the monitor automatically gets the DNS address.

◆ Use the following DNS Address: you need to input the IP address of Preferred DNS server and 
Alternate DNS server.

5. Select the WLAN Setup tab and set WLAN band and channels. The default is Auto, which means the 
monitor can automatically identify the WLAN band.

After configuring the wireless network, select Network Test to verify that the wireless network can be properly 
connected.

If you need to change network settings, select  beside the desired wireless network. Selecting  deletes 
the wireless network.

33.13.5 Managing Certifications
You can delete certifications from the monitor, or import certifications from the USB memory device. To do so, 
follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab → WLAN tab.

3. Select the Certificate Management button from the bottom left corner of the dialog.

◆ From the Local tab, select certifications you want to delete from the monitor, and then select Delete.

◆ From the USB Drive tab, select certifications you want to import from the USB memory device, and 
then select Import.

33.13.6 Enabling Selecting a CMS
To enable selecting a CMS, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab → Central Station Setup tab.

3. Switch on Select CMS.

33.13.7 Adding CMSs
You can add up to 30 central monitoring systems (CMS) for your monitor. To add CMSs, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab → Central Station Setup tab.
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3. Select Add Central Station, and then input the CMS name and IP address of this department.

33.13.8 Setting Multicast Parameters
Multicast helps device discovery between monitors and other devices on the network. Devices in the same 
multicast group can be mutually discovered.

To set multicast parameters, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab→Device Discover tab.

3. Set Multicast TTL.

4. Set Multicast Address.

33.13.9 Setting the Master Server Address
To set the DNS name of the master server, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab→ Device Discover tab.

3. Select Master Server Address to input the DNS name or IP address of the master server.

33.13.10 Setting the Network Service Quality Level
To set the quality of service (QoS), follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab→QoS tab.

3. Select QoS Level For Realtime Monitoring to set the service quality of network connection for realtime 
monitoring, for example parameter measurements and waveforms, alarms, etc.

4. Select QoS Level For Others to set the service quality of network connection for non-realtime monitoring, 
for example history data, printing, etc.

33.13.11 Using the ADT Gateway
The ADT (admit-discharge-transfer) gateway is normally deployed in the eGateway. You can obtain patient 
information from the hospital ADT server through the ADT gateway.

To configure the ADT gateway, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab → ADT tab.

3. Select Server Address to input the host name or IP address of the ADT gateway.

4. Select Port to input the port of the ADT gateway.

ADT Query is switched off by default. You can load patient information to the monitor from the ADT server 
only when this function is enabled. 

After configuring the ADT gateway, select Network Test to verify that the ADT server is properly connected.

33.13.12 Sending Realtime Data, Waveforms and Alarms via HL7 Protocol
You can send the realtime data, waveforms, and alarms from the monitor to the hospital servers via HL7 
protocol. To do so, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab → HL7 Configuration tab.
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3. From the Data + Waveforms area, select Server Address to input the name or IP address for the server 
receiving the realtime data and waveform. Set Port.

4. Switch on Send Data and Send Waveform, as needed. Set Data Interval.

5. From the Alarms area, select Server Address to input the name or IP address for the server receiving the 
alarm data. Set Port.

6. Switch on Send Alarms as needed.

This page also displays the server connection status.

33.13.13 Selecting Data Encryption Type
To set data encryption type, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab → Information Security tab.

3. Select Encryption Connection Type to set data encryption type when connecting devices:

◆ Only Private Encryption: Mindray private encryption is used to encrypt the transmitted data. You 
cannot connect devices supporting SSL (secure sockets layer) encryption.

◆ SSL Encryption Priority: for devices supporting SSL encryption, SSL encryption is used when 
connecting the devices. For devices not supporting SSL encryption, private encryption is used when 
connecting the devices.

33.13.14 Disabling the Broadcasting Patient Demographics Function
When viewing other patients, device location and patient information of remote devices are displayed in the 
remote device list by default. To protect patient privacy, you can disable the broadcasting of patient 
demographics function to prevent the monitor from sending patient information via broadcast. To do so, follow 
this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select Network Setup tab → Information Security tab.

3. Switch off Broadcast Patient Demographics.

Thus, patient information will not display in the remote device list.

33.14 MLDAP
MLDAP refers to Mindray LDAP (Lightweight Directory Access Protocol). It is an independent process which can 
be installed on the eGateway or other application server (Windows). MLDAP provides user identity and 
authentication.

The MLDAP server is connected with the hospital LDAP server. All monitoring devices are connected to the 
MLDAP server to implement identity and authentication for the following operations:

■ Changing alarm settings

■ Changing arrhythmia settings

■ Accessing the Maintenance dialog

33.14.1 Setting MLDAP
To access the MLDAP server, you should set your monitor as follows: 

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab→ MLDAP tab.

3. Set Server address and port of the MLDAP server.
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33.14.2 Testing MLDAP Server Connection
To test whether the monitor is properly connected with the MLDAP server, follow this procedure: 

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Network Setup tab→ MLDAP tab.

3. Select Network Test.

33.14.3 Selecting Password for User Authentication
You can select what password is used when changing alarm settings, arrhythmia settings, and accessing the 
Maintenance dialog. To do so, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Authorization Setup tab.

3. From the Maintenance area, set User Maintenance to select the password for accessing the monitor’s 
Maintenance dialog.

◆ Local Password: the monitor’s password for accessing the Maintenance dialog is required.

◆ User Password: the user name and password saved in the MLDAP server are required.

4. From the Others area, set Alarm Setup: select the password for changing alarm settings.

◆ No Password: changing alarm settings is not password protected.

◆ Local Password: changing alarm switch, alarm limit, and alarm priority is password protected. The 
monitor’s password for changing alarm settings is required.

◆ User Password: changing alarm switch, alarm limit, and alarm priority is password protected. The 
user name and password saved in the MLDAP server are required.

5. Set Arrhythmia: select the password for changing arrhythmia settings.

◆ No Password: changing arrhythmia settings is not password protected.

◆ Local Password: changing arrhythmia switch, alarm priority, and arrhythmia threshold is password 
protected. The monitor’s password for changing arrhythmia settings is required.

◆ User Password: changing arrhythmia switch, alarm priority, and arrhythmia threshold is password 
protected. The user name and password saved in the MLDAP server are required.

From the Maintenance area, selecting Modify Local Password can change the monitor’s password for 
accessing the Maintenance dialog.

From the Others area, selecting Modify Local Password can change the monitor’s password for accessing alarm 
settings and arrhythmia settings.

33.14.4 Setting the Password Timeout Period
If you use the password saved in the MLDAP server to access the Maintenance dialog, alarm settings and 
arrhythmia settings, you can set the password timeout period. Once the timeout period is reached, you will need 
to re-enter the password. To do so, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Authorization Setup tab.

3. Set Retention Time.

33.15 Defining Other Functions

33.15.1 Setting Notch Filter Frequency 
Set notch filter frequency according to the power line frequency of your country. To set notch filter frequency, 
follow this procedure:
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1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Other tab.

3. Set Notch Frequency to 50 Hz or 60 Hz according to the power line frequency.

33.15.2 Setting Mouse Sensitivity
The mouse sensitivity is adjustable. To do so, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Other tab.

3. Set Mouse Sensitivity.

33.15.3 Setting the SpO2 Tone Mode

The monitor adjusts the QRS tone (pitch tone) according to the SpO2 values. To set the SpO2 tone mode, follow 
this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 

password → select .

2. Select the Other tab.

3. Set SpO2 Tone to Mode 1 or Mode 2. The pitch changes more rapidly in Mode 2 than in Mode 1, as 
saturation levels change.

The SpO2 tone mode chart for SpO2 between 40% to 100% is as follows:

CAUTION

• It is highly recommended to use the same SpO2 tone mode for the same monitors in a single area to 
prevent issues arising from inconsistent operation.

33.15.4 Selecting the Language
To set the user interface (UI) language, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Other tab

3. Set Language.
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33.15.5 Switching On or Off a Parameter
 If there is no Parameters On/Off tab in the Screen Setup dialog then setting parameter switches is password 
protected. Follow this procedure to set parameter switches:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Other tab.

3. Select Parameters On/Off.

4. Enable or disable desired parameters.

When a parameter is switched off, the monitor stops data acquisition and alarming for this measurement. 

NOTE

• When a parameter is manually switched off and the corresponding parameter module is plugged in, 
you cannot monitor this parameter.

33.15.6 Setting If Setting Parameter Switches is Protected
You can set whether setting parameter switches is password protected. To do so, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Other tab.

3. Switch on or off Parameters On/Off Protected.

33.15.7 Setting If Parameter Switch is Influenced by Configuration
You can set if the settings of parameter switches are influenced by loading a configuration. To do so, follow this 
procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Other tab.

3. Switch on or off Parameters On/Off Config Influenced.

33.15.8 Setting Whether the Monitor Stands by if MPM module is Removed
You can set whether the monitor enters the Standby mode if the MPM module, including the N1 and T1, is 
removed from the monitor. To do so, follow this procedure:

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Other tab.

3. Set Auto Standby after MPM Module Removed. If Off is selected, the monitor does not enter the 
standby mode if the MPM module is removed.
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34 Battery

34.1 Battery Introduction
This monitor is designed to operate on battery power when the mains power is not available. The monitor uses 
mains power as primary power source. In case of mains power failure, the monitor automatically runs on the 
battery power. 

NOTE

• If the mains power fails and the monitor runs on battery power, the display brightness automatically 
lowers to the value of Brightness on Battery (set in Screen Setup → Display). You can manually 
adjust the display brightness as required.

34.2 Battery Safety Information
   

WARNING

• Keep batteries out of the reach of children. 

• Use only Mindray specified batteries. Use of a different battery may present a risk of fire or 
explosion.

• Keep the batteries in their original package until you are ready to use them. 

• Do not expose batteries to liquid.

• Do not crush, drop or puncture the battery. Mechanical abuse can lead to internal damage and 
internal short circuits. If a battery has been dropped or banged against a hard surface, whether 
damage is externally visible or not, remove the battery from use and dispose of it properly.

• If the battery shows signs of damage or signs of leakage, replace it immediately. Use caution in 
removing the battery. Avoid contacting the leakage. 

• Batteries should be charged only in this monitor.

• Extremely high ambient temperature may cause battery overheat protection, resulting in monitor 
shutdown.

• The lithium-ion battery has a service life of two years (for N22/N19) or three years (for N17/N15/
N12). Replace the battery when it reaches the end of its service life. Failure to replace the battery 
may cause serious damage to the equipment from battery overheating.

• Do not open batteries, heat batteries above 60 °C, incinerate batteries, or short battery terminals. 
They may ignite, explode, leak or heat up, causing personal injury.

CAUTION

• Remove the battery before shipping the monitor or when it will not be used for an extended period 
of time.

• When the monitor runs on battery power, the monitor may automatically shutdown due to high 
power consumption if too many external modules are connected. 

• For N22/N19, the battery run time is about one hour. Connect the mains power as long as the mains 
power is available.

• Use only the AC mains to power the monitor when the iView system is in use.

34.3  Installing or Replacing the Battery
No battery is installed when the monitor is shipped from the factory. 
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For N22/N19, the battery must only be installed or replaced by service personnel trained and authorized by 
Mindray. 

For N12, to install the battery, follow this procedure:

1. Turn off the monitor. Disconnect the power cable and other cables.

2. Place the monitor on the worktable with monitor face down. Ensure that the worktable is free of dirt and 
debris where the monitor face will rest to reduce risk of damage to the monitor screen.

3. If the monitor is installed on a mounting arm, remove the monitor from the mounting arm and remove any 
mounting plates.

4. Open the battery door as indicated by Figure 1 below.

5. Turn the latch aside.

6. Insert the battery into the battery compartment with the battery terminal inwards. Turn the latch back to 
the middle as indicated by Figure 2 below. To replace the battery, remove the old battery and insert a new 
one.

7. Close the battery door.

For N17/N15, to install the battery, follow this procedure:

1. Turn off the monitor. Disconnect the power cable and other cables.

2. Place the monitor on the worktable with monitor face down.

3. If the monitor is installed on a mounting arm, remove the monitor from the mounting arm and remove any 
mounting plates.

4. Pull up the battery door to open the battery compartment as indicated by Figure 1 below.

5. Insert the battery into the battery compartment. Push the battery downwards till the battery terminal is 
plugged into the battery connector as indicated by Figure 2 below. To replace the battery, remove the old 
battery and insert a new one.

6. Close the battery door.

34.4 Battery Indications
The battery LED, on-screen battery power indicator, and related alarm messages indicate the battery status.

34.4.1 Battery LED
The battery LED indications are as follows:

Figure 1 Figure 2

Figure 1 Figure 2
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■ Green: the battery is fully charged.

■ Yellow: the battery is being charged.

■ Flashing green: the monitor is running on battery power.

■ Off: no battery is installed, or the battery malfunctioned, or the AC mains is not connected when the 
monitor is powered off. 

34.4.2 Battery symbols
The on-screen battery symbols indicate the battery status as follows:

■  indicates that the battery is working correctly. The green portion represents the remaining 
charge.

■  indicates that the battery power is low and needs to be charged.

■  indicates that the battery is almost depleted and needs to be charged immediately. Otherwise, 
the monitor will automatically shut down soon.

■  indicates that the battery is being charged.

■  indicates that no battery is installed or the battery has failed.

34.4.3 Battery-related Alarms
The capacity of the battery is limited. When the battery level is low, the monitor presents the Low Battery alarm, 
the alarm lamp flashes, and the monitor produces an alarm sound. 

If the battery is almost depleted, the monitor presents the Critically Low Battery alarm. In this case, 
immediately connect the AC mains to power the monitor and charge the battery. Otherwise, the monitor will 
automatically shut down soon. 

For N22/N19, if the battery is aged, the Battery Service Required alarm is presented each time the monitor is 
turned on, indicating that the battery has reached its lifetime. 

For more information on battery-related alarms, see Appendix D Alarm Messages.   

34.5 Charging the Battery
The battery is recharged automatically when the monitor is connected to AC mains power. 

34.6 Maintaining the Battery

34.6.1 Conditioning the Battery
The performance of batteries deteriorates over time. For N22/N19, you should condition the batteries 
periodically or when you notice a degradation in performance. If the battery is not conditioned for a prolonged 
time, its charge indication may not be accurate and you may wrongly evaluate the remaining battery runtime. 

To condition a battery, follow this procedure:

1. Disconnect the monitor from the patient and stop all monitoring and measuring procedures.

2. Turn off the monitor, and connect the monitor to the external power source.

3. Allow the battery to be charged uninterruptedly until it is fully charged.

4. Disconnect the monitor from the external power source, and turn on the monitor.

5. Allow the monitor to run on the battery until the battery is completely depleted and the monitor automat-
ically shuts down.

6. Fully charge the battery again for use or charge it to 40 - 60% for storage.

NOTE

• Do not use the monitor to monitor a patient during battery conditioning.
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• Do not interrupt battery conditioning. Interrupting battery conditioning to use the monitor will 
prevent completion of the conditioning cycle and require repeating the conditioning process 
completely to properly condition the battery.

34.6.2 Checking Battery Performance
The performance of a rechargeable battery deteriorates over time. You should check the battery performance 
periodically or if you are concerned that the battery may fail. 

See steps 1 to 5 of 34.6.1 Conditioning the Battery to check battery performance. The operating time of the 
batteries reflects their performance directly. If the operating time of a battery is noticeably shorter than that 
stated in the specifications, the battery may have reached its service life or be malfunctioning. If the battery 
performance meets the requirement, fully charge the battery again for use or charge it to 40 - 60% for storage.

NOTE

• Battery operating time depends on equipment configuration and operation. For example, high 
display brightness or measuring NIBP repeatedly will shorten the battery operating time.

34.7 Storing Batteries
When storing batteries, make sure that the battery terminals do not come into contact with metallic objects. If 
batteries are stored for an extended period of time, place the batteries in a cool place with a partial charge of 
40% to 60% capacity. 

Condition the stored batteries every three months. For more information, see 34.6.1 Conditioning the Battery. 

NOTE

• Remove the battery from the equipment if the equipment is not used for a prolonged time (for 
example, several weeks). Otherwise the battery may overdischarge.

• Storing batteries at high temperature for an extended period of time will significantly shorten their 
life expectancy.

• Storing batteries in a cool place can slow the aging process. Ideally the batteries should be stored at 
15 °C. 

34.8 Recycling Batteries
Discard a battery in the following situations: 

■ The battery has visual signs of damage.

■  The battery fails.

■  The battery is aged and its runtime significantly less than the specification.

■  The battery service life is reached.

Properly dispose of batteries according to local regulations. 

WARNING

• Do not open batteries, heat batteries above 60 °C, incinerate batteries, or short the battery 
terminals. They may ignite, explode, leak or heat up, causing personal injury.
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35 Care and Cleaning

35.1 Care and Cleaning Introduction
In this chapter we only describe cleaning and disinfection of the main unit, modules, satellite module rack (SMR) 
and certain accessories. For the cleaning and disinfection of other reusable accessories, refer to their instructions 
for use of the corresponding accessories.

Keep your equipment and accessories clean. To avoid damage to the equipment, follow these guidelines:

■ Always follow the manufacturer’s instructions for each cleaning / disinfecting agent.

■ Do not immerse any part of the equipment or accessories into liquid.

■ Do not pour liquid onto the equipment or accessories.

■ Do not allow liquid to enter the case.

■ Never use abrasive materials (such as steel wool or silver polish), or erosive cleaners (such as acetone or 
acetone-based cleaners).

35.2 Care and Cleaning Safety Information

WARNING

• Be sure to turn off the system and disconnect all power cables from the outlets before cleaning the 
equipment.

CAUTION

• If you spill liquid on the equipment or accessories, contact Mindray or your service personnel.

• Avoid wetting the pins and metal parts of the equipment, mounting kits or accessories during 
cleaning and disinfection.

• Use only Mindray approved cleaners and disinfectants and methods listed in this chapter to clean or 
disinfect your equipment. Warranty does not cover damage caused by unapproved substances or 
methods.

• We make no claims regarding the efficacy of the listed chemicals or methods as a means for 
controlling infection. For the method to control infection, consult your hospital’s Infection Control 
Officer or Epidemiologist.

• The responsible hospital or institution shall carry out all cleaning and disinfection procedures 
specified in this chapter.

• Refer to the respective instructions for use of the cleaning agents and disinfectants.

• Do not mix disinfecting solutions (such as bleach and ammonia) as hazardous gases may result.

NOTE

• To clean or disinfect reusable accessories, refer to the instructions delivered with the accessories.
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35.3 Cleaning and Disinfecting the Equipment and Mounting Kits
Use approved cleaning and disinfecting agents for cleaning or disinfecting the main unit, parameter modules, 
and SMR.

35.3.1  Approved Cleaning and Disinfecting Agents
The following table lists approved cleaning and disinfecting agents:
:

Product Name Product Type Active Ingredients

Sodium hypochlorite bleach Liquid Sodium hypochlorite bleach 0.5%

Hydrogen peroxide Hydrogen peroxide 3%

Isopropanol Isopropanol 70%

1-Propanol 1-Propanol 50%

Metrex CaviCide1™ Diisobutylphenoxyethoxyethyl dimethyl benzyl ammonium 
chloride 0.28%,
Isopropanol 17.2%

 Virex® II 256 (1:256) Didecyl dimethyl ammonium chloride 8.704%, 
n-Alkydimethyl benzyl ammonium chloride 8.190%

Virex® TB n-Alkyl dimethyl benzyl ammonium chlorides 0.105%,
n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.105%

Rely+OnTM Virkon® High Level 
Surface Disinfectant

Powder Used as 1% solution
Biocidal active:
Pentapotassium bis (peroxymonosulphate) bis (sulphate)(500g/
kg),

Contains dipotassium peroxodisulphate.

Alpet® D2 Surface Sanitizing 
Wipes

Wipes Isopropyl Alcohol 58.6000%,
Octyl Decyl Dimethyl Ammonium chloride 0.0075%,
Dioctyl Dimethyl Ammonium Chloride 0.0030%

Clorox Dispatch® Hospital 
Cleaner Disinfectant Towels with 
Bleach

Sodium Hypochlorite 0.65%

Clorox Healthcare® Bleach 
Germicidal Wipes

Sodium Hypochlorite 0.55%

Clorox Healthcare® Hydrogen 
Peroxide Cleaner Disinfectant 
Wipes

Hydrogen Peroxide 1.4%

Diversey Oxivir® TB Wipes Hydrogen Peroxide 0.5%

Metrex CaviWipes™ Diisobutylphenoxyethoxyethyl dimethyl benzyl ammonium 
chloride 0.28%,
Isopropanol 17.2%

PDI Sani-Cloth® AF3 Germicidal 
Disposable Wipe

n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.14%,
n-Alkyl dimethyl benzyl ammonium chlorides 0.14%

PDI Sani-Cloth® Bleach 
Germicidal Disposable Wipe

Sodium Hypochlorite 0.63%,other ingredients 99.37%

PDI Sani-Cloth® HB Germicidal 
Disposable Wipe

n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.07%,
n-Alkyl dimethyl benzyl ammonium chlorides 0.07%

PDI Sani-Cloth® Plus Germicidal 
Disposable Cloth

n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.125%,
n-Alky dimethyl benzyl ammonium chlorides 0.125%

PDI Super Sani-Cloth® Germicidal 
Disposable Wipe

n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.25%, 
n-Alkyl dimethyl benzyl ammonium chlorides 0.25%,
Isopropyl Alcohol 55.0%
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NOTE

• For equipment with the symbol , all the listed cleaning and disinfecting agents are available for 
use. 

35.3.2 Cleaning the Equipment and Mounting Kits
The main unit, parameter modules, and SMR should be cleaned on a regular basis. Before cleaning the 
equipment and mounting kits, consult your hospital’s regulations for cleaning the equipment. 

To clean your equipment, follow this procedure:

1. Shut down the monitor and disconnect it from the AC power.

2. Clean the display screen with wipes or a soft cloth moistened with one of the cleaning agents listed in 
35.3.1 Approved Cleaning and Disinfecting Agents only.

3. Clean the exterior surface of the equipment, module, and SMR with wipes or a soft cloth moistened with 
one of the cleaning agents listed in 35.3.1 Approved Cleaning and Disinfecting Agents only.

4. Wipe off all the cleaning agent residue with a dry cloth.

5. Dry your equipment in a ventilated, cool place.

35.3.3 Disinfecting the Equipment and Mounting Kits
Disinfect the main unit, parameter modules, and SMR as required in your hospital’s servicing schedule using the 
disinfecting agents listed in the table above. Cleaning equipment before disinfecting is recommended.

CAUTION

• Never use EtO or formaldehyde for disinfection.

35.4 Cleaning and Disinfecting the Accessories
For the NIBP air hose, SpO2 cable, and NMT accessories, you should clean and disinfect them using the cleaners 
and disinfectants and methods listed in this section. For other accessories, you should consult the instructions 
delivered with the accessories.

CAUTION

• Fluids entering the NIBP air hose can damage the equipment. When cleaning and/or disinfecting the 
NIBP air hose, prevent liquid from entering the hose.

• Periodically inspect the NIBP air hose and connector for signs of wear or deterioration. Replace the 
NIBP air hose if you detect a leak. Dispose of damaged NIBP air hose according to local laws for 
disposal of hospital waste.

• Never immerse or soak the accessories in any liquid.

• Never clean or disinfect the metalic connectors at either end of the accessories.

• Use only Mindray approved cleaners and disinfectants and methods listed in this section to clean or 
disinfect the accessories. Warranty does not cover damage caused by unapproved substances or 
methods.

• To avoid long term damage, the accessories should be disinfected only when necessary as 
determined by your hospital’s policy.

VIRAGUARD Hospital Surface 
Disinfectant Towelettle

Wipes Isopropanol 70%,
Other ingredients 30%

Product Name Product Type Active Ingredients
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35.4.1 Approved Accessories Cleaning and Disinfecting Agents
The following table lists approved NIBP air hose cleaning and disinfecting agents:
:

The following table lists approved Masimo SpO2 cable cleaning and disinfecting agents:
:

Product Name Product Type Active Ingredients

Isopropanol Liquid Isopropanol 70%

1-Propanol 1-Propanol 50%

Metrex CaviCide1™ Diisobutylphenoxyethoxyethyl dimethyl benzyl ammonium 
chloride 0.28%,
Isopropanol 17.2%

Virex® TB n-Alkyl dimethyl benzyl ammonium chlorides 0.105%,
n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.105%

Rely+OnTM Virkon® High Level 
Surface Disinfectant 

Powder Used as 1% solution
Biocidal active:
Pentapotassium bis (peroxymonosulphate) bis (sulphate)(500g/
kg),
Contains dipotassium peroxodisulphate.

Alpet® D2 Surface Sanitizing 
Wipes

Wipes Isopropyl Alcohol 58.6000%,
Octyl Decyl Dimethyl Ammonium chloride 0.0075%,
Dioctyl Dimethyl Ammonium Chloride 0.0030%

Clorox Dispatch® Hospital 
Cleaner Disinfectant Towels with 
Bleach

Sodium Hypochlorite 0.65%

Metrex CaviWipes™ Diisobutylphenoxyethoxyethyl dimethyl benzyl ammonium 
chloride 0.28%,
Isopropanol 17.2%

PDI Sani-Cloth® AF3 Germicidal 
Disposable Wipe

n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.14%,
n-Alkyl dimethyl benzyl ammonium chlorides 0.14%

PDI Sani-Cloth® Plus Germicidal 
Disposable Cloth

n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.125%,
n-Alky dimethyl benzyl ammonium chlorides 0.125%

PDI Super Sani-Cloth® Germicidal 
Disposable Wipe

n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.25%, 
n-Alkyl dimethyl benzyl ammonium chlorides 0.25%,
Isopropyl Alcohol 55.0%

VIRAGUARD Hospital Surface 
Disinfectant Towelettle

Isopropanol 70%,
Other ingredients 30%

:

Product Name Product Type Active Ingredients

Isopropanol Liquid Isopropanol 70%

Sodium hypochlorite bleach Liquid Sodium hypochlorite bleach, 0.5%

PDI Super Sani-Cloth® Germicidal 
Disposable Wipe

Wipe n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.25%,

n-Alkyl dimethyl benzyl ammonium chlorides 0.25%,

Isopropyl Alcohol 55.0%

Glutaraldehyde Liquid Glutaraldehyde, 2%
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The following table lists approved Nellcor SpO2 cable cleaning and disinfecting agents:
:

The following table lists approved NMT accessory cleaning and disinfecting agents:
:

Product Name Product Type Active Ingredients

Sodium hypochlorite bleach Liquid Sodium hypochlorite bleach 0.5%

Isopropanol Isopropanol 70%

1-Propanol 1-Propanol 50%

Virex® TB n-Alkyl dimethyl benzyl ammonium chlorides 0.105%,
n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.105%

Rely+OnTM Virkon® High Level 
Surface Disinfectant 

Powder Used as 1% solution
Biocidal active:
Pentapotassium bis (peroxymonosulphate) bis (sulphate)(500g/
kg),
Contains dipotassium peroxodisulphate.

Clorox Dispatch® Hospital 
Cleaner Disinfectant Towels with 
Bleach

Wipes Sodium Hypochlorite 0.65%

Clorox Healthcare® Bleach 
Germicidal Wipes

Sodium Hypochlorite 0.55%

Clorox Healthcare® Hydrogen 
Peroxide Cleaner Disinfectant 
Wipes

Hydrogen Peroxide 1.4%

Diversey Oxivir® TB Wipes Hydrogen Peroxide 0.5%

PDI Super Sani-Cloth® Germicidal 
Disposable Wipe

n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.25%, 
n-Alkyl dimethyl benzyl ammonium chlorides 0.25%,
Isopropyl Alcohol 55.0%

VIRAGUARD Hospital Surface 
Disinfectant Towelettle

Isopropanol 70%,
Other ingredients 30%

Product Name Product Type Active Ingredients

Sodium hypochlorite bleach Liquid Sodium hypochlorite bleach 0.5%

Isopropanol Isopropanol 70%

1-Propanol 1-Propanol 50%

Metrex CaviCide1™ Diisobutylphenoxyethoxyethyl dimethyl benzyl ammonium 
chloride 0.28%,
Isopropanol 17.2%

Virex® TB n-Alkyl dimethyl benzyl ammonium chlorides 0.105%,
n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.105%

Rely+OnTM Virkon® Powder 
(Used as 1% solution) 

Powder Used as 1% solution
Biocidal active:
Pentapotassium bis (peroxymonosulphate) bis (sulphate)(500g/
kg),
Contains dipotassium peroxodisulphate.
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35.4.2 Cleaning the Accessories
You should clean the accessories (NIBP air hose, Masimo SpO2 cable, Nellcor SpO2 cable and NMT accessories) on 
a regular basis. Before cleaning the accessories, consult your hospital’s regulations for cleaning the accessories.

To clean the accessories, follow this procedure:

1. Clean the accessories with wipes or a soft cloth moistened with one of the cleaning agents listed in 
35.4.1 Approved Accessories Cleaning and Disinfecting Agents only.

2. Wipe off all the cleaning agent residue with a dry cloth.

3. Allow the accessories to air dry.

35.4.3 Disinfecting the Accessories
We recommend that the accessories (NIBP air hose, SpO2 cables, and NMT accessories) should be disinfected 
only when necessary as determined by your hospital’s policy, to avoid long term damage to the accessories. 
Cleaning the accessories before disinfecting is recommended.

35.5 Sterilization
Sterilization is not recommended for this equipment, related products, accessories, or supplies unless otherwise 
indicated in the Instructions for Use that accompany the products, accessories or supplies.

Alpet® D2 Surface Sanitizing 
Wipes

Wipes Isopropyl Alcohol 58.6000%,
Octyl Decyl Dimethyl Ammonium chloride 0.0075%,
Dioctyl Dimethyl Ammonium Chloride 0.0030%

Clorox Dispatch® Hospital 
Cleaner Disinfectant Towels with 
Bleach

Sodium Hypochlorite 0.65%

Clorox Healthcare® Bleach 
Germicidal Wipes

Sodium Hypochlorite 0.55%

Clorox Healthcare® Hydrogen 
Peroxide Cleaner Disinfectant 
Wipes

Hydrogen Peroxide 1.4%

Diversey Oxivir® TB Wipes Hydrogen Peroxide 0.5%

Metrex CaviWipes™ Diisobutylphenoxyethoxyethyl dimethyl benzyl ammonium 
chloride 0.28%,
Isopropanol 17.2%

PDI Sani-Cloth® AF3 Germicidal 
Disposable Wipe

n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.14%,
n-Alkyl dimethyl benzyl ammonium chlorides 0.14%

PDI Sani-Cloth® Bleach 
Germicidal Disposable Wipe

Sodium Hypochlorite 0.63%,other ingredients 99.37%

PDI Sani-Cloth® Plus Germicidal 
Disposable Cloth

n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.125%,
n-Alky dimethyl benzyl ammonium chlorides 0.125%

PDI Super Sani-Cloth® Germicidal 
Disposable Wipe

n-Alkyl dimethyl ethylbenzyl ammonium chlorides 0.25%, 
n-Alkyl dimethyl benzyl ammonium chlorides 0.25%,
Isopropyl Alcohol 55.0%

VIRAGUARD Hospital Surface 
Disinfectants

Isopropanol 70%,
Other ingredients 30%

Product Name Product Type Active Ingredients
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36 Maintenance

36.1 Maintenance Introduction
Regular maintenance is essential to ensure that the equipment continues to function properly. This chapter 
contains information on periodic testing and maintenance. 

36.2 Maintenance Safety Information

WARNING

• To avoid electric shock, stop using the equipment if you find the housing is damaged, and contact 
the service personnel.

• Failure on the part of the responsible individual hospital or institution using this equipment to 
implement a recommended maintenance schedule may cause undue equipment failure and 
possible health hazards.

• No modification of this equipment is allowed.

• This equipment contains no user serviceable parts. 

• The safety checks or maintenance involving any disassembly of the equipment should be performed 
by professional service personnel. Otherwise, undue equipment failure and possible health hazards 
could result. 

• Do not open batteries, heat batteries to above 60 °C, incinerate batteries, or short the battery 
terminals. Batteries may ignite, explode, leak or heat up, causing personal injury.

• The service personnel must be properly qualified and thoroughly familiar with the operation of the 
equipment.

CAUTION

• The equipment and accessories shall not be serviced or maintained while in use on a patient. 

• If you discover a problem with any of the equipment, contact your service personnel or Mindray.

• Use and store the equipment within the specified temperature, humidity, and altitude ranges.

• When disposing of the packaging material, be sure to observe the applicable waste control 
regulations and keep it out of the reach of children.

• At the end of its service life, the equipment, as well as its accessories, must be disposed of in 
compliance with the guidelines regulating the disposal of such products. If you have any questions 
concerning disposal of the equipment, please contact Mindray.
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36.3 Maintenance and Testing Schedule
Follow the maintenance and testing schedule or local regulations to perform testing and maintenance such as 
defined in section 36.5 Testing Methods and Procedures. Follow your hospital policy on cleaning and disinfecting 
the equipment before testing and maintenance.

The following table lists the maintenance and testing schedule:

36.4 Checking System Software Version 
To view system software version information, select the Main Menu quick key → from the System column select 
Version.

You can check the detailed system software version, module hardware and software version, and firmware 
version only from the Maintenance dialog.

36.5 Testing Methods and Procedures
Except for the following maintenance tasks, all other test and maintenance tasks should be performed by 
Mindray-qualified service personnel only. 

■ Regular checks, including visual inspection and power-on test

■ NMT sensor check

Test/Maintenance Item Recommended Frequency 

Performance Tests 

Visual inspection Every day, before first use.

Measurement module performance test and 
calibration

1. If you suspect that the measurement values are incorrect. 
2. Follow any repairs or replacement of relevant module.
3. Once a year for CO2 and AG tests. 
4. Once every two years for other parameter module performance 
tests. 

Analog output test If you suspect that the analog output function does not work 
properly.

Defibrillation synchronization test If you suspect that the defibrillation synchronization function does 
not work properly.

Nurse call test If you suspect that the nurse call function does not work properly.

Electrical Safety Tests

Electrical safety tests Once every two years. 

Other Tests

Power-on test Before use

NMT sensor check Once a year.

Recorder check 1. When the recorder is used for the first time.
2.Follow any repair or replacement of the recorder. 

Network printer tests 1. When first installed.
2.Follow any repair or replacement of the printer. 

Device integration check 1. When first installed.
2. Following any repair or replacement of the external device. 

Battery check Functionality test 1. When first installed. 
2. When battery is replaced. 

Performance test Every three months or if the battery runtime is reduced significantly. 
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■ Printer and recorder tests

■ Battery check

If your monitor needs a safety test and performance test, contact the service personnel.

36.5.1 Performing Visual Inspection
Visually inspect the equipment before its first use every day. If you find any signs of damage, remove the monitor 
from use and contact the service personnel.

Verify that the equipment meets the following requirements:

■ Environment and power supply specifications are met.

■ The monitor housing and display screen are free from cracks or other damage.

■ The power cord is not damaged and the insulation is in good condition.

■ Connectors, plugs, and cables are not damaged or kinked. 

■ Power cord and patient cables are securely connected to the equipment and modules.

36.5.2 Performing Power-on Test
The monitor automatically performs a power-on test at startup. Verify the following items for the power-on test:

■ The equipment powers on properly.

■ The alarm system works properly, denoted by alarm sounds and display of all 3 alarm light colors.

■ The monitor displays properly.

36.5.3 Checking the NMT Sensor
NMT sensor check is required once a year or when you doubt the measured values.

To calibrate the NMT sensor, 

1. Select the Main Menu quick key → from the System column select Maintenance → input the required 
password → select .

2. Select the Module tab → NMT tab.

3. Follow the on-screen instructions to check the NMT sensor in four ways.

If sensor check completes successfully, the message “Test passed. The function of NMT sensor is OK” is 
presented. If any of the four steps fails, check if the sensor is placed correctly as instructed and perform the 
sensor check again. Replace the sensor or contact your service personnel if it cannot pass the sensor check.

NOTE

• Stop NMT measurement or calibration before starting an NMT sensor check.

• Take care when handling the NMT sensor. Avoid forceful strikes to the sensor.

36.5.4 Testing the Recorder
To test the recorder, follow this procedure:

1. Start a recording task to print waveforms and reports.

2. Check that the recorder functions correctly.

3. Check that the printout is clear without missing dots.

36.5.5  Testing the Network Printer
To check the printer, follow this procedure:

1. Start a printing task to print waveforms and reports.

2. Check that the printer is properly connected and functions correctly. 
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3. Check that the printout is clear with no missing information.

36.5.6 Checking the Battery
For information on battery check, see 34.6.2 Checking Battery Performance. 

36.6 NIBP Maintenance

36.6.1 NIBP Leakage Test
The NIBP leakage test checks the integrity of the system and of the valve. The NIBP leakage test should be 
performed once every two years or when you doubt the NIBP measurements. The NIBP leakage test should be 
performed by Mindray-qualified service personnel only. 

36.6.2 NIBP Accuracy Test
The NIBP accuracy test should be performed once every two years or when you doubt the NIBP measurements. 
The NIBP accuracy test should be performed by Mindray-qualified service personnel only. 

36.7 Disposing of the Monitor
Dispose of the monitor and its accessories when its service life is reached. Follow local regulations regarding the 
disposal of such product.

WARNING

• For disposal of parts and accessories, where not otherwise specified, follow local regulations 
regarding disposal of hospital waste.
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37 Accessories

The accessories listed in this chapter comply with the requirements of IEC 60601-1-2 when in use with the 
patient monitor. The accessory material that contacts the patients has undertaken the bio-compatibility test and 
is verified to be in compliance with ISO 10993-1. For details about the accessories, refer to the instructions for use 
provided with the accessory.

WARNING

• Use accessories specified in this chapter. Using other accessories may cause damage to the patient 
monitor or not meet the claimed specifications.

• Single-use accessories are not designed to be reused. Reuse may cause a risk of contamination and 
affect the measurement accuracy.

CAUTION

• The accessories may not meet the performance specifications if stored or used outside the specified 
temperature and humidity ranges. If accessory performance is degraded due to aging or 
environmental conditions, contact your service personnel.

• Check the accessories and their packages for any sign of damage. Do not use them if any damage is 
detected.

• Use the accessories before the expiration date if an expiration date is indicated.

• Discard disposable accessories according to hospital regulations.

NOTE

• This manual describes all the accessories that are validated for use. Not all accessories are available 
in every market. 

37.1 ECG Accessories

37.1.1  ECG Electrodes Available for Purchase

37.1.2 ECG Electrodes Also Compatible

Model Part No. Description Usage Applicable patient

31499224 0010-10-12304 Electrode, Kendall, pkg of 10 Disposable Adult

1050NPSMKittycat 0681-00-0098-01 NEO pre-wired electrode radio 
Opaque, pkg of 100

Disposable Neonate

1051NPSMKittycat 0681-00-0098-02 NEO pre-wired electrode radio 
Translucent, pkg of 100

Disposable Neonate

H124SG 900E-10-04880 ECG electrode, Kendall, 10 pcs/
package

Disposable Neonate

Model Part No. Description Usage Applicable patient

2245-50 9000-10-07469 ECG electrode, 3M, pkg of 50 Disposable Pediatric
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37.1.3 12-Pin Trunk Cables Available for Purchase

37.1.4 12-Pin Trunk Cables Also Compatible

37.1.5 3-lead ECG Leadwires Available for Purchase
 

37.1.6 3-lead ECG Leadwires Also Compatible
 

Model Part No. Description Usage Applicable patient

EV6206 009-005266-00 ECG cable, 10' (3.1 m), 
defibrillation-proof, for N/T

Reusable Adult/Pediatric

EV6207 009-005267-00 ECG cable, 20' (6.2 m), 
defibrillation-proof, for N/T

Reusable Adult/Pediatric

EV6216 009-005268-00 ECG cable, 10' (3.1 m), ESU-proof, 
for N/T

Reusable Adult/Pediatric

EV6217 009-005269-00 ECG cable, 20' (6.2 m), ESU-Proof, 
for N/T

Reusable Adult/Pediatric

Model Part No. Description Usage Applicable patient

EV6201 0010-30-42719 12Pin 3/5-Lead ECG trunk cable, 
defibrillation-proof

Reusable Adult/Pediatric

EV6202 0010-30-42720 12Pin 3-Lead ECG trunk cable, 
defibrillation-proof

Reusable Pediatric/Neonate

EV6203 0010-30-42721 12Pin 12-Lead trunk cable, 
defibrillation-proof

Reusable Adult/Pediatric

EV6211 0010-30-42723 12Pin 3/5-Lead ECG trunk cable, 
ESU-proof

Reusable Adult/Pediatric

EV6212 0010-30-42724 12Pin 3-Lead ECG trunk cable, ESU-
proof

Reusable Pediatric/Neonate

EV6222 040-000754-00 12Pin 3-Lead trunk cable, 
defibrillation-proof, DIN Conn

Reusable Pediatric/Neonate

Model Part No. Description Usage Applicable patient

EY6316B 009-004765-00 3-Lead, N/T, AHA, snap, 24’’ Reusable Adult/Pediatric

EY6305B 009-004766-00 3-Lead, N/T, AHA, snap, 36’’ Reusable Adult/Pediatric

EY6316A 009-004771-00 3-Lead, N/T, AHA, clip, 24’’ Reusable Adult/Pediatric

EY6305A 009-004772-00 3-Lead, N/T, AHA, clip, 36’’ Reusable Adult/Pediatric

EY6310B 009-004777-00 3-Lead, N/T, AHA, snap, 24’’ Disposable Adult/Pediatric

Model Part No. Description Usage Applicable patient

EL6305A 0010-30-42896 3-Lead leadset, AHA, clip Reusable Neonate

EL6303A 0010-30-42731 3-Lead leadset, AHA, clip, Long Reusable Adult/Pediatric

EL6301B 0010-30-42734 3-Lead leadset, AHA, snap Reusable Adult/Pediatric

EL6311B 040-000146-00 3-Lead leadset, AHA, snap Disposable Pediatric/Neonate

EL6311A 040-000148-00 3-Lead leadset, AHA, clip Disposable Pediatric/Neonate
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37.1.7 5-lead ECG Leadwires Available for Purchase

37.1.8 5-lead ECG Leadwires Also Compatible

37.1.9 6-lead ECG Leadwires Available for Purchase

37.1.10 12-lead ECG Chest Leadwires Available for Purchase

37.1.11 12-lead ECG Leadwires Also Compatible

37.2 SpO2 Accessories

Wavelength emitted by the sensors is between 600 nm and 1000 nm. The maximum photic output consumption 
of the sensor is less than 18 mW.

The information about the wavelength range and maximum photic output consumption can be especially 
useful to clinicians, for example, when photodynamic therapy is performed.

Model Part No. Description Usage Applicable patient

EY6511B 009-004782-00 5-Lead, N/T, AHA, snap, 24’’ Reusable Adult/Pediatric

EY6512B 009-004783-00 5-Lead, N/T, AHA, snap, 36’’ Reusable Adult/Pediatric

EY6511A 009-004786-00 5-Lead, N/T, AHA, pinch, 24’’ Reusable Adult/Pediatric

EY6512A 009-004787-00 5-Lead, N/T, AHA, pinch, 36’’ Reusable Adult/Pediatric

EY6507B 009-004790-00 5-Lead, N/T, AHA, snap, 24’’ Disposable Adult/Pediatric

Model Part No. Description Usage Applicable patient

EL6503A 0010-30-42729 5-Lead leadset, AHA, clip, Long Reusable Adult/Pediatric

EL6501B 0010-30-42735 5-Lead leadset, AHA, snap Reusable Adult/Pediatric

EL6501A 0010-30-42727 5-Lead leadset, AHA, clip Reusable Adult/Pediatric

Model Part No. Description Usage Applicable patient

EY6601B 009-004794-00 6-Lead, N/T, AHA, snap, 24’’ Reusable Adult/Pediatric

EY6602B 009-004795-00 6-Lead, N/T, AHA, snap, 36’’ Reusable Adult/Pediatric

EY6601A 009-004798-00 6-Lead, N/T, AHA, pinch, 24’’ Reusable Adult/Pediatric

EY6602A 009-004799-00 6-Lead, N/T, AHA, pinch, 36’’ Reusable Adult/Pediatric

Model Part No. Description Usage Applicable patient

EL6803A 0010-30-42904 12-Lead leadset, chest, AHA, clip Reusable Adult/Pediatric

EL6803B 0010-30-42908 12-Lead leadset, chest, AHA, snap Reusable Adult/Pediatric

Model Part No. Description Usage Applicable patient

EL6801A 0010-30-42902 12-Lead leadset, limb, AHA, clip Reusable Adult/Pediatric

EL6801B 0010-30-42906 12-Lead leadset, limb, AHA, snap Reusable Adult/Pediatric
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37.2.1 Extension Cables and Adapter Cables Available for Purchase
 

37.2.2 Extension Cables and Adapter Cables Also Compatible
 

37.2.3 Masimo SpO2 RD Set Sensors Available for Purchase

37.2.4 Masimo SpO2 LNCS Sensors Also Compatible
 

Model Part No. Description Usage Applicable patient

572A 0010-20-42712 8-pin SpO2 extension cable, Nellcor Reusable /

583A 040-003310-00 8-pin, RD SET, Masimo Reusable /

4089 040-003381-00 RD to LNCS adapter cable, Masimo Reusable /

4092 040-003426-00 LNCS to RD adapter, Masimo Reusable /

Model Part No. Description Usage Applicable patient

582A 115-020768-00 8-pin SpO2 extension cable, Masimo Reusable /

Model Part No. Description Usage Applicable patient

4050 040-003376-00 SpO2 sensor, RD SET DCI Reusable Adult (> 30 kg)

4051 040-003377-00 SpO2 sensor, RD SET DCI Reusable Pediatric (10-50 kg)

4053 040-003380-00 SpO2 sensor, RD Set TC-I, tip-clip ear 
sensor, 3ft

Reusable Adult (> 30 kg)

4000 040-003382-00 SpO2 sensor, RD SET Adt, adhesive, 
pkg of 20

Disposable Adult (> 30 kg)

4001 040-003383-00 SpO2 sensor, RD SET PDT, adhesive, 
pkg of 20

Disposable Pediatric (10 to 50 
kg)

4002 040-003384-00 SpO2 sensor, RD Set Inf, adhesive, 
pkg of 20

Disposable Infant (3 to 20 kg)

4003 040-003385-00 SpO2 sensor, RD Set Neo, adhesive, 
pkg of 20

Disposable Neonatal /Adult 
(<3Kg or >40Kg)

4004 040-003386-00 SpO2 sensor, RD Set NeoPt, adhesive, 
pkg of 20

Disposable Neonate (<1 kg)

4005 040-003387-00 SpO2 sensor, RD Set NeoPt-500, non-
adhesive, pkg of 20

Disposable Neonate (<1 kg)

Model Part No. Description Usage Applicable patient

LNCS DCI 0010-10-42600 SpO2 sensor, finger-clip Reusable Adult (>30 kg) 

LNCS DCIP 0010-10-42634 SpO2 sensor, finger-clip Reusable Pediatric (10-50 kg) 

LNCS YI 0010-10-43016 SpO2 sensor, multisite Reusable Adult/Pediatric/
Neonate

LNCS NeoPt-L 0010-10-42626 SpO2 sensor Disposable Neonate (<1 kg)

LNCS Neo-L 0010-10-42627 SpO2 sensor Disposable Neonate /Adult 
(<3 kg or>40 kg)

LNCS Inf-L 0010-10-42628 SpO2 sensor Disposable Infant (3-20 kg)
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37.2.5 Nellcor SpO2 Sensors Also Compatible

37.3  Temp Accessories

37.3.1 Temp Cable Available for Purchase

37.3.2 Temp Probes Available for Purchase

LNCS Pdtx 0010-10-42629 SpO2 sensor Disposable Pediatric (10-50 kg) 

LNCS Adtx 0010-10-42630 SpO2 sensor Disposable Adult (>30 kg)

LNCS Adtx 0600-00-0121 SpO2 sensor, finger-clip, 20 pcs/box Disposable Adult (>30 kg)

LNCS Pdtx 0600-00-0122 SpO2 sensor, finger-clip, 20 pcs/box Disposable Pediatric (10-50 kg)

LNCS DCI 0600-00-0126 SpO2 sensor, finger-clip Reusable Adult (>30 kg)

LNCS DCIP 0600-00-0127 SpO2 sensor, finger-clip Reusable Pediatric (10-50 kg)

LNCS NeoPt 0600-00-0156 SpO2 sensor, finger-clip Disposable Neonate (<1Kg)

LNCS Neo-L 0600-00-0157 SpO2 sensor, 20 pcs/box Disposable Neonate /Adult 
(<3 kg or > 40 kg)

LNCS Inf 0600-00-0158 SpO2 sensor, 20 pcs/box Disposable Infant (3-20 kg)

Model Part No. Description Usage Applicable patient

Model Part No. Description Usage Applicable patient

DS-100A 9000-10-05161 SpO2 sensor, finger-clip Reusable Adult

D-YS 0010-10-12476  SpO2 sensor, with wraps Reusable /

OXI-P/I 9000-10-07308 SpO2 sensor, finger, band Reusable Pediatric/Infant

OXI-A/N 9000-10-07336 SpO2 sensor, finger/foot, band Reusable Adult/Neonate 

MAX-AI 0010-10-12202 SpO2 sensor, 24 pcs/box Disposable Adult (>30 kg)

MAX-PI 0010-10-12203 SpO2 sensor, 24 pcs/box Disposable Pediatric (10-50 Kg)

MAX-II 0010-10-12204 SpO2 sensor, 24 pcs/box Disposable Infant (3-20 kg)

MAX-NI 0010-10-12205 SpO2 sensor, 24 pcs/box Disposable Adult/Neonate
(<3 kg or >40 kg)

Model Part No. Description Usage Applicable patient

MR420B 040-001235-00 2-pin Temperature adapter cable Reusable /

Model Part No. Description Usage Applicable patient

MR401B 0011-30-37392 Temperature probe, endocavity Reusable Adult

MR402B 0011-30-37394 Temperature probe, endocavity Reusable Pediatric/Infant

MR403B 0011-30-37393 Temperature probe, skin surface Reusable Adult

MR404B 0011-30-37395 Temperature probe, skin surface Reusable Pediatric/Infant

MR411 040-003292-00 Temperature probe, esophageal/
rectal, 9FR

Disposable Adult/Pediatric
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37.4 NIBP Accessories

37.4.1  NIBP Hoses Available for Purchase

37.4.2 Cuffs Available for Purchase

MR412 040-003293-00 Temp probe, skin surface Disposable All

ES400-12 0206-03-0112-02 PROBE,D TEMP,ES400-12 (box of 20) Disposable Adult

ES400-18 0206-03-0118-02 PROBE,D TEMP,ES400-18 (box of 20) Disposable Adult

ER400-9 0206-03-0209-02 PROBE,D TEMP,ER 400-9 (box of 20) Disposable Adult

ER400-12 0206-03-0212-02 PROBE,D TEMP,ER400-12 (box of 20) Disposable Adult

STS-400 0206-03-0300-02 PROBE,D TEMP,STS-400 (box of 20) Disposable Adult

Model Part No. Description Usage Applicable patient

CM1903 6200-30-09688 NIBP hose, inbuilt connector, 3m Reusable Adult/Pediatric

CM1901 6200-30-11560 NIBP hose, inbuilt connector, 3m Reusable Neonate

Model Part No. Description Usage Applicable patient

Model Part No. Description Usage Applicable patient

CM1301 115-027713-00 Cuff, 10-19 cm, bladderless Reusable Infant

CM1302 115-027714-00 Cuff, 18-26 cm, bladderless Reusable Small Adult

CM1303 115-027715-00 Cuff, 25-35 cm, bladderless Reusable Adult

CM1304 115-027716-00 Cuff, 33-47 cm, bladderless Reusable Adult

CM1305 115-027717-00 Cuff, 46-66 cm, bladderless Reusable Adult thigh

CM1306 115-027718-00 Cuff, 24-35 cm, bladderless Reusable Adult

CM1307 115-027719-00 Cuff, 33-47 cm, bladderless Reusable Adult

CM1501 115-027556-00 Cuff, 10-19 cm, bladderless Disposable Child

CM1502 115-027557-00 Cuff, 18-26 cm, bladderless Disposable Small adult

CM1503 115-027558-00 Cuff, 25-35 cm, bladderless Disposable Adult

CM1504 115-027559-00 Cuff, 33-47 cm, bladderless Disposable Large adult

CM1505 115-027560-00 Cuff, 46-66 cm, bladderless Disposable Adult thigh

CM1506 115-027561-00 Cuff, 25-35 cm, bladderless, long Disposable Adult

CM1507 115-027562-00 Cuff, 33-47 cm, bladderless, long Disposable Large adult

CM1500A 001B-30-70677 Cuff, 3.1-5.7 cm Disposable Neonate

CM1500B 001B-30-70678 Cuff, 4.3-8.0 cm Disposable Neonate

CM1500C 001B-30-70679 Cuff, 5.8-10.9 cm Disposable Neonate

CM1500D 001B-30-70680 Cuff, 7.1-13.1 cm Disposable Neonate

CM1500E 001B-30-70681 Cuff, 5# Disposable Neonate
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37.5 IBP Accessories

37.5.1 IBP Accessories Available for Purchase
 

37.5.2 IBP Accessories Also Compatible

37.5.3 ICP Accessories Available for Purchase
 

37.6 C.O. Accessories Available for Purchase

Model Part No. Description Usage Applicable patient

IM2202 001C-30-70757 12 Pin IBP cable, Argon Reusable /

IM2201 001C-30-70759 12 Pin IBP cable, ICU Medical Reusable /

IM2211 0010-21-12179 12 Pin IBP cable, Edwards Reusable /

Model Part No. Description Usage Applicable patient

DT-4812 6000-10-02107 Disposable transducer kit, Argon Disposable /

682275 0010-10-12156 Mounting background and 
accessory for IBP transducer, Argon

Reusable /

42584 0010-10-42638 IBP transducer, ICU Medical Disposable /

42602 M90-000133--- Mounting background and 
accessory for IBP transducer, ICU 
Medical

Reusable / 

42394 M90-000134--- Mounting clamp for IBP transducer 
(send with the cable), ICU Medical

Reusable /

Model Part No. Description Usage Applicable patient

82-6653 040-002336-00 Codman ICP sensor kit, Johnson & 
Johnson, pkg of 1

Disposable /

CP12601 009-005460-00 12 Pin ICP Cable Reusable /

CP12603 040-001368-00 Adapter for Camino cable Reusable /

/ 009-004401-00 ICP adapting cable for Camino Reusable /

Model Part No. Description Usage Applicable patient

CO7702 0010-30-42743 12Pin C.O. cable, Edwards Reusable /

9850A 0012-00-1519 Cable, bath probe adapter Reusable /

SP4042 6000-10-02079 In-line injection temperature 
sensor, BD

Reusable /

SP5045 6000-10-02080 In-line injection temperature 
sensor housing, BD, pkg of 25

Disposable /

MX387 040-006154-00 12cc control syringe w/Rotator 
(MEDEX MX387)

Disposable /

93522 0012-00-1520 In-line inject temperature probe Reusable /
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37.7 ScvO2 Accessories Available for Purchase

37.8 CO2 Accessories

37.8.1 Sidestream CO2 Accessories Available for Purchase

37.8.2 Microstream CO2 Accessories Also Compatible

Model Part No. Description Usage Applicable patient

PC3030 115-008191-00 ScvO2 optical module Reusable /

PV2022-37 040-000919-00 CeVOX fiberoptic probe, 37 cm, pkg 
of 1

Disposable /

PV2022-35 040-000920-00 CeVOX fiberoptic probe, 35 cm, pkg 
of 1

Disposable /

Model Part No. Description Usage Applicable patient

4000 M02A-10-25937 CO2 Nasal sample cannula, 7'’ line Disposable Adult

4100 M02A-10-25938 CO2 Nasal sample cannula, 7'’ line Disposable Pediatric

4200 M02B-10-64509 CO2 Nasal sample cannula, 7'’ line Disposable Neonatal

60-15200-00 9200-10-10533 Sampling line, 2.5 m Disposable Adult/Pediatric

60-15300-00 9200-10-10555 Sampling line, 2.5 m Disposable Neonatal

60-14100-00 9000-10-07486 Dryline airway adapter, straight Disposable Adu/Ped

040-001187-00 040-001187-00 Airway Adapter Disposable Neonatal

60-14200-00 9000-10-07487 Dryline airway adapter, elbow Disposable /

100-000080-00 115-058733-00 DRYLINE II water trap, pkg of 10 Reusable Adult/Pediatric

100-000081-00 115-058734-00 DRYLINE II water trap, pkg of 10 Reusable Neonatal

Model Part No. Description Usage Applicable patient

MVAI 0010-10-42560 Adult-Pediatric Intubated CO2 FilterLine Disposable Adult, pediatric

MVAIH 0010-10-42561 Adult-Pediatric Intubated CO2 FilterLine Disposable Adult, pediatric

MVIIH 0010-10-42562 Neonatal-Infant Intubated CO2 FilterLine Disposable Neonate

MVAIL 0010-10-42563 Adult-Pediatric Intubated CO2 FilterLine Disposable Adult, pediatric

MVAIHL 0010-10-42564 Adult-Pediatric Intubated CO2 FilterLine Disposable Adult, pediatric

MVIIHL 0010-10-42565 Neonatal-Infant Intubated CO2 FilterLine Disposable Neonate

MVA 0010-10-42566 Adt Oral-Nasal CO2 FilterLine Disposable Adult

MVP 0010-10-42567 Ped Oral‐Nasal CO2 FilterLine Disposable Pediatric

MVAO 0010-10-42568 Adt Oral‐Nasal CO2 FilterLine w/O2 Disposable Adult

MVPO 0010-10-42569 Ped Oral‐Nasal CO2 FilterLine w/O2 Disposable Pediatric

MVAOL 0010-10-42570 Adt Oral-Nasal CO2 FilterLine w/O2 L Disposable Adult

MVPOL 0010-10-42571 Ped Oral‐Nasal CO2 FilterLine w/O2 L Disposable Pediatric

MVANH 0010-10-42572 Adult Nasal CO2 FilterLine Disposable Adult
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37.9 AG Accessories 

37.9.1 AG Accessories Available for Purchase

37.10 EEG Accessories Available for Purchase

37.11 BIS Accessories

37.11.1 BIS Accessories Available for Purchase

37.11.2 BIS Accessories Also Compatible

Model Part No. Description Usage Applicable patient

60-15200-00 9200-10-10533 Sampling line, 2.5 m Disposable Adult/Pediatric

60-15300-00 9200-10-10555 Sampling line, DRYLINE, 2.5m Disposable Neonate

60-14100-00 9000-10-07486 DRYLINE airway adapter, straight Disposable Adult/Pediatric

60-14200-00 9000-10-07487 DRYLINE airway adapter, elbow Disposable Adult/Pediatric

100-000080-00 115-058733-00 DRYLINE II water trap, pkg of 10 Reusable Adult/Pediatric

100-000081-00 115-058734-00 DRYLINE II water trap, pkg of 10 Reusable Neonate

040-001187-00 040-001187-00 Airway adapter Reusable /

Model Part No. Description Usage Applicable patient

B8830085010 040-001594-00 Cable for EEG Reusable Adult/Pediatric

B9721104003 040-001598-00 Cup electrodes for EEG Reusable Adult/Pediatric

B9721105004 040-001602-00 Cup electrodes for EEG (D=6 mm) Reusable Pediatric

Model Part No. Description Usage Applicable patient

186-0195-MR 6800-30-50761 Bispectral Index kit, Covidien Reusable /

186-0224-MR 115-005707-00 BISx4 cable kit, Covidien Reusable /

Model Part No. Description Usage Applicable patient

186-0106 0010-10-42672 BIS Sensor Quatro(186-0106), 
Covidien

Disposable Adult

MVINH 0010-10-42574 Neo-Inf Nasal CO2 FilterLine H Disposable Neonate

MVANOH 0010-10-42575 Adt Nasal CO2 FilterLine w/O2 H Disposable Adult

MVPNOH 0010-10-42576 Ped Nasal CO2 FilterLine w/O2 H Disposable Pediatric

MVAN 0010-10-42577 Adult Nasal CO2 FilterLine Disposable Adult

MVPN 0010-10-42578 Pediatric Nasal CO2 FilterLine Disposable Pediatric

Model Part No. Description Usage Applicable patient
BeneVision N22/N19/N17/N15/N12 Patient Monitor Operator’s Manual 37 - 9



37.12 RM Accessories

37.13 NMT Accessories Available for Purchase

37.14 rSO2 Accessories

37.14.1 rSO2 Accessories Available for Purchase

37.14.2 rSO2 Accessories Also Compatible

186-0200 0010-10-42673 BIS Pediatric sensor(186-0200), 
Covidien

Disposable Pediatric

186-0212 040-000392-00 BISx4 Sensor(Bilateral)(186-0212), 
Covidien

Disposable Adult

186-0160 6800-10-50652 BIS Extend Sensor(186-0160), 
Covidien

Disposable Adult

Model Part No. Description Usage Applicable patient

Model Part No. Description Applicable patient

040-001947-00 040-001947-00 Flow sensor, 1.8 m Adult, pediatric

040-001949-00 040-001949-00 Flow sensor, 3.3 m Adult, pediatric

Model Part No. Description Usage Applicable patient

NM13101 040-001462-00 NMT cable Reusable Adult, pediatric

NM13401 040-001463-00 NMT sensor cable Reusable Adult, pediatric

NM13701 040-001464-00 NMT stimulation cable Reusable Adult, pediatric

NM13901 040-002258-00 Bandage for NMT sensor, pkg of 20 Disposable Adult, pediatric

Model Part No. Description Usage Applicable patient

RSC-1 100-000164-00 Sensor cable, channel 1, INVOS 5100C Reusable /

RSC-2 100-000165-00 Sensor cable, channel 2, INVOS 5100C Reusable /

5100C-PA 100-000173-00 Preamplifier, channel 1 & 2, INVOS 5100C Reusable /

Model Part No. Description Usage Applicable patient

SAFB-SM 100-000168-00 SomaSensor (>40 kg) Disposable Adult

SPFB 100-000169-00 SomaSensor (<40 kg) Disposable Pediatric

SNN 100-000181-00 OxyAlert NIRSensor (<5kg), somatic, 
with sensor cable

Disposable Neonate

CNN 100-000180-00 OxyAlert NIRSensor (<5kg), cerebral, 
with sensor cable

Disposable Neonate

CNN/SNN 100-000182-00 OxyAlert NIRSensor (<5kg), somatic/
cerebral, with sensor cable

Disposable Neonate
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37.15 CCO/SvO2 Accessories Available for Purchase
 

37.16 BeneLink Accessories

Model Part No. Description Usage Applicable patient

/ 009-000259-00 CCO/SvO2 cable Reusable /

Part No. Description

009-001767-00 Serial port adapting cable, type A

009-001768-00 Serial port adapting cable, type B

009-001769-00 Serial port adapting cable, type C

009-002943-00 Serial port adapting cable, type D

009-004613-00 Serial port adapting cable, type E

009-008485-00 Serial port adapting cable, type F

115-011465-00 ID Adapter kit (contains ID Adapter with label and RJ45 cable with label)

115-007277-00 ID Adapter

047-004857-00 ID adapter label 

047-004859-00 Network line label

009-001770-00 RJ45 connecting cable
BeneVision N22/N19/N17/N15/N12 Patient Monitor Operator’s Manual 37 - 11



37.17 External Modules

Module Part No. Comments

MPM module 115-048463-00 3/5/6 lead ECG, NIBP, dual channel Temp, Masimo SpO2, dual channel IBP 

MPM module 115-048464-00 3/5/6 lead ECG, NIBP, dual channel Temp, Nellcor SpO2, dual channel IBP 

MPM module 115-048466-00 3/5/6 lead ECG, NIBP, dual channel Temp, Masimo SpO2

MPM module 115-048467-00 3/5/6 lead ECG, NIBP, dual channel Temp, Nellcor SpO2

MPM module 115-048469-00 3/5/6/12 lead ECG, NIBP, dual channel Temp, Nellcor SpO2, dual channel IBP) 

MPM module 115-048470-00 3/5/6/12 lead ECG, NIBP, dual channel Temp, Masimo SpO2, dual channel IBP  

SpO2 module 115-047230-00 Supports SpO2 monitoring, Masimo SpO2

SpO2 module 115-039629-00 Supports SpO2 monitoring, Nellcor SpO2

Temp module 115-039554-00 Supports temperature monitoring

C.O. module 115-047275-00 Supports C.O. monitoring

IBP module 115-047274-00 Supports IBP monitoring 

CCO/SvO2 module 115-003480-00 Connects Edwards Vigilance II®, VigileoTM, EV1000, or HemoSphere monitor, 
supports CCO and SvO2 monitoring

ScvO2 module 115-007273-00 Supports ScvO2 monitoring

EEG module 115-018152-00 Supports EEG monitoring

NMT module 115-018518-00 Supports NMT monitoring

BIS module 6800-30-50486 Supports BIS monitoring

rSO2 module 115-031388-00 Supports rSO2 monitoring, INVOS

Microstream CO2 
module

6800-30-50558 Supports CO2 monitoring, Oridion

CO2 module 115-048924-00 Supports CO2 monitoring, Sidestream CO2 

CO2 module (with 
O2)

115-048925-00 Supports CO2 monitoring, integrates O2 (paramagnetic) monitoring, 
Sidestream CO2 

AG module 115-045728-00 Supports AG monitoring, integrates O2 (paramagnetic) monitoring

AG module 115-045727-00 Supports AG monitoring, integrates O2 (paramagnetic) and BIS monitoring 

RM module 115-022808-00 Supports RM monitoring

BeneLink module 115-052998-00 Connects external devices

Recorder module 115-031386-00 Supports recording

SMR 115-046943-00 Satellite module rack
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37.18 Mount and Mounting Accessories

The following installation accessories are for N17/N15/N12 only.

The following installation accessories are for N22/N19 only.

Part No. Description

115-033887-00 8-slot satellite module rack (SMR), with handle, hook, and 2 m cable

0010-30-11972 SMR clamp assembly

034-000457-00 GCX M series pivot arm, 12" VESA mount

034-000458-00 GCX M series articulating arm, 12" x 12" for SMR

042-014101-00 NIBP cuff holder

043-006060-00 Cable hooks

115-035995-00 SMR clamp mounting kit, w/ 6" post

034-000458-00 GCX M series articulating arm, 12" x 12" for SMR

115-033911-00 SMR cable management mounting kit

115-035995-00 SMR clamp mounting kit, w/ 6" post

115-045621-00 SMR clamp mounting kit, w/ 9" post

Part No. Description

045-000915-00 N17/N15 rolling stand with mounting plate 

045-000953-00 N12 quick release mount for rolling stand

045-000955-00 N17/N15 quick release mount for rolling stand

045-001190-00 N12 transport stand (MR) with GCX shoe

045-003297-00 N17/N15/N12 Mount Transition Plate

045-003240-00 N17/N15/N12 M Series 12" arm with Transition Plate

045-003253-00 N17/N15/N12 GCX VHM Series arm with Transition Plate

045-003255-00 N12 rolling stand with quick release mount 

115-045865-00 N12 Bedrail Hook

045-003254-00 TDS cross clamp with 9" riser post (for N17/N15/N12)

Part No. Description

034-000456-00 GCX VHM arm

034-000454-00 GCX M series arm, 16", with 6” riser

045-001976-00 Rotatory assembly kit for display 

045-002198-00 Dock install to bracket package

115-033880-00 Host to GCX mounting kit

115-033871-00 Keyboard kit with 9” downpost

115-051379-00 Separate host & display mounting kit, for rotation

041-017853-00 Host mounting block
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37.19 Miscellaneous Accessories

Part No. Description

009-005121-00 SMR cable, 2m

009-005122-00 SMR cable, 10m

009-006593-00 N series to N1/T1 docking station cable, 2 m

009-005123-00 N series to N1/T1 docking station cable, 4 m

009-006594-00 N series to N1/T1 docking station cable, 10 m

009-009766-00 N series to N1/T1 docking station cable, 20 m

009-005391-00 MPM analog output and defib sync cable

8000-21-10361 Nurse call cable

023-001566-00 HP LaserJet Enterprise M608n, black and white

0683-00-0505-02 Recording paper, 50 mm*20 m, pkg of 12 A30-000001---

115-056983-00 Clinical Scoring Custom CD

115-055522-00 Field-installed iView module (N22/N19)

023-001788-00 External display, 21.5’(for N17/N15/N12)

115-049288-00 Display assembly kit, 22", with AC adapter and 5 m video cable (for N22)

115-049289-00 Display assembly kit, 19", with AC adapter and 5 m video cable (for N19)

115-034030-00 Display handle, without encoder (for N22/N19)

115-037270-00 Display handle, with encoder (for N22/N19)

009-005115-00 Video cable, 2.3 m (for N22/N19)

009-007740-00 Video cable, 5 m (for N22/N19)

009-005117-00 Video cable, 10 m (for N22/N19)

009-005118-00 USB cable, 2.3 m (for N22/N19)

009-008237-00 USB cable, 5 m (for N22/N19)

009-005120-00 USB cable, 10 m (for N22/N19)

115-018012-00 Lithium-ion battery, LI23S002A (for N17/N15/N12)

115-065140-00 Lithium-ion battery, LI23S002H (for N17/N15/N12)

115-034132-00 Lithium-ion battery, LI23I003A (for N22/N19)

DA8K-10-14452 Power cord, USA

1000-21-00122 Grounding cable

009-003648-00 Cable protecting tube

009-003903-00 Accessory management tape

023-000247-00 Keyboard, wired USB connector, black

023-000248-00 Mouse, wired USB connector, black

023-000524-00 Wireless keyboard and mouse set

023-000525-00 Wired keyboard and mouse set

115-039575-00 2D Barcode reader, HS-1M, JADAK

115-039635-00 2D Barcode reader, HS-1R, JADAK

115-045643-00 Remote control
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042-007382-00 Cable management hook

034-000666-00 Barcode reader holder (for JADAK Barcode reader)

Part No. Description
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A Product Specifications

A.1 Monitor Safety Specifications
The monitor is classified, according to IEC 60601-1: 2005:

A.2 Physical Specifications

A.2.1 BeneVision N22/N19

A.2.2 BeneVision N17/N15/N12

Degree of protection against electrical 
shock

Type CF defibrillation proof for ECG, Resp, TEMP, IBP, SpO2, C.O., NIBP, EEG, and 
NMT
Type BF defibrillation proof for ScvO2, CO2, AG, BIS, RM, and rSO2

Type of protection against electrical 
shock

Class I

Degree of protection against harmful 
ingress of water

IPX1

Degree of safety of application in the 
presence of flammable anesthetic 
mixture with air or with oxygen or 
nitrous oxide

The equipment is not suitable for use in the presence of a flammable 
anesthetic mixture with air or with oxygen or nitrous oxide

Mode of operation Continuous

Item Maximum 
Weight (kg)

W × H × D (mm) Comments

N19 monitor
(main unit and 
primary display 
installed together)

10.30 509 × 423 × 115
(display horizontally 
installed)
584 × 348 × 115
(display vertically installed)

Including the battery, iView module, Wi-Fi 
module, display with the handle and 
navigation knob.
Excluding SMR, modules, and accessories.

N22 monitor
(main unit and 
primary display 
installed together)

11.50 566 × 458 × 115
(display horizontally 
installed)
641 × 383 × 115
(display vertically installed)

Including the battery, iView module, Wi-Fi 
module, display with the handle and 
navigation knob.
Excluding SMR, modules, and accessories.

Main unit 3.40 268 × 268 × 68 Including the battery.

Display, 19 inch 6.20 509 × 348 × 48 Excluding the handle.

Display, 22 inch 7.40 566 × 383 × 48 Excluding the handle.

Item Maximum 
Weight (kg)

W × H × D (mm) Comments

N17 7.3 466×355×210 Excluding iView module, Wi-Fi module, SMR, 
measurement modules, recorder, battery 
and accessories.N15 5.4 396×313×193

N12 4.1 313×290×161
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A.2.3 SMR and Modules

A.3 Environmental Specifications

WARNING

• The monitor may not meet the performance specifications if stored or used outside the specified 
temperature and humidity ranges. If the performance of the equipment is degraded due to aging or 
environmental conditions, contact your service personnel.

• When the monitor and related products have differing environmental specifications, the effective 
range for the combined products is that range which is common to the specifications for all 
products.

NOTE

• The environmental specification of unspecified parameter modules are the same as those of the 
main unit.

Item Maximum 
Weight (kg)

W × H × D (mm) Comments

Satellite module rack (SMR) 2.30 403 × 221 × 145 Including the handle and cable hooks.

MPM module 0.63 136.5 × 80.5 × 102 /

SpO2 module 0.29 136.5 × 40 × 102 Masimo SpO2 or Nellcor SpO2

Temp module 0.25 136.5 × 40 × 102 /

C.O. module 0.25 136.5 × 40 × 102 /

IBP module 0.26 136.5 × 40 × 102 /

CCO/SvO2 module 0.26 136.5 × 40 × 102 /

ScvO2 module 0.26 136.5 × 40 × 102 /

EEG module 0.28 136.5 × 40 × 102 /

BIS module 0.26 136.5 × 40 × 102 /

NMT module 0.29 136.5 × 40 × 102 /

rSO2 module 0.30 136.5 × 40 × 102 /

Microstream CO2 module 0.38 136.5 × 40 × 102 /

Sidestream CO2 module 0.63 136.5 × 40 × 102 /

AG module 1.03 136.5 × 80.5 × 102 With built-in O2 module

RM module 0.38 136.5 × 40 × 102 /

BeneLink module 0.35 136.5 × 40 × 102 /

Recorder 0.40 136.5 × 80.5 × 102 /

Components Property (unit) Operating Condition Storage Condition

Main Unit Temperature (°C) 0 to 35 (for N17 configured 
with iView module)
0 to 40 for other configuration

-20 to 60

Relative humidity 
(noncondensing) (%)

15 to 95 10 to 95

Barometric (mmHg) 427.5 to 805.5 120 to 805.5
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A.4 Power Supply Specifications

A.4.1 External Power Supply Specifications

A.4.2 Battery Specifications

A.4.2.1 N22/N19 Battery Specifications

Microstream CO2 
module

Temperature (°C) 0 to 40 -20 to 60

Relative humidity 
(noncondensing) (%)

15 to 95 10 to 95

Barometric (mmHg) 430 to 790 430 to 790

Sidestream CO2 
module

Temperature (°C) 5 to 40 -20 to 60

Relative humidity 
(noncondensing) (%)

15 to 95 10 to 95

Barometric (mmHg) 430 to 790 430 to 790

AG module Temperature (°C) 10 to 40 -20 to 60

Relative humidity 
(noncondensing) (%)

15 to 95 10 to 95

Barometric (mmHg) 525 to 805.5 525 to 805.5

RM module Temperature (°C) 5 to 40 -20 to 60

Relative humidity 
(noncondensing) (%)

15 to 95 10 to 95

Barometric (mmHg) 427.5 to 805.5 120 to 805.5

ScvO2 module Temperature (°C) 10 to 40 -20 to 60

Relative humidity 
(noncondensing) (%)

15 to 75 10 to 90

Barometric (mmHg) 427.5 to 805.5 120 to 805.5

rSO2 module Temperature (°C) 16 to 32 -20 to 70

Relative humidity 
(noncondensing) (%)

20 to 80 10 to 95

Barometric (mmHg) 525 to 805.5 435.7 to 822

Components Property (unit) Operating Condition Storage Condition

Line voltage 100 to 240 VAC (±10%)

Input Current N22/N19: 2.8 A to 1.6 A
N17/N15/N12: 2.0 A to 0.9 A

Frequency 50/60 Hz (± 3 Hz)

Battery type Rechargeable lithium-ion battery

Voltage 10.8 VDC

Capacity 5600 mAh
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A.4.3 N17/N15/N12 Battery Specifications

A.5 Display Specifications

A.6 Recorder Specifications

Run time At least 1 hour continuously on a typical configuration, powered by a new, 
fully-charged battery.
Note: A typical configuration is 12-lead ECG, Resp, SpO2, 4-channel IBP, 2-
channel Temp, CO2, C.O., and NIBP module set at an interval of 15 minutes.
WI-Fi is enabled.
The screen brightness is set to the factory default.

Charge time For a new battery:
5 hours to 90% when the monitor is off
9 hours to 90% when the monitor is on.

Shutdown delay At least 15 minutes (after a low battery alarm first occurs)

Battery type Rechargeable lithium-ion battery

Voltage 10.95 VDC

Capacity 5200 mAh

Run time At least 2 hours continuously for N17/N15 or at least 4 hours continuously for 
N12 on a typical configuration, powered by a new, fully charged battery.
The monitor is powered by a new, fully-charged battery at 25 °C with a 5-lead 
ECG and SpO2 cable connected, auto NIBP measurements at an interval of 15 
minutes, and the screen brightness is set to 1.

Charge time No more than 4.5 hours to 90% when the monitor is off
No more than 10 hours to 90% when the monitor is on

Shutdown delay At least 15 minutes (after a low battery alarm first occurs)

Screen type Medical-grade color TFT LCD

Screen Size (diagonal) N22: 22 inches
N19: 19 inches
N17: 18.5 inches
N15: 15.6 inches
N12: 12.1 inches

Resolution N22/N19: 1680 x 1050 pixels
N17/N15: 1920 x1080 pixels
N12: 1280 x 800 pixels

Method Thermal dot array

Horizontal resolution 16 dots/mm (25 mm/s paper speed)

Vertical resolution 8 dots/mm

Paper width 50 mm

Paper length 20 m

Paper speed 25 mm/s, 50 mm/s
Accuracy: ±5%

Number of waveform channels A maximum of 3
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A.7 LEDs

A.8 Audio Indicator

A.9 Monitor Interface Specifications

A.9.1 Interface Specifications of the N22/N19 Main Unit

A.9.2 Interface Specifications of the N22/N19 Separate Primary Display

A.9.3 Interface Specifications of the N22/N19 Integrated Primary Display

A.9.4 Interface Specifications of the N22/N19 Secondary Display

Alarm lamp 1 (three color-coded: red, yellow, and cyan)

Power-on LED 1 (green)

AC power LED 1 (green)

Battery LED 1 (two color-coded: yellow and green)

Speaker Give alarm tones (45 to 85 dB), reminder tones, key tones, QRS tones; support 
PITCH TONE and multi-level tone modulation; alarm tones comply with IEC 
60601-1-8:2012.

AC power input 1

Network connector (LAN1, LAN2, LAN3) 3 standard RJ45 connectors (one on the iView module), 100 Base-TX, IEEE 
802.3

Serial bus connector (MSB) 6: 3 connectors and each connector contains 2 sub-connectors

USB connector 4, USB 2.0 (for iView only)

Satellite module rack (SMR) connector 3

Video output connector (VP1, VP2) 2, VP1 connects the secondary display (DisplayPort). VP2 connects the display 
for iView system (DisplayPort)

Nurse call connector (NC) 1, standard BNC

Equipotential grounding terminal 1

Primary display connectors 1 set (VP3, SIG1, MSB4, and DC-in), for connecting to separate primary display, 
hidden when the display is integrated with the main unit.

Serial bus connector (MSB) 3

Serial bus hub connector (SBH) 1

Signal input connector (SIG1) 1

DC-in connector 1

Video input connector (VP) 1

Serial bus connector (MSB) 1

Serial bus connector (MSB) 3

Serial bus hub connector (SBH) 1
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A.9.5 Interface Specifications of the N17/N15/N12

A.10 Signal Outputs Specifications

Signal input connector (SIG1) 1

DC-in connector 1

Video input connector (VP) 1

AC power input 1

Network connector N17: 2 standard RJ45 connectors (one on the iView module)
N15/N12: 1 standard RJ45 connector

USB connector 4, USB 2.0

Satellite module rack (SMR)/Docking 
station connector

1 (For N17/N15, it connects the SMR or the docking station. For N12, it 
connects the N1/T1 docking station)

Video output connector N17: 2, (configuration A: 1 mirrored (DVI), 1 independent (DVI); configuration 
B: 1 mirrored (DVI), 1 iView (DVI).)
N15/N12: 1 mirrored (DVI)

Nurse call connector 1, standard BNC

Equipotential grounding terminal 1

Auxiliary Output

Standard Meets the requirements of IEC 60601-1:2005 for short-circuit protection and 
leakage current

ECG Analog Output

Bandwidth
(-3dB; reference frequency: 10Hz)

Diagnostic mode: 0.05 to 150 Hz
Monitor mode: 0.5 to 40 Hz
Surgical mode: 1 to 20 Hz
ST mode: 0.05 to 40 Hz

Maximum QRS delay 25 ms (in diagnostic mode, and non-paced)

Gain (reference frequency 10Hz) 1V/mV (±5%)

Pace enhancement Signal amplitude: Voh≥2.5V
Pulse width: 10ms±5%
Signal rise and fall time: ≤100μs

IBP Analog Output

Bandwidth (-3dB; reference 
frequency:1Hz)

0 to 40 Hz 

Maximum transmission delay 30 ms

Gain (reference frequency 1 Hz) 1 V/100 mmHg, ±5%

Nurse Call Signal

Amplitude High level: 3.5 to 5 V, ±5%, providing a minimum of 10 mA output current;
Low level: < 0.5 V, receiving a minimum of 5 mA input current.

Rise and fall time ≤1 ms

Defib Sync Pulse

Output impedance ≤100 Ω

Maximum time delay 35 ms (R-wave peak to leading edge of pulse)
A - 6  BeneVision N22/N19/N17/N15/N12 Patient Monitor Operator’s Manual



A.11 Data Storage

A.12 Wi-Fi Specifications

A.12.1 Wi-Fi Technical Specifications (MSD45N)

Amplitude High level: 3.5 to 5 V, ±5%, providing a maximum of 10 mA output current;
Low level: < 0.5 V, receiving a maximum of 5 mA input current.

Pulse width 100 ms ±10%

Maximum rise and fall time 1 ms

Alarm output

Alarm delay time from the monitor to 
remote equipment 

The alarm delay time  measured at the monitor signal output connector:
From the monitor to the CMS and remote monitors: ≤2 seconds
From the monitor to the TM80 telemetry monitor: ≤3 seconds

Alarm signal sound pressure level range 45 dB(A) to 85 dB(A) within a range of one meter

Trends A minimum of 120 hours of trend data for trend interval as low as 1 minute.

Events 1000 events

NIBP measurements 1000 sets

Interpretation of resting 12-lead ECG 
results

20 sets

Full-disclosure waveforms 48 hours at maximum. The specific storage time depends on the waveforms 
stored and the number of stored waveforms.

ST view A maximum of 120 hours of ST segment waveforms. One group of ST segment 
waveforms is stored every minute.

OxyCRG view A maximum of 48 hours of oxyCRG events

Protocol IEEE 802.11a/b/g/n

Modulation mode BPSK, QPSK, 16QAM, 64QAM

Operating frequency 2.4 GHz to 2.495 GHz.
5.15 GHz to 5.25 GHz, 5.725 GHz to 5.85 GHz

Channel spacing IEEE 802.11b/g: 5 MHz 
IEEE 802.11n (at 2.4 GHz): 5 MHz 
IEEE802.11a: 20 MHz
IEEE802.11n (at 5 GHz): 20 MHz

Wireless data rate IEEE 802.11b: 1 Mbps to 11 Mbps
IEEE 802.11g: 6 Mbps to 54 Mbps
IEEE 802.11n: 6.5 Mbps to 72.2 Mbps (MCS0-MCS7)
IEEE 802.11a: 6 Mbps to 54 Mbps

Output power <20 dBm (CE requirements, detection mode: RMS)
<30 dBm (FCC requirements, detection mode: peak power)

Operating mode As station, access AP for data transmission

Data security Standards: WPA-PSK, WPA2-PSK, WPA-Enterprise, WPA2-Enterprise, WPA CCKM, WPA2 
CCKM
EAP method: EAP-FAST, EAP-TLS, EAP-TTLS, PEAP-GTC, PEAP-MSCHAPv2, PEAP-TLS, LEAP
Encryption: AES
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A.12.2 Wi-Fi Technical Specifications (SX-SDMAC-2832S+)

A.12.3 Wi-Fi Performance Specifications

WARNING

• All network functions of data communication are designed to operate on a private network.

A.12.3.1 System Capacity

Number of the monitors supported by a single AP: ≤ 12 (for N22/N19) or ≤ 16 (for N17/N15/N12).

Testing conditions are as follows:

■ Each monitor can communicate with the CMS. 

■ Two monitors are used to view other monitors.

■ Only one monitor can transmit history data. 

■ The weakest strength of the AP signal where the monitor is located cannot be less than -65 dBm.

A.12.3.2 Resistance to Wireless Interference

The distance between the interfering devices and the monitor is greater than 20 cm. A Wi-Fi interference (no 
greater than -85 dBm) in the same channel and a Wi-Fi interference (no greater than -50 dBm) in an adjacent-
channel are presented synchronously. The interfering devices include, but are not limited to, 2.4 GHz wireless 
devices, cellular mobile networks, microwave ovens, intercoms, cordless phones, and ESU equipment. The 
interfering devices do not include Wi-Fi devices.

The monitoring network must support the following requirements:

■ All the monitors do not encounter communication loss.

■ The total delay of data transmission from the monitor to the CMS: ≤ 2 seconds.

■ The delay for monitor-related settings configured at the CMS to be effective: ≤ 2 seconds.

Protocol IEEE 802.11a/b/g/n

Modulation mode BPSK, QPSK, 16QAM, 64QAM

Operating frequency 2412 MHz to 2462 MHz

5180 MHz to 5320 MHz, 5500 MHz to 5700 MHz, 5745 MHz to 5825 MHz 

WARNIGN: SX-SDMAC-2832S+ supports the DFS channels. When using the DFS 
channels, Wi-Fi performance stability and roaming time can be undermined due to 
avoiding interfering with Radar systems. DFS channels are disabled by default and 
not recommended. The operator should comprehensively assess the risk before 
using the DFS channels.

Channel spacing IEEE 802.11b/g: 5 MHz 

IEEE 802.11n (at 2.4 GHz): 5 MHz 

IEEE802.11a: 20 MHz

IEEE802.11n (at 5 GHz): 20 MHz

Wireless data rate IEEE 802.11b: 1 Mbps to 11 Mbps

IEEE 802.11g: 6 Mbps to 54 Mbps

IEEE 802.11n: MCS0 - MCS7 

IEEE 802.11a: 6 Mbps to 54 Mbps

Output power <20 dBm (CE requirements, detection mode: RMS)

<30 dBm (FCC requirements, detection mode: peak power)

Operating mode As station, access AP for data transmission

Data security Standards: WPA-PSK, WPA2-PSK, WPA-Enterprise, WPA2-Enterprise, WPA CCKM, WPA2 
CCKM

EAP method: EAP-FAST, EAP-TLS, EAP-TTLS, PEAP-GTC, PEAP-MSCHAPv2, PEAP-TLS, LEAP

Encryption: AES
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■ The total delay of data transmission from one monitor to the other: ≤ 2 seconds.

■ The delay for the monitor to reset alarms of another to be effective: ≤ 2 seconds.

A.12.3.3 Wi-Fi Network Stability

The ratio of the communication data loss on the CMS from any monitor does not exceed 0.1% over a 24-hour 
period.

Testing conditions are as follows:

■ Number of the monitors supported by a single AP: ≤ 12 (for N22/N19) or ≤ 16 (for N17/N15/N12).

■ For N17/N15/N12, 12 of the 16 monitors connected to the network roam for 30 times

■ Each monitor can communicate with the CMS. 

■ Two monitors are used to view other monitors.

■ Only one monitor can transmit history data. 

■ The weakest strength of the AP signal where the monitor is located cannot be less than -65 dBm.

A.12.3.4 Line of Sight Distance

The line of sight distance between the monitor and the AP is no less than 50 meters.

A.13 Measurement Specifications
The adjustable range of alarm limits is the same with the measurement range of signals unless otherwise 
specified. 

A.13.1 ECG Specifications

ECG

Standards Meets the requirements of IEC 60601-2-27: 2011 and IEC 60601-2-25: 2011

Lead set 3-lead: I, II, III
5-lead: I, II, III, aVR, aVL, aVF, V
6-lead: I, II, III, aVR, aVL, aVF, Va, Vb
12-lead: I, II, III, aVR, aVL, aVF, V1 to V6

ECG standard AHA, IEC

Display sensitivity 1.25 mm/mV (×0.125), 2.5 mm/mV (×0.25), 5 mm/mV (×0.5), 10 mm/mV (×1), 
20 mm/mV (×2), 40 mm/mV (×4), Auto, less than 5% error

Sweep speed 6.25 mm/s, 12.5 mm/s, 25 mm/s, 50 mm/s, less than 5% error

Bandwidth (-3dB) Diagnostic mode:
Monitor mode: 
Surgery mode: 
ST mode:
High frequency cut-off (for 12-
lead ECG analysis):

0.05 to 150 Hz
0.5 to 40 Hz
1 to 20 Hz
0.05 to 40 Hz
350 Hz (0.05 to 350 Hz), 150 Hz (0.05 to 150 
Hz), 35 Hz (0.05 to 35 Hz), 20 Hz (0.05 to 20 
Hz) selectable

Common mode rejection ratio
(with Notch filter off )

Diagnostic mode:
Monitor mode:
Surgery mode:
ST mode:

>90 dB
>105 dB (with notch filter on)
>105 dB (with notch filter on)
>105 dB (with notch filter on)

Notch filter 50/60 Hz
Monitor, surgical, and ST mode: notch filter turns on automatically
Diagnostic mode and High Freq Cut-off: notch filter is turned on/off manually

Differential input impedance ≥5 MΩ

Input signal range ±8 mV (peak-to-peak value)
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Accuracy of signal reproduction Use A and D methods based on IEC 60601-2-25: 2011 to determine frequency 
response.

Electrode offset potential tolerance ±500 mV

Lead-off detection current Measuring electrode: <0.1 μA
Drive electrode: <1 μA

Input offset current ≤0.1 μA, (drive lead≤1μA)

Defibrillation protection Withstands 5000V (360 J) charge without data loss or corruption
Baseline recovery time: <5 s
Polarization recovery time: <10 s
Defibrillation energy absorption: ≤10% (100 Ω load)

Patient leakage current <10 uA

Calibration signal 1mV (peak-to-peak value) ±5%

ESU protection Cut mode: 300 W
Coagulate mode: 100 W
Recovery time: ≤10 s
In compliance with the requirements in clause 202.6.2.101 of IEC 60601-2-27: 
2011

Pace Pulse

Pace pulse markers Pace pulses meeting the following conditions are labelled with a PACE marker:

Amplitude:
Width:
Rise time: 
No overshoot

±2 mV to ±700 mV
0.1 ms to 2 ms
10 μs to 100 μs (< 10% of pulse width)

Pace pulse rejection When tested in accordance with the IEC 60601-2-27: 2011: 201.12.1.101.13, 
the heart rate meter rejects all pulses meeting the following conditions. 

Amplitude:
Width:
Rise time: 
No overshoot

±2 mV to ±700 mV
0.1 ms to 2 ms
10 μs to 100 μs (< 10% of pulse width)

HR

Measurement range Neonate: 15 to 350 bpm
Pediatric: 15 to 350 bpm
Adult: 15 to 300 bpm

Resolution 1 bpm

Accuracy ±1 bpm or ±1%, whichever is greater.

Sensitivity 200 μV (lead II)

HR averaging method In compliance with the requirements in Clause 201.7.9.2.9.101 b) 3) of IEC 
60601-2-27: 2011, the following method is used:
If the last 3 consecutive RR intervals are greater than 1200 ms, the 4 most 
recent RR intervals are averaged to compute the HR. Otherwise, heart rate is 
computed by subtracting the maximum and minimum ones from the most 
recent 12 RR intervals and then averaging the remaining 10 RR intervals.
The HR value displayed on the monitor screen is updated every second.

Response to irregular rhythm In compliance with the requirements in Clause 201.7.9.2.9.101 b) 4) of IEC 
60601-2-27: 2011, the heart rates for the specified test signals after 20 seconds 
of stabilization are:
Ventricular bigeminy (waveform A1): 80±1 bpm
Slow alternating ventricular bigeminy (waveform A2): 60±1 bpm
Rapid alternating ventricular bigeminy (waveform A3): 120±1 bpm
Bidirectional systoles (waveform A4): 90±2 bpm
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Response time to heart rate change Meets the requirements of IEC 60601-2-27: 2011: Clause 201.7.9.2.9.101 b) 5).
From 80 to 120 bpm: less than 11 s
From 80 to 40 bpm: less than 11 s 

Time to alarm for tachycardia Meets the requirements in Clause 201.7.9.2.9.101 b) 6) of IEC 60601-2-27: 2011.

Waveform
B1h-range:
B1-range:
B1d-range:
B2h-range:
B2-range:
B2d-range:

<11 s
<11 s
<11 s
<11 s
<11 s
<11 s

Tall T-wave rejection capability When the test is performed based on Clause 201.12.1.101.17 of IEC 60601-2-27: 
2011, the heart rate calculation is not affected for QRS of 1 mV amplitude and 
100 ms duration, T-wave duration of 180 ms and amplitude lower than 1.2 mV, 
and QT interval of 350 ms. 

Arrhythmia Analysis Classifications Asystole, V-Fib/V-Tach, V-Tach, Vent Brady, Extreme Tachy, Extreme Brady, Vent 
Rhythm, PVCs/min, Pauses/min, Couplet, Bigeminy, Trigeminy, R on T, Run 
PVCs, PVC, Tachy, Brady, Missed Beats, Pacer Not Pacing, Pacer Not Capture, 
Multiform PVC, Nonsus V-Tach, Pause, Irr Rhythm, A-Fib

ST Segment Analysis 

Measurement range -2.0 mV to +2.0 mV RTI

Accuracy -0.8 mV to +0.8 mV: ±0.02 mV or ±10%, whichever is greater
Beyond this range: not specified

Resolution 0.01mV

QT/QTc Analysis

Measurement range QT: 200 to 800 ms
QTc: 200 to800 ms
QT-HR: 15 bpm to 150 bpm for adult, 15 bpm to 180 bpm for pediatric and 
neonate

Accuracy QT: ±30 ms

Resolution QT: 4 ms
QTc: 1 ms

12-lead ECG Interpretation

Sampling rate 1000 samples/s (A/D) 
500 samples/s (ECG algorithm)

Amplitude quantisation 24 bits

Alarm limit Range Step

HR High HR≤40bpm: (low limit + 2 bpm) to 40 bpm
HR > 40 bpm: (low limit + 5 bpm) to 295 bpm (Adult/Pediatric)
                     (low limit + 5 bpm) to 300 bpm (Neonate)

HR≤40bpm: 1 bpm
HR > 40 bpm: 5 bpm

HR Low HR≤40bpm: 16 bpm to (high limit - 2 bpm) (Adult/Pediatric)
                         15 bpm to (high limit - 2 bpm) (Neonate)
HR > 40 bpm: 40 bpm to (high limit - 5 bpm)

ST High (low limit + 0.2 mV) to 2.0 mV (ST alarm mode: Absolute)
0 mV to 2.0 mV (ST alarm mode: Relative)

0.05 mV

ST Low -2.0 mV to (high limit - 0.2 mV) (ST alarm mode: Absolute)
-2.0 mV to 0 mV (ST alarm mode: Relative)
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A.13.2 Resp Specifications

A.13.3 SpO2 Specifications

Refer to Appendix F SpO2 Sensor Accuracy for the clinical study results of SpO2 sensor accuracy.

Masimo SpO2 Module

QTc High 200 ms to 800 ms 10 ms

ΔQTc High 30 ms to 200 ms

Technique Trans-thoracic impedance

Lead Options are lead I, II, and Auto. 

Respiration excitation waveform <300 μA RMS, 62.8 kHz (±10%)

Minimum respiration impedance 
threshold

0.3Ω

Baseline impedance range 200 to 2500 Ω (using an ECG cable with 1kΩ resistance)

Bandwidth 0.2 to 2.5 Hz (-3 dB)

Sweep speed 3mm/s, 6.25 mm/s, 12.5 mm/s, 25 mm/s or 50 mm/s, less than 10% error

Respiration Rate

Measurement range Adult: 0 to 120 rpm
Pediatric, neonate: 0 to 150 rpm

Resolution 1 rpm

Accuracy 7 to 150 rpm: ±2 rpm or ±2%, whichever is greater
0 to 6 rpm: not specified

Apnea alarm delay 10 s, 15 s, 20 s, 25 s, 30 s, 35 s, 40 s

Alarm limit Range (rpm) Step (rpm)

RR High Adult, pediatric:
RR≤20
RR>20
Neonate: 
RR≤20
RR>20

(low limit + 2) to 20
(low limit + 5) to 100

(low limit + 2) to 20
(low limit + 5) to 150

RR≤20: 1
RR>20: 5

RR Low RR≤20:
RR>20:

0 to (high limit - 2)
20 to (high limit - 5)

Alarm limit Range (%) Step (%)

SpO2 High (low limit + 2) to 100 1

SpO2 Low Masimo: (Desat+1) to (high limit - 2) 
Nellcor: (Desat+1) or 20 (whichever is greater) 
to (high limit - 2)

ΔSpO2 High 0 to 50

SpO2 Desat Low 0 to (SpO2 low limit - 1)

Standards Meets the requirements of ISO 80601-2-61: 2017

Measurement range 1 to 100%

Resolution 1%
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Nellcor SpO2 Module

A.13.4 PR Specifications

Response time ≤20 s (normal perfusion, no disturbance, SpO2 value sudden change from 70% 
to 100%)

Accuracy1 70 to 100%: ±2%ABS (adult/pediatric, without motion) 
70 to 100%: ±3%ABS (adult/pediatric, with motion) 
70 to 100%: ±3%ABS (neonate) 
1% to 69%: Not specified. 

Refresh rate ≤ 1 s 

SpO2 averaging time 2-4 s, 4-6 s, 8 s, 10 s, 12 s, 14 s, 16 s 

Low perfusion conditions Pulse amplitude: >0.02% 
Light penetration: >5%

Low perfusion SpO2 accuracy2 ±2%

PI measurement range 0.02 to 20% 

1 The Masimo pulse oximeter with sensors have been validated for no motion accuracy in human blood studies on healthy 
adult volunteers in induced hypoxia studies in the range of 70% to 100% SpO2 against a laboratory co-oximeter and ECG 
monitor. This variation equals plus or minus one standard deviation. Plus or minus one standard deviation encompasses 
68% of the population. One percent was added to the accuracies for neonatal sensors to account for accuracy variation due 
to properties of fetal hemoglobin.
 The Masimo pulse oximeter with sensors has been validated for motion accuracy in human blood studies on healthy adult 
volunteers in induced hypoxia studies while performing rubbing and tapping motions at 2 to 4 Hz. At an amplitude of 1 to 
2 cm and non-repetitive motion between 1 to 5 Hz. At an amplitude of 2 to 3 cm in induced hypoxia studies in the range of 
70% to 100% SpO2 against a laboratory co-oximeter and ECG monitor. This variation equals plus or minus one standard 
deviation. Plus or minus one standard deviation encompasses 68% of the population. 
2 The Masimo pulse oximeter has been validated for low perfusion accuracy in bench top testing against a Biotek Index 2 
simulator and Masimo's simulator with signal strengths of greater than 0.02% and a % transmission of greater than 5% for 
saturations ranging from 70 to 100%. This variation equals plus or minus one standard deviation. Plus or minus one 
standard deviation encompasses 68% of the population. 

Standard Meet the requirements of ISO 80601-2-61 2017

Measurement range 0 to 100%

Resolution 1%

Refresh rate ≤1 s

Response time ≤30 s (normal perfusion, no disturbance, SpO2 value sudden changes from 
70% to 100%)

Accuracy 70 to 100%: ±2%ABS (adult/pediatric)
70 to 100%: ±3%ABS (neonate)
0 to 69%: Not specified.

When the SpO2 sensor is applied for neonatal patients as indicated, the specified accuracy range is increased by ±1%, to 
compensate for the theoretical effect on oximeter measurements of fetal hemoglobin in neonatal blood.

Alarm limit Range (bpm) Step (bpm)

PR High PR≤40: (low limit + 2) to 40
PR > 40: (low limit + 5) to 295 (Adult/Pediatric), 
(low limit + 5) to 300 (Neonate)

PR≤40: 1
PR>40: 5

PR Low PR≤40: 16 to (high limit - 2) (Adult/Pediatric), 
15 to (high limit - 2) (Neonate)
PR > 40: 40 to (high limit - 5)
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PR from Masimo SpO2

PR from Nellcor SpO2

 

PR from NIBP

PR from IBP

A.13.5 Temp Specifications

Measurement range 25 to 240 bpm

Resolution 1 bpm

Response time ≤20 s (with normal perfusion, no disturbance, and a PR value transition from 
25 to 220 bpm)

Accuracy ±3 bpm (without motion) 
±5 bpm (with motion) 

Refresh rate ≤1 s

Measurement range 20 to 300 bpm

Resolution 1 bpm

Response time ≤30 s (with normal perfusion, no disturbance, and a PR value transition from 
25 to 250 bpm)

Accuracy 20 to 250 bpm: ±3 bpm
251 to 300 bpm: not specified

Refresh rate ≤1 s

Measurement range 30 to 300 bpm

Resolution 1 bpm

Accuracy ±3 bpm or ±3%, whichever is greater

Measurement range 25 to 350 bpm

Resolution 1 bpm

Accuracy ±1 bpm or ±1%, whichever is greater

Standard Meets the requirements of ISO 80601-2-56: 2009

Technique Thermal resistance

Operating mode Direct mode

Measurement range 0 to 50 °C (32 to 122 °F)

Resolution 0.1°C

Accuracy ±0.1 °C or ±0.2 °F (excluding probe error)

Minimum time for accurate 
measurement

Body surface: <100 s
Body cavity: <80 s

Alarm limit Range Step
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A.13.6 NIBP Specifications

Txx High (xx refers to temperature site) (low limit +1.0) to 50.0 °C
(low limit +2.0) to 122.0 °F

0.1 °C
0.1 °F

Txx Low (xx refers to temperature site) 0.1 to (high limit - 1.0) °C
32.2 to (high limit - 2.0) °F

ΔT High 0.1 to 50.0 °C
0.2 to 90.0 °F

Standard Meets the requirements of IEC 80601-2-30: 2013

Technique Oscillometry

Mode of operation Manual, Auto, STAT, Sequence

Auto mode repetition intervals 1, 2, 2.5, 3, 5, 10, 15, 20, 30, 60, 90, 120, 180, 240 or 480 min

STAT mode cycle time 5 min

Max measurement time Adult, pediatric: 180 s
Neonate: 90 s

Heart rate range 30 to 300 bpm

Measurement ranges
(mmHg)

Adult Pediatric Neonate

Systolic: 25 to 290 25 to 240 25 to 140

Diastolic: 10 to 250 10 to 200 10 to 115

Mean: 15 to 260 15 to 215 15 to 125

Accuracy Max mean error: ±5 mmHg
Max standard deviation: 8 mmHg

Resolution 1mmHg

Initial cuff inflation pressure range 
(mmHg)

Adult: 80 to 280
Pediatric: 80 to 210
Neonate: 60 to 140

Default initial cuff inflation pressure 
(mmHg)

Adult: 160
Pediatric: 140
Neonate: 90

Software overpressure protection Adult: 297±3 mmHg
Pediatric: 297±3 mmHg
Neonate: 147±3 mmHg

Static pressure measurement range 0 mmHg to 300 mmHg

Static pressure measurement accuracy ±3 mmHg

Alarm limit Range (mmHg) Step (mmHg)
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NIBP-S High Adult: (low limit + 5) to 285
Pediatric: (low limit + 5) to 235
Neonate: (low limit + 5) to 135

NIBP ≤ 50: 1
NIBP > 50: 5

NIBP-S Low 26 to (high limit - 5)

NIBP-M High Adult: (low limit + 5) to 255
Pediatric: (low limit + 5) to 210
Neonate: (low limit + 5) to 120

NIBP-M Low 16 to (high limit - 5)

NIBP-D High Adult: (low limit + 5) to 245
Pediatric: (low limit + 5) to 195
Neonate: (low limit + 5) to 110

NIBP-D Low 11 to (high limit - 5)

NIBP-S Extreme High NIBP-S high limit < 50
Adult: (NIBP-S high limit + 1) to 290
Pediatric: (NIBP-S high limit + 1) to 240
Neonate: (NIBP-S high limit + 1) to 140

NIBP-S high limit ≥ 50
Adult: (NIBP-S high limit + 5) to 290
Pediatric: (NIBP-S high limit +5) to 240
Neonate: (NIBP-S high limit +5) to 140

NIBP ≤ 50: 1
NIBP > 50: 5

NIBP-S Extreme Low NIBP-S low limit ≤ 50
25 to (NIBP-S low limit - 1)

NIBP-S low limit > 50

25 to (NIBP-S low limit - 5)

NIBP-M Extreme High NIBP-M high limit < 50
Adult: (NIBP-M high limit + 1) to 260
Pediatric: (NIBP-M high limit + 1) to 215
Neonate: (NIBP-M high limit + 1) to 125

NIBP-M high limit ≥ 50
Adult: (NIBP-M high limit + 5) to 260
Pediatric: (NIBP-M high limit + 5) to 215
Neonate: (NIBP-M high limit + 5) to 125

NIBP ≤ 50: 1
NIBP > 50: 5

NIBP-M Extreme Low NIBP-M low limit ≤ 50
15 to (NIBP-M low limit - 1)

NIBP-M low limit > 50
15 to (NIBP-M low limit - 5)

NIBP-D Extreme High NIBP-D high limit < 50
Adult: (NIBP-D high limit + 1) to 250
Pediatric: (NIBP-D high limit + 1) to 200
Neonate: (NIBP-D high limit + 1) to 115

NIBP-D high limit ≥ 50
Adult: (NIBP-D high limit + 5) to 250
Pediatric: (NIBP-D high limit + 5) to 200
Neonate: (NIBP-D high limit + 5) to 115

NIBP ≤ 50: 1
NIBP > 50: 5

NIBP-D Extreme Low NIBP-D low limit ≤ 50
10 to (NIBP-D low limit - 1)

NIBP-D low limit > 50
10 to (NIBP-D low limit - 5)
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*Measurement accuracy verification: In adult and pediatric modes, the blood pressure measurements measured 
with this device are in compliance with the Standard for Non-invasive sphygmomanometers (ISO 81060-2: 2013) 
in terms of mean error and standard deviation by comparing with intra-arterial or auscultatory measurements 
(depending on the configuration) in a typical patient population. For auscultatory reference, the 5th Korotkoff 
sound was used to determine the diastolic pressure.

In neonatal mode, the blood pressure measurements measured with this device are in compliance with the 
American National Standard for Non-invasive sphygmomanometers (ISO 81060-2) in terms of mean error and 
standard deviation by comparing with intra-arterial measurements (depending on the configuration) in a typical 
patient population.

A.13.7 IBP Specifications

A.13.8 C.O. Specifications

Standard Meets the requirements of IEC 60601-2-34: 2011

Technique Direct invasive measurement

IBP

Measurement range -50 to 300 mmHg

Resolution 1 mmHg

Accuracy ±2% or ±1 mmHg, whichever is greater (excluding sensor error)

PPV

Measurement range 0% ~ 50%

Pressure transducer

Excitement voltage 5 VDC, ±2%

Sensitivity 5 μV/V/mmHg

Zero adjustment range ±200 mmHg

Impedance range 300 to 3000Ω

Volume displacement <0.04 mm3 /100 mmHg

Alarm limit Range (mmHg) Step (mmHg)

Sys High IBP ≤ 50: (low limit + 2) to 50
IBP > 50: (low limit + 5) to 295

IBP ≤ 50: 1
IBP > 50: 5

Mean High

Dia High

Sys Low IBP ≤ 50: -49 to (high limit - 2)
IBP > 50: 50 to (high limit - 5)

Mean Low

Dia Low

Art-S Extreme High High limit < 50: (High limit+ 1) to 300
High limit ≥ 50: (High limit+ 5) to 300

IBP ≤ 50: 1
IBP > 50: 5

Art-M Extreme High

Art-D Extreme High

Art-S Extreme Low low limit ≤ 50: -50 to (low limit- 1)
low limit > 50: -50 to (low limit- 5)

Art-M Extreme Low

Art-D Extreme Low

Measurement method Thermodilution method
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A.13.9 ScvO2/SvO2 Specifications from the Edwards Monitor

A.13.10 CCO Specifications from the Edwards Monitor

Measurement range C.O.: 
TB: 
TI: 

0.1 to 20 L/min
23 to 43 °C
0 to 27 °C

Resolution C.O.: 
TB, TI: 

0.1 L/min 
0.1 °C (excluding sensor)

Accuracy C.O.: 
TB, TI: 

±5% or ±0.1 L /min, whichever is greater
±0.1 °C (excluding sensor)

Repeatability C.O.: ±2% or ±0.1 L/min, whichever is greater

Alarm range TB: 23 to 43 °C

Alarm limit Range Step

TB High (low limit + 1) to 43 °C
(low limit + 2) to 109.4 °F

0.1 °C
0.1 °F

TB Low 23 to (high limit - 1) °C
73.4 to (high limit - 2) °F

Operating mode Interfaces with Edwards Vigilance II®, VigileoTM monitor, EV1000, or 
HemoSphere monitor

Measured parameters Consistent with SvO2/ScvO2-related parameters output by Vigilance II®, 
VigileoTM monitor, EV1000, or HemoSphere monitor 

Parameter alarms SvO2, ScvO2

Signal Output

Standard Meets the requirements of IEC 60601-1 for short-circuit protection and 
leakage current

Output impedance ≤1000Ω

Isolation voltage 1500 VAC

SpO2 Analog Signal Output

Output voltage 0 to 10V (0 to 100%)

Output voltage error ±5%

Alarm Limit Range Step 

SvO2 /ScvO2High ScvO2<60%: (Low limit + 5%) to 60%
ScvO2≥60%: (Low limit + 1%) to 99%

ScvO2<60%: 5%
ScvO2≥60%: 1%

SvO2 /ScvO2 Low ScvO2<60%: 0 to (High limit - 5%)
ScvO2≥60%: 60% to (Low limit - 1%)

Operating mode Interfaces with Edwards Vigilance II®, VigileoTM monitor, EV1000, or 
HemoSphere monitor

Measured parameter Consistent with CCO-related parameters output by Vigilance II®, VigileoTM 
monitor, EV1000, or HemoSphere monitor

Parameter alarm CCO, CCI 

Signal Outputs
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A.13.11 ScvO2 Specifications

A.13.12 CO2 Specifications

Standard Meets the requirements of IEC 60601-1 for short-circuit protection and 
leakage current

Output impedance ≤1000Ω

Isolation voltage 1500 VAC

ECG Analog Output

Bandwidth (-3dB; reference frequency: 
10Hz)

Diagnostic mode: 0.05~150Hz
Monitor mode: 0.5~40Hz
Surgery mode: 1~20Hz
ST mode: 0.05~40Hz

Sensitivity 2 V/mV ±5%

MAP Analog Signal Output

Output voltage 0 to 5 V (0 to 500 mmHg)

Output voltage error ±5%

CVP Analog Signal Output

Output voltage 0 to 5 V (0 to 100 mmHg)

Output voltage error ±5%

Alarm Limit Range  Step

CCO High (Low limit + 0.1) to 25 L/min 0.1 L/min

CCO Low 0.3 to (high limit - 0.1)L/min

CCI High (Low limit + 0.1) to 15 L/min/m2 0.1 L/min/m2

CCI Low 0.1 to (high limit - 0.1)L/min/m2

Measured parameters Measurement range Measurement accuracy

ScvO2 0 to 99% 50% to 80%: ±3%
Other ranges: Not specified.

Alarm Limit Range Step

ScvO2 High ScvO2<60%: (Low limit + 5%) to 60%
ScvO2≥60%: (Low limit + 1%) to 99%

ScvO2<60%: 5%
ScvO2≥60%: 1%

ScvO2 Low ScvO2<60%: 0 to (High limit - 5%)
ScvO2≥60%: 60% to (High limit - 1%)

Measurement mode Sidestream, microstream

Technique Infrared absorption

Apnea delay 10 s, 15 s, 20 s, 25 s, 30 s, 35 s, 40 s

Alarm limit Range Step
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Sidestream CO2 Module

EtCO2 High (low limit + 2) to 99 mmHg 1 mmHg

EtCO2 Low 1 to (high limit - 2) mmHg

FiCO2 High 1 to 99 mmHg

Standard Meets the requirements of ISO 80601-2-55: 2011

CO2 Measurement range 0 to 150 mmHg

CO2 absolute accuracy* Full accuracy mode:
0 - 40 mmHg: ±2mmHg
41 - 76 mmHg: ±5% of reading
77 - 99 mmHg: ±10% of reading
100 - 150mmHg: ±(3mmHg + 8% of reading
ISO accuracy mode: Add ±2mmHg to the full accuracy mode

Accuracy specifications are affected by the breath rate and I:E. The EtCO2 accuracy is within specification for breath rate ≤ 
60 rpm and I/E ratio ≤ 1:1, or breath rate ≤ 30 rpm and I/E ratio ≤ 2:1. 

CO2 resolution 1 mmHg

O2 measurement range 0 to 100%

O2 absolute accuracy 0≤O2 concentration≤25%:
25<O2 concentration≤80%:
80<O2 concentration≤100%:

±1%
±2%
±3%

O2 resolution 1%

Accuracy drift Meets the requirements for measurement accuracy within 6 hours

Sample flowrate For CO2 measurement (with O2 measurement):
Connected a DRYLINE II watertrap for adult and pediatric patient: 120 ml/min
Connected a DRYLINE II watertrap for neonatal patient: 90 ml/min
For CO2 measurement (without O2 measurement):
Connected a DRYLINE II watertrap for adult and pediatric patient: 120 ml/min
Connected a DRYLINE II watertrap for neonatal patient: 70 ml/min, 90 ml/min

Sample flowrate tolerance ±15% or ±15 ml/min, whichever is greater.

Start-up time Maximum: 90 s
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Rise time For CO2 measurement (without O2 measurement):
Measured with a DRYLINE II neonatal watertrap and a 2.5-meter neonatal sampling 
line:
≤250 ms@70 ml/min
≤250 ms@90 ml/min
Measured with a DRYLINE II adult watertrap and a 2.5-meter adult sampling line:
≤300 ms@120 ml/min 
For CO2 measurement (with O2 measurement):
Measured with a DRYLINE II neonatal watertrap and a 2.5-meter neonatal sampling 
line:
≤250 ms@90 ml/min
Measured with a DRYLINE II adult watertrap and a 2.5-meter adult sampling line:
≤300 ms@120 ml/min 
Measured with a DRYLINE II adult watertrap and a 2.5-meter adult sampling line 
(using with the RM module):
≤240 ms@150 ml/min 

For O2 measurements:
Measured with a DRYLINE II neonatal watertrap and a 2.5-meter neonatal sampling 
line:
≤800 ms@90 ml/min
Measured with a DRYLINE II adult watertrap and a 2.5-meter adult sampling line:
≤750 ms@120 ml/min
Measured with a DRYLINE II adult watertrap and a 2.5-meter adult sampling line 
(using with the RM module):
≤650 ms@150 ml/min 

Response time For CO2 measurement (without O2 measurement):
Measured with a DRYLINE II neonatal watertrap and a 2.5-meter neonatal sampling 
line:
≤5.0 s @ 70 ml/min 
≤4.5 s @ 90 ml/min 
Measured with a DRYLINE II adult watertrap and a 2.5-meter adult sampling line:
≤5.0 s @ 120 ml/min

For CO2 measurement (with O2 measurement):
Measured with a DRYLINE II neonatal watertrap and a 2.5-meter neonatal sampling 
line:
≤4.5 s@90 ml/min
Measured with a DRYLINE II adult watertrap and a 2.5-meter adult sampling line:
≤5 s@120 ml/min 
Measured with a DRYLINE II adult watertrap and a 2.5-meter adult sampling line 
(using with the RM module):
≤4.5 s@150 ml/min 

For O2 measurements:
Measured with a DRYLINE II neonatal watertrap and a 2.5-meter neonatal sampling 
line:
≤4.5 s @ 90 ml/min 
Measured with a DRYLINE II adult watertrap and a 2.5-meter adult sampling line:
≤5 s@120 ml/min
Measured with a DRYLINE II adult watertrap and a 2.5-meter adult sampling line 
(using with the RM module):
≤4.5 s@150 ml/min 

awRR measurement range 0 to 150 rpm

awRR measurement precision ≤60 rpm: ±1 rpm
61 to 150 rpm: ±2 rpm

awRR resolution 1 rpm

Data sample rate 50 Hz
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Effect of interference gases on CO2 measurements

Gas Concentration (%) Quantitative effect*

N2O ≤60 ±1 mmHg

Hal ≤4

Sev ≤5

Iso ≤5

Enf ≤5

Des ≤15 ±2 mmHg

*: means an extra error should be added in case of gas interference when CO2 measurements are performed between 0 to 
40mmHg. 

Effect of interference gases on O2 measurements

Gas Quantitative effect

CO2 ±0.2%

N2O ±0.2%

Hal, Des, Sev, Iso, Enf ±1.0%

Standard Meets the requirements of ISO 80601-2-55: 2011

CO2 Measurement range 0 to 99 mmHg

Accuracy* 0 to 38 mmHg: 

39 to 99 mmHg:

±2 mmHg

±5% of the reading (0.08% of the reading 
increased in error for every 1 mmHg if the 
reading is more than 38 mmHg)

Accuracy drift Meets the requirements for measurement accuracy within 6 hours

* Accuracy applies for respiration rate up to 80 rpm. For respiration rate above 80 rpm and EtCO2 exceeding 18 mmHg, the 
accuracy is 4 mmHg or ±12% of the reading, whichever is greater. For respiration rate above 60 rpm, the above accuracy 
can be achieved by using the FilterLine H Set for Infant/Neonatal. In the presence of interfering gases, the above accuracy 
is maintained to within 4%.

Resolution 1 mmHg

Sample flow rate 50 (- 7.5/+15) ml/min

Initialization time Maximum 180 s

Response time 4.3 s (with any 2-meter FilterLine)

5.5 s (with any 4-meter FilterLine)

Rise time 190 msec (with any 2-meter FilterLine)

210 msec (with any 4-meter FilterLine)

awRR measurement range 0 to 150 rpm

awRR measurement accuracy 0 to 70 rpm: 

71 to 120 rpm: 

121 to 150 rpm: 

±1 rpm

±2 rpm

±3 rpm

awRR resolution 1 rpm

Data sample rate 40 Hz

Microstream CO2 Module
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A.13.13 AG Specifications

Standard meets the requirements of ISO 80601-2-55: 2011

Technique Infrared absorption, paramagnetic properties for O2 monitoring

Warm-up time Iso accuracy mode: 
Full accuracy mode: 

≤45 s
≤10 min

Sample flow rate Adult, pediatric:
Neonate:
Accuracy: 

 200 ml/min
120 ml/min
±10 ml/min or ±10%, whichever is greater

Measurement range CO2: 
O2: 
N2O: 
Des: 
Sev: 
Enf: 
Iso: 
Hal: 
awRR: 

0 to 30%
0 to 100%
0 to 100%
0 to 30%
0 to 30%
0 to 30%
0 to 30%
0 to 30%
2 to 100 rpm

Resolution CO2: 
O2: 
N2O:
Des: 
Sev: 
Enf: 
Iso: 
Hal: 
awRR: 

0.1%
1%
1%
0.1%
0.1%
0.1%
0.1%
0.1%
1 rpm

Iso accuracy As full accuracy specifications, but derated as follows:
Add ±0.3%ABS to accuracy for CO2

Add ±8%REL to accuracy for all anesthetic gases
N2O accuracy is ±(8%REL+2%ABS)
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Full accuracy Gases Range (%REL)1 Accuracy (%ABS)

CO2 0≤CO2≤1
1<CO2≤5
5<CO2≤7
7<CO2≤10
CO2>10

±0.1
±0.2
±0.3
±0.5
Not specified

N2O 0≤NO2≤20
20<NO2≤100

±2
±3

O2 0 to 25
25 to 80
80 to 100

±1
±2
±3

Des 0 to 1
1 to 5
5 to 10
10 to 15
15 to 18
>18

±0.15
±0.2
±0.4
±0.6
±1
Not specified

Sev 0 to 1
1 to 5
5 to 8
>8

±0.15
±0.2
±0.4
Not specified

Enf, Iso, Hal 0 to 1
1 to 5
>5

±0.15
±0.2
Not specified

awRR 2 to 60 rpm

>60 rpm

±1 rpm

Not specified

Note1: The highest GAS LEVEL for a single halogenated anaesthetic gas in a gas 
mixture that is concealed when the anaesthetic concentration falls is 0.15/0.3% 
(Full/ISO accuracy).

Accuracy drift Meet the requirement for measurement accuracy within 6 hours

Apnea alarm delay 10 s, 15 s, 20 s, 25 s, 30 s, 35 s, 40 s

Refresh rate 1 s

Rise time
(10% ~ 90%)

Gas sample flow rate 120ml/min, using a DRYLINE II neonatal watertrap and 
sampling line (2.5m):

CO2: ≤250 ms
N2O: ≤250 ms 
Hal, Iso, Sev, Des: ≤300 ms
Enf: ≤350 ms
O2: ≤600 ms

Gas sample flow rate 200 ml/min, using the adult DRYLINE II water trap and 
sampling line (2.5 m):

CO2: ≤250 ms
N2O: ≤250 ms 
Hal, Iso, Sev, Des: ≤300 ms
Enf: ≤350 ms
O2: ≤500 ms 

Delay time <4 s
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Response time Measured with a DRYLINE II neonatal watertrap and a 2.5-meter neonatal sampling 
line:

120 ml/min:
CO2: 
N2O: 
O2: 
Hal, Iso, Sev, Des, Enf: 

≤4s 
≤4.2s
≤4s
≤4.4s

Measured with a DRYLINE II adult watertrap and a 2.5-meter adult sampling line:

200 ml/min:
CO2: 
N2O: 
Hal, Iso, Sev, Des, Enf:
O2: 

≤4.2s 
≤4.3s
≤4.5s
≤4s

Anesthetic agent limit Primary anesthetic agent
In full accuracy mode: 0.15%

Secondary anesthetic agent:
In full accuracy mode: 5% of primary agent if primary agent is greater than 10%, 
0.3% if primary agent is less than or equal to 10%.

Data sample rate 25 Hz

Accuracy specifications are affected by the breath rate and I:E change. The end-tidal gas reading is within specification for 
breath rate below 15 rpm and I:E ratio smaller than 1:1 relative to the gas readings without breath; Add ±6%REL to 
inaccuracy for Hal and O2 for breath rate larger than 15 rpm; Add ±6%REL to inaccuracy for all gases for breath rate larger 
than 30 rpm (inaccuracy for HAL and O2 are unspecified in this case); inaccuracy is unspecified for breath rate larger than 
60 rpm.

Effect of interference gases on AG measurements

Gas
Concentration(
%)

Quantitative effect(%ABS)3)

CO2 N2O Agent 1) O2

CO2 / / 0.1 0 0.2

N2O / 0.1 / 0.1 0.2

Agent 1) 2) / 0.1 0.1 0.1 1

Xenon <100% 0.1 0 0 0.5

Helium <50% 0.1 0 0 0.5

Ethanol <0.1% 0 0 0 0.5

Acetone <1% 0.1 0.1 0 0.5

Methane <1% 0.1 0.1 0 0.5

Saturated Isopropanol vapour / 0.1 0 0 0.5

Metered dose inhaler propellants / Unspecified Unspecified Unspecified Unspecified

O2 / 0.2 0.2 1.0 /

1) Agent represents one of Des, Iso, Enf, Sev, and Hal.
2) Multiple agent interference on CO2, N2O and O2 is typically the same as single agent interference. 
3) For CO2, N2O and Agents, maximum interference from each gas at concentrations within specified accuracy ranges for 
each gas. The total interference of all gases is never larger than 5%REL. 

Alarm limit Range Step

EtCO2 High (low limit + 2) to 99 mmHg 1 mmHg

EtCO2 Low 1 to (high limit - 2) mmHg

FiCO2 High 0 to 99 mmHg
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A.13.14 RM Specifications

EtO2 High (low limit + 2%) to 100% 1%

EtO2 Low 0 to (high limit - 2)%

FiO2 High (low limit + 2%) to 100%

FiO2 Low 18% to (high limit - 2)%

EtN2O High (low limit + 2) to 100% 1%

EtN2O Low 0 to (high limit - 2)%

FiN2O High (low limit + 2) to 100%

FiN2O Low 0 to (high limit - 2)%

EtHal/Enf/Iso High (low limit + 0.2) to 5.0% 0.1%

EtHal/Enf/Iso Low 0 to (high limit - 0.2)%

FiHal/Enf/Iso High (low limit + 0.2) to 5.0%

FiHal/Enf/Iso Low 0 to (high limit - 0.2)%

EtSev High (low limit + 0.2) to 8.0% 0.1%

EtSev Low 0 to (high limit - 0.2)%

FiSev High (low limit + 0.2) to 8.0%

FiSev Low 0 to (high limit - 0.2)%

EtDes High (low limit + 0.2) to 18.0% 0.1%

EtDes Low 0 to (high limit - 0.2)%

FiDes High (low limit + 0.2) to 18.0%

FiDes Low 0 to (high limit - 0.2)%

Technique  Differential pressure flow measurement technology

Flow

Measurement range Adult/pediatric: ± (2 to 120) L/min

Accuracy Adult/pediatric: 1.2 L/min or ±10% of the reading, whichever is greater

Resolution 0.1 L/min

Paw

Measurement range -20 to 120 cmH2O

Accuracy ±3% × reading

Resolution 0.1 cmH2O

MVe/MVi

Measurement range Adult/Pediatric: 2 to 60 L/min

Accuracy ±10% × reading

Resolution 0.01 L/min if airflow is less than 10 L/min, 0.1 L/min if airflow is equal to or 
more than 10 L/min

TVe/TVi

Measurement range Adult/Pediatric: 100 to 1500 ml

Resolution 1 ml
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Specifications of parameters monitored when using with the sidestream CO2 module or AG module configured with 
the paramagnetic oxygen sensor

Accuracy Adult/pediatric: ±10% or ±15 ml, whichever is greater

awRR

Measurement range 4 to 120 rpm

Resolution 1 rpm

Accuracy 4 to 99 rpm
100 to 120 rpm

±1 rpm
±2 rpm

Calculated Parameters Measurement range Measurement accuracy

I:E 4:1 to 1:8 Not specified

FEV1.0 0 to 100% Not specified

Pmean 0 to 120 cmH2O ±10%

PEEP 0 to 120 cmH2O Not specified

PEF 2 to 120 L/min ±10% 

PIF 2 to 120 L/min ±10% 

PIP 0 to 120 cmH2O ±10%

Pplat 0 to 120 cmH2O Not specified

Compl 0 to 200 ml/cmH2O Not specified

RSBI 0 to 4095 rpm/L Not specified

Parameter Measurement range Measurement accuracy

VCO2 0 to 200 ml ±15% or ±15 ml, whichever is greater

VO2 0 to 200 ml ±15% or ±15 ml, whichever is greater

Parameter Resolution Parameters Resolution Parameters Resolution

VCO2 1 mL MVCO2 1 mL/min VO2 1 mL

MVO2 1 mL/min EE 1 kCal/day RQ 0.01

Alarm limit Range Step

PEEP High PEEP≤50 cmH2O: (low limit + 1) to 50 cmH2O
PEEP>50 cmH2O: (low limit + 5) to 120 cmH2O

PEEP≤50 cmH2O: 1 cmH2O
PEEP>50 cmH2O: 5 cmH2O

PEEP Low PEEP≤50 cmH2O: 0 to (high limit - 1) cmH2O
PEEP>50 cmH2O: 50 to (high limit - 5) cmH2O

PIP High PIP≤50 cmH2O: (low limit + 1) to 50 cmH2O
PIP>50 cmH2O: (low limit + 5) to 120 cmH2O

PIP≤50 cmH2O: 1 cmH2O
PIP>50 cmH2O: 5 cmH2O

PIP Low PIP≤50 cmH2O: 0 to (high limit - 1) cmH2O
PIP>50 cmH2O: 50 to (high limit - 5) cmH2O

MVe High Mve≤10 L/min: (low limit + 0.5 L/min) to 10.0 L/min
Mve>10 L/min: (low limit + 2 L/min) to 60.0 L/min

Mve≤10 L/min: 0.5 L/min
Mve>10 L/min: 2 L/min

MVe Low Mve≤10 L/min: 0.5 L/min to (high limit - 0.5 L/min)
Mve>10 L/min: 10 L/min to (high limit - 2 L/min)
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A.13.15 EEG Specifications

A.13.16 BIS Specifications

A.13.17 NMT Specifications (NMT from Mindray NMT module)

Standard meets the requirements of IEC 60601-2-26: 2012

Bandwidth 0.5 to 50 Hz (-3 dB)

Input Signal Range  -2 mVp-p to +2 mVp-p

Max. DC Input Offset ± 500 mV

Common Mode Rejection Ratio ≥100 dB @51 kΩ imbalance and 60 Hz

Noise Level ≤0.5 uV rms (1 Hz to 30 Hz)

Differential Input Impedance >15 MΩ @10 Hz

Electrode Impedance Range:
Accuracy:

0 to 90 kΩ,
± 1 kΩ or ± 10%, whichever is greater

Standard Meet the standard of IEC 60601-2-26: 2012

Technique Bispectral index

Measured parameters EEG
BIS, BIS L, BIS R: 0 to 100

Calculated parameters SQI, SQI L, SQI R:0 to 100%
EMG, EMG L, EMG R: 0 to 100 dB
SR, SR L, SR R: 0 to 100%
SEF, SEF L, SEF R: 0.5 to 30.0 Hz
TP, TP L, TP R: 40 to 100 dB
BC, BC L, BC R: 0 to 30
sBIS L, sBIS R: 0 to 10.0
sEMG L, sEMG R: 0 to 10.0
ASYM: 0 to 100%

Impedance range 0 to 999 kΩ

Sweep speed 6.25 mm/s, 12.5 mm/s, 25 mm/s or 50 mm/s, ±10% error

Input impedance >5 MΩ

Noise (RTI) <0.3 μV (0.25 to 50 Hz)

Input signal range ±1 mV

EEG bandwidth 0.25 to 100 Hz

Patient leakage current <10 μA

Alarm limit Range Step

BIS High (low limit + 5) to 100 5

BIS Low 0 to (high limit - 5)

Standard meets the requirements of IEC 60601-2-10: 2012
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A.13.18 rSO2 Specifications

Stimulation output Pulse width 100, 200, or 300 μs; monophasic rectangle 
pulse
Accuracy: ±10%

Current range 0 to 60 mA in increments of 5 mA
Accuracy: ± 5% or ±2 mA, whichever is 
greater

Max. skin impedance 3 kΩ @ 60 mA, 5 kΩ @ 40 mA

Max. output voltage 300 V 

ST mode ST-Ratio 0 to 200% 

Measurement interval Manual, 1 s, 10 s, 20 s 

TOF mode TOF-Count 0 to 4 

TOF-Ratio 5% to 160% 

TOF-T1% 0 to 200%

Measurement interval Manual, 12s, 15s, 20s, 30s, 1min, 5min, 
15min, 30min, 60min

PTC mode PTC-Count 0 to 20 

Measurement interval Manual

DBS mode Measurement interval Manual, 15s, 20s, 30s, 1min, 5min, 15min, 
30min, 60min

DBS-Count 0 to 2

DBS-Ratio 5% to 160%

NMT message Threshold

Block Recovery Off, 1, 2, 3, 4, 5%, 10%, 20%, 30%, 40%, 50%, 60%, 70%, 80%, 90%, 100%

Measurement range 15% to 95%
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B EMC and Radio Regulatory Compliance

B.1 EMC
The device meets the requirements of IEC 60601-1-2: 2014. 

WARNING

• Use of accessories, transducers and cables other than those specified or provided by the 
manufacturer of this equipment could result in increased electromagnetic emissions or decreased 
electromagnetic immunity of this equipment and result in improper operation.

• The non-ME EQUIPMENT (e.g. information technology equipment (ITE)) that is a part of an ME 
SYSTEM may be disrupted by the electromagnetic interference of nearby equipment. It may be 
necessary to take mitigation measures, such as re-orienting or relocating the non-ME EQUIPMENT or 
shielding the location. 

• Use of this equipment adjacent to, or stacked with, other equipment should be avoided because it 
could result in improper operation. If such use is necessary, this equipment and the other equipment 
should be observed to verify that they are operating normally.

• This equipment is intended for use in professional healthcare facility environment only. If it is used 
in a special environment, such as a magnetic resonance imaging environment, the equipment/
system may be disrupted by the operation of nearby equipment.

• Portable RF communications equipment (including peripherals such as antenna cables and external 
antennas) should be used no closer than 30 cm (12 inches) to any part of the this device, including 
cables specified by the manufacturer. Otherwise, degradation of the performance of this equipment 
could result.

If the system is operated within the electromagnetic environment listed in Table Guidance and Declaration -
Electromagnetic Immunity, the system will remain safe and provide the following essential performance:

■ Operating mode

■ Accuracy

■ Function

■ Accessories identification

■ Data stored

■ Alarm

Guidance and Declaration - Electromagnetic Emissions

The device is intended for use in the electromagnetic environment specified below. The customer or the user of the device 
should assure that it is used in such an environment.

Emission tests Compliance Electromagnetic environment - guidance

Conducted and radiated RF 
EMISSIONS CISPR 11

Group 1 The device uses RF energy only for its internal function. 
Therefore, its RF emissions are very low and are not likely to 
cause any interference in nearby electronic equipment.

Conducted and radiated RF 
EMISSIONS CISPR 11

Class A The device is suitable for use in all establishments other than 
domestic and those directly connected to the public low-voltage 
power supply network that supplies buildings used for domestic 
purposesHarmonic distortion 

EMISSIONS IEC61000-3-2: 
2014

Class A

Voltage Fluctuations/Flicker 
EMISSIONS IEC61000-3-3: 
2013

Complies
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■ Detect for connection

NOTE

• If the essential performance is lost or degraded, it may be necessary to take mitigation measures, 
such as re-orienting or relocating the ME EQUIPMENT or ME SYSTEM or shielding the location. 
During this time, the user should stop using the monitor and contact the service personnel.

• The device needs special precautions regarding EMC and needs to be installed and put into service 
according to the EMC information provided below. 

• Other devices may interfere with this device even though they meet the requirements of CISPR.

• When an input signal is below the minimum amplitude provided in technical specifications, 
erroneous measurements could result.

• The EMISSIONS characteristics of this device make it suitable for use in industrial areas and hospitals 
(CISPR 11 class A). If it is used in a residential environment (for which CISPR 11 class B is normally 
required) this device might not offer adequate protection to radio-frequency communication 
services. The user might need to take mitigation measures, such as relocating or re-orienting the 
device.

Guidance and Declaration - Electromagnetic Immunity 

The device is intended for use in the electromagnetic environment specified below. The customer or the user of the device 
should assure that it is used in such an environment. 

Immunity test IEC60601test level Compliance level Electromagnetic environment - guidance

Electrostatic 
discharge (ESD) IEC 
61000-4-2: 2008

±8 kV contact
±15 kV air

±8 kV contact
±15 kV air

Floors should be wood, concrete or ceramic 
tile. If floors are covered with synthetic 
material, the relative humidity should be at 
least 30%.

Electrical fast 
transient/burst IEC 
61000-4-4: 2012

±2 kV for power 
supply lines
±1 kV for input/
output lines
(length greater than 3 
m)

±2 kV for power 
supply lines
±1 kV for input/
output lines
(length greater than 3 
m)

Mains power quality should be that of a 
typical commercial or hospital environment.

Surge IEC 61000-4-5: 
2014

±1 kV line(s) to line(s)
±2 kV line(s) to earth

±1 kV line(s) to line(s)
±2 kV line(s) to earth

Voltage dips and 
voltage interruptions
IEC 61000-4-11: 2004

0 % UT for 0.5 cycle: at 
0°, 45°, 90°, 135°, 180°, 
225°, 270° and 315°

0 % UT for 1 cycle and 
70 % UT for 25/30 
cycles: at 0°

0 % UT for 250/300 
cycle

0 % UT for 0.5 cycle: at 
0°, 45°, 90°, 135°, 180°, 
225°, 270° and 315°

0 % UT for 1 cycle and 
70 % UT for 25/30 
cycles: at 0°

0 % UT for 250/300 
cycle

Mains power quality should be that of a 
typical commercial or hospital environment. If 
the user of our product requires continued 
operation during power mains interruptions, 
it is recommended that our product be 
powered from an uninterruptible power 
supply or a battery.

RATED power 
frequency magnetic 
fields
IEC 61000-4-8: 2009

30 A/m
50 Hz/60 Hz

30 A/m
50 Hz/60 Hz

Power frequency magnetic fields should be at 
levels characteristic of a typical location in a 
typical commercial or hospital environment.

Note: UT is the AC mains voltage prior to application of the test level.

Guidance and Declaration - Electromagnetic Immunity

The device is intended for use in the specified electromagnetic environment. The customer or the user of the device should 
assure that it is used in such an environment as described below.
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WARNING

• The device is configured with a wireless network connector to receive wireless signal. Other devices 
may interfere with this device even though they meet the requirements of CISPR.

Immunity test IEC60601 test level Compliance level Electromagnetic environment - guidance

Conducted 
disturbances induced 
by RF fields
IEC61000-4-6: 2013

3 Vrms
150 kHz to 80 MHz

3Vrms Portable and mobile RF communications 
equipment should be used no closer to any 
part of the system, including cables, than the 
recommended separation distance calculated 
from the equation appropriate for the 
frequency of the transmitter. Recommended 
separation distances:

 

6 Vrms
in ISM bandsa 
between 0.15 MHz 
and 80 MHz

6 Vrms

Radiated RF EM fields
IEC61000-4-3: 
2006+A1:2007+A2:20
10

3 V/m
80 MHz to 2.7 GHz

3V/m Recommended separation distances:
80 MHz to 800 MHz: 
800MHz - 2.7GHz:  
Where, P is the maximum output power rating 
of the transmitter in Watts (W) according to 
the transmitter manufacturer and d is the 
recommended separation distance in meters 
(m)b.
Field strengths from fixed RF transmitters, as 
determined by an electromagnetic site 
surveya should be less than the compliance 
level in each frequency rangeb.
Interference may occur in the 
vicinity of equipment marked with 
the following symbol: 

Proximity fields from 
RF wireless 
communications 
equipment
IEC61000-4-3: 
2006+A1:2007+A2:20
10

27 V/m
380 - 390 MHz

27 V/m /

28 V/m
430 - 470 MHz,
800 - 960 MHz
1700 - 1900 MHz,
2400 - 2570 MHz

28 V/m

9 V/m
704 - 787 MHz,
5100 - 5800 MHz

9 V/m

Note 1: At 80 MHz and 800 MHz, the higher frequency range applies.
Note 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and 
reflection from structures, objects and people.

a: The ISM (industrial, scientific, and medical) bands between 150 kHz and 80 MHz are 6.765 MHz to 6.795 MHz; 13.553 MHz 
to 13.567 MHz; 26.957 MHz to 27.283 MHz; and 40.66 MHz to 40.70 MHz.
b: Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile 
radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. To 
assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be considered. 
If the measured field strength in the location in which the ME EQUIPMENT or ME SYSTEM is used exceeds the applicable 
RF compliance level above, the ME EQUIPMENT or ME SYSTEM should be observed to verify normal operation. If abnormal 
performance is observed, additional measures may be necessary, such as re-orienting or relocating the ME EQUIPMENT or 
ME SYSTEM.
c: Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3V/m. 

Guidance and Declaration - Electromagnetic Immunity

d 1.2 P=

d 1.2 P=
d 2.3 P=
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B.2 Radio Regulatory Compliance
This device complies with Part 15 of the FCC Rules and RSS-210 of Industry Canada. Operation is subject to the 
following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause undesired operation.

Any changes or modifications to this equipment not expressly approved by Mindray may cause harmful radio 
frequency interference and void your authority to operate this equipment.

The maximum antenna gain permitted complies with the e.i.r.p. limits as stated in RSS-210.

The maximum antenna gain permitted complies with the e.i.r.p. limits specified for point-to-point operation, as 
stated in RSS-210.

WARNING

• Changes or modifications not expressly approved by the party responsible compliance could void 
the user’s authority to operate the equipment.

Recommended separation distances between portable and mobile RF communications equipment and the device

The device is intended for use in an electromagnetic environment in which radiated RF disturbances are controlled. The 
customer or the user of the device can help prevent electromagnetic interference by maintaining a minimum distance 
between portable and mobile RF communications equipment (transmitters) and the device as recommended below, 
according to the maximum output power of the communications equipment.

Rated maximum 
output power of 
transmitter (W)

Separation distance in meters (m) according to frequency of the transmitter

150 kHz to 80 MHz
 

80 MHz to 800 MHz
 

800 MHz to 2.7 GHz
 

0.01 0.12 0.12 0.23

0.1 0.38 0.38 0.73

1 1.20 1.20 2.30

10 3.80 3.80 7.30

100 12.00 12.00 23.00

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in metres 
(m) can be estimated using the equation applicable to the frequency of the transmitter, where P is the maximum output 
power rating of the transmitter in Watts (W) according to the transmitter manufacturer.
Note 1: At 80 MHz and 800 MHz, the higher frequency range applies.
Note 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and 
reflection from structures, objects and people.

d 1.2 P= d 1.2 P= d 2.3 P=
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C Default Settings

C.1 ECG, Arrhythmia, ST and QT Default Settings

C.1.1 ECG Default Settings

Item Default Setting

HR Alarm switch On

High limit Adult: 120 bpm
Pediatric: 160 bpm
Neonate: 200 bpm

Low limit Adult: 50 bpm
Pediatric: 75 bpm
Neonate: 100 bpm

Priority Med

Alarm Outputs Off

Alarm Source Auto

ECG1 II

ECG2 (5-lead, 6-lead, 12-lead) V (for 5-lead).Va (for 6-lead), V1 (for 12-lead)

Va (for 6-lead only) Va

Vb(for 6-lead only) Vb

ECG Gain ×1

Speed 25 mm/sec

Filter OR: Surgery
CCU: Diagnostic
Other departments: Monitor

Notch Filter On

Lead Set Auto

Smart Lead On

QRS Volume General and OR: 2
Other departments: 0

Baseline Drift Removal (for 12-lead only) On

Waveform Layout (for 12-lead only) Standard

QRS Threshold 0.16 mV

Paced Adult: Unspecified
Pediatric/neonate: No

Pacer Reject Off
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C.1.2 Arrhythmia Default Settings

C.1.2.1 Arrhythmia Alarm Default Settings

Item Alarm Switch Priority Alarm Outputs

Asystole On High, unadjustable Off

V-Fib/V-Tach On High, unadjustable Off

V-Tach On High, unadjustable Off

Vent Brady On High, unadjustable Off

Extreme Tachy On High, unadjustable Off

Extreme Brady On High, unadjustable Off

R on T CCU: On
Other departments: Off

Med Off

Run PVCs Off Low Off

Couplet Off Prompt Off

Multiform PVC Off Med Off

PVC Off Prompt Off

Bigeminy CCU: On
Other departments: Off

Med Off

Trigeminy CCU: On
Other departments: Off

Med Off

Tachy Off Med Off

Brady Off Med Off

Pacer Not Capture Off Prompt Off

Pacer Not Pacing Off Prompt Off

Missed Beat Off Prompt Off

Nonsus V-Tach CCU: On
Other departments: Off

Med Off

Vent Rhythm CCU: On
Other departments: Off

Med Off

Pause Off Low Off

Irr Rhythm Off Prompt Off

A-Fib Off Prompt Off

PVCs/min CCU: On
Other departments: Off

Med Off

Pauses/min CCU: On
Other departments: Off

Med Off
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C.1.2.2 Arrhythmia Threshold Default Settings 

C.1.3 ST Default Settings

Item Default Setting

Adult Pediatric

Asystole Delay 5 sec 5 sec

Tachy 120 bpm 160 bpm

Brady 50 bpm 75 bpm 

Extreme Tachy 160 bpm 180 bpm

Extreme Brady 35 bpm 50 bpm

Multif PVCs Window 15 beats 15 beats

PVCs/min 10 10

Pauses/min 8 8

Pause Threshold 2.0 sec 2.0 sec

AF/Irr Rhy End Time 2 min 2 min

V-Tach Rate 130 bpm 130 bpm

V-Brady Rate 40 bpm 40 bpm

V-Tach PVCs 6 6

V-Brady PVCs 5 5

Item Default Setting

ST Alarm Mode Absolute

ST Alarm Mode set to Absolute:
ST-I, ST-II, ST-III, ST-aVR, ST-aVL, ST-aVF, ST-V1, ST-
V2, ST-V3, ST-V4, ST-V5,ST-V6, ST-Va, ST-Vb

Alarm switch Off

High limit 0.2 mV

Low limit -0.2 mV

Priority Med

Alarm Outputs Off

ST Alarm Mode set to Relative:
ST Single,
ST Dual

Alarm switch Off

High limit 0.1 mV

Low limit -0.1 mV

Priority Med

Alarm Outputs Off

ST Analysis Off

ST Segment Auto

Show Marker Off

ST Point J+60

Auto Adjust On

J 48

ISO -80
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C.1.4 QT Default Settings

C.1.5 Glasgow 12-lead ECG Algorithm Default Settings

C.2 Respiration Default Settings

Item Default Setting

QTc Alarm switch Off

High limit Adult: 500
Pediatric: 480
Neonate: 460

Priority Med

Alarm Outputs Off

ΔQTc Alarm switch Off

High limit 60

Priority Med

Alarm Outputs Off

QT Analysis Off

QT Lead All

Item Default Setting

High Freq Cut-off 35 Hz

Baseline Drift Removal On

Tachy 100

Brady 50

Waveform Layout Standard

Median Complex Off

Measurements On

Interpretation On

Interpretation Summary On

Item Default Setting

RR Alarm switch On

High limit Adult: 30
Pediatric: 30
Neonate: 100 

Low limit Adult: 8
Pediatric: 8
Neonate: 30 

Priority Med

Alarm Outputs Off

Apnea Alarm switch On

Priority High, unadjustable

Alarm Outputs Off
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C.3 SpO2/SpO2b Default Settings

Apnea Delay Adult: 20 sec
Pediatric: 20 sec
Neonate: 15 sec

RR Source Auto

Resp Lead Adult: Auto
Pediatric: Auto
Neonate: II

Gain ×2

Speed 6.25 mm/s

Auto Threshold Detection On

Item Default Setting

Item Default Setting

SpO2/SpO2b Alarm switch On

High limit Adult: 100%
Pediatric: 100%
Neonate: 95%

Low limit 90%

Priority Med

Alarm Outputs Off

SpO2/SpO2b 
Desat 

Alarm switch On

Low limit 80%

Priority High

Alarm Outputs Off

ΔSpO2 Alarm switch On

High limit 10%

Priority Med

Alarm Outputs Off

Satsecond (for Nellcor SpO2) Off

NIBP Simul Off

FastSAT (for Masimo SpO2) Off

Display SIQ (for Masimo SpO2) Off

Display PI (for Masimo SpO2) On

Speed 25 mm/s
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C.4 Temperature Default Settings

C.5 NIBP Default Settings

PR Alarm switch On

High limit Adult: 120
Pediatric: 160 
Neonate: 200

Low limit Adult: 50
Pediatric: 75  
Neonate: 100

Priority Med

Alarm Outputs Off

Alarm Source Auto

PR Source Auto

Display PR On

QRS Volume General, OR: 2
Other departments: 0

Item Default Setting

Item Default Setting

Txx
(xx refers to 
temperature site)

Alarm switch On

High limit 38.0 °C

Low limit 35.0 °C

Priority Med

Alarm Outputs Off

ΔT Alarm switch On

High limit 2.0 °C

Priority Med

Alarm Outputs Off

Item Default Setting

NIBP-S Alarm switch On

High limit Adult: 160 mmHg 
Pediatric: 120 mmHg
Neonate: 90 mmHg

Low limit Adult: 90 mmHg 
Pediatric: 70 mmHg
Neonate: 40 mmHg

Priority Med

Alarm Outputs Off
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NIBP-D Alarm switch On

High limit Adult: 90 mmHg 
Pediatric: 70 mmHg
Neonate: 60 mmHg

Low limit Adult: 50 mmHg 
Pediatric: 40 mmHg
Neonate: 20 mmHg

Priority Med

Alarm Outputs Off

NIBP-M Alarm switch On

High limit Adult: 110 mmHg 
Pediatric: 90 mmHg
Neonate: 70 mmHg

Low limit Adult: 60 mmHg 
Pediatric: 50 mmHg
Neonate: 25 mmHg

Priority Med

Alarm Outputs Off

NIBP-S Extreme Alarm switch Off

High limit Adult: 175 mmHg 
Pediatric: 130 mmHg
Neonate: 95 mmHg

Low limit Adult: 75 mmHg 
Pediatric: 60 mmHg
Neonate: 35 mmHg

Priority High

Alarm Outputs Off

NIBP-D Extreme Alarm switch Off

High limit Adult: 105 mmHg 
Pediatric: 80 mmHg
Neonate: 65 mmHg

Low limit Adult: 35 mmHg 
Pediatric: 30 mmHg
Neonate: 15 mmHg

Priority High

Alarm Outputs Off

NIBP-M Extreme Alarm switch Off

High limit Adult: 125 mmHg 
Pediatric: 100 mmHg
Neonate: 75 mmHg

Low limit Adult: 45 mmHg 
Pediatric: 40 mmHg
Neonate: 20 mmHg

Priority High

Alarm Outputs Off

Item Default Setting
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C.6 IBP Default Settings
 

Initial Pressure Adult: 160 mmHg 
Pediatric: 140 mmHg
Neonate: 90 mmHg

Interval OR: 5 min
Neonatology: 30 min
Other departments: 15 min

Start Mode Clock

NIBP End Tone Off

Venipuncture Pressure Auto

Display Format Sys/Dia (Mean)

Display Alarm Limits Off

Display PR Off

Item Default Setting

Item Default Setting

IBP-S Alarm switch On

High limit ■ Art/Ao/UAP/BAP/FAP/LV/P1-P2 arterial pressure 

           Adult: 160 mmHg 
            Pediatric: 120 mmHg 

            Neonate: 90 mmHg 

■ PA

            Adult: 35 mmHg 
             Pediatric and neonate: 60 mmHg 

Low limit ■ Art/Ao/UAP/BAP/FAP/LV/P1-P2 arterial pressure 

            Adult: 90 mmHg 
            Pediatric: 70 mmHg 
            Neonate: 55 mmHg 
■ PA

            Adult: 10 mmHg 
            Pediatric and neonate: 24 mmHg 

Priority Med

Alarm Outputs Off
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IBP-D Alarm switch On

High limit ■ Art/Ao/UAP/BAP/FAP/LV/P1-P2 arterial pressure 

            Adult: 90 mmHg 
            Pediatric: 70 mmHg 
            Neonate: 60 mmHg 
■ PA

            Adult: 16 mmHg 
            Pediatric and neonate: 4 mmHg 

Low limit ■ Art/Ao/UAP/BAP/FAP/LV/P1-P2 arterial pressure 

            Adult: 50 mmHg 
            Pediatric: 40 mmHg 
            Neonate: 20 mmHg 
■ PA

            Adult: 0 mmHg 
            Pediatric and neonate: -4 mmHg 

Priority Med

Alarm Outputs Off

IBP-M Alarm switch On

High limit ■ Art/pArt/Ao/UAP/BAP/FAP/LV/P1-P2 arterial pressure 

            Adult: 110 mmHg 
            Pediatric: 90 mmHg 
            Neonate: 70 mmHg 
■ PA

            Adult: 20 mmHg 
            Pediatric and neonate: 26 mmHg 
■ CVP

            Adult: 14 cmH2O 
            Pediatric and neonate: 5 cmH2O 
■ ICP/RAP/LAP/UVP/P3-P4 venous pressure

            Adult: 10 mmHg 
            Pediatric and neonate: 4 mmHg 

Low limit ■ Art/Ao/UAP/BAP/FAP/LV/P1-P2 arterial pressure 

            Adult: 70 mmHg 
            Pediatric: 50 mmHg 
            Neonate: 35 mmHg 
■ PA

            Adult: 0 mmHg 
            Pediatric and neonate: 12 mmHg 
■ CVP

            Adult: 0 cmH2O
            Pediatric and neonate: 0 cmH2O
■ ICP/RAP/LAP/UVP/P3-P4 venous pressure

            Adult: 0 mmHg 
            Pediatric and neonate: 0 mmHg 

Priority Med

Alarm Outputs Off

Item Default Setting
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Art-S Extreme Alarm switch Off

High limit Adult: 175 mmHg 
Pediatric: 130 mmHg 
Neonate: 95 mmHg 

Low limit Adult: 75 mmHg 
Pediatric: 60 mmHg 
Neonate: 50 mmHg 

Priority High

Alarm Outputs Off

Art-D Extreme Alarm switch Off

High limit Adult: 105 mmHg 
Pediatric: 80 mmHg 
Neonate: 65 mmHg

Low limit Adult: 35mmHg 
Pediatric: 30 mmHg 
Neonate: 15 mmHg 

Priority High

Alarm Outputs Off

Art-M Extreme Alarm switch Off

High limit Adult: 125 mmHg 
Pediatric: 100 mmHg 
Neonate: 75 mmHg

Low limit Adult: 55 mmHg 
Pediatric: 40 mmHg 
Neonate: 30 mmHg 

Priority High

Alarm Outputs Off

CPP Alarm switch On

High limit Adult: 130 mmHg 
Pediatric: 100 mmHg 

Neonate: 90 mmHg 

Low limit Adult: 50 mmHg 
Pediatric: 40 mmHg 
Neonate: 30 mmHg 

Priority Med

Alarm Outputs Off

Measure (for P1, P2) All

Measure (for P3, P4) Mean Only

Sensitivity Med

Speed 25 mm/sec

Item Default Setting
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C.7 C.O. Default Settings

Scale ICP/RAP/LAP/UVP 
venous pressure

0- 20 mmHg

Art/Ao/BAP/FAP/LV/P1/
P2 arterial pressure 

0-160 mmHg

UAP/P3/P4 venous 
pressure

0-80 mmHg

CVP/PA CVP: 0-30 cmH2O
PA: 0 - 30 mmHg

Display Format Sys/Dia (Mean)

Display Alarm Limits Off

Use PA-D as PAWP (only available for 
independent external display)

Off

PPV Measure Off

PPV Source Auto

PAWP Reference Waveform 1 II

Reference Waveform 2 Resp

Speed 12.5 mm/sec

PA Scale 0-30 mmHg

Overlapping 
Waveform Setup

Left Scale 0-160 mmHg

Right Scale 0-20 mmHg

CVP Scale 0-30 cmH2O

ICP Scale 0-20 mmHg

PA Scale 0-30 mmHg

Speed 25 mm/sec

Gridlines Off

Item Default Setting

Item Default Setting

TB Alarm switch On

High limit 39.0 °C

Low limit 36.0 °C

Priority Med

Alarm Outputs Off

Comp const 0.542

Auto Start On

Auto TI On
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C.8 ScvO2 Default Settings

C.9 CCO Default Settings(Vigilance II/Vigileo/EV1000/HemoSphere)

C.10 ScvO2/SvO2 Default Settings(Vigilance II/Vigileo/EV1000/
HemoSphere)

Item Default Setting

ScvO2 Alarm switch On

High limit 90

Low limit 40

Priority Med

Alarm Outputs Off

Hb/Hct Hb

Item Default Setting

CCO Alarm switch On

High limit 14.0

Low limit 2.0

Priority Med

Alarm Outputs Off

CCI Alarm switch On

High limit 10.0

Low limit 1.0

Priority Med

Alarm Outputs Off

SVR Unit DS/cm5

Select Parameter CCI, GEF, SVRI, ELWI, GEDI

Item Default Setting

SvO2 /ScvO2 Alarm switch On

High limit 90

Low limit 40

Priority Med

Alarm Outputs Off
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C.11 CO2 Default Settings

C.11.1 General Settings

C.11.2 Sidestream CO2 Default Settings

Item Default Setting

EtCO2 Alarm switch On

High limit Adult and pediatric: 50 mmHg
Neonate: 45 mmHg

Low limit Adult and pediatric: 25mmHg
Neonate: 30mmHg 

Priority Med

Alarm Outputs Off

FiCO2 Alarm switch On

High limit 4 mmHg

Priority Med

Alarm Outputs Off

Apnea Delay Adult and pediatric: 20 s 
Neonate: 15 s 

RR Source Auto

Speed 6.25 mm/s

Scale 50 mmHg

Waveform Type Draw

Item Default Setting

EtO2 Alarm switch On

High limit 88%

Low limit 18%

Priority Med

Alarm Outputs Off

FiO2 Alarm switch On

High limit Adult and pediatric: 100% 
Neonate: 90% 

Low limit 18%

Priority Med

Alarm Outputs Off

BTPS Compensation Off

O2 Compensation (for CO2 module without 
O2 measurement)

OR: 100%
Other departments: 21% 

N2O Compenation 0%

AG Compenation 0%

Auto Standby 60 min
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C.11.3 Microstream CO2 Default Settings

C.12 Gas Default Settings

Operating Mode Measure

Item Default Setting

Item Default Setting

BTPS Compen Off

Maximum Hold 20 sec

Auto Standby Off

Operating Mode Measure

Item Default Setting

EtCO2 Alarm switch On

High limit Adult and pediatric: 50 mmHg
Neonate: 45 mmHg

Low limit Adult and pediatric: 25 mmHg
Neonate: 30 mmHg 

Priority Med

Alarm Outputs Off

FiCO2 Alarm switch On

High limit 4 mmHg

Priority Med

Alarm Outputs Off

EtO2 Alarm switch On

High limit 88%

Low limit 18%

Priority Med

Alarm Outputs Off

FiO2 Alarm switch On

High limit Adult and pediatric: 100% 
Neonate: 90% 

Low limit 18%

Priority Med

Alarm Outputs Off

EtN2O Alarm switch On

High limit 55%

Low limit 0%

Priority Med

Alarm Outputs Off
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FiN2O Alarm switch On

High limit 53%

Low limit 0%

Priority Med

Alarm Outputs Off

EtAA/FiAA Alarm switch On

High limit 30%

Low limit 0.0%

Priority Med

Alarm Outputs Off

EtHal/EtEnf/EtIso Alarm switch On

High limit 3.0%

Low limit 0.0%

Priority Med

Alarm Outputs Off

FiHal/FiEnf/FiIso Alarm switch On

High limit 2.0%

Low limit 0.0%

Priority Med

Alarm Outputs Off

EtSev Alarm switch On

High limit 6.0%

Low limit 0.0%

Priority Med

Alarm Outputs Off

FiSev Alarm switch On

High limit 5.0%

Low limit 0.0%

Priority Med

Alarm Outputs Off

EtDes Alarm switch On

High limit 8.0%

Low limit 0.0%

Priority Med

Alarm Outputs Off

Item Default Setting
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C.13 RM Default Settings

FiDes Alarm switch On

High limit 6.0%

Low limit 0.0%

Priority Med

Alarm Outputs Off

Apnea Delay Adult and pediatric: 20 sec 
Neonate: 15 sec 

RR Source Auto

Operating Mode Measure

Auto Standby Off

RR Source Auto

Speed 6.25 mm/sec

Scale O2: 400 mmHg
CO2: 50  mmHg
N2O: 50 % 
Hal, Enf, and Iso: 2.5%  
Sev: 4.0% 
AA and Des: 9.0 % 

Waveform Type Draw (for CO2 only)

O2 compensation OR: 100%
Other departments: Off

Item Default Setting

Item Default Setting

PEEP Alarm switch On

High limit 10

Low limit 0

Priority Med

Alarm Outputs Off

PIP Alarm switch On

High limit 40

Low limit 1

Priority Med

Alarm Outputs Off

MVe Alarm switch On

High limit 30.0

Low limit 2.0

Priority Med

Alarm Outputs Off

Apnea Delay 20 sec
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C.14 EEG Default Settings

RR Source Auto

Atmosphere Temp 25 °C

Relative Humidity 55 %

Paw Scale 40 cmH2O

Flow Scale 60 L/min

Vol Scale 1200 ml

Speed 6.25 mm/s

Paw View PIP, PEEP, Pmean, Pplat, RR

Flow View PEF, PIF, Compl

Vol View MVe, MVi, TVe, TVi

Item Default Setting

Item Default Setting

Scale 100 μV

Speed 25mm/s

Low Filter 0.5 Hz

High Filter 30 Hz

Notch Filter On

EEG Expand View Default Setting

EEG EEG Channels All

Scale 100 μV

Speed 25mm/s

Trends EEG Channels EEG1, EEG2, EEG3, EEG4

Parameters SEF

Trend Length 60 min

DSA EEG Channels All

Parameters SEF

Trend Length 20 min

Power Scale 1 - 64 dB

CSA EEG Channels All

Parameters SEF

Trend Length 20 min

Power Scale 1 - 64 dB

CSA Clipping On
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C.15 BIS Default Settings

C.16 NMT Default Settings

C.17 rSO2 Default Settings

Item Default Setting

BIS Alarm switch On

High limit 70

Low limit 20

Priority Med

Alarm Outputs Off

Smoothing Rate 30 sec

Display OR: BIS Trend
Other departments: EEG LT/RT

Scale 100 μV

Speed 25mm/s

Filter On

Auto Check On

BIS Expand View Default Setting

Parameter 1 BIS L

Parameter 2 EMG

Trend Length 60 min

Item Default Setting

Stimulation Current Supra (60 mA)

Pulse Width 200 μs

Block Recovery Off

Stimulation Beep Volume 2

Interval TOF Mode: 1 min
ST Mode: 10 sec
DBS Mode: 1 min

DBS Mode 3.3

Item Default Setting

rSO2-1/rSO2-2/
rSO2-1’/rSO2-2’

Alarm switch On

High limit 90

Low limit 40

Priority Med

Alarm Outputs Off
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C.18 Alarm Default Settings

C.19 Display Default Settings

rSO2-1/rSO2-2/
rSO2-1’/rSO2-2’ 
Variance

Low Limit -20

Auto Low Limit Off

rSO2-1 Label L

rSO2-2 Label R

rSO2-1’ Label S1

rSO2-2’ Label S2

AUC Mode Below Baseline Percentage

Fixed Threshold 50

Percentage Below Baseline 25

Select Parameter Baseline, Baseline Variance

Item Default Setting

Item Default Setting

Alarm Volume 2

High Alarm Volume Alarm Volume + 2

Reminder Volume 2

Apnea Delay Adult/Pediatric: 20 sec
Neonate: 15 sec

Printing Duration on Alarm 20 sec

Auto Limits for New Patient On

Item Default Setting

Choose Screen Normal Screen

Display Screen Lock Duration General: Permanent
CCU: Permanent
Other departments: 10 sec

Brightness 5

Brightness On Battery 1

Night Mode Brightness 1

Alarm Volume 2

QRS Volume 1

Key Volume 0

NIBP End Tone Off

Stop NIBP Off
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D Alarm Messages

This chapter lists only the physiological and technical alarm messages. Some messages appearing on your 
monitor may not be included. In the “Cause and solution” column, corresponding solutions are given instructing 
you to troubleshoot problems. If the problem persists, contact your service personnel.

D.1 Physiological Alarm Messages 

D.1.1 General Physiological Alarm Messages

Note: XX represents a measurement or parameter label, such as HR, NIBP, PVCs, RR, SpO2, PR, etc.

D.1.2 Arrhythmia Alarm Messages

Alarm messages Default priority Cause and solution

XX High Med XX value has risen above the high alarm limit or fallen below the low 
alarm limit. Check the patient’s condition and check if the patient 
category and alarm limit settings are correct.XX Low Med

Alarm message Default priority

Asystole High

V-Fib/V-Tach High

V-Tach High

Vent Brady High

Extreme Tachy High

Extreme Brady High

R on T Med

Run PVCs Low

Couplet Prompt

Multiform PVC Med

PVC Prompt

Bigeminy Med

Trigeminy Med

Tachy Med

Brady Med

Pacer Not Pacing Prompt

Pacer Not Capture Prompt

Missed Beats Prompt

Nonsus. Vtac Med

Vent Rhythm Med

Pause Low
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Note: When arrhythmia alarms occur, check the patient’s condition and the ECG connections.

D.1.3 Resp Physiological Alarm Messages

D.1.4 SpO2 Physiological Alarm Messages

D.1.5 PR Physiological Alarm Messages

D.1.6 NIBP Physiological Alarm Messages

Irr Rhythm Prompt

PVCs/min Med

Pauses/min Med

A-Fib Prompt

Alarm message Default priority

Alarm message Default priority Cause and solution

Resp Artifact High The patient’s heartbeat has interfered with the impedance respiration 
measurement. Check the patient’s condition and the ECG connections.

Apnea High The respiration signal is so weak that the monitor cannot perform 
respiration analysis. Check the patient’s condition, module and patient 
connections.

Alarm message Default priority Cause and solution

SpO2/SpO2b Desat High The SpO2 or SpO2b value falls below the desaturation alarm limit. 
Check the patient’s condition and check if the alarm limit settings are 
correct.

ΔSpO2 High Med The ΔSpO2 value exceeds the alarm limit. Check the patient’s 
condition.

Alarm message Default priority Cause and solution

No Pulse High The pulse signal is so weak that the monitor cannot perform pulse 
analysis. Check the patient’s condition and the source of the PR, such as 
IBP or SpO2 sensor, and measurement site. 

Alarm message Default priority Cause and solution

NIBP-S Extremely 
High/NIBP-D 
Extremely High/NIBP-
M Extremely High

High The NIBP value is higher than the NIBP Extreme alarm high limit. Check the 
patient’s condition and check if the alarm limit settings are correct.

NIBP-S Extremely 
High/NIBP-D 
Extremely High/NIBP-
M Extremely Low

High The NIBP value is lower than the NIBP Extreme alarm low limit. Check the 
patient’s condition and check if the alarm limit settings are correct.
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D.1.7 IBP Physiological Alarm Messages

D.1.8 CO2 Physiological Alarm Messages

D.1.9 AG Physiological Alarm Messages

D.1.10 RM Physiological Alarm Messages

D.2 Technical Alarm Messages
This section lists technical alarms, their default priority, responses on alarm reset, and the actions that can be 
taken when an alarm occurs. Some of alarms may not be included.

Various technical alarms respond differently when the alarm system is reset. For easy clarification, in this section 
the technical alarms are classified into three categories of response when the alarm system is reset:

■ A: technical alarms are cleared. The monitor gives no alarm indications.

■ B: technical alarms are changed to the prompt messages.

■ C: the alarm is silenced and a √ appears before the alarm message. 

In the following tables A, B, and C are used to refer to the responses on alarm reset.

Alarm message Default priority Cause and solution

Art-S/Art-D/Art-M 
Extremely High

High The Art value is higher than the Art Extreme alarm high limit. Check the 
patient’s condition and check if the alarm limit settings are correct.

Art-S/Art-D/Art-M 
Extremely Low

High The Art value is lower than the Art Extreme alarm low limit. Check the 
patient’s condition and check if the alarm limit settings are correct.

Alarm message Default priority Cause and solution

FiO2 Shortage High FiO2 concentration is less than 18%. Check the patient’s condition, the 
ventilated O2 content and the airway connection.

Alarm message Default priority Cause and solution

FiO2 Shortage High FiO2 concentration is less than 18%. Check the patient’s condition, the 
ventilated O2 content and the AG connections.

Mixed Agent and MAC≥3 Med The mixed anaesthetic gases concentration is too high. Verify the MAC 
parameters are correct and adjust the anaesthetic gases concentration 
as necessary.

Apnea High The respiration signal was so weak that the monitor cannot perform 
respiration analysis. Check the patient’s condition, module and patient 
connections.

Alarm message Default priority Cause and solution

Apnea High The respiration signal was so weak that the monitor cannot perform 
respiration analysis. Check the patient’s condition, module and patient 
connections.
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D.2.1 General Technical Alarm Messages

Note: XX represents a measurement or parameter label, such as HR, RR, SpO2, or EtCO2, etc.

D.2.2 ECG Technical Alarm Messages

Note: XX represents ECG lead name, for example RL, LL, V, Va, Vb, etc.

D.2.3 Resp Technical Alarm Messages

D.2.4 SpO2 Technical Alarm Messages

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

XX Module Error High C XX module does not work properly. Reinsert the 
module, if the alarm persists, contact your service 
personnel.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

ECG Noisy Low/Prompt A The ECG signal is noisy. Check for any possible 
sources of signal noise around the cable and 
electrode, and check the patient for excessive 
motion.

ECG Amplitude Too Small Low C The ECG amplitude does not reach the detected 
threshold. Check for any possible source of 
interference around the cable and electrode.

ECG (XX) Lead Off Low B The electrode has become detached from the 
patient or the lead wire has become 
disconnected from the adapter cable. Check the 
connections of the electrodes and leadwires.

ECG Signal Invalid Low A Patient skin impedance is too high. Check ECG 
electrode application. 

ECG Learning Prompt / ECG learning is manually or automatically 
triggered.

Cannot Analyze QT Prompt / /

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

Resp Interference Prompt / The respiration circuit is disturbed. Check for any 
possible sources of signal noise.

Electrode Poor Contact Prompt / Check the electrode application. Reposition or 
replace the electrodes if necessary.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

SpO2 Sensor Off/SpO2b 
Sensor Off

Low B The SpO2 sensor has become detached from the 
patient or the module. Check the sensor 
connection. If the alarm persists, replace the 
sensor.
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D.2.5 Temp Technical Alarm Messages

D.2.6 NIBP Technical Alarm Messages

SpO2 No Sensor/SpO2b 
No Sensor

Low A The SpO2 extension cable is detached from the 
SpO2 module, or the SpO2 sensor is detached 
from the SpO2 extension cable. Check the SpO2 
cable and the sensor connection. If the alarm 
persists, replace the sensor.

SpO2 Excess Light/SpO2b 
Excess Light

Low C Ambient light is too strong. Move the sensor to a 
place with lower level of ambient light or cover 
the sensor to minimize the ambient light.

SpO2 No Pulse/SpO2b No 
Pulse

Low C The SpO2 sensor failed to obtain pulse signal. 
Check the patient’s condition and replace the 
sensor application site. If the alarm persists, 
replace the sensor.

SpO2 Sensor 
Incompatible/SpO2b 
Sensor Incompatible

Low C Incompatible or an unspecified SpO2 sensor is 
used. Use specified sensors.

SpO2 Low Signal Quality/
SpO2b Low Signal Quality

Low C 1. Check the sensor and sensor position.
2. Make sure the patient is not shivering or 
moving.
3. The patient’s pulse may be too low to be 
measured.

SpO2 Interference
/SpO2b Interference

Low C The SpO2 signal has interference. Check for any 
possible sources of signal noise and check the 
patient for excessive motion.

SpO2 Sensor Error/SpO2b 
Sensor Error

Low C Replace the sensor and measure again.

SpO2 Searching Pulse/
SpO2b Searching Pulse

Prompt / SpO2 is searching for pulse.

SpO2 Low Perfusion/
SpO2b Low Perfusion

Prompt / The SpO2 sensor is not properly placed or the 
patient’s perfusion index is too low.
1. Check the sensor and sensor position.
2. Reposition the sensor if necessary.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

T1/T2 Sensor Off Low A Check the sensor connection and reconnect the 
sensor.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

NIBP Loose Cuff Low A There is a leak in the cuff or air tubing. Use a cuff 
of correct type based on the patient size. Apply 
the cuff and connect the air tubing as instructed 
in the manual.

NIBP Air Leak Low A Check the NIBP cuff and pump for leakages.

NIBP Airway Error Low A The air tubing may be occluded. Check the air 
tubing for an occlusion or kinking. If the alarm 
persists, contact your service personnel.
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D.2.7 IBP Technical Alarm Messages

Note: XX represents an IBP label, for example PA, CVP, FAP, P1, etc.

NIBP Weak Signal Low A The patient’s pulse is weak or the cuff is loose. 
Check the patient’s condition and replace the cuff 
application site. 

NIBP Overrange Low A The measured NIBP value exceeds the module 
measurement range. Check the patient’s 
condition.

NIBP Excessive Motion Low A Check the patient’s condition and reduce patient 
motion.

NIBP Cuff Overpress Low A The NIBP airway may be occluded. Check the 
airway and measure again. If the alarm persists, 
contact your service personnel.

NIBP Timeout Low A The measurement time exceeds 120 seconds in 
the adult or pediatric mode, or exceeds 90 
seconds in the neonatal mode, and the BP value 
cannot be obtained. Check the patient’s 
condition and NIBP connections, or replace the 
cuff and measure again.

NIBP Cuff and Patient 
Mismatch

Low A The cuff type mismatches the patient category. 
Verify the patient category or replace the cuff if 
necessary. If patient category is correct, check 
that the tubing is not bent and the airway is not 
occluded.

NIBP Airway Leak Low A Airway leakage is found during the NIBP leakage 
test. Check the NIBP cuff and pump for leakages.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

XX Sensor Error Med C The IBP sensor fails. Replace the sensor.

XX No Sensor Med A The IBP patient cable and/or corresponding IBP 
sensor is not connected or detached. Check the 
cable and sensor connection.

XX No Pulse Low A The catheter may be occluded. Please flush the 
catheter.

XX Disconnected High C The tubing is disconnected from the patient, or 
the three-way valve is open to the air. Check the 
connection of the tubing, or check the valve is 
open to the patient. If the alarm persists, contact 
your service personnel.

Monitor Version Low Low A The N Series system software version is too low. 
In order for the N Series monitor to connect to 
the N1 which connects to the external IBP 
module and perform IBP monitoring, the system 
software of N 1 and N series monitor should be 
V01.62.00 and above.
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D.2.8 C.O. Technical Alarm Messages

D.2.9 ScvO2 Technical Alarm Messages

D.2.10 CO2 Technical Alarm Messages

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

TB Sensor Off Low A Check the sensor connection and reconnect the 
sensor.

TI Sensor Off Low A Check the sensor connection and reconnect the 
sensor.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

ScvO2 High Signal Low C Check the sensor and reposition the catheter. 
Recalibrate the sensor.

ScvO2 Low Signal Low C Check the sensor and reposition the catheter. 
Recalibrate the sensor.

ScvO2 Excess Light Low C Avoid excessively strong backlight.

Optical Module 
Disconnected

Low A Connect the optical module.

Unsupported CeVOX 
Version

Low A The module version is not compatible with the 
system. Contact your service personnel.

Disconnected from 
Vigilance

Low A The Vigilance monitor is disconnected. Check the 
connection between the CCO/SvO2 module and 
the Vigilance monitor. 

Disconnected from 
Vigileo

Low A The Vigileo monitor is disconnected. Check the 
connection between the CCO/SvO2 module and 
the Vigileo monitor. 

Disconnected from 
EV1000

Low A The EV1000 monitor is disconnected. Check the 
connection between the CCO/SvO2 module and 
the EV1000 monitor. 

Disconnected from 
HemoSphere

Low A The HemoSphere monitor is disconnected. Check 
the connection between the CCO/SvO2 module 
and the HemoSphere monitor. 

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

CO2 Module High Temp Low C Ambient temperature is too high or there is a 
module failure.
1. Lower the operating temperature.
2. Reinsert the module.
3. If the alarm persists, the CO2 module may have 
failed, contact your service personnel.

CO2 Module Low Temp Low C Ambient temperature is too low or there is a 
module failure.
1. Raise the operating temperature.
2. Reinsert the module.
3. If the alarm persists, the CO2 module may have 
failed, contact your service personnel.
BeneVision N22/N19/N17/N15/N12 Patient Monitor Operator’s Manual D - 7



CO2 Zero Failed Low C Reinsert the module. If the alarm persists, contact 
your service personnel.

CO2 No Watertrap Low B Check the watertrap connections.

CO2 High Airway Press. Low C 1. Check the airway pressure settings of the 
ventilator/anesthesia machine.
2. Disconnect the module from the ventilator/
anesthesia machine.
3. Reinsert the module.
4. If the alarm persists, contact your service 
personnel.

CO2 Low Airway Press. Low C 1. Check the airway pressure settings of the 
ventilator/anesthesia machine.
2. Disconnect the module from the ventilator/
anesthesia machine.
3. Reinsert the module.
4. If the alarm persists, contact your service 
personnel.

High Barometric Low C The ambient pressure exceeds the operating 
pressure range or CO2 module fails.
1. Make sure that the ambient pressure meets the 
specifications, and check for sources that affect 
the ambient pressure.
2. Reinsert the module. If the alarm persists, 
contact your service personnel.

Low Barometric Low C The ambient pressure exceeds the operating 
pressure range or CO2 module fails.
1. Make sure that the ambient pressure meets the 
specifications, and check for sources that affect 
the ambient pressure.
2. Reinsert the module. If the alarm persists, 
contact your service personnel.

CO2 Airway Occluded Low C 1. Check if the sample line is kinked or occluded.
2. Replace the sample line.
3. Reinsert the module.
4. If the alarm persists, contact your service 
personnel.

CO2 No Filterline Low A Make sure that the filterline is connected.

CO2 Calibration Required Low C Perform a calibration.

CO2 Airway Error Low C 1. Check if the sample line is kinked or occluded.
2. Replace the sample line.
3. Reinsert the module.
4. If the alarm persists, contact your service 
personnel.

CO2 Adapter Error Low A Check, clean or replace the airway adapter. 
Perform a zero calibration.

CO2 No Sensor Low A Make sure that the CO2 transducer is connected.

CO2: Change Watertrap Low C Replace the watertrap.

CO2 Watertrap Mismatch Low C Check the patient category and use a correct 
watertrap.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution
D - 8  BeneVision N22/N19/N17/N15/N12 Patient Monitor Operator’s Manual



D.2.11 AG Technical Alarm Messages

D.2.12 RM Technical Alarm Messages

D.2.13 EEG Technical Alarm Messages

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

AG No Watertrap Low B Check the connections of the watertrap and re-
connect it.

AG: Change Watertrap Low C Replace the watertrap.

AG Watertrap and Patient 
Mismatch

Low C Check the patient category and use a correct 
watertrap.

AG Zero Failed Low C There is external electromagnetic interference, 
airway occlusion or module failure.
1. Check for external inference sources.
2. Check for “AG Airway Occluded” alarm 
message. Remove the occlusion.
3. If the alarm persists, contact your service 
personnel.

Anesthetic Mixture Low C Anesthetic mixture is detected.

AG Airway Occluded Low C 1. Check if the sample line is occluded.
2. Replace the sample line.
3. Reinsert the module.
4. If the alarm persists, contact your service 
personnel.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

RM No Sensor Low A Check and reconnect the sensor.

RM Zero Failed Low C Reinsert the module. If the alarm persists, contact 
your service personnel.

RM Sensor and Patient 
Mismatch

Low C Patient Category is set to Adult, but a neonatal 
sensor is used. Check patient category setting 
and use correct RM sensor.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

EEG No Sensor Low A The EEG patient cable is not connected. Connect 
the cable.

EEG Sensor Off Low A EEG electrodes are not connected or detached. 
Check electrode connection and reconnect the 
electrodes.

EEG Electrode X + Y Off Low A X + Y electrode is detached. Check the electrode 
connection and reconnect the electrode.

EEG Electrode X + Y Poor 
Contact

Low A X + Y electrode does not properly contact the 
patient. Check the electrode connection and 
reconnect the electrode.

EEG: Module Protected High C EEG module may have failed. Disconnect the EEG 
module and reconnect it. If the alarm persists, 
replace the module, or contact your service 
personnel.
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Note: X represents EEG channel and polarity, for example A+, A-, A+, A-, etc. Y represents electrode 
location, for example Fp1, T3, etc. 

D.2.14 BIS Technical Alarm Messages

Note: XX represents BIS label, for example G, C, LE, LT, RL-RA, L-R, F-R, 1, 2, etc.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

BIS Sensor Off Low A Check and reconnect the BIS sensor. If the alarm 
persists, replace the sensor.

BIS Electrode XX Off Low A Check the electrode connection, and re-attach 
the electrodes if necessary.

BIS Electrode XX Poor 
Contact

Low A Enter the Sensor Check menu, and check the 
connections of the sensor and electrodes.

BISx Error High C Reinsert the module. If the alarm persists, contact 
your service personnel.

BIS No Sensor Low A BIS sensor is not properly connected, BIS cable 
failure, BISx or BISx4 failure.
1. Check the BIS sensor connection.
2. Reinsert the BIS module.
3. Replace the BIS cable.
4. Replace BISx or BISx4.

BIS Sensor Too Many Uses Low A Replace the sensor.

BIS Sensor Old Low A Replace the sensor.

BIS XX Signal Quality Too 
Low

Low A SQI < 15%

1. Check the patient’s condition.
2. Check the sensor position, and its contact with 
the patient’s skin.
3. Check that BISx or BISx4 is away from 
electrically radiating equipment.

BIS XX Low Signal Quality Low A SQI between 50% and 15%.
1. Check the patient’s condition.
2. Check the sensor position, and its contact with 
the patient’s skin.
3. Check that BISx or BISx4 is away from 
electrically radiating equipment.

BIS Wrong Sensor Type Low A Check or replace the sensor.

BIS Sensor Error Low C Replace the sensor.

BISx Disconnected Low A BISx or BISx4 is not connected properly or fails, or 
BIS patient cable fails.
1. Check that BISx or BISx4 is connected properly.
2. Replug the BIS Module.
3. Replace the BIS patient cable.
4. Replace BISx or BISx4.

Reconnect BISx Low A Reinsert the BIS Module.
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D.2.15 NMT Technical Alarm Messages

D.2.16 rSO2 Technical Alarm Messages

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

NMT No Cable Low A Check that NMT patient cable is properly 
connected to the NMT module.

NMT No Sensor Low A Check that NMT sensor is properly connected to 
the NMT patient cable. If the alarm persists, 
replace the sensor.

NMT Stimulation 
Electrode Off

Low A Check that NMT sensor is properly connected to 
the NMT patient cable. If the alarm persists, check 
the application of electrodes.

NMT Sensor Error Low C Contact your service personnel.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

rSO2-1 No Sensor
rSO2-2 No Sensor
rSO2-1’ No Sensor
rSO2-2’ No Sensor

Low A rSO2 sensor is detached, or the sensor cable is 
disconnected from the pre-amplifier. Re-connect 
the sensor to the pre-amplifier.

rSO2-1 Excess Light
rSO2-2 Excess Light
rSO2-1’ Excess Light
rSO2-2’ Excess Light

Low C The sensor is detached or ambient light is too 
strong. Re-attach the sensor or reduce the level of 
ambient light.

rSO2-1 Low Signal Quality
rSO2-2 Low Signal Quality
rSO2-1’ Low Signal Quality
rSO2-2’ Low Signal Quality

Low C The signal acquired by the sensor was unstable or 
weak due to power supply noise. Check the 
sensor connection. If the alarm persists, contact 
your service personnel.

rSO2 -1/rSO2-2 No 
Preamplifier
rSO2-1’/rSO2-2’ No 
Preamplifier

Low A Properly connect the pre-amplifier.

rSO2 -1: Change Sensor
rSO2-2: Change Sensor
rSO2-1’: Change Sensor
rSO2: Change Sensor

Low C The sensor type mismatches patient category, 
the reusable sensor cable fails, the sensor reaches 
the lifetime, or the sensor type mismatches the 
monitor and patient category setting. Verify 
patient category and use sensors of correct 
patient category.

rSO2 -1/rSO2-2 
Interference
rSO2-1’/rSO2-2’ 
Interference

Low C There is noise interference (such as 
electrosurgical unit). Check   for any possible 
sources of signal noise. 

rSO2-1 Auto Baseline
rSO2-2 Auto Baseline
rSO2-1’ Auto Baseline
rSO2-2’ Auto Baseline

Prompt / The monitor automatically sets the rSO2 baseline.

Disconnect/ Reconnect 
rSO2-1/rSO2-2
Disconnect/ Reconnect 
rSO2-1’/rSO2-2’

Low A Remove the rSO2 module and reconnect it.
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D.2.17 Power Supply Technical Alarm Messages

Note: XX represents 2.5, 3.3, 5, or 12.

D.2.18 Recorder Technical Alarm Messages

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

Low Battery Med C Connect the monitor to an AC power source and 
allow the batteries to charge.

Critically Low Battery High C Connect the monitor to an AC power source and 
allow the batteries to charge.

Battery Service Required 
(N22/N19)

Low B The battery has reached its lifetime. Contact the 
service personnel.

Battery Overload (N22/
N19)

High C Too many parameter modules are connected, 
causing system overload and high power 
consumption. Use AC power supply.

Power Board Comm Error High C Shutdown and restart the monitor. If the alarm 
persists, contact your service personnel.

Battery Err High C The battery may have failed. Contact your service 
personnel.

Battery Charging Error 
(N22/N19)

High C The charging circuit fails or the battery fails. 
Contact your service personnel.

RT Clock Need Reset High C Contact your service personnel.

RT Clock Not Exist High C Contact your service personnel.

XX V Too High High C There is a problem with the system power supply. 
Shutdown and restart the monitor.

XX V Too Low High C

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

Recorder Init Error Low A An error occurred during the recorder 
initialization. Reinsert the module. If the alarm 
persists, contact your service personnel.

Recorder Comm Error Low A Reinsert the recorder. Shutdown and restart the 
monitor. If the alarm persists, contact your service 
personnel.

Recorder Unavailable Low A Recorder module failure. Replace the module.

Recorderhead 
Overheated

Low C The recorder has been printing for too long. Stop 
the recording and resume the recording after the 
recorder’s print head cools down.

Recorder Initializing Prompt / Wait until the recorder initialization is completed.

Recorder No Paper Prompt / The recorder paper is not loaded or the recorder 
door is not closed. Check the recorder, load the 
recorder paper or close the recorder door.

Recorder Busy Prompt / The buffer queue for recording is full. 

Recorder Not Found Prompt / The recorder module is not inserted in. Insert the 
module.
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D.2.19 Printer Technical Alarm Messages

D.2.20 Technical Alarm Messages Related to Networked Monitoring

Note: XX refers to the department name, YY refers to the room number, and ZZ refers to the bed number.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

Printer Buffer Full Prompt / The printer buffer is full. Wait until the printer 
finishes the printing task.

Printing Failed Prompt / The printer ran out of paper or cannot be found 
on the network. Check the printer.

Printing Stopped Prompt / Printing was manually stopped.

Printer Unavailable Prompt / The printer may have failed. Check the printer.

PDF storage space is 
nearly full

Prompt / Delete the files saved under the PDF file path to 
release storage space. Otherwise you cannot save 
new PDF files.

Error storing PDF file Prompt / The PDF file path settings on the print server and 
the PDF Creator are not consistent or the PDF 
storage space is full. Check the PDF file path 
settings for consistency, or delete the files saved 
under the PDF file path to release storage space. 

Change the print server 
language to be consistent 
with this monitor

Prompt / Verify that the language settings of the print 
server and the monitor are consistent, Otherwise 
you cannot perform printing.

Print Server Disconnected Prompt / Check that the monitor is properly connected 
with the print server.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

CMS/eGW Disconnected Low B The monitor is disconnected from the CMS. 
Check the network connection.

View Bed XX YY-ZZ, 
Network Disconnected.

Low A The network is interrupted when the monitor is 
viewing the remote device. Check the network 
connection.

Viewed by Bed XX YY-ZZ, 
Network Disconnected.

Low A The network is interrupted when the monitor is 
viewed by another remote device. Check the 
network connection.

WLAN IP Address Conflict Low C There is a wireless network IP address conflicts. 
Check the network settings.

LAN1 IP Address Conflict Low C There is a wired network IP address conflicts. 
Check the network settings.

Fail To Get WLAN IP 
Address

Low C Unable to automatically obtain the wireless 
network IP address. Check the network settings.

Fail To Get LAN1 IP 
Address

Low C Unable to automatically obtain the wired 
network IP address. Check the network settings.
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D.2.21 Technical Alarm Messages Related to Telemetry Monitors

D.2.22 Other System Technical Alarm Messages

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

Telemetry Disconnected High B The telemetry is powered off, the monitor or the 
telemetry is not connected to the wireless 
network, or out of the network coverage.
1. Power on the telemetry.
2. Connect the monitor and the telemetry to the 
network.
3. Move the telemetry in the network coverage.
4. The exchanger network connected by the 
telemetry and the monitor does not support 
multicast data transfer. Contact your service 
personnel.

Telemetry Error High C An error occurred to the telemetry.
Restart the telemetry. If the problem still persists, 
replace with a known good telemetry.

Telemetry Low Battery Med C The telemetry battery charge is low.
Replace with a known good battery.

Telemetry Battery 
Depleted

High C The telemetry battery charge is critically low.
Replace with known good batteries.

Telemetry Battery 
Maintenance Required

Med C The telemetry battery may reach its life. Replace 
with known good batteries.

Telemetry Battery Error Med C The telemetry battery communication 
encounters an error. Replace with known good 
batteries.

Telemetry Battery Type 
Error

Med C The telemetry battery contacts may fail. Replace 
with known good batteries.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution

Primary Screen Alarm 
Error

High C The alarm signal communication between the 
primary display and the main unit is interrupted. 
The primary display cannot provide alarm 
indications. Check the connection between the 
main unit and the primary display.

Secondary Screen Alarm 
Error

High C The alarm signal communication between the 
secondary display and the main unit is 
interrupted. The secondary display cannot 
provide alarm indications. Check the connection 
between the main unit and the secondary 
display.

XX: Disconnected
(XX refers to the name of 
the external device)

High B Corresponding external device is disconnected. 
Check the connection between the monitor and 
the external device.

Storage Error High C The storage card failed or files are damaged. 
Shutdown and restart the monitor.  Format the 
storage card (CAUTION: this will clear all patient 
data stored on this monitor). If the alarm persists, 
contact your service personnel.
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Loading Default Config 
Failed

Low A The default configuration was not correctly 
loaded. The monitor will restore to the factory 
default configuration for the current patient 
category.

XX Conflicts
(XX refers to the module 
label)

Prompt / The same type of corresponding module being 
used exceeds the supported number. Remove 
the conflict module. 

XX Measurement has 
been closed
(XX refers to the module 
label)

Prompt / The parameter module is disabled. Switch on the 
module if you want to use it. For more 
information, see 3.9.1 Switching On or Off a 
Parameter.

The display setup for XX is 
disabled.
(XX refers to the 
parameter label)

Prompt / The parameter of the newly inserted module is 
not displayed on the screen. Select a desired area 
to display the parameter numerics and 
waveforms. For more information, see 
3.9.2 Displaying Parameter Numerics and 
Waveforms.

The patient data storage 
space is nearly full. Please 
delete some discharged 
patients.

Med B The storage space of the monitor is full. Delete 
unnecessary discharged patients.

Alarm message Default priority
Indication on 
alarm reset

Cause and solution
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E SpO2 Sensor Accuracy

E.1 The Accuracy of Masimo SpO2 Sensors

Table information for the plots below show ARMS values measured with Masimo SET Oximetry Technology in a 
clinical study.

Adtx/Pdtx/4000/4001

Inf/Neo/NeoPt/4002/4003/4004/4005
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DCI/DCIP/4050/4051

LNCS YI

4053
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E.2 The Accuracy of Nellcor SpO2 Sensors

SpO2 Accuracy for Nellcor Sensors vs. Co-Oximeters (Arms)

Modified Bland-Altman for SpO2 - MAXAI, MAXPI, MAXII, MAXNI Sensors: (SpO2 - SaO2) 
vs.SaO2

Modified Bland-Altman for SpO2 - DS-100A Sensors: (SpO2 - SaO2) vs.SaO2

SpO2 Range 100% to 70% 100% to 90% 90% to 80% 80% to 70%

DS-100A 1.64% 1.16% 1.67% 2.25%

D-YS, OXI-P/I, OXI-A/N 2.41% 1.38% 2.50% 3.60%

MAXAI, MAXPI, MAXII 1.62% 1.49% 1.57% 2.50%

MAXNI 1.85% 1.71% 1.51% 1.59%
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Modified Bland-Altman for SpO2 - D-YS, OXI-A/N, OXI-P/I Sensors: (SpO2 - SaO2) vs.SaO2
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F Units, Symbols and Abbreviations

F.1 Units 

Abbreviation In Full

μA microampere

μV microvolt

μs microsecond

A Ampere

Ah Ampere hour

bpm beat per minute

bps bits per second

°C Celsius

cc cubic centimeter

cm centimeter

dB decibel

DS dyne second

°F Fahrenheit

g gram

GHz gigahertz

GTT gutta

h hour

Hz hertz

in inch

k kilo

kg kilogram

kPa kilopascal

L litre

lb pound

m meter

mAh milliampere hour

Mb mega byte

mcg microgram

mEq milli-equivalents

mg milligram

min minute

ml milliliter

mm millimeter
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F.2 Symbols

mmHg millimeters of mercury

cmH2O centimeters of water

ms millisecond

mV millivolt

mW milliwatt

MΩ megaohm

nm nanometer

rpm breaths per minute

s second

V volt

VA volt ampere

Ω ohm

W watt

Abbreviation In Full

Symbol Explanation

– negative, minus

% percent

/ per; divide; or

～ to

＋ plus

＝ equal to

＜ less than

＞ greater than

≤ less than or equal to

≥ greater than or equal to

± plus or minus

× multiply

© copyright
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F.3 Abbreviations

Abbreviation In Full

AaDO2 alveolar-arterial oxygen gradient

AC alternating current

ACI acceleration index

Adu adult

AG anaesthesia gas

AHA American Heart Association

Ao aortic pressure

Art arterial

ATMP barometric pressure

AUC area under the curve

Avg rSO2 average

aVF left foot augmented lead

aVL left arm augmented lead

aVR right arm augmented lead

awRR airway respiratory rate

BAP brachial arterial pressure

BC burst count

BL baseline

BoA Balance of Anesthesia

BSA body surface area

BT blood temperature

BTPS body temperature and pressure, saturated

CAA Clinical Assistive Application

CaO2 arterial oxygen content

CCI continuous cardiac index

CCO continuous cardiac output

CCU cardiac (coronary) care unit

CE Conformité Européenne

CFI cardiac function index

C.I. cardiac index

CIS clinical information system

CISPR International Special Committee on Radio Interference

CMOS complementary metal oxide semiconductor

CMS central monitoring system

C.O. cardiac output

CO2 carbon dioxide

COHb carboxyhemoglobin
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Compl compliance

COPD chronic obstructive pulmonary disease

CPI cardiac power index

CPO cardiac power output

CVP central venous pressure

DC direct current

Des desflurane

Dia diastolic

dpi dot per inch

dPmx left ventricular contractility

DVI digital video interface

DO2 oxygen delivery

DO2I oxygen delivery index

ECG electrocardiograph

EDV end-diastolic volume

EEC European Economic Community 

EEG electroencephalogram

EMC electromagnetic compatibility

EMG electromyograph

EMI electromagnetic interference

Enf enflurane

ESV end systolic volume

ESVI end systolic volume index

ESU electrosurgical unit

Et end-tidal

EtAA end-tidal anesthetic agent

EtDes end-tidal anesthetic agent

EtEnf

EtHal 

EtIso

EtSev

EtCO2 end-tidal carbon dioxide

EtN2O end-tidal nitrous oxide

EtO ethylene oxide

EtO2 end-tidal oxygen

EVLW extravascular lung water

ELWI extravascular lung water index

EWS Early Warning Score

FAP femoral arterial pressure

Abbreviation In Full
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FCC Federal Communication Commission

FDA Food and Drug Administration

Fi fraction of inspired

FiAA inspired anesthetic agent

FiDes inspired anesthetic agent

FiEnf

FiHal 

FiIso

FiSev

FiCO2 fraction of inspired carbon oxygen

FiN2O fraction of inspired nitrous oxide

FiO2 fraction of inspired oxygen

FPGA field programmable gate array

FV flow-volume

GCS Glasgow Coma Scale

GEDV global end diastolic volume

GEDI global end diastolic volume index

GEF global ejection fraction

Hal halothane

Hb hemoglobin

Hct haematocrit

HIS hospital information system

HR heart rate

IBP invasive blood pressure

IBW ideal body weight

ICP intracranial pressure

ICT/B intracranial catheter tip pressure transducer

ICU intensive care unit

ID identification

I:E inspiratory time: expiratory time ratio

IEC International Electrotechnical Commission 

IEEE Institute of Electrical and Electronic Engineers

IP internet protocol

Iso isoflurane

ITBI intrathoracic blood volume index

ITBV intrathoracic blood volume

LA left arm

LAP left atrial pressure

LCD liquid crystal display

Abbreviation In Full
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LCW left cardiac work

LCWI left cardiac work index

LDAP Lightweight Directory Access Protocol

LED light emitting diode

LL left leg

LVET left ventricular ejection time

LVSW left ventricular stroke work

LVSWI left ventricular stroke work index

MAC minimum alveolar concentration

MAP mean arterial pressure

Mb myoglobin

MetHb methemoglobin

MEWS Modified Early Warning Score

MLDAP Mindray LDAP, Mindray lightweight directory access protocol

MRI magnetic resonance imaging

MV minute volume

MVe expiratory minute volume

MVi inspiratory minute volume

N/A not applied

N2 nitrogen

N2O nitrous oxide

Neo neonate

NEWS National Early Warning Score

NIBP noninvasive blood pressure

NIF negative inspiratory force

O2 oxygen

O2% oxygen concentration

OR operating room

OxyCRG oxygen cardio-respirogram

PA pulmonary artery

Paw airway pressure

PAWP pulmonary artery wedge pressure

Ped pediatric

PEEP positive end expiratory pressure

PEF peak expiratory flow

PEP pre-ejection period

PIF peak inspiratory flow

PIP peak inspiratory pressure

Pleth plethysmogram

Abbreviation In Full
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Pmean mean pressure

PO2 oxygen supply pressure

Pplat plateau pressure

PPV pulse pressure variation

PR pulse rate

PVC premature ventricular contraction

PVPI pulmonary vascular permeability index

PVR pulmonary vascular resistance

PVRI pulmonary vascular resistance index

qSOFA quick Sepsis-Related Organ Failure Assessment

RA right arm

RAP right atrial pressure

Raw airway resistance

Rec record, recording

Resp respiration

RL right leg

RR respiration rate

RSBI rapid shallow breathing index

RVEF right ventricular ejection fraction

rSO2 regional oxygen saturation

SaO2 arterial oxygen saturation

ScvO2 central venous oxygen saturation

SEF spectral edge frequency

Sev sevoflurane

SI stroke index

SMR satellite module rack

SOFA Sepsis-Related Organ Failure Assessment

SpO2 arterial oxygen saturation from pulse oximetry

SQI signal quality index

SR suppression ratio

SSC Surviving Sepsis Campaign

SSI signal strength index

STR systolic time ratio

SV stroke volume

SVI stroke volume index

SVR systemic vascular resistance

SVRI systemic vascular resistance index

SVV stroke volume variation

SvO2 venous oxygen saturation

Abbreviation In Full
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Sync synchronization

Sys systolic pressure

TB blood temperature

tcpCO2 transcutaneous carbon dioxide partial pressures

tcpO2 transcutaneous oxygen partial pressures

TD temperature difference

Temp temperature

TFC thoracic fluid content

TFI thoracic fluid index

TFT thin-film technology

TI injectate temperature

TP total power

TRC tube resistance compensation

TVe expiratory tidal volume

TVi inspiratory tidal volume

TV tidal volume

UAP umbilical arterial pressure

UPS uninterruptible power supply

USB universal serial bus

UVP umbilical venous pressure

VAC volts alternating current

VEPT volume of electrically participating tissue

VI velocity index

VPB ventricular premature beat per minute

WOB work of breathing

Abbreviation In Full
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